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3 1章　概要

システム構成例

UHFシンセサイザーダイバーシティチューナー	
URX-S03D
デジタルワイヤレスレシーバー	
DWR-S02DN

ワイヤレス	
マイクロホン
パッケージ	
UWP-D21	
UWP-D22

（受信機：
URX-P40）

ワイヤレス	
マイクロホン
レシーバー	
URX-P03D

マルチインター
フェースシュー
アダプター	
SMAD-P3D

マルチインターフェース
シューアダプター	
SMAD-P5

Aマウントアダプター	
LA-EA3	
LA-EA4

Eマウントレンズ

マイクロホン	
ECM-VG1、ECM-MS2

リモートコントロール
ユニット	
RM-30BP

グリップリモコン（付属）

PXW-FX9V/PXW-FX9VK

ショルダーアダプター	
VCT-FS7

XLRアダプター
キット	
XLR-K2M、
XLR-K3M

ビデオライト	
HVL-LBPC

XQDメモリーカード	
S/N/M/H/Gシリーズ

バッテリーパック	
BP-U35、BP-U70、
BP-U100

ACアダプター	
（付属）

拡張ユニット	
XDCA-FX9

XQDカードリーダー	
MRW-E80、MRW-E90

バッテリーチャージャー	
BC-U1A、BC-U2A

マウントアダプター	
LA-EB1

マルチカメラライブ
プロデューサー	
MCX-500

*	 Eマウント以外のレンズの場合はマウント変換アダプターが必要です。
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各部の名称と働き
左側面・前面・ハンドル部
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1.	 ハンドル（5ページ）

2.	Wi-Fiアンテナ（59ページ）

3.	 排気口
［ご注意］

排気口をふさがないでください。

4.	ビューファインダー接続端子（20ページ）

5.	 REMOTE端子
汎用のLANC端子アクセサリーを接続します。

6.	USB/マルチ端子（24ページ）

7.	 INPUT1スイッチ（LINE/MIC/MIC+48V）
（45ページ）

8.	ショルダーパッド（24ページ）

9.	 INPUT2スイッチ（LINE/MIC/MIC+48V）
（45ページ）

10.	グリップ取り付け部（23ページ）

11.	メジャーフック
メジャーフックがイメージセンサー面の位置とな
ります。本機から被写体までの距離を正確に測
るには、メジャーフックの位置を参考にしてくだ
さい。メジャーフックにメジャーの先端をかけて、
被写体からの距離を実測できます。

12.	記録/タリーランプ（フロント）（33ページ）
記録メディアやバッテリー残量が少なくなると点
滅します。

13.	レンズロックリングストッパー（22ページ）

14.	イメージセンサー

15.	マルチファンクションダイヤル（47ページ）
ビューファインダーに映像が表示されているとき
に押すとダイレクトメニューが表示され、操作す
ることができます。
また、ビューファインダーに各種メニューが表示
されているときに回すとカーソルが上下に移動し
て、メニュー項目や設定値を選択できます。押す
と選択している項目を確定します。
メニュー表示していないときは、アサイナブルダ
イヤルのように機能させることができます。

16.	レンズ信号接点
Eマウントレンズを接続します。

17.	 WB	SET（ホワイトバランスセット）ボタン
（44ページ）

18.	レンズロックピン（22ページ）

19.	レンズロックリング（22ページ）

20.	GPSモジュールアンテナ
この部分にGPSアンテナと周辺回路が内蔵され
ています。

21.	アクセサリーシュー（4ページ）

22.	ハンドル録画START/STOPボタン
ロックレバーをロック位置にすると録画ボタンが
効かなくなります。

23.	ハンドルズームレバー（114ページ）

24.	マルチインターフェースシュー

マルチインターフェースシュー対応アクセサリーに
ついて詳しくは販売店にお問い合わせください。

アクセサリーシューを取り付ける

1 シューバネの先端を持ち上げ、刻印された
矢印の向きと反対方向へ引き抜く。

シューバネ

アクセサリーシュー

1

2 アクセサリーシューの凸部とアクセサリー
シュー取り付け部の凹部を合わせて取り付
け、4本のネジを締める。

3 シューバネを矢印の方向に挿入し、コの字部
分がアクセサリーシューの端部にはまるよう
に取り付ける。
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シューバネ

アクセサリーシュー

3 22

アクセサリーシューを取り外す

「アクセサリーシューを取り付ける」の手順1と同
様にシューバネを外し、ネジを緩めてアクセサ
リーシューを外す。

ハンドルを取り外す

4本のハンドル取り付けネジを外し、ハンドルを
本機から取り外す。

ハンドルコネクター保護キャップ（付属
品）の使いかた

ハンドルを外して本機を使用するときは、付属
の保護キャップを使って端子部を保護してくださ
い。

接続端子の保護について

接続端子を保護するために、使用しない端子類
にはカバーを装着してください。

上面

1

3

2

1.	 拡張ネジ穴（3/8インチ）
3/8-16UNCのネジ（長さ10.0	mm以下）に対応し
ています。

2.	拡張ネジ穴（1/4インチ）
1/4-20UNCのネジ（長さ7.0	mm以下）に対応し
ています。

3.	 ハンドル接続端子
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右側面前部/上部/下部
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右側面後部（7ページ）

1.	 本体内蔵スピーカー（33ページ）

2.	 VOLUME（モニター音量調節）ボタン
モニター音量やアラーム音量を調整します。

3.	 	（Nマーク）
ˎˎ NFC機能搭載のスマートフォンと本機を無線接
続するときにタッチします（59ページ）。	
一部のおサイフケータイ対応のスマートフォン
はNFCに対応しています。詳しくはスマートフォ
ンの取扱説明書でご確認ください。

ˎˎ NFC（Near	Field	Communication）は近距離
無線通信技術の国際標準規格です。

4.	HOLDスイッチ（114ページ）
本体の操作を無効（ホールド状態）にします。

5.	 録画START/STOPボタン/ランプ（33ペー
ジ）

6.	ND	VARIABLEダイヤル（42ページ）

7.	 ND	PRESET/VARIABLEスイッチ（42
ページ）

8.	ND	FILTER	POSITION上下ボタン（42
ページ）

9.	 ND	CLEARランプ（42ページ）

10.	ND	VARIABLE	AUTOボタン（42ページ）

11.	 STATUS（ステータス）ボタン（14ページ）
本機の主な設定を表示します。一部の項目は設
定の変更ができます。

12.	FOCUS	AUTOランプ（35ページ）

13.	 FOCUSスイッチ（35ページ）

14.	PUSH	AUTO	FOCUS（プッシュオートフォー
カス）ボタン（38ページ）

15.	 IRISファンクションボタン（41ページ）

16.	PUSH	AUTO	IRIS（プッシュオートアイリス）
ボタン（41ページ）

17.	 ISO/GAINファンクションボタン（41ペー
ジ）

18.	ISO/GAIN（ゲイン切り替え）スイッチ（41
ページ）

19.	ASSIGN（アサイナブル）9ボタン（47ペー
ジ）

20.	WHT	BAL（ホワイトバランス）ファンクション
ボタン（44ページ）

21.	WHT	BAL（ホワイトバランスメモリー切り替
え）スイッチ（44ページ）

22.	SHUTTER（シャッター）ファンクションボタン
（42ページ）

23.	吸気口
［ご注意］
吸気口をふさがないでください。

24.	POWERランプ（33ページ）

25.	POWERスイッチ（33ページ）



1章　概要：各部の名称と働き7

右側面後部

MENU

THUMBNAIL

EXT

MI SHOE MAN

INT AUTO

SLOT SELECT  

AUDIO LEVEL

CANCEL/
BACK

DISPLAY

S&Q

1

3

EXT

MI SHOE MAN

INT AUTO

7 8

CH-1

CH-2

CH-3

CH-42

1 2

1415 13

6

3
5

7
89

10

1112

4

1.	 ASSIGN（アサイナブル）1～3、7～ 8ボタン
（47ページ）

2.	 SLOT	SELECT（XQDメモリーカード選択）ボ
タン（33ページ）

3.	 CH1	INPUT切り替えスイッチ（45ページ）

4.	CH1（AUTO/MAN）スイッチ（45ページ）

5.	 AUDIO	LEVEL（CH1）ダイヤル（45ページ）

6.	AUDIO	LEVEL（CH3）ダイヤル（45ペー
ジ）

7.	 CH2	INPUT切り替えスイッチ（45ページ）

8.	CH2（AUTO/MAN）スイッチ（45ページ）

9.	 AUDIO	LEVEL（CH2）ダイヤル（45ペー
ジ）

10.	AUDIO	LEVEL（CH4）ダイヤル（45ペー
ジ）

11.	 CANCEL/BACKボタン（76ページ）

12.	矢印（///）とSETボタン（76ペー
ジ）

13.	MENU（メニュー）ボタン（78ページ）

14.	THUMBNAIL（サムネイル）ボタン（75ペー
ジ）

15.	DISPLAY（画面表示）ボタン（11ページ）
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カードスロット部・背面・端子部
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1.	 XQDカードスロット（A）（29ページ）

2.	アクセスランプ（XQD	A）（30ページ）

3.	 XQDカードスロット（B）（30ページ）

4.	アクセスランプ（XQD	B）（30ページ）

5.	 ヘッドホン端子（33ページ）

6.	アクセスランプ（SDカード）（32ページ）

7.	 UTILITY	SD/MSカードスロット（32ペー
ジ）

8.	拡張ユニット接続端子（内部）（25ページ）

9.	 DC	IN端子（19ページ）

10.	記録/タリーランプ（リア）（33ページ）

11.	 BATT	RELEASEボタン（18ページ）

12.	バッテリー（18ページ）

13.	バッテリーパック装着部（18ページ）

14.	吸気口
［ご注意］

吸気口をふさがないでください。

15.	本体内蔵マイク（45ページ）
環境音収録用のナレーションマイクです。

16.	SDI	OUT	1端子（127ページ）

17.	 INPUT1（オーディオ入力1）端子（45ペー
ジ）

18.	INPUT2（オーディオ入力2）端子（45ペー
ジ）

19.	SDI	OUT	2端子（127ページ）

20.	IN/OUT切り替えスイッチ（128ページ）

21.	TC	IN/TC	OUT（タイムコード入力/出力）端子
（128ページ）

22.	GENLOCK	IN（Genlock用入力）/REF	OUT
（同期信号出力）端子（128ページ）

23.	HDMI	OUT端子（127ページ）

底面

1

1.	 三脚用ネジ穴（1/4インチ、3/8インチ）
1/4-20UNCネジ、3/8-16UNCネジに対応三脚（別
売、ネジの長さ5.5	mm以下）を取り付けます。

ビューファインダー

ビューファインダー（付属）の取り付けについては、
20ページをご覧ください。

1
2
3

4 65

1.	 PEAKINGボタン

2.	 ZEBRAボタン

3.	 ASSIGN（アサイナブル）10ボタン（47ペー
ジ）

4.	MIRRORスイッチ

5.	 アイピース取り付けフック

6.	タッチパネル
アサイナブルボタンまたはメニューでタッチ操作
を無効にすることもできます（10ページ）。
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アイピース

アイピース（付属）の取り付けについては、
22ページをご覧ください。

1 2

1.	 視度調節つまみ

2.	アイカップ

グリップリモコン

グリップリモコン（付属）の取り付けについては、
23ページをご覧ください。

1
2
3

4

5
6
7
8

1.	 ズームレバー

2.	 ASSIGN（アサイナブル）4ボタン

3.	 アサイナブルダイヤル

4.	ASSIGN（アサイナブル）6ボタン

5.	 グリップ回転レバー

6.	録画START/STOPボタン

7.	 マルチセレクター（8方向/SETボタン）

8.	ASSIGN（アサイナブル）5ボタン	

拡張ユニットXDCA-FX9（別
売）

拡張ユニットXDCA-FX9（別売）の取り付けにつ
いては、25ページをご覧ください。

前面

1

2
3

1.	 ワイヤレスレシーバー挿入部
ワイヤレスマイクロホンを使用するときに、ポー
タブルワイヤレスチューナーを取り付けます。

2.	 DC	OUT端子（丸型4ピン）
12V	DC電源出力用端子です。

3.	 LIGHT端子（2ピン）
12V	DC電源出力用端子です。

後面

2

1

4

6

3

5

8 97

1.	 USB端子（A型）

2.	バッテリーリリースレバー

3.	 バッテリー取り付け端子

4.	 TC	OUT端子（BNC型）

5.	 REF	OUT端子（BNC型）

6.	DC	IN端子（XLR型、4ピン）

7.	 記録/タリーランプ（リア）（33ページ）

8.	RAW	OUT端子（BNC型）

9.	有線LAN端子
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タッチパネルの使いかた
タッチパネル利用上のご注意

本製品のビューファインダーはタッチパネルに
なっており、指で直接触れて操作を行えます。

ˎˎ タッチパネルは指で軽く触れるように設計され
ています。指で強く押したり、先の尖ったもの

（爪／ボールペン／ピンなど）を押し付けたりし
ないでください。

ˎˎ 次の場合はタッチパネルに触れても動作しない
ことがあります。また、誤動作の原因となりま
すのでご注意ください。

ˎˎ 	爪の先での操作

ˎˎ 	異物を操作面に乗せたままでの操作

ˎˎ 	保護シートやシールなどを貼っての操作

ˎˎ 	ディスプレイに水滴が付着または結露して
いる状態での操作

ˎˎ 	濡れた指または汗で湿った指での操作

ˎˎ 	水中での操作

タッチパネル上の操作

タップ
アイコンなどの項目に指で軽く触れ、すぐに離し
ます。

ドラッグ
画面に触れたまま目的の位置までなぞって指を離
します。

フリック／スワイプ
画面に触れて上下または左右にはらうように操作
します。

［メモ］
表示内容が画面の外へ続く場合は、表示内容をドラッグし
たりフリックしたりしてスクロールさせることができます。

タッチパネルの設定

タッチパネルを利用するかどうかは、Technical
メニューのTouch	Operation（81ページ）で
設定できます。
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画面表示
撮影中（記録中/記録待機中）および再生中は、ビューファインダー画面の映像に本機の状態や設定が
重ねて表示されます。
表示/非表示の切り替えは、DISPLAYボタンで行います。
また、項目ごとに表示/非表示を選択することもできます（107ページ）。

撮影中の画面に表示される情報

5 62

8

3 4

10

11 1297

13
16 14 1517
18
19

20
21
22

23 24 25 26 27 28 29 30 31 32 33

34
35
36
37
38
39
40
41
42

143

1.	 ネットワーク状態表示（13ページ）
ネットワーク接続の状態がアイコンで表示されま
す。

2.	アップロード中表示/転送ファイル残数表示
（65ページ）

3.	 ネットワーククライアントモード状態表示
（14ページ）

ネットワーククライアントモード時の接続状態を
表示します。

4.	ストリーミング状態表示

5.	 フォーカスエリア表示（36ページ）
オートフォーカスでフォーカスを合わせる領域が
表示されます。

6.	記録モード/スロットA/B/動作状態表示、イ
ンターバルレック記録間隔時間表示（50
ページ）

表示 意味
●Rec 記録中
Stby 記録待機中

7.	 被写界深度表示

8.	イメージャースキャンモード表示（28ペー
ジ）

使用レンズのイメージサークルサイズと、イメー
ジャースキャンモードの有効画サイズに不一致が
ある場合は、 	マークが表示されます。

9.	 RAW出力動作状態表示（58ページ）
RAW信号の出力状態が表示されます。

10.	UWP-Dシリーズの状態表示（14ページ）
UWP-DシリーズをMIシューにデジタルオーディ
オ伝送の設定で接続したとき、電波強度を示す
RFレベルなどがアイコンで表示されます。

11.	 スロー＆クイックモーション撮像フレーム
レート表示（48ページ）

12.	バッテリー残量/DC	IN電圧表示（18ペー
ジ）

13.	フォーカスモード表示（39ページ）
意味 表示
Focus	Holdモード Focus	Hold
MFモード MF
AFモード AF
リアルタイムトラッキング
AFモード

顔/瞳検出AF（AF/ /Only/ / 	）

顔/瞳検出アイコン

顔/瞳限定AFアイコン Only
保存された追尾顔あり
アイコン

	

顔/瞳限定AF中のAF
一時停止アイコン1)

1)	 追尾対象の顔が保存されていない状態で顔が検出され
ないとき、または追尾対象の顔が保存されているが、追
尾対象の顔が検出されないときに表示されます。

14.	フォーカスポジション表示
フォーカスの位置が表示されます。

15.	フォーカスマーカー表示（36ページ）
フォーカスの基準位置からの差分が–99999	～	
+99999の範囲で表示されます。

16.	ズームポジション表示
ズームの位置が0（広角端）～	99（望遠端）の範
囲で表示されます。（ズーム設定表示対応レンズ
装着時のみ）
バー表示または焦点距離表示に変えることもで
きます（116ページ）。

17.	 GPS状態表示（54ページ）
GPSの状態を表示します。

18.	手ブレ補正モード表示

19.	SDI出力/HDMI出力のRec	Control状態表
示（127ページ）

RECコントロール信号の出力状態を表示します。

20.	フォーカスインジケーター表示（35ペー
ジ）

21.	メディア残量表示

22.	ホワイトバランスモード表示
表示 意味

自動モード

	Hold 自動モード一時停止

W:P プリセットモード
W:A メモリー	A	モード
W:B メモリー	B	モード

23.	タイムコード外部ロック表示/タイムデータ表
示（33ページ）

他機のタイムコードにロックさせると「EXT-LK」と
表示されます。

24.	NDフィルター表示（42ページ）

25.	シーンファイル表示（124ページ）
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26.	アイリス表示
アイリスの位置（F値またはT値）が表示されます。

（アイリス設定表示対応レンズ装着時のみ）

27.	映像レベル注意表示

28.	ゲイン表示（41ページ）
ProjectメニューのBase	SettingのShooting	
Mode（93ページ）が「Cine	EI」のときは、EI
値を表示します。

表示 意味
自動モード

H プリセットHモード
M プリセットMモード
L プリセットLモード

一時調節モード

29.	クリップ名表示（75ページ）

30.	シャッター表示（42ページ）

31.	AEモード/AEレベル表示（41ページ）

32.	水準器表示
本機の水平方向の傾きが±1°刻みで±15°まで表
示されます。

33.	オーディオレベルメーター
CH1とCH2またはCH3とCH4のオーディオレベ
ルを表示します。
AudioメニューのAudio	Output	>	Monitor	CH

（111ページ）の設定によって、以下のように表
示されます。

Monitor	CHの設定 表示チャンネル

CH1/CH2 CH1/CH2
CH3/CH4 CH3/CH4
MIX	ALL CH1/CH2
CH1 CH1/CH2

Monitor	CHの設定 表示チャンネル

CH2 CH1/CH2
CH3 CH3/CH4
CH4 CH3/CH4

ステータス画面でもオーディオレベルを確認でき
ます。

34.	映像信号モニター（52ページ）
ウェーブフォーム、ベクトルスコープ、ヒストグラ
ムを表示します。
ProjectメニューのBase	SettingのShooting	
Mode（93ページ）が「Cine	EI」のときは、表
示の上にモニター対象としているモニター LUTの
種類などが表示されます。

35.	記録フォーマット（コーデック）表示（93
ページ）

XQDメモリーカードに記録されるフォーマット名
称を表示します。

36.	Base	Sensitivity表示/Base	ISO表示
（41ページ）

ProjectメニューのBase	SettingのShooting	
Mode（93ページ）が「SDR」または「HDR」の
ときは、ShootingメニューのISO/Gain/EIの
Base	Sensitivityで設定されている基準感度が
表示されます。
ProjectメニューのBase	SettingのShooting	
Mode（93ページ）が「Cine	EI」のときは、
ShootingメニューのISO/Gain/EIのBase	ISO
で設定されているBase	ISO感度が表示されま
す。

37.	ガンマ表示アシスト/モニター LUT表示
ガンマ表示アシストの状態を表示します。ガ
ンマ表示アシストの表示/非表示は、Gamma	
Display	Assistが割り当てられたアサイナブルボ

タン（47ページ）で切り替えることができます。
ProjectメニューのBase	SettingのShooting	
Mode（93ページ）が「Cine	EI」のときは、モ
ニター LUT（91ページ）の設定を表示します。

38.	ガンマ表示（101ページ）
XQDメモリーカードに記録される映像のガンマ
設定値を表示します。

39.	プロキシ状態表示
表示 意味

プロキシ記録On

プロキシ記録中

		
（点滅）

プロキシ記録準備中

プロキシ分割記録On
プロキシ分割記録中

	
（点滅）

プロキシ分割記録準備中

40.	4K	&	HD（Sub）記録表示

41.	記録フォーマット（フレームレートとスキャン
方式）

42.	記録フォーマット（画サイズ）表示（93ペー
ジ）

XQDメモリーカードに記録される画サイズを表示
します。

43.	リアルタイムトラッキングAF終了ボタン
（40ページ）
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再生中の画面に表示される情報

再生画像には、次のような情報が重ねて表示されます。

1

11 12 13 14 15 16

2 3 4 5 6 7 8 9 10

1.	 ネットワーク状態表示

2.	アップロード中表示/転送ファイル残数表示

3.	 クリップ番号/クリップ総数

4.	再生動作状態表示

5.	 再生フォーマット（フレームレートとスキャン
方式）表示

6.	ネットワーククライアントモード状態表示

7.	 ストリーミング状態表示

8.	再生フォーマット（画サイズ）表示

9.	バッテリー残量/DC	IN電圧表示

10.	再生フォーマット（コーデック）表示

11.	 メディア表示
メモリーカードがプロテクトされている場合は、
	マークが表示されます。

12.	タイムデータ表示

13.	クリップ名表示

14.	ガンマ表示アシスト表示

15.	オーディオレベルメーター
記録されているオーディオレベルを表示します。

16.	ガンマ表示

アイコン表示について

ネットワーク接続のアイコン表示

ネットワークモード 接続状態 アイコン
アクセスポイントモード アクセスポイントとして動作中

アクセスポイント動作エラー

ステーションモード Wi-Fi接続中
電波強度によりアイコンが変化（4段階）

	 	 	

Wi-Fi接続断（準備中含む）

Wi-Fi接続エラー

モデム/スマートフォン1) 3G/4G接続中電波強度によりアイコンが
変化（5段階）
電波強度を通知しないモデムの場合、接
続中は強度3のアイコンを表示

3G接続中
	－	

4G接続中
	－	

3G/4Gが判別できないネット
ワークに接続中

	－	

3G/4G接続断（準備中含む）

3G/4G接続エラー

電波強度を通知しないモデム/スマート
フォンなどが接続されているため電波強
度が不明

1)	本機に取り付けたXDCA-FX9（別売）にモデムを2台接続できます。モデムを2台接続したとき、モデムの状態によりアイ
コンは次のように変化します。

接続状態 アイコン
モデムを2台接続して、Modem	1のみ使用中 	

モデムを2台接続して、Modem	2のみ使用中 	

モデムを2台接続して、両方とも使用中 	
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ネットワーククライアントモードのアイコン表示

ネットワーククライアントモード接続状態 アイコン
ネットワーククライアントモードで接続済みの状態

ネットワーククライアントモードで接続待機状態

ネットワーククライアントモードで接続エラー状態

UWP-Dシリーズのアイコン表示

送信機の状態 受信状態 アイコン
電源OFF 未受信

通常送信状態 受信中 	～	 	（受信レベル
を4段階で表示）

ミュート状態 受信中（ミュート中）

バッテリー残量警告状態 受信中 	（アイコン点滅）

ミュート、かつバッテリー残量警告状態 受信中 	（アイコン点滅）

ステータス画面

ステータス画面では、本機の設定や状態を確認
することができます。また、*印が付いている項
目については設定を変更できます。
ステータス画面はタッチ操作に対応しています。

ステータス画面を表示させるには
ˎˎ STATUS（ステータス）ボタンを押す

［メモ］
TechnicalメニューのStatus	Page	On/Off（115ページ）
で、各ステータス画面の表示/非表示を切り替えることが
できます。

ステータス画面を切り替えるには
ˎˎ マルチファンクションダイヤルを回す

ˎˎ 矢印ボタンの/ボタンを押す

ˎˎ ステータス画面を上下にスワイプする

ステータス画面を消すには
ˎˎ STATUS（ステータス）ボタンを押す

設定を変更するには

ステータス画面の表示中にマルチファンクション
ダイヤルやマルチセレクターを押すと、ページ内
の設定項目を選べるようになります。ページ番号
を選んで押すと、ページ切り替えに戻ります。な
お、タッチ操作で直接選ぶこともできます。

［メモ］
TechnicalメニューのMenu	SettingsのUser	Menu	Only

（114ページ）をOnにすると、ステータス画面で設定変
更できなくなります。

メインステータス画面

カメラの主な機能の設定やメディアの空き状態を
表示します。

表示項目 説明
S&Q	Frame	
Rate*	

スロー＆クイックモーション撮
影とフレームレートの設定

Frequency/
Scan*

システム周波数と走査方式の
設定

Imager	Scan* イメージセンサーの読み出し
モード

Media	Remain	
(A)

Slot	Aのメディアの空き容量

ND	Filter NDフィルターの設定値
ISO/Gain/EI ISO/Gain/Exposure	Index

の設定値
Base	ISO/
Sensitivity*

Base	ISO/Base	Sensitivity
の設定

Codec* 記録するコーデックおよび
RAW出力の有無の設定

Media	Remain	
(B)

Slot	Bのメディアの空き容量

Scene	File* 使用中のScene	Fileとその
File	ID

Monitor	LUT* モニター LUTの設定
Shutter シャッタースピードまたは

シャッター角度の設定値
Iris アイリスの設定値
Video	Format* XQDメモリーカードに記録す

る画サイズ
RAW	Output	
Format*

RAW出力の画サイズ

White	Balance ホワイトバランスの設定値
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カメラステータス画面

主にカメラの各種プリセットの状態を表示しま
す。

表示項目 説明
White	
Switch<B>

ホワイトバランスのメモリー B
の設定値

White	
Switch<A>

ホワイトバランスのメモリーA
の設定値

White	
Switch<P>

Preset	Whiteの設定値

ND<Preset> NDフィルターのPreset1 ～ 3
の設定値

ISO	/	Gain	1)	<L>* ISO/Gain	1)	<L>の設定
ISO	/	Gain	1)	<M>* ISO/Gain	1)	<M>の設定
ISO	/	Gain	1)	<H>* ISO/Gain	1)	<H>の設定
Base	ISO/
Sensitivity*

Base	ISO/Base	Sensitivity
の設定

Zebra1* ゼブラ1のOn/Offと設定レベ
ル

Zebra2* ゼブラ2のOn/Offと設定レベ
ル

VF	Gamma/
Gamma

ガンマカテゴリーとカーブ

Scene	File* 使用中のScene	Fileとその
File	ID

1)	 Shooting	ModeがCine	EIのときはExposure	Indexと
なります。

オーディオステータス画面

各チャンネルの入力設定とオーディオレベルメー
ター、音声モニターの設定を表示します。

表示項目 説明
CH1 Level	Control 自動調節のOn/Off状態

Level	Meter オーディオレベルメーター
Source* 入力ソース
Reference* 入力リファレンスレベル
Wind	Filter* マイクの風音低減フィル

ターの設定
CH2 Level	Control 自動調節のOn/Off状態

Level	Meter オーディオレベルメーター
Source* 入力ソース
Reference* 入力リファレンスレベル
Wind	Filter* マイクの風音低減フィル

ターの設定
CH3 Level	

Control*
自動調節のOn/Off状態

Level	Meter オーディオレベルメーター
Source* 入力ソース
Reference* 入力リファレンスレベル
Wind	Filter* マイクの風音低減フィル

ターの設定
CH4 Level	

Control*
自動調節のOn/Off状態

Level	Meter オーディオレベルメーター
Source* 入力ソース
Reference* 入力リファレンスレベル
Wind	Filter* マイクの風音低減フィル

ターの設定
Audio	Input	Level* マスター音声入力レベルの

設定
HDMI	Output	CH* HDMIに出力される音声

チャンネルの設定
Headphone	Out* ヘッドホン出力方式の設定

表示項目 説明
Monitor	CH* モニターするチャンネルの

設定

［ご注意］
CH1およびCH2のSourceの設定は、基本的に本機右側面
のCH1	INPUT切り替えスイッチ（7ページ）およびCH2	
INPUT切り替えスイッチ（7ページ）で行います。CH1お
よびCH2のSourceは、ポータブルワイヤレスチューナーを
使用する場合に設定できます（25ページ）。また、CH2
のSourceは、CH2	INPUT切り替えスイッチがEXTのとき
に設定できます。

プロジェクトステータス画面

撮影プロジェクトに関する基本的な設定を表示
します。

表示項目 説明
Frequency/
Scan*

システム周波数と走査方式の
設定

Codec* 記録するコーデックの設定
Rec	Function* 特殊な記録機能のOn/Offと

主な設定
Simul	Rec* 2スロット同時記録機能の

On/Off状態と設定
Title	Prefix	1)	/	
Reel	2)

クリップ名のタイトル部分/
Camera	IDとReel	Number
の設定値

Imager	Scan* イメージセンサーの読み出し
モード

Video	Format* XQDメモリーカードに記録す
る画サイズ

Picture	Cache	
Rec*

ピクチャーキャッシュレック機
能のOn/Off状態と設定

Number	1)	/	
Shot	2)

クリップ名の最後の数値部分/
Shot	Numberの値

Shooting	Mode* 撮影モードの設定
RAW	Output	
Format*

RAW出力の画サイズ

表示項目 説明
4K	&	HD	(Sub)	
Rec*

4K	&	HD	(Sub)	記録機能の
On/Off状態

Proxy	Rec* プロキシ記録のOn/Off状態
と設定

Genlock ゲンロックの状態

1)	 Auto	NamingがTitleまたはPlanのとき
2)	Auto	NamingがCam	ID+Reel#のとき

モニタリングステータス画面

SDI、HDMI、ビデオ出力の設定を表示します。

表示項目 説明
SDI1 Signal* 出力画サイズ

Info.	Disp* 画面表示出力On/Off
Color	
Gamut*

色域の設定値/モニター
LUTの適用状態

SDI2 Signal* 出力画サイズ
Info.	Disp* 画面表示出力On/Off
Color	
Gamut*

色域の設定値/モニター
LUTの適用状態

HDMI Signal* 出力画サイズ
Info.	Disp* 画面表示出力On/Off
Color	
Gamut*

色域の設定値/モニター
LUTの適用状態

Stream Signal 出力画サイズ
Info.	Disp 画面表示出力（Off固定）
Color	
Gamut*

色域の設定値/モニター
LUTの適用状態

RAW RAW出力の画サイズ
Monitor	LUT* モニター LUTの設定
VF* ガンマ表示アシストの設

定/モニター LUTの適用
状態/色域の設定値

［ご注意］
モニター LUTの設定は、VFを含む全ての出力系統が連動
します。表示項目VFでは、ガンマ表示アシストの設定のみ
可能です。
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アサイナブルボタンステータス画面

各アサイナブルボタンに割り当てた機能を表示し
ます。

表示項目 説明
1 ASSIGN1ボタンに割り当てら

れている機能
2	 ASSIGN2ボタンに割り当てら

れている機能
3 ASSIGN3ボタンに割り当てら

れている機能
4 ASSIGN4ボタンに割り当てら

れている機能
5 ASSIGN5ボタンに割り当てら

れている機能
6 ASSIGN6ボタンに割り当てら

れている機能
7 ASSIGN7ボタンに割り当てら

れている機能
8 ASSIGN8ボタンに割り当てら

れている機能
9 ASSIGN9ボタンに割り当てら

れている機能
10 ASSIGN10ボタンに割り当て

られている機能
Focus	Hold	
Button

レンズのFocus	Holdボタンに
割り当てられている機能

Multi	Function	
Dial

マルチファンクションダイヤル
に割り当てられている機能

Assignable	Dial アサイナブルダイヤルに割り
当てられている機能

バッテリーステータス画面

バッテリーまたはDC	IN電源の情報を表示します。

表示項目 説明
Detected	
Battery

バッテリーの種類

Remaining 残容量（％）

表示項目 説明
Charge	Count 充電を行った回数
Capacity 残容量（Ah）
Voltage 電圧（V）
Manufacture	
Date

バッテリーの製造年月日

Video	Light	
Remaining

ビデオライトバッテリー残量
表示

Power	Source 電源供給源
Supplied	
Voltage	

供給電源電圧

メディアステータス画面

記録メディアの残量および残記録可能時間を表
示します。

表示項目 説明
メディアAのメディ
ア情報

Aスロットにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアAの残量
メーター

Aスロットに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアAの残時
間

現在と同じ状態でAスロット
に挿入されている記録メディ
アに記録したときの予測残時
間を分単位で表示する

メディアBのメディ
ア情報

Bスロットにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアBの残量
メーター

Bスロットに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアBの残時
間

現在と同じ状態でBスロット
に挿入されている記録メディ
アに記録したときの予測残時
間を分単位で表示する

表示項目 説明
SDカードのメディ
ア情報

UTILITY	SD/MSカードスロッ
トにメディアが挿入されてい
るとき、メディアアイコンを表
示する

SDカードのプロテ
クト情報

UTILITY	SD/MSカードスロッ
トに挿入されている記録メ
ディアがプロテクトされてい
るとき、Protectアイコンを表
示する

SDカードの残量
メーター

UTILITY	SD/MSカードスロッ
トに挿入されている記録メ
ディアの残容量を、残比率で
表したバーで表示する

SDカードの残容
量

UTILITY	SD/MSカードスロッ
トに挿入されている記録メ
ディアに記録したときの予測
残時間を分単位で表示。また
は残容量を単位GBで表示す
る

GPSステータス画面

GPSの測位状態と情報を表示します。

表示項目 説明
GPS GPS信号の測位状態
Dilution	Of	
Precision

測位精度の情報

Latitude 緯度情報
Longitude 経度情報
Altitude 高度情報
Positioning	
date	and	time

測位日時

Current	date	
and	time

現在日時

Time	Zone Time	Zoneの設定値

ネットワークステータス画面

ネットワーク接続の接続状態を表示します。

表示項目 説明
Wireless	LAN ワイヤレスネットワークの設

定、接続状態
Wired	LAN 有線LANネットワークの設定、

接続状態
Modem	1 モデム（別売）によるワイヤレス

ネットワークの設定、接続状
態

Modem	2 モデム（別売）によるワイヤレス
ネットワークの設定、接続状
態

NCM/	ストリーミングステータス画面

ネットワーククライアントモードの接続状態とス
トリーミングの状態を表示します。

表示項目 説明
Network	Client	
Mode	Status

ネットワーククライアントモー
ドの状態

CCM	Name ネットワーククライアントモー
ド時に接続中のCCMの名称

CCM	Address ネットワーククライアントモー
ド時に接続中のCCMのアドレ
ス

QoS	Streaming1	
Bit	Rate

ストリーミングの配信ビット
レート1

QoS	Streaming2	
Bit	Rate

ストリーミングの配信ビット
レート2

Streaming	
Status

ストリーミングの配信状態

Streaming	Type 現在選択しているストリーミ
ング設定の種別
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ファイル転送ステータス画面

ファイル転送の情報を表示します。

表示項目 説明
Auto	Upload Auto	UploadのOn/Off状態
Auto	Upload	
(Proxy)

Auto	Upload	(Proxy)のOn/
Off/Chunk状態

Total	Transfer	
Progress

総ジョブの転送進捗状況

Default	Upload	
Server

Auto	Upload/Auto	Upload	
(Proxy)の転送先サーバー名

Job	Status	
(Remain	/	Total)

総ジョブ数と残りのジョブ数

Current	File	
Transfer	
Progress

転送中ファイルの転送進捗状
況

Current	
Transferring	File	
Name

転送中のファイル名

Server	Address ファイル転送先サーバーのア
ドレス

Destination	
Directory

ファイル転送先サーバーの転
送先ディレクトリー

タッチ操作対応設定画面の使いかた

画面構成
設定項目 Set（決定）ボタン

直前の設定値
を示す印

設定値選択カーソル（橙色枠）

設定項目名

設定値の選択肢

操作方法

1 設定項目をタップする。

タップ
設定値の選択肢が表示されます。

2 設定値を直接タップするか、ドラッグまたはフ
リックして設定値をカーソル位置に移動する。

フリック

3 Setボタンまたは設定値選択カーソルをタッ
プする。
設定値を確定し元の画面に戻ります。

［メモ］

ˎˎ 矢印ボタンのボタンを押しても確定します。
ˎˎ 	CANCEL/BACKボタンを押すと直前の設定値に戻りま
す。
ˎˎ 	マルチファンクションダイヤルやマルチセレクターでも操
作できます。
ˎˎ 	タッチ操作を無効にすることもできます（10ページ）。
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電源の準備
バッテリーパック、またはACアダプターを介して
AC電源を使用できます。
安全のため、下記ソニー純正以外のバッテリー
パックを使用しないでください。

リチウムイオンバッテリーパック
BP-U35
BP-U70
BP-U100

バッテリーチャージャー
BC-U1A
BC-U2A

ACアダプター（付属）

拡張ユニットXDCA-FX9装着時にはVシューバッ
テリーが使用できます。
安全のため、下記ソニー純正以外のバッテリー
パックおよびACアダプターを使用しないでくださ
い。

リチウムイオンバッテリーパック
BP-GL95B

ACアダプター
AC-DN10A

直射日光の下や火気の近くなど、高温のところに
バッテリーを置かないでください。

［ご注意］

ˎˎ AC電源につないで使うときは、付属のACアダプターを
ご使用ください。

ˎˎ バッテリーパックやACアダプターは、必ず本機の
POWERスイッチをOffの位置にしてから脱着してくださ
い。POWERスイッチをOnの位置のまま脱着した場合、
まれに起動しなくなることがあります。もし起動しなく
なった場合には、POWERスイッチをOffの位置にしてか
らバッテリーパックおよびACアダプターを一旦取り外し、
約30秒放置した後に取り付けてください。（バッテリー
パックで動作中の本機にACアダプターを着脱する場合
は、POWERスイッチはOnの位置のままで問題ありませ
ん。）
ˎˎ AC-DN10A使用時、周辺機器を装着して使用する場合

は、周辺機器の消費電力の合計が25 W以内になるよう
にしてください。

バッテリーパックを使う

バッテリーパックをバッテリーパック装着部
（8ページ）の奥まで差し込んで、下にスライ
ドさせてロックします。

取り外すときは、BATT RELEASEボタン（8
ページ）を押しながらバッテリーパックを上にスラ
イドさせてロックを外し、引き抜きます。

BATT RELEASE
ボタン

［ご注意］

ˎˎ 装着する前に、専用のバッテリーチャージャー BC-U1A
またはBC-U2Aを使用して充電してください。
ˎˎ 使用直後などバッテリーパックの温度が上昇した状態で

充電すると、完全に充電されないことがあります。

残量を確認する

バッテリーパックを使用して撮影・再生している
ときは、ビューファインダー画面（11ページ）
にバッテリー残量が表示されます。

アイコン 意味
100％～ 91％

90％～ 71％

70％～ 51％

50％～ 31％

30％～ 11％

10％～ 0％

残量は、現在の消費電流のペースで本機を継続
使用した場合のバッテリーパックの使用可能時間
を計算して、分単位で表示されます。

拡張ユニット使用時について

拡張ユニットXDCA-FX9使用時は、使用するバッ
テリーによってバッテリー電圧またはバッテリー
残量が表示されます。

［ご注意］
本機にXDCA-FX9を取り付けている場合は、本機にバッ
テリーパックは装着できません。XDCA-FX9にバッテリー
パックを装着するか、または電源を接続する必要がありま
す。

バッテリーパックの容量が低下すると

使用中にバッテリーパックの容量が一定の値まで
低下すると（Low Battery状態）、バッテリーパッ
クの残りが少ないことを知らせるメッセージが画
面に表示され、記録/タリーランプの点滅とブザー
音で警告します。
さらに容量が減り、動作が継続不可能な状態に
なると（Battery Empty状態）、バッテリーパック
の残りがないことを知らせるメッセージに切り替
わります。
充電されたバッテリーパックに交換してください。

警告残量を変更する

工場出荷時には、Low Batteryはフル充電の
10%、Battery Emptyは3%に設定されています。
これらの設定は、TechnicalメニューのCamera 
Battery Alarm（116ページ）で変更することも
できます。
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AC電源を使う

バッテリーが切れることを心配しないで使えま
す。

DC	IN	端子

ACアダプター

電源コード

ACアダプターを本体のDC	IN端子につなぎ、電
源コード（付属）をAC電源に接続します。

ACアダプターの出力電圧が低下する
と

使用中にACアダプターの出力電圧が一定の値ま
で低下すると（DC	Low	Voltage1状態）、ACアダ
プターの出力電圧が低下していることを知らせる
メッセージが画面に表示され、記録/タリーラン
プの点滅とブザー音で警告します。
さらに電圧が低下し、動作が継続不可能な状態
になると（DC	Low	Voltage2状態）、ACアダプ
ターの出力電圧が不足していることを知らせる
メッセージに切り替わります。
ACアダプターが故障している可能性があります
ので、必要に応じて点検を行ってください。

［メモ］
バッテリー装着状態でAC電源を使うと、ACアダプターの
出力電圧が低下した場合に電源が自動的にバッテリーに切
り替わります。

警告電圧を変更する

工場出荷時には、DC	Low	Voltage1は16.5	V、
DC	Low	Voltage2は15.5	Vに設定されています。
これらの設定は、TechnicalメニューのCamera	
DC	IN	Alarm（116ページ）で変更することもで
きます。

ACアダプターについて

ˎˎ ACアダプターを壁との隙間などの狭い場所に
設置して使用しないでください。

ˎˎ ACアダプターは手近なAC電源を使用してくだ
さい。本機を使用中、不具合が生じたときは
すぐにAC電源からプラグを抜き、電源を遮断
してください。

ˎˎ ACアダプターのプラグを金属類でショートさ
せないでください。故障の原因になります。

ˎˎ ACアダプターをつないでも本機に装着した
バッテリーを充電することはできません。
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機器の取り付け・調整
クランプレバーの操作につい
て

マイクホルダーとビューファインダーの取り付け
や取り外し、位置調節をするときはクランプレ
バーを操作します。
取り付けるときは、クランプレバーを時計方向に
回してロッドを固定します。
取り外すときや位置調節するときは、クランプレ
バーを反時計方向に回し、クランプレバーを緩め
ます。
クランプレバーが回しにくい位置にある場合は、
クランプレバーを引き出してから操作しやすい位
置まで回します。位置を決めたらクランプレバー
を元の位置に戻します。

クランプレバー

マイクホルダーの位置を調節
する

クランプレバーを緩め、マイクホルダーを前後に
回して位置を調節します。

クランプレバー

マイクホルダーとマイクの取り付け方
向について

マイクホルダーとマイクは下図のように取り付け
てください。

マイクロッドを交換する

［ご注意］

ˎˎ マイクロッドは取り付けた状態で出荷されています。
ˎˎ マイクロッドの取り付け・取り外しは、本機の電源を切っ
た状態で行ってください。
ˎˎ マイクロッドの取り付け・取り外しは、イメージセンサー
を傷つけないようボディキャップを装着して行ってくださ
い。

1 ネジを緩める。

2 マイクロッドを引き抜く。

3 逆の手順でマイクロッドを取り付ける。

ビューファインダーを取り付
ける

［ご注意］
ビューファインダーの取り付け/取り外しは、本機の電源を
切った状態で行ってください。通電状態でビューファイン
ダーを取り外すと本機が自動的に再起動します。

1 ビューファインダーのクランプレバーを緩め、
マイクロッドに差し込んで取り付ける。

クランプレバー

	 ［ご注意］
ビューファインダーを取り付けるには、各部品が下図
のような位置関係になるように、ロッドクランプをマイ
クロッドに取り付けてください。
	– クランプロックレバーの位置がVFロッドとハンドル
の間になるようにする

	– VFロッドの位置がマイクロッドよりも上になるよう
にする

ハンドル

クランプ	
ロックレバー

VFロッド

マイクロッド

ロッド	
クランプ
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2 ビューファインダーの左右位置が決まったら
クランプレバーを回して締め、ビューファイ
ンダーケーブルを本機のビューファインダー
接続端子に接続し、ケーブルクランパーに
ビューファインダーケーブルを取り付ける。

ケーブルクランパー

	 ［ご注意］

ˎˎ 	VFロッドの位置がVFクランプのクランプロックレ
バーの上になるように、ビューファインダーを取り付
けてください。

VFロッド

クランプロック
レバー

VFクランプ

ビューファインダー

ˎˎ 確実にビューファインダーが取り付けられていること
を確認してください。クランプレバーが緩んでいる
と、撮影中にビューファインダーが抜け落ちる恐れ
があります。

ビューファインダーの向きを調節する

ビューファインダーを上下方向に回して、見やす
い角度に調節します。

対面撮影にも活用できます。MIRRORスイッチを
B/Tの位置にすると液晶画面には左右反転して映
りますが、実際には左右正しく録画されます。

ビューファインダーの位置を調節する

90°単位で調節する
ロッドの接続部に角形クランプスペーサーが取り
付けられている場合は、90°単位でビューファイ
ンダーの位置を調節できます。
一度ビューファインダーを取り外し、角度を変え
て取り付けます。

任意の角度で調節する
ロッドの接続部に丸形クランプスペーサーが取り
付けられている場合は、ロッドを軸にビューファ
インダーを回転して位置を調節できます。

下図のようにビューファインダーを180°回転させ
た場合はMIRRORスイッチをROTの位置にして、
撮影画面と情報表示を上下左右に反転します。

［ご注意］
丸形クランプスペーサーを取り付けた場合は、ロッドも市
販のφ15	mmのロッドに付け替えてください。

［メモ］
初期状態では角形クランプスペーサーが取り付けられてい
ます。

クランプスペーサーを付け替える

下図のようにクランプスペーサーを取り外して、
角形または丸形クランプスペーサーの突起部をク
ランプの溝に合わせて取り付けます。

突起部

突起部

溝

溝

［ご注意］
ワッシャーを必ず取り付けてください。ワッシャーがない
と、ロッドの締め付け不足になり、ビューファインダーが落
下するおそれがあります。

スペーサーの形状は、下図のように見分けること
ができます。

角形クランプスペーサー

角形の刻印
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丸形クランプスペーサー

丸形の刻印

ビューファインダーを取り外す

ビューファインダーのクランプレバーを緩め、
ビューファインダーを取り付けたときと逆の方向
に抜き取ります。

アイピースを取り付ける

［ご注意］
アイピースの取り付け／取り外しは、本機の電源を切った
状態で行ってください。

1 ビューファインダー上部の取り付けフックに
アイピース上部のフックをひっかけてから、
下部の取り付けフックにアイピース下部の金
具をひっかける。

取り付けフック

2 アイピース下部のロック板を矢印の方向に押
し上げてアイピースをロックする。

ロック板

アイピースを開く

矢印部のボタンを押します。

ロックが外れて、アイピースが上方に開きます。
アイピースをつけたままビューファインダーを直視
できます。

上方に開いたアイピース後部を取り外
す

アイピースを上方に開いた状態で、アイピース後
部のロックを矢印（）の方向に解除し、アイピー
ス後部を矢印（）の方向にスライドさせて取り
外します。アイピース後部を取り外すことでアイ
ピース前部をフード代わりに使用することができ
ます。

アイピース後部を取り付けるには
アイピース後部を取り付けるときは、ヒンジの突
起をガイド溝に合わせ、ロックするまで下図の矢
印の方向に押し込んでください。

ガイド溝 突起

アイピースを取り外す

アイピースのロックを解除してビューファインダー
からアイピースを取り外します。

レンズを取り付ける

レンズを太陽に向けて放置しないでください。太
陽光がレンズを通して機器内部に焦点を結び、
火災の原因となることがあります。

［ご注意］

ˎˎ レンズの取り付け/取り外しは、本機の電源を切った状
態で行ってください。
ˎˎ レンズは精密部品です。レンズは、マウント部側を下に
して直に置かないでください。必ず付属のキャップをか
ぶせてください。

［メモ］
本機で使用できるレンズについて詳しくは、ソニーのサー
ビス窓口にご相談ください。

Eマウントレンズを取り付ける

1 レンズからカバーを外す。

2 レンズロックリングストッパーを解除し、レ
ンズロックリングを時計方向に回して、本体
からボディキャップを外す。
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レンズ
ロック
リング

レンズロック
リング	
ストッパー

3 本体とレンズのマウント標点（白色）を合わせ
て、レンズを軽く本体に押し付けながら、レ
ンズロックリングを反時計方向にゆっくり回
して、レンズをしっかり締め付け装着する。

マウント標点（白色）

［ご注意］

ˎˎ レンズを取り付けたときに、レンズロックリングストッ
パーがロック位置になっていない場合は、手動でロック
位置にしてください。
ˎˎ レンズを取り付けるときは、レンズロックリングの標点（白
色）と本体の標点（白色）を揃えてください。

Aマウントレンズを取り付ける

Aマウントレンズを取り付けて使用する場合は、
マウントアダプター（別売）を取り付けてからAマ
ウントレンズを装着してください。

［ご注意］
Aマウントレンズ使用時は、アイリスがマニュアルに、フォー
カスがMFになります。

レンズを取り外す

次の手順で取り外してください。

1 レンズロックリングストッパーを解除し、レ
ンズをしっかりと支えながらレンズロックリ
ングを時計方向に回す。

2 レンズを前方に引き抜く。

［ご注意］

ˎˎ レンズを取り外すときは、レンズロックリングの標点と本
体の標点を揃えてください。
ˎˎ レンズを落とさないように、レンズを手でしっかりと持っ
て取り外してください。
ˎˎ 別のレンズをすぐに取り付けないときは、必ずボディ
キャップを取り付けてください。

レンズにAuto	Irisスイッチがついてい
る場合のアイリス調節について

ˎˎ レンズのAuto	IrisをAUTOにすると、アイリス
の自動調節、または本機からの手動調節操作
が可能です。

ˎˎ レンズのAuto	IrisをMANUALにすると、レン
ズリング操作のみ可能となり、本機からのアイ
リス操作を受け付けなくなります。

レンズにフォーカス切り替えスイッチが
ついている場合のフォーカス調節につ
いて

ˎˎ レンズのフォーカス切り替えスイッチを「AF/
MF」または「AF」にすると、フォーカスの自動
調節、またはリモートコントロールユニットか
らの手動調節が可能です。

ˎˎ レンズのフォーカス切り替えスイッチを「MF」に
すると、レンズリング操作、またはリモートコ
ントロールユニットからの手動調節が可能で
す。

	 ［ご注意］
Aマウントレンズ使用時はリモートコントロールユニット
からの手動調節ができない場合があります。

ˎˎ レンズのフォーカス切り替えスイッチを「Full	
MF」にすると、レンズリング操作のみ可能とな
り、本機からのフォーカス操作を受け付けなく
なります。

三脚の取り付けについて

三脚に取り付けるときは、本機の三脚用ネジ穴を
ご使用ください。レンズの三脚座を使用すると、
破損することがあります。

アナモルフィックレンズについて

本機のビューファインダーでデスクイーズ表示を
する手順は54ページをご覧ください。

グリップリモコンを取り付け
る

［ご注意］
グリップリモコンの取り付け/取り外しは、本機の電源を
切った状態で行ってください。

1 グリップ取り付け部にアームを取り付け、ネ
ジを締めて固定する。
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2 グリップリモコンのケーブルを本機のUSB/
マルチ端子に接続し、クランパーを締めて固
定する。

クランパー

［ご注意］

ˎˎ グリップリモコンのケーブルを取り付けるときは、破損
防止のため、クランパーを締めてケーブルを固定してくだ
さい。
ˎˎ 確実に本機とアームが取り付けられていることを確認し
てください。ネジが緩んでいると、撮影中に本機が落ち
る恐れがあります。
ˎˎ グリップリモコンだけで本機の重量を支えないようにし
てください。
ˎˎ グリップリモコンのケーブルを接続したら、必ずクラン
パーをロックしてください。使用中に強く引っ張ると、
端子破損の原因になります。
ˎˎ グリップのケーブルが邪魔になる場合は、アーム中央部
にあるケーブルクランパーに固定してください。

グリップリモコンの位置を調節する

ˎˎ アーム取り付けネジを緩めて、アームの角度（1）
を調節し、調節後ネジをしっかり締め付ける。

ˎˎ アーム伸縮ネジを緩めて、アームの長さ（2）を
調節し、調節後ネジをしっかり締め付ける。

ˎˎ グリップ回転レバー（9ページ）を押してグ
リップリモコンの角度（3）を調節する。

2

3

1

グリップを本機の近くに取り付ける

1 アーム取り付けネジを取り外す（1）。

2 アーム伸縮ネジ（2）を緩めて、穴が現れるま
でアームを伸ばす（3）。

1

2

3

	 ［ご注意］
アームを伸ばした後、ネジをしっかり締め付けて固定
してください。

3 グリップリモコンのケーブルを本機のUSB/
マルチ端子に接続する。

4 グリップ取り付け部の凹みとアームの凸部を
合わせてから、手順1で取り外したネジで固
定する。

ショルダーパッドの位置を調
整する

ショルダーパッドは、前後にスライドさせること
ができます。本機を肩にのせた状態で操作しやす
くなるように、ショルダーパッドの位置を調整し
てください。

2

1 3

1 3 1 3

ショルダーパッド

1 ショルダーパッドのネジ（3本）を緩める。

2 前後方向にスライドして、適当な位置に調整
する。

3 ネジを締めて固定する。
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XDCA-FX9を取り付ける

本機に拡張ユニットXDCA-FX9（別売）を取り付
けると、Vシューバッテリーや有線LANの使用な
ど、本機の機能を拡張することができます。

［ご注意］

ˎˎ 本機にXDCA-FX9を取り付けている場合は、本機にバッ
テリーパックは装着できません。XDCA-FX9にバッテ
リーパックを装着するか、または電源を接続する必要が
あります。
ˎˎ XDCA-FX9の取り付け/取り外しは、本機の電源を切っ
た状態で行ってください。

1 本機に装着されているバッテリーパックを取
り外す（18ページ）。

2 2本のネジを外し、拡張ユニット接続端子部
のカバーを本機から取り外す。

3 本機の左右の溝にXDCA-FX9の凸部を合わ
せ奥までスライドさせてから、下にスライド
させて接続端子部を合わせる。

溝 凸部

4 XDCA-FX9上部のネジ2本を回して締め、
XDCA-FX9を固定する。

XDCA-FX9を取り外す

XDCA-FX9上部のネジ2本を回して緩め、
XDCA-FX9を本機から取り外します。

Vシューバッテリーを取り付け
る

VシューバッテリーをXDCA-FX9のバッテリー装
着部に差し込みます。

Vシューバッテリーを取り外す

取り外すときは、バッテリーリリースレバーを押
しながらVシューバッテリーをXDCA-FX9のバッ
テリー装着部から引き抜きます。

ドングルガードを取り付ける

USB端子に装着したモデムなどのUSB機器を保
護するためのドングルガードを取り付けることが
できます。
ドングルガードとドングルガード固定版を拡張ユ
ニットに取り付け、固定版固定用ネジで固定しま
す。

ドングルガード固定版

マジックテープを取り付けるには

USB機器を固定するためのマジックテープをドン
グルガードに取り付けます。
マジックテープの輪っか部を、接着部を上にして

ドングルガードの背面に取り付け、下図のように
マジックテープを取り付けます。

マジックテープ

輪っか部

ポータブルワイヤレスチュー
ナーを取り付ける（ワイヤレス
マイクロホン使用時）

ワイヤレスマイクロホンを使用するときは、本機
の電源をオフにしてから次のいずれかのポータブ
ルワイヤレスチューナーを取り付けます。

ˎˎ UHFシンセサイザーダイバーシティチューナー
URX-S03D

ˎˎ デジタルワイヤレスレシーバー DWR-S02DN

	˜ ポータブルワイヤレスチューナーの取扱説明書も併せ
てご覧ください。

［ご注意］
販売地域、および対応する周波数帯域によって販売される
ワイヤレスチューナーが異なります。本機で使用可能なワ
イヤレスチューナーについてはお買い上げ店、またはソニー
の営業担当者にご相談ください。
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1 挿入口のカバーを固定している4本のネジを
ゆるめ、カバーを取り外す。

2 DWR-S02DNまたはURX-S03Dを挿入し、
4本のネジを締めて固定する。
DWR-S02DNまたは
URX-S03D

3 以下のいずれかの設定をする。
CH1入力の場合：CH1	INPUT切り替えスイッ

チをMI	SHOEにして、Audioメニュー
のAudio	InputのCH1	MI	SHOE	Input	
SelectをWirelessにします。

CH2入力の場合：CH2	INPUT切り替えスイッ
チをMI	SHOEにして、Audioメニュー
のAudio	InputのCH2	MI	SHOE	Input	
SelectをWirelessにします。

CH3/CH4入力の場合：Audioメニューの
Audio	InputのCH3	Input	Selectまたは
CH4	Input	SelectをWirelessにします。
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本機の基本動作を設定する
本機を初めて使用するときやバックアップ電池が
放電してしまった後に、初めて本機の電源を入れ
るとビューファインダー画面に初回設定画面が表
示されます。
この画面を使用して内蔵時計の日付/時刻を設定
してください。
また、撮影を始める前に、使用する運用形態に
合わせて、基本動作の設定を行います。

Time	Zone	について
UTC（協定世界時）からの時差を設定します。必
要に応じて変更してください。

日付/時刻を設定する

矢印ボタン（7ページ）またはマルチファンク
ションダイヤル（4ページ）で項目や数値を選
び、SETボタンまたはマルチファンクションダイヤ
ルを押して決定すると、時計が動き始めます。
設定画面が消えた後は、Maintenanceメニュー
のClock	Set（123ページ）を使用してTime	
Zoneおよび日時の設定を変更することができま
す。

［ご注意］

ˎˎ 動作電源が供給されていない（バッテリーパックもDC	IN
電源も接続されていない）状態でバックアップ電池が消
耗するなどして現在日時の情報が失われた場合は、次に
電源を入れると初回設定画面が表示されます。
ˎˎ 初回設定画面が表示されている状態では、この画面で
の設定が完了するまで電源を切る以外の操作はできま
せん。
ˎˎ 本機は日時や各種の設定を電源の入/切と関係なく保持
するために、充電式電池を内蔵しています。内蔵の充電
式電池については、130ページをご覧ください。

撮影モード

本機では、撮影現場で自在に映像の作りこみが
できる「SDRモード」と、広色域・広ダイナミック
レンジでの撮影ができる「HDRモード」、ポストプ
ロダクション処理を前提とし、撮影現場では画作
りを行わないフィルムカメラと同等の使いかたが
できる「Cine	EIモード」を切り替えて使用できま
す。
ProjectメニューのBase	SettingのShooting	
Mode*（93ページ）で切り替えます。
*	 ステータス画面でも設定可能。

［ご注意］

ˎˎ Cine	EIモードでは以下の制約があります。
ˎˎ 自動調節（追尾）できない機能

	– ホワイトバランス
	– ゲイン
	– シャッター

ˎˎ 設定変更できない機能
	– ISO感度/ゲイン（基準ISO感度に固定）
	– Paintメニューの設定（すべて無効）
	– Scene	File（無効）

ˎˎ 以下の機能はCine	EIモードでのみ使用可能です。
ˎˎ Exposure	Index
ˎˎ Monitor	LUT

撮影モードがCine	EIモードのときは、記録信号
および出力信号のベースとなる色域を選択しま
す。ここで選択した色域がMLUTをOffに設定し
た映像出力の色域となります。
ProjectメニューのCine	EI	SettingのColor	
Gamut（95ページ）で切り替えます。

ˎˎ S-Gamut3.Cine/SLog3：デジタルシネマの
色域（DCIP3）への調整がしやすい色域

ˎˎ S-Gamut3/SLog3：ソニー独自のITU-R	
BT.2020をカバーする広い色域

LUTデータをメタデータとして記録す
る

Cine	EIモードのときに、撮影時にモニター映像
に適用していたLUTデータ（Cubeデータ）を、ク
リップにメタデータとして記録することができま
す。
ProjectメニューのCine	EI	SettingのEmbed	
LUT	File（95ページ）をOnに設定します。
記録開始時に選択していたLUTのCubeデータを
メタデータとして記録します。ただし、以下の場
合はメタデータとして記録することはできません。

ˎˎ 内部メモリーにCubeデータがない場合

ˎˎ 内部メモリーにCubeデータが存在していても、
以下の操作を行った場合
	– 適用するLUTデータを変更した直後に記録
を開始した場合

ShootingメニューのMonitor	LUTのLUT	Select
（91ページ）で709(800%)またはs709を
選択した場合、もしくはUser	3D	LUT	Select

（91ページ）で内部メモリーに保存されている
ユーザー3D	LUTを選択した場合に記録されま
す。

［ご注意］

ˎˎ 1つのクリップに記録できるメタデータは1つのみです。
ˎˎ ShootingメニューのMonitor	LUT	SettingのInternal	
Rec（91ページ）がMLUT	Onのときは、メタデータを
記録することはできません。
ˎˎ ShootingメニューのMonitor	LUTのUser	3D	LUT	
Select（91ページ）で先頭に	 	マークが表示されて
いるファイル名を選択した場合は、Cubeデータが保存
されません。再度ユーザー3D	LUTデータを読み込んで
から選択してください。

システム周波数

ProjectメニューのRec	FormatのFrequency*

（93ページ）で切り替えます。設定値によって
は、切り替えを実行すると本機が自動的に再起
動します。
*	 ステータス画面でも設定可能。

［ご注意］
記録・再生中にシステム周波数を切り替えることはできま
せん。
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イメージャースキャンモード

イメージセンサーの有効画サイズと解像度の設
定を行います。
ProjectメニューのRec	FormatのImager	Scan	
Mode*（93ページ）で切り替えます。
*	 ステータス画面でも設定可能。

ˎˎ FF	6K：フルサイズの6K解像度で使用します。

ˎˎ FFcrop	5K：フルサイズの約83%の画角の5K
解像度で使用します。

ˎˎ S35	4K：Super	35mmサイズの4K解像度で
使用します。

ˎˎ FF	2K：フルサイズの2K解像度で使用します。

ˎˎ S35	2K：Super	35mmサイズの2K解像度で
使用します。

ˎˎ S16	2K：Super	16mmサイズの2K解像度で使
用します。

［メモ］
Crop	Selectを割り当てたアサイナブルボタン（47ペー
ジ）を使うと、ビデオフォーマットを変更しない範囲でイ
メージャースキャンモードをすばやく変更することができま
す。

［ご注意］

ˎˎ 記録・再生中にイメージャースキャンモードを切り替える
ことはできません。
ˎˎ イメージャースキャンモードの設定がFF	2Kまたは
S35	2K、S16	2Kのときは、記録フォーマットの設定は
1920x1080解像度に制限されます。

コーデック

ProjectメニューのRec	FormatのCodec*

（93ページ）で切り替えます。
*	 ステータス画面でも設定可能。

［ご注意］
記録・再生中にコーデックを切り替えることはできません。

ビデオフォーマット

記録するビデオフォーマットの設定を行いま
す。ProjectメニューのRec	FormatのVideo	
Format*（93ページ）で切り替えます。
*	 ステータス画面でも設定可能。

［ご注意］

ˎˎ 記録・再生中にビデオフォーマットを切り替えることは
できません。
ˎˎ ビデオフォーマットの設定によって、SDI	OUTおよび
HDMI	OUT端子からの信号も制限されます。



2章　準備29

XQDメモリーカードを使う
本機では、撮影した映像・音声を、カードスロット内のXQDメモリーカード（別売）に記録します。

XQDメモリーカードについて

本機では、下記のソニー製XQDメモリーカードをご使用ください。
他社製メディアの動作については、各社メディアの取扱説明書やメーカー情報をご確認ください。
XQDメモリーカード	Sシリーズ（QD-S64E/S32E/S64/S32）
XQDメモリーカード	Hシリーズ（QD-H32/H16）
XQDメモリーカード	Nシリーズ（QD-N64）
XQDメモリーカード	Mシリーズ（QD-M128A/M64A/M32A）
XQDメモリーカード	Gシリーズ（QD-G240F/G120F/G256E/G128E/G64E/G32E/G128A/G64A/
G32A）
ソニー製XQDメモリーカード以外のメモリーカードをご使用の場合、動作の保証はいたしかねます。

［メモ］
XQDメモリーカードの使いかたや使用上のご注意について詳しくは、XQDメモリーカードの取扱説明書をご覧ください。

推奨メディアについて

動作保証条件はRec	FormatやRecording設定によって異なります。
Yes：動作を保証
No：保証しない

記録フォーマット Gシリーズ
Sシリーズ
(QD-S64E/
S32E)

Nシリーズ
Mシリーズ

Hシリーズ
Sシリーズ
(QD-S64/
S32)

XAVC	Intra	
422

4096	x	
2160

Normal	
mode	or	
S&Q（60P以
下）

59.94P/	
50P/	
29.97P/	
25P/	
23.98P/	
24P

Yes No No

3840	x	2160 Normal	
mode	or	
S&Q（60P以
下）

59.94P/	
50P/	
29.97P/	
25P/	
23.98P

Yes No No

1920	x	1080 Normal	
mode	or	
S&Q（60P以
下）

59.94P/	
50P

Yes No No

59.94i/	
50i/	
29.97P/	
25P/	
23.98P

Yes Yes No

S&Q（60Pよ
り上）

59.94P/	
50P/	
29.97P/	
25P/	
23.98P

Yes No No
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記録フォーマット Gシリーズ
Sシリーズ
(QD-S64E/
S32E)

Nシリーズ
Mシリーズ

Hシリーズ
Sシリーズ
(QD-S64/
S32)

XAVC	Long	
422

3840	x	2160 Normal	
mode	or	
S&Q（60P以
下）

59.94P/	
50P/	
29.97P/	
25P/	
23.98P

Yes Yes No

1920	x	1080 Normal	
mode	or	
S&Q（60P以
下）

59.94P/	
50P/	
59.94i/	
50i/	
29.97P/	
25P/	
23.98P

Yes Yes Yes

S&Q（60Pよ
り上）

59.94P/	
50P

Yes Yes No

29.97P Yes 50	Mbps:No
35	Mbps:Yes

No

25P/	
23.98P

Yes No No

MPEG2	HD	
422

1920	x	1080 Normal	
mode

59.94i/	
50i/	
29.97P/	
25P/	
23.98P

Yes Yes Yes

XQDメモリーカードを入れる

1 カードスロット部のメディア蓋を開ける。

2 XQDメモリーカードを、XQDのラベルを左
にして差し込む。
アクセスランプ（8ページ）が赤く点灯し、
使用可能な状態になると緑で点灯します。

3 メディア蓋を閉める。

［ご注意］

ˎˎ 誤った向きで無理に入れると、メモリーカードやメモリー
カードスロット、画像データが破損することがあります。
ˎˎ XQDカードスロットA/B両方にメディアを挿入して記録
を行う際には、どちらのスロットにも、記録するフォーマッ
トに対して動作が推奨されているメディアを挿入してく
ださい。

XQDメモリーカードを取り出
す

カードスロット部のメディア蓋を開け、XQDメモ
リーカードを軽く1回押して取り出します。

［ご注意］

ˎˎ メモリーカードにアクセス中に本機の電源を切ったりメ
モリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があ
ります。電源を切ったり、カードを抜くときは、必ず使
用するメモリーカードのアクセスランプが緑で点灯また
は消灯していることを確認してから操作してください。
ˎˎ 記録終了後にXQDメモリーカードを取り出した際、XQD
メモリーカードが熱くなっている場合がありますが故障
ではありません。

XQDメモリーカードをフォー
マット（初期化）する

フォーマットされていないXQDメモリーカード、
または別の仕様でフォーマットされたXQDメモ
リーカードを装着すると、メッセージ「フォーマッ
トが必要なメディアです」がビューファインダー画
面に表示されます。
下記の手順に従ってフォーマットしてください。

1 TC/MediaメニューのFormat	Media
（106ページ）を選択する。

2 Media（A）（スロットA）またはMedia（B）（ス
ロットB）を選択して、Executeを選択する。
確認メッセージが表示されます。

3 Executeを選択する。
実行中はメッセージが表示され、アクセスラ
ンプが赤く点灯します。
フォーマットが終了すると、完了メッセージ
が表示されますので、SETボタンまたはマル
チファンクションダイヤルを押して消します。

［ご注意］
メモリーカードをフォーマットすると、記録された映像デー
タ、セットアップファイルなどを含む、すべてのデータが消
去されます。

フォーマットできなかったときは

本機で使用できないメモリーカードはフォーマッ
トできません。
警告メッセージが表示されますので、メッセージ
に従って、使用できるXQDメモリーカードに交換
してください。
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残りの記録可能時間を確認
する

撮影中（記録中/記録待機中）は、ビューファイン
ダー画面（11ページ）のA/Bスロットメディア
残量表示部で、各スロットに装着したXQDメモ
リーカードの残量を確認することができます。
現在設定されているビデオフォーマット（記録ビッ
トレート）で撮影した場合に記録可能な時間を、
それぞれのスロット内のメディアの残量から計算
して分単位で表示します。

XQDメモリーカードの交換時期

ˎˎ 記録中に2枚のメモリーカードの残記録可能時
間の合計が5分を切ると、警告メッセージ「メ
ディア残量がわずかです」（Media	Near	Full）
が表示され、記録/タリーランプの点滅とブザー
音（ヘッドホン出力）で警告します。	
空きのあるメディアに交換してください。

ˎˎ 記録を継続して、残記録可能時間の合計が0
になると、メッセージが「メディア残量がありま
せん」（Media	Full）に変わり記録が停止しま
す。

［ご注意］
1枚のXQDメモリーカードに約600個までのクリップを記録
できます。
記録できるクリップ数の上限に達すると、残時間表示が「0」
になり、上限に達した旨のメッセージが表示されます。

XQDメモリーカードを修復す
る

何らかの原因でメモリーカード内のデータに異常
が発生した場合は、メモリーカードの修復が必
要になります。
修復が必要なXQDメモリーカードを挿入したとき
は、修復を実行するかどうかを確認するメッセー
ジがビューファインダー画面に表示されます。

修復を実行する

矢印ボタン（7ページ）またはマルチファンク
ションダイヤル（4ページ）でExecuteを選択
し、SETボタンまたはマルチファンクションダイヤ
ルを押します。
実行中メッセージが表示され、アクセスランプが
赤く点灯します。
修復が終了すると、完了メッセージが表示されま
す。

修復できなかったときは

ˎˎ エラーが発生したXQDメモリーカードは修復で
きません。警告メッセージが表示されますので、
メッセージに従って別のXQDメモリーカードに
交換してください。

ˎˎ エラーが発生したXQDメモリーカードは、
フォーマットをし直すと再利用できる場合があ
ります。

ˎˎ 一部のクリップのみが修復できない場合もあり
ます。修復できたクリップは再生可能になりま
す。

ˎˎ 修復を実行しても繰り返し「一部修復ができま
せんでした」とメッセージが表示されるように
なったXQDメモリーカードは、以下の手順で

正常に戻せる場合があります。
1	 ThumbnailメニューのCopy	Clip（112

ページ）で必要なクリップを他のXQDメモ
リーカードへコピーする。

2	問題のあるXQDメモリーカードを本機で
フォーマットする。

3	フォーマットしたXQDメモリーカードに必要
なクリップをコピーして戻す。

［ご注意］

ˎˎ 本機で記録されたメディアは、本機で修復してください。
ˎˎ 本機以外で記録されたメディアや、本機と同一機種で
あってもバージョンが異なる機器で記録されたメディア
は、本機では修復できない場合があります。
ˎˎ 2秒以下のクリップは修復できません。



2章　準備32

Utility	SD/MSカードを使う
UTILITY	SD/MSカードは、プロキシ記録、設定
内容の保存・読み出しと、将来のバージョンアッ
プ（ソフトウェアアップデート）時に使用します。

本機で使用可能なSD/MS
カード

SDXCメモリーカード*

SDHCメモリーカード*

SDメモリーカード*

“メモリースティックPRO-HGデュオ”**

“メモリースティックPROデュオ”**

*	 本書ではまとめてSDカードと表現しています。
**	本書ではまとめて“メモリースティック”と表現していま

す。

［ご注意］
“メモリースティック”にはプロキシ記録はできません。

SD/MSカードを入れる

1 カードスロット部のメディア蓋を開ける。

2 SDカードまたは“メモリースティック”のラベ
ルを右にしてカードスロットに差し込む。
アクセスランプ（8ページ）が赤く点灯し、
使用可能な状態になると消灯します。

3 メディア蓋を閉める。

SD/MSカードを取り出す

カードスロット部のメディア蓋を開け、SDカード
または“メモリースティック”を軽く1回押して取り
出します。

［ご注意］

ˎˎ SDカードまたは“メモリースティック”にアクセス中に本
機の電源を切ったりSDカードまたは“メモリースティッ
ク”を抜いた場合はデータは保証されません。カードに
記録されたすべてのデータが壊れる可能性があります。
電源を切ったり、カードを抜くときは、必ず使用するSD
カードまたは“メモリースティック”のアクセスランプが消
灯していることを確認してから操作してください。
ˎˎ 出し入れ時にはSDカードまたは“メモリースティック”の
飛び出しにご注意ください。

SD/MSカードをフォーマット
（初期化）する

本機で初めてSDカードまたは“メモリースティッ
ク”を使用するときは、フォーマットが必要です。
本機で使用するSDカードまたは“メモリース
ティック”は、本機のフォーマット機能を使用して
フォーマットしてください。

1 TC/MediaメニューのFormat	Media
（106ページ）を選択する。

2 Utility	SD/MSを指定し、Executeを選択
する。
確認メッセージが表示されます。

3 Executeを選択する。
実行中はメッセージと進捗状況が表示され、
アクセスランプが赤く点灯します。

フォーマットが終了すると、完了メッセージ
が表示されますので、SETボタンまたはマル
チファンクションダイヤルを押して画面を消
します。

［ご注意］
SDカードまたは“メモリースティック”をフォーマットすると、
すべてのデータが消去され、復元できません。

残容量を確認する

メディアステータス画面（16ページ）を表示さ
せると、SDカードまたは“メモリースティック”の
残量を確認することができます。
プロキシ記録がOnのとき、撮影中（記録中
/記録待機中）は、ビューファインダー画面

（11ページ）のメディア残量表示部でSDカー
ドの残量を確認することができます。

［ご注意］

SDカードがプロテクトされている場合は、	 マークが表示
されます。

本機でフォーマットしたメディアを他
の機器で使用するには

あらかじめバックアップを取り、お使いになる機
器でフォーマットし直して使用してください。
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基本操作手順
基本的な撮影は次の手順で行います。

1 必要な機器が取り付けられ、電源が供給さ
れていることを確認する。

2 メモリーカードを入れる。

3 POWERスイッチをOnにする。
POWERランプが点灯して、ビューファイン
ダーに撮影画面が表示されます。

4 録画START/STOPボタン（6ページ）を
押す。
記録/タリーランプが点灯して、記録が始ま
ります。

5 記録を終了するときは、もう一度録画
START/STOPボタン（6ページ）を押す。
記録が停止し、本機はSTBY（記録待機）モー
ドになります。

［ご注意］
電源を入れてから数秒以内に録画START/STOPボタンを
押すと、記録/タリーランプが点灯し録画状態になりますが、
選択している記録フォーマットによっては最初の数秒間はメ
ディアに記録されない場合があります。

XQDメモリーカードを切り替
える

XQDメモリーカードが2枚装着されているとき
は、SLOT	SELECTボタン（7ページ）を押し
て切り替えます。
撮影中にメモリーカードA（またはメモリーカード
B）の残量がなくなる直前に、自動的にもう一方
のメモリーカードへの記録に切り替わります（リ
レー記録）。メモリーカードが切り替わるたびに、
記録済みのメモリーカードを新しいメモリーカー
ドに交換することで、中断することなく撮影を続
けられます。

［ご注意］
再生中にXQDメモリーカードを切り替えることはできませ
ん。またスロットAとスロットBをまたぐ連続再生はできま
せん。

クリップ（記録データ）
記録を停止すると、開始から停止までの画像・音
声と付随データが、1つの「クリップ」としてXQD
メモリーカードに記録されます。

クリップ名について
本機で記録されるクリップの名前は、TC/Media
メニューのClip	Name	Format（105ページ）で
設定された形式でつけられます。

クリップの最大時間
1クリップあたり6時間までです。
動画の連続撮影可能時間は、クリップの最大記
録時間と同様です。録画時間がクリップの最大時
間を超える場合、録画を継続したまま自動的に新
しいクリップが作られます。新しいクリップはサム
ネイル画面で別のクリップとして確認できます。

リレー記録では複数のクリップに連続記録します
が、約24時間で自動的に停止します。

［ご注意］

ˎˎ 記録中のメモリーカードを取り出さないでください。記
録中にメモリーカードを入れ替えるときは、スロットの
ランプが消灯しているスロットのみ行ってください。
ˎˎ 記録中のメモリーカードの残量が1分未満のときに、も
う一方のスロットに記録可能なメモリーカードが入って
いると、メッセージ「まもなくスロットを切り替えます」
が表示されます。メモリーカードスロットが切り替わる
と消えます。
ˎˎ メモリーカードの残量が1分未満のときに記録を始める
と、リレー記録ができない場合があります。リレー記録
を正しく行うには、記録開始時にメモリーカードの残量
が1分以上あることを確認してください。
ˎˎ 本機を使ってリレー記録した動画は、本機上ではシーム
レス再生できません。
ˎˎ 本機を使ってリレー記録した動画を結合するには、ソフ
トウェア「Catalyst	Browse」を使用してください。

音声を聞く

記録される音声をヘッドホンでモニターできます。
ヘッドホン端子（8ページ）にヘッドホンをつ
なぐと、記録される音声をモニターできます。また、
再生時（76ページ）は内蔵スピーカー（6
ページ）またはヘッドホンでモニターできます。
モニターする音声の音量の調整は、VOLUME（モ
ニター音量調節）ボタン（6ページ）で行いま
す。
モニターするチャンネルの選択は、Audioメ
ニューのAudio	OutputのMonitor	CH*（111
ページ）で行います。
Monitor	CHの設定は、Audio	Monitor	CHま
たはAudio	Mon.	CH	Switchが割り当てられた
アサイナブルボタン（47ページ）で切り替える
ことができます（54ページ）。
*	 ステータス画面でも設定可能。

タイムデータ

タイムコードを設定する

記録されるタイムコードは、TC/Mediaメニュー
のTimecode（105ページ）で設定します。

ユーザービットを設定する

8桁の16進数をユーザービットとして記録映像に
付加できます。ユーザービットを現在時刻に設
定することも可能です。TC/Mediaメニューの
Users	Bit（105ページ）で設定します。

タイムデータを表示する

表示するタイムコードは、TC/Mediaメニューの
TC	Display（105ページ）のDisplay	Selectで
設定します。
DURATION/TC/U-BIT機能が割り当てられたア
サイナブルボタン（47ページ）を押すと、表示
がタイムコード、ユーザービット、経過時間の順
に切り替わります。

タイムコードの入力/出力を切り替える

IN/OUT切り替えスイッチ（8ページ）で、タ
イムコードの入力/出力を切り替えることができ
ます。
詳しくは128ページをご覧ください。
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記録内容を確認する（レック
レビュー）

直前に記録したクリップの映像を画面で確認
（レックレビュー）できます。

［ご注意］
記録後にビデオフォーマットを変更したときは、レックレ
ビューはできません。

レックレビューの方法

事前にアサイナブルボタンのいずれかにRec	
Reviewを割り当てておきます。
記録を停止したら、Rec	Reviewが割り当てられ
たアサイナブルボタン（47ページ）を押します。
すると、直前に記録したクリップの再生が始まり
ます。
クリップの終わりまで再生すると、レックレビュー
は終了し、STBY（記録待機）モードに戻ります。

レックレビューを中止するには

Rec	Reviewが割り当てられたアサイナブルボタ
ンまたはCANCEL/BACKボタンを押します。

レックレビューの設定

TechnicalメニューのRec	Review（114ペー
ジ）の設定により、再生開始位置を次のいずれか
に設定できます。

ˎˎ クリップの最後の3秒

ˎˎ クリップの最後の10秒

ˎˎ クリップの先頭から

［メモ］
撮影した複数のクリップから任意のクリップを確認したい
場合は、THUMBNAILボタンを押してサムネイル画面から
クリップを選択して再生を開始することができます。
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フォーカスを調節する
撮影時の状況に応じて、フォーカスを自動または
手動で調整します。

フォーカスを手動調節する（マ
ニュアルフォーカス）

フォーカスを手動調整するには、FOCUSスイッチ
（6ページ）を「MAN」に設定します。
撮影状況に応じて、手動でフォーカス合わせが
できます。
以下のようなときに使います。

ˎˎ 水滴の多い被写体

ˎˎ 背景とコントラストの弱い被写体

ˎˎ 意図的にフォーカスを手前の被写体から奥の
被写体に送るとき

タッチ操作でフォーカスを合わせる（ス
ポットフォーカス）

マニュアルフォーカス時、ピントを合わせたい位
置をタッチ操作で指定すると、フォーカスを合わ
せることができます。
スポットフォーカスを使用するには、Shootingメ
ニューのFocusのTouch	Function	in	MF（90
ページ）をSpot	Focusに設定します。
ピントを合わせたい位置をタップすると、スポッ
トフォーカスマークが表示されます。

［メモ］

ˎˎ スポットフォーカス中にPush	AF/Push	MFが割り当て
られたアサイナブルボタン（47ページ）押すとスポット
フォーカスを終了し、そのボタンを押している間はオート
フォーカスになります。ボタンから指を離すと、マニュア
ルフォーカスに戻ります。
ˎˎ レンズ側でマニュアルフォーカスに設定されていると、
スポットフォーカスは動作しません。
ˎˎ ピント拡大中、またはTechnicalメニューのTouch	
Operation（114ページ）がOffのときは、スポット
フォーカスの位置指定操作はできません。

一時的に自動でフォーカスを合わせる
（プッシュオートフォーカス（AF））

ShootingメニューのFocusのPush	AF	Mode
（90ページ）でAFを選択し、マニュアルフォー
カス中にPUSH	AUTO	FOCUSボタン（6ペー
ジ）を押すと、そのボタンを押している間はオー
トフォーカスになります。
ShootingメニューのFocusのFocus	Area

（90ページ）で設定したフォーカスエリア内で
フォーカスを合わせます。
ボタンから指を離すと、マニュアルフォーカスに
戻ります。
マニュアルフォーカス中に、ある被写体から別の
被写体にゆっくりとフォーカス送りするような場
合に有効です。

［メモ］

ˎˎ Push	AF/Push	MFが割り当てられたアサイナブルボタ
ン（47ページ）でも同様の動作が可能です。
ˎˎ アサイナブルボタン（47ページ）にPush	AF	Modeを	
割り当てることもできます。

［ご注意］
レンズ側でマニュアルフォーカスに設定されていると、プッ
シュオートフォーカスは動作しません。

迅速に自動でフォーカスを合わせる
（プッシュオートフォーカス（AF-S））

ShootingメニューのFocusのPush	AF	Mode
（90ページ）でSingle-shot	AF(AF-S)を
選択し、ShootingメニューのFocusのFocus	
Area(AF-S)（90ページ）でフォーカスを合わせ
る位置を設定します。
マニュアルフォーカス中にPUSH	AUTO	FOCUS
ボタンを押すと、最速でオートフォーカスを行い
ます。なお、合焦前に離すと中止します。
フォーカスインジケーター表示にてフォーカス合
わせの状況を表示します。

ˎˎ 点灯：	フォーカスが合焦した位置で固定されて
います。

ˎˎ 点滅：	フォーカスが合っていません。自動で
フォーカスを合わせられないので、構図や
フォーカス設定などを変更してください。

ボタンから指を離すとマニュアルフォーカスに戻
ります。
撮影する前にフォーカスをさっと合わせておきた
いときに使うと便利です。

［メモ］

ˎˎ Push	AF/Push	MFが割り当てられたアサイナブルボタ
ン（47ページ）でも同様の動作が可能です。
ˎˎ アサイナブルボタン（47ページ）にPush	AF	Modeを
割り当てることもできます。
ˎˎ アサイナブルボタン（47ページ）にFocus	Area(AF-S)
を割り当てることもできます。

ˎˎ MonitoringメニューのDisplay	On/OffのFocus	Area	
Ind.(AF-S)（107ページ）で、フォーカスエリア枠表示
をOn/Offすることができます。
ˎˎ ピント拡大中は拡大表示している位置にフォーカスを合
わせます。

［ご注意］

ˎˎ レンズ側でマニュアルフォーカスに設定されていると、
プッシュオートフォーカスは動作しません。
ˎˎ フォーカスエリア枠はDISPLAYボタンでは非表示になり
ません。

拡大表示をしてフォーカスを合わせる
（ピント拡大）

工場出荷時はグリップリモコンのASSIGN4ボ
タンとビューファインダーのASSIGN10ボタンに
Focus	Magnifier	×3/×6が割り当てられてい
ます（47ページ）。
ASSIGN4ボタンまたはASSIGN10ボタンを押す
と、ピント拡大画面に切り替わり、画面中央が
約3倍に拡大され、もう一度押すと約6倍に拡大
されます。フォーカスが合っているかを確認する
ときに便利です。
もう一度押すと元に戻ります。
ピント拡大中に矢印ボタン（7ページ）または
マルチセレクター（9ページ）で拡大位置を
移動できます。SETボタン（7ページ）または
マルチセレクターを押し込むと中央に戻ります。
ピント拡大中にプッシュオートフォーカス(AF)
を実行すると、ShootingメニューのFocusの
Focus	Area（90ページ）で設定したフォーカ
スエリア内でフォーカスを合わせます。
ピント拡大中にプッシュオートフォーカス(AF-S)
を実行すると、ピント拡大表示している位置に
フォーカスを合わせます。

［ご注意］

ˎˎ ピント拡大で表示されていても、記録される画像やSDI
出力、HDMI出力の画像は拡大されません。
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ˎˎ ピント拡大中は、STATUS（ステータス）ボタンやMENU
ボタン操作など、無効になる操作があります。
ˎˎ 拡大位置は本機の電源を切ると画面中央に戻ります。

フォーカスマーカーを表示してマニュ
アル操作を行う

マニュアルフォーカスのとき、基準としたフォーカ
スポジションとの差を数値で確認できます。
あらかじめ特定のフォーカスポジションを記憶さ
せることで、撮影時に数値を目安にボケ量の変
化を調節したり、もとのポジションに戻したいと
きなどに有効です。

1 MonitoringメニューのDisplay	On/Offの
Focus	Marker（107ページ）をOnに設定
する。

2 Focus	Zero	Markerをアサイナブルボタン
（47ページ）に割り当てる。

3 フォーカスポジションを基準としたい位置に
して、Focus	Zero	Markerボタンを押す。
フォーカスマーカー表示の値が0になります。

4 フォーカスマーカー表示の値を目安にフォー
カスポジションを操作する。

［ご注意］
数値は撮影条件や使用されるレンズによって異なります。
あらかじめ動作を確認してからご使用ください。

フォーカスを自動調節する
（オートフォーカス）

本機は、高速性に優れる位相差AF方式と、高い
精度でフォーカスを合わせることに優れるコント
ラストAF方式を採用しています。
これらの2つのAF方式を掛け合わせて利用する
ことで、高速性・高精度を両立したオートフォー
カスを実現しています。
フォーカスを自動調整するには、本機のFOCUS
スイッチ（6ページ）を「AUTO」に設定しま
す。レンズにフォーカス切り替えスイッチがある
場合はあらかじめ「AF/MF」または「AF」に設定し
てください。「Full	MF」または「MF」の場合、レン
ズは本機からのフォーカス指示を受け付けません

（23ページ）。
AF時はFOCUS	AUTO	LEDが点灯します。

［メモ］
ShootingメニューのFocusのAF	Assist（90ページ）を
Onに設定すると、オートフォーカス中でもレンズのフォーカ
スリングでフォーカスを動かすことができます。

［ご注意］

ˎˎ オートフォーカスに対応したレンズが必要です。
ˎˎ 撮影状況により精度が出ない場合があります。
ˎˎ Aマウントレンズではフォーカスを自動調節できません。
ˎˎ MonitoringメニューのVF	SettingのDe-Squeeze
（109ページ）がOff(1.0x)以外のときは、オートフォー
カスは使用できません。

オートフォーカスの対象領域/位置を
設定する（フォーカスエリア）

ShootingメニューのFocusのFocus	Area
（90ページ）でオートフォーカスの対象とする
領域を設定できます。

Flexible	Spot：
映像の指定した位置にフォーカスを合わせます。
選択後、矢印ボタン（7ページ）またはマルチ
セレクター（9ページ）で位置を指定します。
SETボタン（7ページ）またはマルチセレクター
を長押しすると中央の位置に戻ります。

Zone：
指定したゾーン内から自動でフォーカスを合わせ
る位置を探します。
選択後、矢印ボタン（7ページ）またはマルチ
セレクター（9ページ）で位置を指定します。
SETボタン（7ページ）またはマルチセレクター
を長押しすると中央の位置に戻ります。

Wide：
映像全域からフォーカスを合わせる位置を探しま
す。枠は表示されません。

［メモ］
Focus	Areaを割り当てたアサイナブルボタン（47ペー
ジ）でも同様の動作が可能です。
MonitoringメニューのDisplay	On/OffのFocus	Area	
Indicator（107ページ）で、フォーカスエリア枠表示を
On/Offすることができます。

［ご注意］
フォーカスエリア枠はDISPLAYボタンでは非表示になりま
せん。

フォーカスエリアをすばやく変更する
(フォーカスセット)

アサイナブルボタン（47ページ）にFocus	
Settingを割り当てると、撮影中などにオート
フォーカスの対象領域（フォーカスエリア）の位置
や大きさをすばやく変更することができます。
フォーカスエリアの設定により動作が変わりま
す。

ShootingメニューのFocusのFocus	Area
（90ページ）がFlexible	Spotまたは
Zoneの場合：
Focus	Settingを割り当てたアサイナブルボタン
を押すと、矢印ボタン（7ページ）またはマル
チセレクター（9ページ）、タッチ操作（37
ページ）でフォーカスエリアの位置を変更するこ
とができます。
位置変更中にSETボタン（7ページ）またはマ
ルチセレクターを押すと、フォーカスエリアの位
置が中央に戻ります。
Focus	Settingを割り当てたアサイナブルボタン
を長押しするとフォーカスエリアの大きさを変更
することができます。
大きさを変更後、SETボタンまたはマルチセレク
ターを押すとフォーカスエリアの位置を設定しま
す。
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設定の変更が終了したら、Focus	Settingを割
り当てたアサイナブルボタンを押して元の画面に
戻ります。

ShootingメニューのFocusのFocus	Area
（90ページ）がWideの場合：
Focus	Settingを割り当てたアサイナブルボタン
の長押しによるフォーカスエリアの大きさ変更の
み可能です。種別をFlexible	SpotまたはZone
に変更すれば、続けて位置変更も可能です。

［メモ］

ˎˎ フォーカスエリアの位置変更が可能な場合は、フォーカ
スエリア枠がオレンジ色で表示されます。
ˎˎ ShootingメニューのFocusのPush	AF	Mode（90
ページ）がSingle-shot	AF(AF-S)の場合は、Focus	
Area(AF-S)（90ページ）のフォーカスエリア位置を変
更することができます。

フォーカスエリア枠をタッチ操作で移
動する（タッチフォーカスエリア）

ShootingメニューのFocusのFocus	Area
（90ページ）でFlexible	SpotもしくはZone
の選択後や、Focus	Settingを割り当てたアサイ
ナブルボタンを押すなどしてフォーカスエリア枠
がオレンジ色で表示されているとき、フォーカス
エリア位置をタッチ操作で移動することができま
す。
タップした場所をフォーカスエリアの中心とし、
フォーカスエリアの位置を移動します。ドラッグ
すると、フォーカスエリアの位置は指の動きに追
従して移動します（10ページ）。

任意の位置をタップする

タップした位置をフォーカスエリアの中心として
位置を移動する

ドラッグで指先を追従し、フォーカスエリアの
位置を移動する

［ご注意］

ˎˎ 	タップまたはドラッグした位置がフォーカスエリアの位
置の設定範囲を超えた場合、フォーカスエリアの位置は
設定範囲内の上下左右端に移動します。
ˎˎ 	以下の場合、この機能は使えません。

	– TechnicalメニューのTouch	Operation（81ペー
ジ）がOffの場合

	– フォーカスエリア枠がグレーまたは非表示の場合

オートフォーカスの動作の調節をする
（AFトランジション速度、AF乗り移り
感度）

AFトランジション速度
ShootingメニューのFocusのAF	Transition	
Speed（90ページ）で、被写体が移り変わる
際のフォーカス駆動の速さを設定することができ
ます。
低速側に設定すると被写体の移り変わり時に
ゆっくりとフォーカス送りし、印象的な映像表現
を可能にします。
高速側に設定すると被写体間のフォーカス送り
がすばやくなります。フレームに入った被写体に
すぐにフォーカスが合うので、すばやいフォーカ
ス合わせが要求されるドキュメンタリー撮影など
に効果的です。

乗り移り中
1(低速)：フォーカスがゆっくり動く
・
・
・
7(高速)：フォーカスがすばやく動く

奥の被写体に合焦している

手前の被写体に合焦
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AF乗り移り感度
ShootingメニューのFocusのAF	Subj.	Shift	
Sens.（90ページ）で、被写体の乗り移り感度
を設定することができます。
粘る側に設定するとフォーカスの合っている被写
体の前に別の被写体が来てもフォーカスが移りに
くくなり、敏感側に設定すると手前に来た被写体
を優先してフォーカスが移りやすくなります。

［メモ］
AF	Speed/Sens.を割り当てたアサイナブルボタンを押す
たびに、調整用のレベルバーが以下の順で表示され、AF
トランジション速度とAF乗り移り感度の設定を変更できま
す。
AFトランジション速度→AF乗り移り感度→非表示・・・

AF	Subj.	Shift	Sens.:	1（粘る） AF	Subj.	Shift	Sens.:	5（敏感）

別の被写体にフォーカスが移りにくい 別の被写体にフォーカスが移りやすい

手動でフォーカス対象を変更する（AF	
Assist）

ShootingメニューのFocusのAF	Assist（90
ページ）をOnに設定すると、オートフォーカス
中でもレンズのフォーカスリングを使ってオート
フォーカス対象の被写体を任意に選ぶことがで
きます。
フォーカスリングを動かすのを止めるとオート
フォーカス動作に戻ります。
ShootingメニューのFocusのAF	Subj.	Shift	
Sens.（90ページ）で被写体の乗り移り感度を
1（Locked	On）側に設定しておくと、距離の違う
被写体にフォーカス位置を移動させて、そのまま
オートフォーカス動作を継続させたいときに特に
有効です。

一時的に手動でフォーカスを合わせる
（プッシュマニュアルフォーカス）

オートフォーカス中に、PUSH	AUTO	FOCUSボ
タン（6ページ）を押すと、そのボタンを押し
ている間はマニュアルフォーカスになります。
ボタンから指を離すと、オートフォーカスに戻り
ます。
被写体の手前を撮影対象でないものが横切ると
きなどに、一時的にオートフォーカスを止めて手
動でフォーカスを合わせることができます。

［メモ］
Push	AF/Push	MFが割り当てられたアサイナブルボタン

（47ページ）でも同様の動作が可能です。
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顔や瞳を検出して追尾する
（顔/瞳検出AF）

人物の顔や瞳を追尾対象として検出し、フォーカ
スエリア内にある顔や瞳にフォーカスを合わせ続
けることができます。
フォーカスモードがAFモードまたはプッシュオー
トフォーカス中のみ使用できます。
顔を検出すると灰色の顔/瞳検出枠が表示され、
オートフォーカス可能と判断されると枠が白色に
なり、追尾が開始されます。さらに瞳を検出し
フォーカスが合うと、瞳に顔/瞳検出枠が表示さ
れます。複数の人物を検出したときは、主な被写
体は自動的に決定します。

［メモ］

ˎˎ フォーカスエリアがZoneまたはFlexible	Spotに設定さ
れているときは、設定したフォーカスエリアの範囲に顔
や瞳が重なっているときに、顔/瞳検出枠が白色になり、
その顔や瞳へのオートフォーカスが可能となります。
ˎˎ プッシュオートフォーカス（AF-S）実行時、フォーカスが
合った顔/瞳検出枠は緑色になります。

ShootingメニューのFocusのFace/Eye	
Detection	AF（90ページ）で、顔/瞳検出AF
の動作を設定します。

Face/Eye	Only	AF：
カメラが被写体（人物）の顔や瞳を検出したとき、
人の顔や瞳にフォーカスを合わせ追尾します。顔
や瞳を検出しない間は、AFが一時停止し、顔/
瞳限定AF中の	 	（AF一時停止アイコン）（11
ページ）が表示されます。顔や瞳だけにフォーカ
スを合わせて追尾したいときに有効なモードで
す。

Face/Eye	Priority	AF：
カメラが被写体（人物）の顔や瞳を検出したとき、
人の顔や瞳に優先的にフォーカスを合わせ追尾
します。顔や瞳を検出しないときは、AFモード
になります（初期設定）。

Off：
顔/瞳検出AF機能を無効にします。

［ご注意］

ˎˎ Face/Eye	Only	AFに設定しているときでも、プッシュ
オートフォーカス実行中は、Face/Eye	Priority	AFにな
ります。
ˎˎ FOCUSスイッチが「MAN」のときは、顔/瞳検出AFでき
ません（プッシュオートフォーカス実行中を除く）。
ˎˎ Face/Eye	Only	AFに設定した状態で本機の電源を
切った場合、次に電源を入れると自動的にFace/Eye	
Priority	AFになります。

顔/瞳検出枠を消す

顔/瞳検出枠の表示/非表示は、Monitoring
メニューのDisplay	On/OffのFace/Eye	
Detection	Frame（107ページ）で設定できま
す。

［ご注意］
DISPLAYボタンで非表示、またはFace/Eye	Detection	
FrameをOffに設定しているときでも、プッシュオート
フォーカス（AF-S）でフォーカスが合った顔や瞳には緑色の
顔/瞳検出枠が表示されます。

アサイナブルボタンで顔/瞳検出AFの
動作を切り替える

アサイナブルボタン（47ページ）にFace/Eye	
Detection	AFを割り当てると、そのボタンを
押すたびに、顔/瞳検出AFの動作がFace/Eye	
Priority	AF、Face/Eye	Only	AF、Offの順に切
り替わります。

ダイレクトメニューで設定する

顔/瞳検出AFの動作は、ダイレクトメニュー
（47ページ）でも切り替えることができます。

被写体を指定して追尾する
（リアルタイムトラッキング
AF）

タッチ操作や顔検出枠選択操作で指定した被写
体にフォーカスを合わせ続けることができます。
被写体を選択すると白色の追尾枠が表示され、
追尾が開始されます。

［メモ］

ˎˎ フォーカスエリアの設定に関わらず、映像領域全体で追
尾します。
ˎˎ ShootingメニューのFocusのTouch	Function	in	MF
（90ページ）をTracking	AFに設定すると、フォーカ
スモードがMFモードの場合でもリアルタイムトラッキン
グAFが可能です。

顔/瞳検出AFの動作モードの設定によって、追
尾対象に対して次のように動作します。

Face/Eye	Only	AF、Face/Eye	Priority	
AF：
指定した被写体にフォーカスを合わせ追尾しま
す。
追尾対象が人物で、顔/瞳を検出した場合は、顔
/瞳にフォーカスを合わせます。
追尾対象の顔/瞳を検出した場合、追尾対象の
顔を保存します。保存が完了すると	 	（保存さ
れた追尾顔ありアイコン）（11ページ）が表示
されます。

［ご注意］
マニュアルフォーカス中にトラッキングAFを開始した場合
は、追尾対象の顔は保存しません。
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Off：
指定した被写体にフォーカスを合わせ追尾します。
追尾対象が人物であっても、顔/瞳の検出は行い
ません。

［ご注意］

ˎˎ レンズ側でマニュアルフォーカスに設定されていると、リ
アルタイムトラッキングAFは動作しません
ˎˎ Face/Eye	Only	AFに設定した状態で本機の電源を
切った場合、次に電源を入れると自動的にFace/Eye	
Priority	AFになります。

リアルタイムトラッキングAFを開始す
る

カメラの被写体を追尾対象に指定すると、追尾
対象に対して追尾が開始されます。

タッチ操作で指定する
次のいずれかの状態のときに、追尾対象とする
被写体をタップします。

ˎˎ フォーカスモードがMFモード、またはプッシュ
マニュアルフォーカス中で、Shootingメニュー
のFocusのTouch	Function	in	MF（90ペー
ジ）がTracking	AFのとき

ˎˎ フォーカスモードがAFモード、またはプッシュ
オートフォーカス（AF）中のとき

［ご注意］
TechnicalメニューのTouch	Operation（114ページ）が
Offの場合はタッチ操作での指定はできません。

顔検出枠選択操作で指定する
矢印ボタン（7ページ）またはマルチセレクター
（9ページ）で顔選択カーソル（オレンジ色の
下線）を追尾対象にする被写体に移動して、SET
ボタン（7ページ）を押すかマルチセレクター
を押し込みます。

他の顔検出枠（灰色） 追尾枠

顔選択カーソル（オレンジ）

［メモ］

ˎˎ リアルタイムトラッキングAF中に追尾対象を変更するこ
ともできます。
ˎˎ リアルタイムトラッキングAF中にFocus	Magnifierを
割り当てたアサイナブルボタン（47ページ）を押すと、
追尾状態を継続したままピント拡大が実行されます。た
だし、ピント拡大中は、追尾対象の指定はできません。

［ご注意］
マニュアルフォーカス中は、顔検出枠選択操作でトラッキ
ングを開始できません。

リアルタイムトラッキングAFを終了す
る

タッチ操作で終了する
タッチパネル左上に表示される	 	（リアルタ
イムトラッキングAF終了）ボタンをタップします。

［メモ］

ˎˎ 以下の場合もリアルタイムトラッキングAFが終了します。
	– FOCUSスイッチまたはレンズ側でAUTO/MANを切
り替えたとき

	– フォーカスモードを変更したとき
	– オートフォーカスアシストを実行したとき
	– フォーカスエリアの設定や顔/瞳検出AFの動作を変
更したとき

	– Push	AF/Push	MFを割り当てたアサイナブルボタン
を押したとき

	– 撮影画面内から追尾対象がなくなり、フォーカスが
どこにも合っていない状態が数秒経過したとき

ˎˎ 追尾顔が保存されている（保存された追尾顔ありアイコ
ン「 」が表示されているとき）場合は、撮影映像領域内
に保存された追尾顔が入ると再びリアルタイムトラッキ

ングAFが開始されます。追尾顔を削除するにはほかの
顔を指定するか、上記のリアルタイムトラッキングAF終
了の操作を行ってください。
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明るさを調節する
ND

PRESET
ND

VARIABLE

ND ON

CLEAR

ND AUTO

STATUS FOCUS

IRIS

SHUTTER

L
M
H

WHT  BALISO/GAIN

AUTO MAN-PUSH AUTO

PUSH AUTO

B
A
PRESET

B

C
D

E
F
G
I

J

A

アイリス、ゲイン、シャッタースピードを調節した
り、NDフィルターを使って光量を調節したりして、
明るさを調節できます。自動調節することもでき
ます。
明るさを自動調節するときの目標レベルは、
ShootingメニューのAuto	Exposure（87
ページ）のLevelで設定します。アサイナブルボタ
ン（47ページ）にAuto	Exposure	Levelを割
り当てることもできます。

［ご注意］
Cine	EIモードではゲインを調節できません。基準感度に固
定されます。また、シャッタースピードによる明るさの自動
調節はできません。アイリスやNDフィルターによる明るさ
の自動調節は可能です。

基準感度を選択する

本機では2種類の基準感度を選択することがで
きます。
SDR/HDRモードではShootingメニューのBase	
Sensitivity*でHighまたはLow、Cine	EIモー
ドではShootingメニューのBase	ISO*でISO	
4000またはISO	800から選択します。
*	 ステータス画面でも設定可能。
通常の照明下ではLowまたはISO	800、低照度
の条件ではHighまたはISO	4000を選択するこ
とで、ノイズ感を粗くせずバランスの取れた撮影
を行うことができます。

［メモ］
アサイナブルボタンにBase	ISO/Sensitivityを割り当てる
こともできます（47ページ）。

アイリスを調節する

アイリスを調節して、明るさを調節できます。

アイリスを自動調節する

被写体に応じて明るさを調整します。対応するレ
ンズが必要です。

1 レンズにAuto	Irisスイッチがついている場
合、AUTOにする。

2 IRISファンクションボタン（F）を長押ししてダ
イレクトメニュー（47ページ）を表示させ、
Autoを選ぶ。

	 ［メモ］
アサイナブルボタンにAuto	Irisを割り当てることもで
きます（47ページ）。

	 ［ご注意］
Aマウントレンズではアイリスを自動調節できません。

アイリスを手動調節する

1 IRISファンクションボタン（F）を長押ししてダ
イレクトメニュー（47ページ）を表示させ、
Manualを選ぶ。

2 IRISファンクションボタン（F）を押して、アイ
リス値が白背景で表示された状態にする。

3 マルチファンクションダイヤルを回して調節
する。

	 ［メモ］

ˎˎ マルチファンクションダイヤルにIRISを割り当てる
と、マルチファンクションダイヤルを常時IRISとして
動作させることもできます（47ページ）。
ˎˎ アサイナブルダイヤルにIRISを割り当てることもでき
ます（47ページ）。

一時的に自動調節する

PUSH	AUTO	IRISボタン（E）を押している間、ア
イリスを自動調節します。
指を離すと手動アイリスに戻ります。

［メモ］
アサイナブルボタンにPush	Auto	Irisを割り当てることもで
きます（47ページ）。

［ご注意］
レンズのAuto	IrisスイッチをMANUALにすると、本機から
のAuto	IrisやPush	Auto	Irisを受け付けなくなります。ま
た、本機からのアイリス手動調節操作も受け付けなくなり
ます。

ゲインを調節する

SDR/HDRモードではゲインを調節して、明るさ
を調節できます。

ゲインを自動調節する

ISO/GAINファンクションボタン（I）を長押しして
ダイレクトメニュー（47ページ）を表示させ、
Autoを選ぶ。

［メモ］

ˎˎ ShootingメニューのAuto	Exposure（87ページ）の
AGCをOnにしても同様の調節が可能です。
ˎˎ アサイナブルボタンにAGCを割り当てることもできます
（47ページ）。

ゲインを手動調節する

アイリスを固定したまま露出調整したいときや、
AGCによるゲインアップを行いたくないときなど
に使用します。

1 ISO/GAINファンクションボタン（I）を長押し
してダイレクトメニュー（47ページ）を表
示させ、Manualを選ぶ。

2 ISO/GAINスイッチ（J）でH/M/Lを選択する。

［メモ］
アサイナブルボタンにPush	AGCを割り当てると、そのボタ
ンを押している間だけAGCをOnにできます。

ゲインを微調整する

1 ISO/GAINファンクションボタン（I）を押して、
ゲイン値が白背景で表示された状態にする。

2 マルチファンクションダイヤルを回して調節
する。
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［メモ］
ISO/GAINスイッチ（J）の設定に応じたゲインプリセット値
を変更します。

ゲインを一時的に微調整する

アサイナブルダイヤル（47ページ）にISO/
Gain/EIを割り当てると、ISO/GAINスイッチ（J）
で設定した値からダイヤルで調整することができ
ます。
被写界深度を変えずにもう一歩露出を追い込み
たいときに便利です。
一時的に微調整した結果は、ISO/GAINスイッチ

（J）および基準感度の切り替えやAGCをOn、電
源をOffにすると無効になります。

［メモ］
マルチファンクションダイヤルに割り当てることもできます

（47ページ）。

Exposure	Indexを調整する

Cine	EIモードではMLUTをOffに設定した映像
出力を本線として記録することを想定しており、
EI値に合わせてMLUT	On側の映像の明るさを変
化させることで、ポストプロダクション処理での
増感減感処理結果を撮影時に確認することがで
きます。
EI値の変更は、ISO/GAINスイッチ（J）でH/M/L
を選択することで行えます。

［メモ］
ShootingメニューのISO/Gain/EIのExposure	
Index<H>/<M>/<L>（85ページ）およびステータス画
面のカメラステータス画面（15ページ）で各スイッチポジ
ションでのEI値を変更できます。

Exposure	Indexを微調整する

1 ISO/GAINファンクションボタン（I）を押して、
EI値が白背景で表示された状態にする。

2 マルチファンクションダイヤルを回して調節
する。

［メモ］
ISO/GAINスイッチ（J）の設定に応じたEIプリセット値を変
更します。

シャッターを調節する

シャッターを調節して、明るさを調節できます。

シャッターを自動調節する

SHUTTERファンクションボタン（G）を長押しして
ダイレクトメニュー（47ページ）からAutoを
選ぶと、映像の明るさに応じて自動でシャッター
速度または開角度を調整できます。

［メモ］
ShootingメニューのAuto	ExposureのAuto	Shutter

（88ページ）をOnにしても同様の調節が可能です。

シャッターを手動調節する

1 SHUTTERファンクションボタン（G）を長押
しして、ダイレクトメニュー（47ページ）
からSpeedまたはAngleを選ぶ。

2 SHUTTERファンクションボタン（G）を押し
て、シャッター値が白背景で表示された状
態にする。

3 マルチファンクションダイヤルを回してシャッ
ター速度を調節する。

［メモ］

ˎˎ 露光時間をフレーム周期に合わせる場合は、手順1で
Offを選択します。
ˎˎ 角度で設定したり、周波数で細かく設定することもでき
ます（86ページ）。

光量を調節する（NDフィル
ター）

撮影状況が明るすぎるときは、NDフィルターを
変更して適切な明るさにすることができます。
本機は2つのNDフィルターモードを備えていま
す。2つのモードはND	PRESET/VARIABLEスイッ
チで切り替えます。

プリセットモードで調節する

ND	PRESET/VARIABLEスイッチ（A）をPRESET
の位置にして、ND	FILTER	POSITION上下ボタン

（B）で切り替えます。
Clear：NDなし
1：ShootingメニューのND	FilterのPreset1

（86ページ）で設定した透過率。
2：ShootingメニューのND	FilterのPreset2

（86ページ）で設定した透過率。
3：ShootingメニューのND	FilterのPreset3

（86ページ）で設定した透過率。

バリアブルモードで調節する

ND	PRESET/VARIABLEスイッチ（A）を
VARIABLEの位置にします。ND	FILTER	
POSITION上下ボタン（B）でCLEARとOnを切り
替えます。

光量を自動調節する
オートNDフィルターをOnにすると、NDフィル
ターを使った自動露出調節を行います。

1 ND	FILTER	POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。
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2 ND	VARIABLE	AUTOボタン（C）をAutoに
なるまで長押しする。

光量を手動調節する

1 ND	FILTER	POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。

2 ND	VARIABLE	AUTOボタン（C）をManual
になるまで長押しする。

3 ND	VARIABLEダイヤル（D）を回してフィル
ターの透過率を調節する。

［メモ］
アサイナブルダイヤルにND	Filterを割り当てることもでき
ます（47ページ）。

一時的に自動調節する
Push	Auto	NDが割り当てられたアサイナブルボ
タン（47ページ）を押している間、オートNDフィ
ルターがOnになります。指を離すとオートNDフィ
ルターがOffに戻ります。
ND	FILTER	POSITION上下ボタン（B）の＋を押し
て、NDフィルターをOnの状態にしておいてくだ
さい。

［ご注意］
撮影中にCLEARをまたいでNDフィルターを切り替えたと
き、画像内にNDフィルターの枠が入り、音声に動作音が入
ります。

［メモ］

ˎˎ ND	VARIABLEダイヤル（D）をND1/4からさらに下に
回すと、CLEARにすることができます。また、CLEAR
からある程度上に回すと、ND1/4にすることができま
す。TechnicalメニューのND	DialのCLEAR	with	Dial

（114ページ）で、この動作を無効にすることができま
す。
ˎˎ ND	FILTER	POSITION上下ボタンの代わりに、ND	
Filter	Positionが割り当てられたアサイナブルボタン

（47ページ）を押して設定を変更することもできます。	
プリセットモード：Clear→Preset1→Preset2→	
Preset3→Clear・・・	
バリアブルモード：Clear→On→Clear・・・
ˎˎ Auto	ND	Filterが割り当てられたアサイナブルボタン
（47ページ）を押してオートNDフィルターをOn/Off
することもできます。
ˎˎ 明るい被写体を撮影するとき、アイリスを極端に絞ると
回折現象が生じフォーカスが甘くなることがあります（ビ
デオカメラでは一般的に起こる現象です）。NDフィルター
を使うことでこの現象を抑え、より良好な撮影結果を得
ることができます。
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撮影状況に応じて調整モードを選択できます。

ATW（自動追尾ホワイトバラ
ンス）

常に適切なホワイトバランスになるように自動的
に調整します。
光源の色温度が変化すると、ホワイトバランスを
自動的に調整し直します。
WHT	BALファンクションボタン（H）を長押しして、
ダイレクトメニュー（47ページ）からATWを
設定します。
ShootingメニューのWhite	SettingのATW	
Speed（89ページ）で、5段階の調整速度を選
択できます。

［メモ］
アサイナブルボタン（47ページ）にATW	Hold機能を割
り当てておくと、このボタンを押すことによって、ATWモー
ドでも一時的にATWを停止させ、ホワイトバランスを固定
することができます。

［ご注意］

ˎˎ Cine	EIモードのとき、ATWは使えません。
ˎˎ 照明や被写体の条件によっては、ATWを使用しても適
切な色に調整できないことがあります。	
例：
	– 空、海、地面、草花など単一色の被写体が大部分を
占める場合

	– 色温度が非常に高い/非常に低い光源下の被写体
	 ATWの自動追従の時間が遅い場合や、適切な効果が得

られない場合は、オートホワイトバランスを実行してくだ
さい。

ホワイトバランスを手動調節
する

1 ホワイトバランスがATWモードになっている
ときは、WHT	BALファンクションボタン（H）
を長押ししてダイレクトメニュー（47ペー
ジ）からManualを選ぶ。

2 WHT	BALスイッチ（K）でB/A/PRESETを選
択する。
B:	メモリー Bモード
A:	メモリーAモード
PRESET:	プリセットモード

［メモ］
ShootingメニューのWhite	SettingのWhite	Switch<B>

（89ページ）でATWを選択すると、メモリー BにATW
が割り当てられます。

メモリーA/メモリー B	モード
メモリーA	またはメモリー B	に保存されたホワ
イトバランスに調整します。

プリセットモード
色温度をプリセット値（工場出荷時：3200K）に
調整するモードです。

既定のプリセット値に変更する

プリセットモードでは既定のプリセット値に直接
変更することができます。
WHT	BALファンクションボタン（H）を長押しして、
ダイレクトメニューで以下から選択する。
SDR/HDR モード：→ 3200K、→ 4300K、

→ 5600K、→ 6300K
Cine	EI モード：→ 3200K、→ 4300K、

→ 5500K

［メモ］
Preset	White	Selectが割り当てられたアサイナブルボタン

（47ページ）を押して設定を変更することもできます。
SDR/HDRモード：3200K→4300K→5600K→6300K→	

3200K・・・
Cine	EIモード：3200K→4300K→5500K→3200K・・・

任意の色温度に変更する

1 WHT	BALファンクションボタン（H）を押して、
色温度が白背景で表示された状態にする。

2 マルチファンクションダイヤルを回して調節
する。

［メモ］

ˎˎ プリセットモードでは100K単位で設定できます。
ˎˎ メモリーモードでは20K単位で設定できます。また、
ShootingメニューのWhite（88ページ）でTintの調
節ができます。

オートホワイトバランスを実行する

メモリーA/メモリーBモードで保存するホワイト
バランスを自動で設定します。

1 メモリーAモードまたはメモリー Bモードを
選択する。

2 被写体の照明光源と同じ条件のところに白
い紙などを置き、ズームアップして画面に白
を映す。

3 明るさを調整する。
「アイリスを手動調節する」（41ページ）
に従って、アイリスを調整してください。

4 WB	SETボタン（4ページ）を押す。

ˎˎ メモリーモードで実行した場合は、調整値
は手順1で選択したメモリー（AまたはB）に
保存されます。

ˎˎ ATWモードで実行した場合は、調整が終
わるとATWモードでのホワイトバランス調
整に戻ります。

［ご注意］
正常に終了しなかったときは画面に約3秒間エラーメッセー
ジが表示されます。繰り返し調整を試みてもエラーメッセー
ジが表示されるときは、ソニーのサービス担当者にご相談
ください。

自然な色合いに調節する（ホワイトバランス）
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本機の入力端子やスイッチ、ダイヤルなどを使い、
収録する音声を設定します。

外部音声の入力端子と切り替えスイッ
チ

INPUT1端子（8ページ）
INPUT2端子（8ページ）
マルチインターフェースシュー（4ページ）
CH1	INPUT切り替えスイッチ（7ページ）
CH2	INPUT切り替えスイッチ（7ページ）
INPUT1スイッチ（LINE/MIC/MIC+48V）（4
ページ）
INPUT2スイッチ（LINE/MIC/MIC+48V）（4
ページ）

録音レベルの設定用スイッチ

CH1（AUTO/MAN）スイッチ（7ページ）
CH2（AUTO/MAN）スイッチ（7ページ）
AUDIO	LEVEL（CH1）ダイヤル（7ページ）
AUDIO	LEVEL（CH2）ダイヤル（7ページ）
AUDIO	LEVEL（CH3）ダイヤル（7ページ）
AUDIO	LEVEL（CH4）ダイヤル（7ページ）

音声入力機器を選ぶ

1 音声入力を切り替える。
CH1/CH2の場合は、CH1	INPUT切り替えス
イッチ/CH2	INPUT切り替えスイッチで音声
入力を切り替えます。
INPUT1端子/INPUT2端子を使う場合は、
EXTを設定します。
また、シューマイク、XLRアダプター、UWP

（UHFワイヤレスマイクロフォン）またはポー
タブルワイヤレスチューナーを使う場合は、
同様にMI	SHOEを設定します。XLRアダプ
ターについては「オーディオ入力端子を増設
する」（46ページ）をご覧ください。
ポータブルワイヤレスチューナーについては

「ポータブルワイヤレスチューナーを使用す
る」（46ページ）をご覧ください。
CH3/CH4の場合は、Audioメニューの
Audio	InputのCH3	Input	Select*（110
ページ）、CH4	Input	Select*（110ページ）
で音声入力を切り替えます。
*	 ステータス画面でも設定可能。

	 ［メモ］
CH2は、AudioメニューのAudio	InputのCH2	EXT	
Input	Select*（110ページ）でINPUT1を選択するこ
ともできます。
*	 ステータス画面でも設定可能。

	 ［ご注意］
本機は環境音収録用のナレーションマイクを内蔵して
います。他機器とのタイミング合わせなどにご利用い
ただけます。その場合はINTまたはInternal	MICを設
定します。

2 入力する音源を選ぶ。
INPUT1/INPUT2端子に接続する機器に
合わせて、INPUT1/INPUT2（LINE/MIC/
MIC+48V）スイッチを設定します。

接続機器 スイッチの位置
外部音声機器（ミキサーな
ど）

LINE

ダイナミックマイクや電池内
蔵のマイク

MIC

+48V電源（ファンタム電源）
対応のマイク

MIC+48V

ˎˎ MIC+48Vにしたままで+48V電源に対応し
ていない機器を接続すると、接続した機器
の故障の原因になります。接続前にご確認
ください。

ˎˎ 接続しない端子の雑音が気になるときは、
INPUT1/INPUT2（LINE/MIC/MIC+48V）
スイッチを「LINE」にしてください。

録音レベルを自動調節する

自動調整するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「AUTO」にします。
CH3/CH4の場合は、AudioメニューのAudio	
InputのCH3	Level	Control*、CH4	Level	
Control*をAutoに設定します（110ページ）。
*	 ステータス画面でも設定可能。

録音レベルを手動調節する

CH1/CH2の録音レベルを手動調整する場合は、
以下の手順で行います。

1 調節するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「MAN」にする。

2 撮影中またはスタンバイ中に、調節するチャ
ンネルのAUDIO	LEVEL（CH1）/（CH2）ダイ
ヤルを回して、音量を調節する。

ˎˎ CH3/CH4の場合は、Audioメニューの
Audio	InputのCH3	Level	Control*、
CH4	Level	Control*をManualに設定し、
AUDIO	LEVEL(CH3)/(CH4)ダイヤルで録
音レベルを調節します。

ˎˎ CH1～ CH4を一括してレベル調整するこ
ともできます。Audio	Input	Levelが割
り当てられたアサイナブルダイヤル（47
ページ）やAudioメニューのAudio	Input
のAudio	Input	Level*で調節します。

*	 ステータス画面でも設定可能。

［メモ］
音声入力レベルの確認には、オーディオステータス画面が
便利です（15ページ）。

［ご注意］

ˎˎ Audioメニューの設定の組み合わせによりAudio	Input	
Levelの設定が無効になる場合があります。詳細は
149ページの図をご覧ください。
ˎˎ CH1	INPUT切り替えスイッチ、CH2	INPUT切り替え
スイッチがどちらもINTに設定されている場合は、CH1

（AUTO/MAN）スイッチの設定に連動してCH2の自動・
手動も切り替わります。また、AUDIO	LEVEL（CH1）ダ
イヤルの設定に連動してCH2の録音レベルも変わりま
す。
ˎˎ 本機では組み合わせによりさまざまな設定ができます。
詳細は149ページの図をご覧ください。

収録する音声を設定する
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オーディオ入力端子を増設す
る

XLRアダプターXLR-K2M（別売）、XLR-K3M（別
売）を使うと、同時に4系統のXLR音声機器を本
機に接続することができます。
マルチインターフェースシューにXLRアダプター
を装着して、AudioメニューのAudio	Inputの
CH3	Input	Select*をShoe	CH1に、CH4	Input	
Select*をShoe	CH2に設定してください。
入力にXLRアダプターを選択したチャンネルで
は、重複する本機の機能は無効になります。
XLRアダプターのスイッチやダイヤルで調節してく
ださい。
*	 ステータス画面でも設定可能。

［ご注意］

ˎˎ 本機はXLR-K3Mのデジタルオーディオインターフェース
に対応しています。
ˎˎ AudioメニューのAudio	InputのCH3	LevelやCH4	
LevelをAudio	Input	Levelに設定した場合は、XLRア
ダプターで調節したレベルに本機のAudio	Input	Level
が掛け合わされます。	
XLRアダプターのスイッチをAUTOに設定した場合も
Audio	Input	Levelが有効になります。	
Throughに設定した場合は、XLRアダプターで調節した
レベルで記録されます（150ページ）。
ˎˎ XLRアダプターXLR-K2M（別売）、XLR-K3M（別売）を
本機に取り付ける場合は、本機のマイクホルダーを取り
外してください。

ポータブルワイヤレスチュー
ナーを使用する

別売の拡張ユニットXDCA-FX9が必要です。
XDCA-FX9の取り付けについては、25ページ
をご覧ください。
XDCA-FX9にポータブルワイヤレスチューナーを
装着した状態で、AudioメニューのAudio	Input

（110ページ）のCH1	MI	SHOE	Input	Select*、
CH2	MI	SHOE	Input	Select*、CH3	Input	
Select*、またはCH4	Input	Select*をWireless
に設定してください。
*	 ステータス画面でも設定可能。
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便利な機能
ダイレクトメニュー操作

ビューファインダー画面に表示される本機の状態
や設定を、直接選択して変更することができます。
設定できる項目は、以下のとおりです。

ˎˎ Face/Eye	Detection	AF

ˎˎ Steady	Shot

ˎˎ White	Mode

ˎˎ Color	Temp

ˎˎ Scene	File

ˎˎ ND	Filter	Position	/	Auto	ND	Filter

ˎˎ ND	Filter	Value

ˎˎ Auto	Iris

ˎˎ Iris	Value

ˎˎ AGC

ˎˎ Gain	Value

ˎˎ ISO	Value

ˎˎ EI	Gain	Value

ˎˎ Auto	Shutter

ˎˎ Shutter	Value

ˎˎ Auto	Exposure	Mode

ˎˎ Auto	Exposure	Level

ˎˎ S&Q	Motion	Frame	Rate

1 マルチファンクションダイヤル、または
Direct	Menuが割り当てられたアサイナブル
ボタンを押す。
ダイレクトメニュー操作のできる項目のいず
れかにオレンジのカーソルが表示されます。

2 マルチファンクションダイヤルで操作したい
項目にカーソルを合わせ、マルチファンクショ
ンダイヤルを押す。
メニューが表示されるか、または項目が白
背景で表示されます。

3 マルチファンクションダイヤルで設定を選び、
マルチファンクションダイヤルを押す。
メニューまたは白背景が消えて、新しい設定
がオレンジのカーソルで表示されます。
再びDirect	Menuが割り当てられたアサイ
ナブルボタンを押すか、何も操作しないで3
秒経過すると、ダイレクトメニューが終了し
ます。

	 ［メモ］

ˎˎ 各種ファンクションボタン（6ページ）を長押し
して、直接設定をする状態にすることもできます。
ˎˎ 白背景で表示された状態では、マルチファンクショ
ンダイヤルをアサイナブルダイヤルのように使うこと
ができます。
ˎˎ 選択操作はマルチセレクター（9ページ）でも行
えます。

アサイナブルボタン/ダイヤル

本機には、機能を割り当てて使用できるアサイナ
ブルボタンが10個（6、9ページ）ありま
す。
グリップリモコンのアサイナブルダイヤル（9
ページ）と、本体のマルチファンクションダイヤル
にも機能を割り当てることができます。
アサイナブルボタン1～ 3、7～ 9にはLEDが内
蔵されており、割り当てられている機能の状態に
応じて消灯/点灯（橙）します。

ボタンの機能を変更する

ProjectメニューのAssignable	Button（96
ページ）を使用します。

割り当てられた機能は、アサイナブルボタンス
テータス画面（16ページ）で確認することがで
きます。

工場出荷時にアサイナブルボタンに割り当
てられている機能
ボタン1	 S&Q	Motion
ボタン2	 Off
ボタン3	 Off
ボタン4	 Focus	Magnifier	x3/x6
ボタン5	 Direct	Menu
ボタン6	 Off
ボタン7	 Off
ボタン8	 Off
ボタン9	 Off
ボタン10	 Focus	Magnifier	x3/x6
Focus	Holdボタン	 Focus	Hold

割り当てられる機能
機能によっては、状態に応じてアサイナブルボタ
ン（1～ 3、7～ 9）の番号が点灯します。
－：点灯しない
機能 LED点灯条件

Off －
Base	ISO/Sensitivity －
AGC Onで点灯
Push	AGC 機能が動作している間

だけ点灯
ND	Filter	Position －
Auto	ND	Filter Onで点灯
Push	Auto	ND 機能が動作している間

だけ点灯
Auto	Iris Onで点灯
Push	Auto	Iris 機能が動作している間

だけ点灯
Auto	Shutter Onで点灯

機能 LED点灯条件

Auto	Exposure	Level －
Backlight バックライトモード時に

点灯
Spotlight スポットライトモード時

に点灯
Preset	White	Select －
ATW Onで点灯
ATW	Hold Onで点灯
AF	Speed/Sens. －
Focus	Zero	Marker －
Focus	Setting －
Focus	Area －
Focus	Area(AF-S) －
Face/Eye	Detection	
AF

顔/瞳検出AFが有効な
ときに点灯

Push	AF	Mode －
Push	AF/Push	MF 機能が動作している間

だけ点灯
Focus	Hold 機能が動作している間

だけ点灯
Focus	Magnifier		
x3/x6

Off以外（3倍/6倍）で点
灯

Focus	Magnifier	x3 Onで点灯
Focus	Magnifier	x6 Onで点灯
S&Q	Motion Onで点灯
SteadyShot Off以外（Active/

Standard）で点灯
Crop	Select －
Rec 記録/タリーランプと連

動して点灯または点滅
Picture	Cache	Rec Onで点灯
Rec	Review レックレビュー中に点灯
Last	Clip	Del. －
Shot	Mark1 －
Shot	Mark2 －
Clip	Flag	OK －



3章　撮影：便利な機能48

機能 LED点灯条件

Clip	Flag	NG －
Clip	Flag	Keep －
Color	Bars Onで点灯
Tally	[Front] Onで点灯
CALL Onで点灯
DURATION/TC/U-BIT －
Display －
Lens	Info Off以外（Meter/Feet）

で点灯
Video	Signal	Monitor Off以外（Waveform/

Vector/Histogram）で
点灯

Marker Onで点灯
VF	Adjust －
VF	Mode モノクロ時に点灯
Gamma	Display	
Assist

Onで点灯

Peaking Onで点灯
Zebra Onで点灯
Audio	Monitor	CH －
Audio	Mon.	CH	
Switch

－

Thumbnail －
Touch	Operation Onで点灯
Handle	Zoom －
NFC －
Network	Client	Mode Onで点滅

Connection	Control	
Manager（CCM）に接
続すると点灯

Auto	Upload	(Proxy) OnまたはChunkで点灯
Direct	Menu －
User	Menu －
Menu －

ダイヤルの機能を変更する

本体のマルチファンクションダイヤルと、グリップ
リモコンのアサイナブルダイヤルの機能を変更す
ることができます。
マルチファンクションダイヤルはProjectメ
ニューのMulti	Function	Dial（98ページ）の
Default	Functionで設定します。
工場出荷時にはOffが割り当てられています。

マルチファンクションダイヤルに割り当て
られる機能
ˎˎ Off

ˎˎ IRIS

ˎˎ ISO/Gain/EI

ˎˎ Audio	Input	Level

［ご注意］
メニューなどを表示しているときは、本設定は無効になり
ます。

アサイナブルダイヤルはProjectメニューの
Assignable	Dial（98ページ）で設定します。
工場出荷時にはIRISが割り当てられています。

アサイナブルダイヤルに割り当てられる機
能
ˎˎ Off

ˎˎ ISO/Gain/EI

ˎˎ ND	Filter

ˎˎ IRIS

ˎˎ Audio	Input	Level

割り当てられた機能は、アサイナブルボタンス
テータス画面（16ページ）で確認することがで
きます。

スロー＆クイックモーション

記録フォーマット（93ページ）が下記に設定されているときは、撮像時のフレームレートを再生時の
フレームレートと異なる値に設定することができます。

記録フォーマット フレームレート
システム周波数 イメージャー	

スキャンモード
コーデック ビデオフォーマット

59.94/50 FFcrop	5K/	
S35	4K

XAVC-I 4096×2160P 1-60
3840×2160P 1-60
1920×1080P 1-60

XAVC-L 3840×2160P 1-60
1920×1080P 1-60

FF	2K XAVC-I 1920×1080P 1-60、100、120、150、180*1	

XAVC-L 1920×1080P 1-60、100、120
S35	2K XAVC-I 1920×1080P 1-60、100、120

XAVC-L 1920×1080P 1-60、100、120
S16	2K XAVC-I 1920×1080P 1-60、100、120、150、180*1

XAVC-L 1920×1080P 1-60、100、120
29.97/25/23.98 FF	6K XAVC-I 4096×2160P 1-30

3840×2160P 1-30
1920×1080P 1-30

XAVC-L 3840×2160P 1-30
1920×1080P 1-30

FFcrop	5K/	
S35	4K

XAVC-I 4096×2160P 1-60
3840×2160P 1-60
1920×1080P 1-60

XAVC-L 3840×2160P 1-60
1920×1080P 1-60

FF	2K XAVC-I 1920×1080P 1-60、100、120、150、180*2

XAVC-L 1920×1080P 1-60、100、120
S35	2K XAVC-I 1920×1080P 1-60、100、120

XAVC-L 1920×1080P 1-60、100、120
S16	2K XAVC-I 1920×1080P 1-60、100、120、150、180*2

XAVC-L 1920×1080P 1-60、100、120
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記録フォーマット フレームレート
システム周波数 イメージャー	

スキャンモード
コーデック ビデオフォーマット

24 FF	6K XAVC-I 4096×2160P 1-30
FFcrop	5K/	
S35	4K

XAVC-I 4096×2160P 1-60

*1	システム周波数が59.94のときのみ選択可能。
*2	システム周波数が29.97/23.98のときのみ選択可能。

記録フォーマット フレームレート
システム周波数 イメージャー	

スキャンモード
コーデック RAWフォーマット

59.94/50 FFcrop	5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1-60

S35	4K RAW 4096×2160 1-60
3840×2160 1-60、100、120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1-60

FF	2K RAW/
RAW&XAVC-I*3

2048×1080 1-60、100、120、
150、180*1

RAW&XAVC-L*3 2048×1080 1-60、100、120
S35	2K RAW/

RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1-60、100、120

S16	2K RAW/
RAW&XAVC-I*3

2048×1080 1-60、100、120、
150、180*1

RAW&XAVC-L*3 2048×1080 1-60、100、120

記録フォーマット フレームレート
システム周波数 イメージャー	

スキャンモード
コーデック RAWフォーマット

29.97/25/23.98 FF	6K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1-30

FFcrop	5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1-60

S35	4K RAW 4096×2160 1-60
3840×2160 1-60、100、120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1-60

FF	2K RAW/
RAW&XAVC-I*3

2048×1080 1-60、100、120、
150、180*2

RAW&XAVC-L*3 2048×1080 1-60、100、120
S35	2K RAW/

RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1-60、100、120

S16	2K RAW/
RAW&XAVC-I*3

2048×1080 1-60、100、120、
150、180*2

RAW&XAVC-L*3 2048×1080 1-60、100、120
24 FF	6K RAW 4096×2160 1-30

FFcrop	5K/	
S35	4K

RAW 4096×2160 1-60

*1	システム周波数が59.94のときのみ選択可能。
*2	システム周波数が29.97/23.98のときのみ選択可能。
*3	ビデオフォーマットは1920×1080になります。

S&Q	Motionが割り当てられたアサイナブルボタン（47ページ）を押すと、スロー＆クイックモーショ
ンモードをOn/Offできます。
ボタンを長押しすると、撮像時のフレームレートを設定できます。

［メモ］
ShootingメニューのS&Q	Motionやメインステータス画面のS&Q	Frame	Rate、プロジェクトステータス画面のRec	
Functionでも設定可能です。

［ご注意］

ˎˎ 記録中、再生中、サムネイル表示中は、スロー＆クイックモーションモードにできません。
ˎˎ スロー＆クイックモーションモードでは、音声は記録できません。
ˎˎ スロー＆クイックモーションモードでは、オートフォーカス機能とオートアイリス機能、オートシャッター機能が無効にな
ります。
ˎˎ RAW出力の使用方法は58ページをご覧ください。
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間欠的に映像を記録する（イ
ンターバルレック機能）

本機のメモリーを利用して間欠的に映像を取り込
み、記録するインターバルレック機能は、主に動
きの少ない被写体を撮影するときに有効です。
記録を開始すると、設定したフレーム数（Number	
of	Frames）分の映像を、任意のインターバル

（Interval	Time）で自動記録できます。

撮影の間隔（Interval	Time）

1回に記録する画像フレーム数
（Number	of	Frames）

インターバルレックを有効にしているときは、撮
影開始前にビデオライトHVL-LBPC（別売）を自
動的に点灯させ、光量、色温度を安定させた状
態で撮影を行うことができます（プリライティン
グ機能）。

［ご注意］

ˎˎ インターバルレックなどの特殊記録機能を複数同時に使
用できません。
ˎˎ インターバルレック使用中に他の特殊記録機能を有効に
すると、インターバルレックは自動的に解除されます。
ˎˎ ビデオフォーマットなどのシステム設定を変更すると、
インターバルレックモードは自動的に解除されます。
ˎˎ 記録中や再生中、サムネイル画面表示中にインターバル

レックの設定を変更することはできません。

設定するには

ProjectメニューのInterval	Rec（95ページ）
でSettingをOnに設定し、Number	of	Frames
とInterval	Timeを設定してください。
ビデオライトHVL-LBPC（別売）を使用する場合
は、必要に応じてProjectメニューのInterval	
RecのPre-Lightingで記録開始前のビデオライ
ト点灯時間を設定してください。

［メモ］
プロジェクトステータス画面のRec	Functionでも設定可能
です。

［ご注意］

ˎˎ ビデオライトを記録前に点灯させる場合は、ビデオラ
イトのスイッチをAUTOに設定してください。このとき
TechnicalメニューのVideo	Light	Set（116ページ）
の設定に従ってビデオライトが自動点灯／消灯します。
ˎˎ ビデオライトのスイッチをONに設定すると、ビデオライ
トは常時点灯します。（ビデオライトは自動点灯／消灯し
ません。）
ˎˎ 各設定により消灯時間が5秒以下になる場合は、ビデオ
ライトは消灯しません。

本機の電源を切るとインターバルレックモー
ドは解除されますが、Number	of	Frames、
Interval	Time、Pre-Lightingの設定は保持さ
れます。次回インターバルレックモードで撮影す
るときに再設定する必要はありません。

撮影するには

録画START/STOPボタンを押すと記録が開始
され、ビューファインダー画面上に「IntRec」と

「IntStby」が交互に表示されます。
プリライティング機能を使用する場合は、記録
が始まる前にビデオライトが点灯します。

撮影を終了するには

記録停止の操作を行います。
撮影を終了すると、その瞬間までメモリーに蓄え
られていた映像がメディアに記録されます。

インターバルレックモードを解除する
には

次のいずれかを実行します。

ˎˎ POWERスイッチをOffにする。

ˎˎ 記録待機中に、ProjectメニューのInterval	
RecのSettingをOffに設定する。

また、本機が再起動した場合もインターバルレッ
クモードは解除されます。

記録中の動作制限

ˎˎ 音声は記録されません。

ˎˎ レックレビュー操作は行えません。

ˎˎ ゲンロックはかかりません。

本機の電源が切れた場合

ˎˎ 本機のPOWERスイッチをOffにした場合は、
その瞬間までメモリーに蓄えられていた映像を
記録するため、メディアにアクセスしてから、
自動的に電源が切れます。

ˎˎ 記録中にバッテリーを取り外したり、DC電源
コードを引き抜いたり、ACアダプター側の電
源を切ったりした場合は、その瞬間以前に撮
影したショット（最大10秒）が記録されないこ
とがあります。バッテリー交換の際は充分ご注
意ください。

数秒前の映像から記録する
（ピクチャーキャッシュレック
機能）

ピクチャーキャッシュレック機能を使用すると、
撮影している映像を、指定した時間内蔵キャッ
シュメモリーに蓄えておくことによって、記録開
始以前にさかのぼって映像をXQDメモリーカード
に記録することができます。Projectメニューの
Picture	Cache	RecのSetting*（96ページ）
をOnに設定します。ピクチャーキャッシュレッ
クの蓄積時間は、ProjectメニューのPicture	
Cache	RecのCache	Rec	Time（96ページ）
で設定できます。
*	 ステータス画面でも設定可能。

対応記録フォーマットについて

コーデック ビデオ
フォーマッ
ト

システム	
周波数

キャッシュ
時間［秒］

XAVC-I 4096×
2160P

59.94 0-4	s
50
29.97
25 0-4/	

4-8	s23.98
24

3840×
2160P

59.94 0-4	s
50
29.97
25 0-4/	

4-8	s23.98
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コーデック ビデオ
フォーマッ
ト

システム	
周波数

キャッシュ
時間［秒］

XAVC-I 1920×
1080P

59.94 0-4/	
4-8	s50

29.97 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24	s

25

23.98 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

1920×
1080i

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20	s

1920×
1080i

50 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24	s

XAVC-L 3840×
2160P

59.94 0-4/	
4-8/	
8-12/	
12-16	s

50

29.97 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

25
23.98

コーデック ビデオ
フォーマッ
ト

システム	
周波数

キャッシュ
時間［秒］

XAVC-L 1920×
1080P	50

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50
29.97
25
23.98

1920×
1080P	35

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50
29.97
25
23.98

1920×
1080i	50

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50

1920×
1080i	35

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50

1920×
1080i	25

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50

コーデック ビデオ
フォーマッ
ト

システム	
周波数

キャッシュ
時間［秒］

MPEG	
HD422

1920×
1080i	50

59.94 0-4/	
4-8/	
8-12/	
12-16/	
16-20/	
20-24/	
24-28	s

50
29.97
25
23.98

［ご注意］

ˎˎ ピクチャーキャッシュレックは、インターバルレック、ス
ロー＆クイックモーションと同時にOnにすることはでき
ません。ピクチャーキャッシュレックをOnにすると、こ
れらの機能は強制的にOffになります。
ˎˎ 記録中、レックレビュー中は、ピクチャーキャッシュレッ
クモードにできません。
ˎˎ ピクチャーキャッシュレックがOnのときは、タイムコー
ドはTC/Mediaメニューの設定に関わらず常にFree	
Runモードで記録されます（105ページ）。
ˎˎ ピクチャーキャッシュレック中はOutput	Formatの設
定を変更できない場合があります。この場合、一度ピク
チャーキャッシュレックをOffにしてから変更操作を行っ
てください。

撮影前の設定

あらかじめProjectメニューのPicture	Cache	
Rec（96ページ）で設定を行ってください。
アサイナブルボタン（47ページ）にPicture	
Cache	Rec機能を割り当てて、ボタン操作で
SettingのOn/Offを切り替えることもできます。
設定を完了すると、ビューファインダー画面上に

「」（は緑）が点灯します。

ピクチャーキャッシュレックを実行す
る

録画START/STOPボタンを押すと記録が開始さ
れ、キャッシュメモリーに蓄積されている映像か
らXQDメモリーカードに書き込まれます。

ピクチャーキャッシュレック機能を解
除するには

ProjectメニューのPicture	Cache	Recで
SettingをOffにするか、Picture	Cache	Rec機
能を割り当てたアサイナブルボタンを押します。

［ご注意］

ˎˎ 記録フォーマットが変更されると、それまで蓄えていた
映像をクリアし、新たに蓄積を開始します。したがって、
変更直後に記録を開始しても、フォーマット変更前の映
像はピクチャーキャッシュレックできません。
ˎˎ XQDメモリーカード挿入直後にピクチャーキャッシュ
レックの開始/終了操作を行った場合は、データがカー
ドに記録されないことがあります。
ˎˎ 画像の蓄積は、ピクチャーキャッシュレック機能をOnに
してから開始されます。したがって、Onにする前の映像
はピクチャーキャッシュレックできません。
ˎˎ 再生、レックレビュー、サムネイル画面表示など、XQD
メモリーカードにアクセスしている間は映像を蓄えない
ため、この間の映像はピクチャーキャッシュレックでき
ません。

メモリーカードAとメモリー
カードBの両方に記録するに
は（2スロット同時記録）

ProjectメニューのSimul	RecのSetting*をOn
にすると、メモリーカードAとメモリーカードBの
両方に同時に記録できます。
*	 ステータス画面でも設定可能。

［ご注意］
スロー &クイックモーションモード（91ページ）やピク
チャーキャッシュレックモード（96ページ）のときは同時
記録できません。また、次の記録フォーマット（93ページ）
では同時記録できません。
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XAVC-I
ビデオフォーマット
4096 × 2160P、3840 × 2160P

XAVC-L
ビデオフォーマット
4096 × 2160P、3840 × 2160P

録画START/STOPボタンと
ハンドル録画START/STOP
ボタンの設定を変える

同時記録に設定しているとき、録画START/
STOPボタンとハンドル録画START/STOPボタン
で、それぞれ別のメモリーカードの記録開始／終
了をすることができます。
工場出荷時は、どちらのボタンもメモリーカード
AとメモリーカードBの両方に同時に記録するよ
うに設定されています。

ˎˎ “Rec	Button	[SlotA	SlotB]	Handle	Rec	
Button	[SlotA	SlotB]”

それぞれのボタンで別のメモリーカードへ記録す
るように設定したとき、SDI/HDMI	Rec	Control
は、スロットAの記録状態に従います。

設定を変えるには

ProjectメニューのSimul	RecのRec	Button	
Setを選択します。

Rec	Button	Setの	
設定

ボタンとメモリーカード

“Rec	Button	[SlotA	
SlotB]	Handle	
Rec	Button	[SlotA	
SlotB]”

どちらのボタンを押して
も、メモリーカードAとメ
モリーカードBに同時に
記録を開始/終了する。

“Rec	Button	[SlotA]	
Handle	Rec	Button	
[SlotB]”

録画START/STOPボタ
ンを押したときはメモ
リーカードAに、ハンド
ル録画START/STOPボ
タンを押したときはメモ
リーカードBに、記録を
開始/終了する。

“Rec	Button	[SlotB]	
Handle	Rec	Button	
[SlotA]”

録画START/STOPボタ
ンを押したときはメモ
リーカードBに、ハンド
ル録画START/STOPボ
タンを押したときはメモ
リーカードAに、記録を
開始/終了する。

4K	&	HD	(Sub)記録

1枚のXQDメモリーカードに、4K（QFHD）の映
像をメインクリップ、事前編集などに活用できる
MPEG	HD422の映像をサブクリップとして、同
時に記録することができます。
4K	&	HD	(Sub)記録に使用できるXQDメモリー
カードの記録フォーマットは、以下のとおりです。
サブクリップの記録フォーマットは、メインクリッ
プのシステム周波数によって決まります。

メインクリップ記
録フォーマット

システム	
周波数

サブクリップ記
録フォーマット

	ˎ XAVC-I		
4096×2160P
	ˎ XAVC-I		
3840×2160P
	ˎ XAVC-L		
3840×2160P

29.97/25/	
23.98

MPEG	HD422	
1920×1080P

59.94/50 MPEG	HD422	
1920×1080i

［メモ］
ThumbnailメニューのCopy	Sub	Clip（112ページ）で、
サブクリップを別メディアにメインクリップとしてコピーする
ことができます。

映像信号モニター

MonitoringメニューのDisplay	On/Offの
Video	Signal	Monitor（108ページ）で、ビュー
ファインダー画面に表示する映像信号の種類を
ウェーブフォーム、ベクトルスコープ、ヒストグラ
ムのいずれかに設定できます。
本機の映像信号モニターは映像出力の経路上で
映像信号を計測するため、記録映像に対して出
力映像がエッジクロップされている場合、切り取
られた部分の信号成分は計測されません。この
とき、映像信号モニターの左上に「EC」が表示さ
れます。

モニター対象の表示

Cine	EIモードのときは、モニター対象を示す情
報として、色域設定（27ページ）またはモニター
LUTの設定（91ページ）が映像信号モニターの
右上に表示されます。

ハイダイナミックレンジ（HDR）
撮影

ハイダイナミックレンジ（HDR）モードにすると、
ダイナミックレンジを拡大し、BT.2020相当の色
域で記録や出力を行うことができます。

ハイダイナミックレンジモードを設定す
る

ProjectメニューのBase	SettingのShooting	
Mode*（93ページ）でHDRを選択します。
*	 ステータス画面でも設定可能。

HLGの種類の設定

PaintメニューのHDR	Paint	SettingのHLG	
Look（101ページ）で、HDRモード時のHLGの
種類を設定できます。

HLG	Lookの設定 説明

Natural ITU-R	BT.2100(HLG)に準拠
した特性があります。
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HLG	Lookの設定 説明

Live ITU-R	BT.2100(HLG)に準拠
し、よりHDRの効果を引き
出す特性があります。ただし、
この設定を使用すると、ノイ
ズレベルが上がることがあり
ます。

ガンマ表示アシスト機能の設定

MonitoringメニューのGamma	Display	Assist
のSetting*（109ページ）をOnにすると、ビュー
ファインダーへの表示をHDRモードでの撮影の
しやすさを考慮した表示にすることができます。
*	 ステータス画面でも設定可能。

ガンマ表示アシスト機能有効時に
ビューファインダーの表示を選択する

ガンマ表示アシスト機能が有効なときにビュー
ファインダーのHDR映像の表示方法を次の2種
類から選択できます。

HDRの低輝度部分や高輝度部分のコント
ラストを保持して表示する
HDRの表現力を活かし、明るめの露出、または
暗めの露出で撮影した場合にも、黒つぶれや白
飛びを起こさずに映像をビューファインダーに表
示できます。その反面、全体のコントラストは少
し低くなります。
この表示方法を使用するには、Projectメニュー
のHDR	SettingのVF	SDR	Preview（95ペー
ジ）をOffにします。

HDRからSDRへの変換を想定して簡易変
換されたSDRを表示
いままでのSDRと同様の感覚でのカメラオペレー
ションが可能です。
HDRとSDRのゲイン差をSDR	Gainで設定するこ
とで、HDR映像の明るさを設定できます。
この表示方法を使用するには次の設定を行いま
す。

1 ProjectメニューのHDR	SettingのVF	SDR	
Preview（95ページ）をOnにする。

2 ProjectメニューのHDR	SettingのSDR	
Gain（95ページ）で、HDRモード時の
SDRゲイン値を調整する。

［メモ］
撮影後、SR	Live	Metadataを使用して表示をHDR映像か
らSDRに変換する場合、変換にSDR	Gainが適用され、撮
影時にビューファインダーで確認していた露出のSDR映像
の表示に変換されます。

ユーザー3D	LUT

Cine	EIモードのとき、RAW	Viewerや
Blackmagic	Design	Pty.	Ltd.製DaVinci	
Resolveで生成される17格子または33格子の
CUBEファイル（*.cube）を、SDカードまたはク
ラウドサービスから本機に読み込むことができま
す。

［ご注意］
生成されたユーザー3D	LUTファイルは、SDカードの以下
の階層に保存してください。
\PRIVATE\SONY\PRO\LUT\

ユーザー3D	LUTを使用するには以下の操作が
必要です。

SDカードから読み込む

1 SDカードを、ラベルを右にしてUTILITY	
SD/MSカードスロット（8ページ）に差し
込む。

2 ShootingメニューのMonitor	3D	LUTの
Load	from	Utility	SD/MS（91ページ）
を選択する。

3 読み込み先を選択する。
本機の内部メモリーに16個まで登録できま
す。

4 読み込むファイルを選択する。

5 OKを選択する。
選択したファイルが読み込まれます。

6 OKを選択する。

7 ShootingメニューのMonitor	LUTの
Category（91ページ）でUser	3D	LUTを
選択する。

8 ShootingメニューのMonitor	LUTのUser	
3D	LUT	Select（91ページ）で使用したい
ユーザー3D	LUTを選択する。

クラウドサービスから読み込む

1 本機をスマートフォンアプリ「C3	Portal	
App」に接続する（69ページ）。

2 ShootingメニューのMonitor	3D	LUTの
Load	from	Cloud(Private)またはLoad	
from	Cloud(Share)（92ページ）を選択
する。

3 読み込み先を選択する。
本機の内部メモリーに16個まで登録できま
す。
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4 読み込むファイルを選択する。

5 OKを選択する。
選択したファイルが読み込まれます。

6 OKを選択する。

7 ShootingメニューのMonitor	LUTの
Category（91ページ）でUser	3D	LUTを
選択する。

8 ShootingメニューのMonitor	LUTのUser	
3D	LUT	Select（91ページ）で使用したい
ユーザー3D	LUTを選択する。

デスクイーズ表示設定

シネマスコープサイズの映像コンテンツを制作す
る場合、アナモフィックレンズを使用して撮影し
ます。
使用するアナモフィックレンズの倍率に合わせた
デスクイーズ表示設定をすると、直接被写体を
見たときと同じ縦横比に調整された映像をビュー
ファインダー画面に表示することができます。

デスクイーズ表示は、MonitoringメニューのVF	
SettingのDe-Squeeze（109ページ）で設定し
ます。

［ご注意］
De-Squeeze設定が1.3xまたは2.0xの場合は、ビューファ
インダー上にのみマーカーが表示されます。映像出力には
表示されません。また、MonitoringメニューのMarkerの
Aspect	Select（108ページ）は2.39:1に固定されます。

ボタン操作で音声チャンネル
を切り替える

AudioメニューのAudio	Output	>	Monitor	CH
（111ページ）で設定した音声チャンネルの組み
合わせを、アサイナブルボタンの操作で切り替え
ることができます。
内蔵スピーカーやヘッドホンから聞こえる音声
チャンネルを選択して、各記録チャンネルに収録
される音声を確認することができます。

Audio	Monitor	CHが割り当てられたアサイナブ
ルボタン（47ページ）を押すと、以下のように
音声チャンネルが切り替わります。

現在のMonitor	CHの
設定値

Audio	Monitor	CHで
切り替え後の設定値

CH1/CH2 CH1
CH3/CH4 CH3
MIX	ALL 対象外
CH1 CH2
CH2 CH1/CH2
CH3 CH4
CH4 CH3/CH4

Audio	Mon.	CH	Switchが割り当てられたアサ
イナブルボタンを押すと、以下のように音声チャ
ンネルが切り替わります。

現在のMonitor	CHの
設定値

Audio	Mon.	CH	
Switchで切り替え後の
設定値

CH1/CH2 CH3/CH4
CH3/CH4 CH1/CH2
MIX	ALL 対象外
CH1 CH3
CH2 CH4
CH3 CH1
CH4 CH2

［メモ］

ˎˎ Audio	Monitor	CHまたはAudio	Mon.	CH	Switchの
アサイナブルボタンを押したとき、現在のMonitor	CH
の設定値がメッセージ表示されます。
ˎˎ Monitor	CHの設定値を変更する場合は、現在の
Monitor	CHの設定値が表示されている間にAudio	
Monitor	CHまたはAudio	Mon.	CH	Switchのアサイナ
ブルボタンを押します。
ˎˎ Monitor	CHがMIX	ALLのときは、音声チャンネルは切
り替わりません。

位置情報を取得する（GPS）

TechnicalメニューのGPSをOnに設定すると	

が表示され、測位準備が行われます。測位
できた場合、動画の撮影時に測位情報を記録し
ます。

［ご注意］

ˎˎ ハンドルにGPS受信機が内蔵されているため、ハンドル
未装着時はTechnicalメニューでGPSをOnにできませ
ん。
ˎˎ GPS衛星からの電波の受信状況によって画面に表示さ
れるアイコンが変わります。

ˎˎ GPS機能使用中に、ハンドルを握ると、測位精度に影
響をおよぼすことがあります。

測位状況 画面表示 GPS受信状況
機能切 非表示 GPSがOffになっている、

またはエラーが起きてい
る。

測位困難 GPS信号を受信できない
ため、測位情報が取得で
きない。空の開けた場所
に移動してください。

衛星探索
中

衛星を探索中です。測位
中になるまで数分かかる
ことがあります。

測位中 弱いGPS信号を受信中。

GPS信号を受信中。測位
情報を取得できる。
強いGPS信号を受信中。
測位情報を取得できる。

［メモ］

ˎˎ 工場出荷時はGPSがOnになっています。Onにすると、
GPSの測位中に撮影した動画の位置情報や測位時刻が
記録されます。
ˎˎ 数分待ってもアイコンが測位中にならないときは、受信
困難な状態です。そのまま撮影を始めるか、空の開け
た場所に移動してください。そのまま撮影すると測位情
報は記録されません。
ˎˎ 屋内や高い建物のそばでは電波をうまく受信できませ
ん。空の開けた場所に移動してください。
ˎˎ「測位中」になっていても、電波の受信状況によりGPS情
報の記録が途切れることがあります。

プランニングメタデータ

プランニングメタデータとは、撮影・記録の計画
情報が記述されているXMLファイルです。
プランニングメタデータファイルで、あらかじめ
定義したクリップ名やショットマーク名を使用し
て、撮影できます。
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プランニングメタデータは「Content	Browser	
Mobile」アプリケーションを使用してネットワー
ク経由で送受信することもできます。

［ご注意］

ˎˎ メディアスロットの蓋を開けると、ネットワーク経由での
プランニングメタデータ転送が中断されます。蓋を開け
ている間はプランニングメタデータの転送はできません。
蓋を閉じると転送処理は再開されます。
ˎˎ クリップ名やショットマーク名の定義には、
MaintenanceメニューのLanguageのSelect（123
ページ）で設定した言語のフォントセットを使用してくだ
さい。本機の言語設定と異なる言語を使用すると、文
字が正常に表示されない場合があります。

ˎˎ フランス語、オランダ語、フィンランド語でクリップ名
やショットマーク名を定義した場合、一部の文字が他の
類似のフォントで表示されます。
ˎˎ 日本語でクリップ名やショットマーク名を定義すると、
一部の文字が他のフォントに置き換えられ、ビューファ
インダー画面に正しく表示されないことがあります。

プランニングメタデータファイルを読
み込む

クリップの記録時にプランニングメタデータファ
イルを一緒に記録するには、撮影前にプランニン
グメタデータファイルを本機のメモリーに読み込
んでおく必要があります。
以下のディレクトリーにプランニングメタデータ
ファイル（.xml）を保存したXQDメモリーカードを
本機のカードスロットに挿入し、Projectメニュー
のPlanning	Metadata（99ページ）でLoad	
from	Media(A)またはLoad	from	Media(B)を
選択して読み込むファイルを選びます。
exFAT：XDROOT/General/Sony/Planning

プランニングメタデータの詳細情報を確
認する
本機のメモリーに読み込んだプランニングメタ
データのファイル名や作成日時、タイトルなどの
詳細情報を確認することができます。
ProjectメニューのPlanning	Metadata（99
ページ）でPropertiesを選択し、Executeを選
びます。

読み込んだプランニングメタデータを消去
する
本機のメモリーに読み込んだプランニングメタ
データをメモリーから消去します。
ProjectメニューのPlanning	Metadata（99
ページ）でClear	Memoryを選択し、Execute
を選びます。

プランニングメタデータでクリップ名
を設定する

プランニングメタデータには、次の2種類のクリッ
プ名文字列を記述することができます。

ˎˎ ビューファインダー画面上に表示できるASCII
形式の名称

ˎˎ 実際にクリップ名として登録されるUTF-8形式
の名称

プランニングメタデータでクリップ名を設定する
と、ビューファインダー画面の動作状態表示の下
にクリップ名が表示されます。

クリップ名文字列の記述例
テキストエディターを使用して、プランニングメタ
データの<Title>タグの内容を変更します。
網掛け部分がクリップ名文字列です。

「Typhoon」はASCII形式（44文字以下）で記述し
ています。「台風上陸」はUTF-8形式（44バイト以
下）で記述しています。

「sp」はスペース、は改行を表します。

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"	spassignId="
P0001"	spcreationDate="
2011-08-20T17:00:00+09:00"sp
lastUpdate="
2011-09-28T10:30:00+09:00"sp
version="1.00">

<Properties	sppropertyId="
assignment"	spupdate="
2011-09-28T10:30:00+09:00"sp
modifiedBy="Chris">

<TitlespusAscii="Typhoon"sp
xml:lang="ja">台風上陸
</Title>

</Properties>
</PlanningMetadata>

［ご注意］

ˎˎ 実際にファイルを作成する場合は、改行位置でのみ改
行し、「sp」が表示されていない位置にはスペースは入れ
ずに1つの文として記述してください。
ˎˎ クリップ名に使用できる有効文字数は44バイト（または
44文字）です。	
UTF-8形式で44バイトを超えるクリップ名を定義する
と、44バイトまでの文字列がクリップ名に使用されます。	
ASCII形式のクリップ名のみ定義している場合は、ASCII
形式の44文字までの文字列がクリップ名に使用されま
す。	
ASCII形式で記述した文字列、UTF-8形式で記述した
文字列が、いずれもクリップ名として使用できない場合、
クリップ名は標準形式となります。

ˎˎ 以下の文字はクリップ名の禁止文字のため、使用すると
“_”に変換されます。	
禁止文字	"*/:<>?\|

プランニングメタデータで記述したクリッ
プ名をつける
クリップ名を記述したプランニングメタデータ
ファイルを本機のメモリーに読み込み、TC/
MediaメニューのClip	Name	FormatのAuto	
Naming（105ページ）で、Planを選びます。
記録を行うたびに、プランニングメタデータファ
イルに記述したクリップ名が、アンダーバー（_）
と5桁の通し番号（00001～ 99999）が付加さ
れた形式で自動生成されます。
例：台風上陸_00001、台風上陸_00002、...

［ご注意］

ˎˎ 通し番号が99999に達したら、次の記録操作で00001
に戻ります。
ˎˎ 他のプランニングメタデータを読み込むと、5桁の通し
番号は00001に戻ります。
ˎˎ 日本語のクリップ名は、一部の文字が他のフォントで表
示されることがあります。

プランニングメタデータでショットマー
ク名を設定する

ショットマーク1、2を記録するとき、プランニン
グメタデータで定義した文字列でショットマーク
名を記録することができます。

ショットマーク名文字列の記述形式
テキストエディターを使用して、プランニングメタ
データの<Meta	name>タグの内容を変更しま
す。
網掛け部分がショットマーク名文字列です。
ASCII形式（32文字以下）、またはUTF-8形式（16
文字以下）で記述します。

「sp」はスペース、は改行を表します。
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［ご注意］
ASCII形式以外の文字が1文字以上含まれていれば、その
文字列の最大長は16文字になります。

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata	xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp
update="2011-04-15T15:00:00Z"sp
modifiedBy="Chris">

<TitlespusAscii="Football
Game"spxml:lang="ja">
Football	Game	15/04/2011
</Title>

<Metaspname="_ShotMark1"sp
content="Goal"/>
<Metaspname="_ShotMark2"sp
content="Shoot"/>

</Properties>
</PlanningMetadata>

［ご注意］
実際にファイルを作成する場合は、改行位置でのみ改行し、
ショットマーク名文字列以外では「sp」が表示されていない
位置にはスペースは入れずに1つの文として記述してくださ
い。

プランニングメタデータファイルを転
送する

プランニングメタデータファイルは、オリジナル
ファイルまたはプロキシファイルと一緒に転送す
ることができます。
ProjectメニューのProxy	RecのSetting

（95ページ）をOnに設定しSDカードにプロキ
シ記録を行うことで可能になります。
プロキシ記録については「プロキシ記録をする」

（57ページ）、オリジナルファイル、プロキシ
ファイルの転送については「ファイルを転送する」

（65ページ）をご覧ください。

［ご注意］
以下の場合は、プランニングメタデータファイルは転送さ
れません。
ˎˎ Media	Fullにより記録が停止した場合
ˎˎ 記録中にSLOT	SELECTを押したり、残量がなくなってメ
モリーカードが切り替わった場合
ˎˎ クリップの最大時間まで記録してクリップが分かれた場
合
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プロキシ記録をする
XQDメモリーカードに記録するのと同時に、プロ
キシデータをSDカードに記録することができま
す。

	˜ 使用可能なSDカードや、SDカードのフォーマット方
法、残容量の確認方法については「Utility	SD/MSカー
ドを使う」（32ページ）をご覧ください。

撮影前の設定

1 ProjectメニューのProxy	Rec*で、Setting
をOnにする。
*	 ステータス画面でも設定可能。

2 SDカードを、ラベルを右にしてUTILITY	
SD/MSカードスロット（8ページ）に差し
込む。

［ご注意］
プロキシ記録は、スロー＆クイックモーション、インターバ
ルレック、ピクチャーキャッシュレック、2スロット同時記録、
4K	&	HD	(Sub)記録と同時にOnにすることはできません。
プロキシ記録をOnにすると、スロー &クイックモーション
以外の機能は強制的にOffになります。
プロキシ記録がOnのときにスロー &クイックモーションを
Onにするとプロキシ記録が一時的にOffとなり、スロー &
クイックモーションをOffにすると再びプロキシ記録がOn
になります。

プロキシ記録で撮影する

撮影前に必要な設定が終わったら、録画START/
STOPボタンを押すと記録を開始します。

［ご注意］

ˎˎ SDカードにアクセス中に本機の電源を切ったりSDカー
ドを抜いた場合はデータは保証されません。カードに記
録されたすべてのデータが壊れる可能性があります。電
源を切ったり、カードを抜くときは、必ず使用するSDカー
ドのアクセスランプが消灯していることを確認してから
操作してください。
ˎˎ 出し入れ時にはSDカードの飛び出しにご注意ください。

撮影を終了するには、記録停止の操作を行いま
す。
XQDメモリーカードの記録と同時に、プロキシ
データの記録も停止します。

プロキシ記録時の設定を変
更する

映像のサイズを設定する

ProjectメニューのProxy	RecのProxy	Format
（95ページ）で、映像のサイズを設定できます。

オーディオチャンネルを設定する

ProjectメニューのProxy	RecのAudio	Channel
（95ページ）で、プロキシデータに記録する
オーディオチャンネルを設定できます。

プロキシファイルを分割記録
し、転送する

オートアップロードの設定をChunkにしてプロキ
シファイルを分割記録すると、本線記録中でも
プロキシファイルを転送することが可能になりま
す。
分割記録したプロキシファイルの転送について
は、「ファイルを自動転送する」（66ページ）
をご覧ください。

1 Projectメニューで、Proxy	Rec（95ペー
ジ）を選択する。

2 Chunkで、分割記録時間を選択する。
30s：30秒単位でプロキシファイルを分割し

て記録します（初期設定値）。
1min：1分単位でプロキシファイルを分割し

て記録します。
2min：2分単位でプロキシファイルを分割し

て記録します。

3 NetworkメニューのFile	Transferで、Auto	
Upload	(Proxy)（122ページ）をChunkに
する。

4 プロキシ記録を開始する。
設定した分割記録時間ごとにプロキシファイ
ルが転送ジョブとしてジョブリストに登録さ
れます。

［ご注意］
Auto	Upload	(Proxy)をChunkに設定しない場合、プロ
キシの分割記録は行われません。

記録されるファイルについて

拡張子は「.mp4」です。
タイムコードも同時に記録されます。

ファイルの保存先について

記録したファイルは、「/PRIVATE/PXROOT/
Clip」のディレクトリーに保存されます。

ファイル名について

XQDメモリーカードに記録されるクリップ名+連
番です。
2スロット同時記録のときは、Slot	Aのクリップ
名が優先されます。
連番は電源を切っても保存されます。All	Reset
を実行すると、0001に戻ります。
クリップ名については、TC/Mediaメニューの
Clip	Name	Format（105ページ）をご覧くださ
い。
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RAW動画を記録する
本機に取り付けたXDCA-FX9（別売）のRAW	
OUT端子から出力したRAW動画信号を、対応す
る外部レコーダーに記録できます。

1 外部RAWレコーダーを、本機に装着した
XDCA-FX9のRAW	OUT端子に接続する。

2 ProjectメニューのBase	Settingの
Shooting	Mode*でCine	EIを選択する。

3 ProjectメニューのRec	FormatのCodec*

でRAWを選択する。
RAW	&	XAVC-Iなどを選ぶと、外部RAWレ
コーダーでの記録と同時に、本機のXQDメ
ディアにHDの動画を記録することができま
す。

4 ProjectメニューのRec	FormatのImager	
Scan	Mode*で画角と解像度を選択する。

5 外部レコーダーの電源が入っていることを確
認し、本機の録画START/STOPボタンを押
す。

	 ［ご注意］
本機の録画START/STOPボタンを使わずに外部レ
コーダーで録画操作を行うと、正常に記録されない場
合があります。

［メモ］
*印が付いている機能はステータス画面でも設定可能です。

サポートをしているRAW出力フォーマットは以下
のとおりです。

Project>Rec	Format
Frequency Codec Imager	

Scan	
Mode

RAW	
Output	
Format

59.94/50 RAW FFcrop	5K 4096×
2160

S35	4K 4096×
2160/
3840×
2160

FF	2K/	
S35	2K/
S16	2K

2048×
1080

RAW	&	
XAVC-I/
RAW	&	
XAVC-L/
RAW	&	
MPEG	HD	
422

FFcrop	5K/	
S35	4K

4096×
2160

FF	2K/	
S35	2K/
S16	2K

2048×
1080

29.97/25/	
23.98

RAW FF	6K/
FFcrop	5K

4096×
2160

S35	4K 4096×
2160/	
3840×
2160

FF	2K/	
S35	2K/
S16	2K

2048×
1080

RAW	&	
XAVC-I/
RAW	&	
XAVC-L/
RAW	&	
MPEG	HD	
422

FF	6K/
FFcrop	5K/	
S35	4K

4096×
2160

FF	2K/	
S35	2K/
S16	2K

2048×
1080

24 RAW FF	6K/
FFcrop	5K/
S35	4K

4096×
2160

記録制御状態表示

MonitoringメニューのDisplay	On/Off（107
ページ）で、RAW	Output	Control	Statusが
Onに設定されている場合は、ビューファインダー
画面にRAW動画の記録制御状態がアイコンで表
示されます。

［ご注意］
本機はRAW	OUT端子から記録制御信号を出力しますが、
外部レコーダーの状態を取得することはできません。その
ため、本機でRAW動画の記録中と表示していても、実際
に記録していないことがあります。正確な動作状態は外部
レコーダー上の表示で確認してください。

［メモ］
RAW	Output	Formatの設定値も表示されます。

スロー＆クイックモーション
記録

ShootingメニューのS&Q	Motionで、Setting
がOnに設定されている場合は、スロー＆クイッ
クモーションモードでRAW動画を記録します。
撮影可能なフレームレートは48ページをご覧
ください。
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デバイスとLAN接続する
本機の内蔵LAN機能を使用して、スマートフォン
やタブレットなどのデバイスと本機をLAN接続す
ることができます。
LAN接続されたデバイスと本機の間では、Web
リモコン（71ページ）や「Content	Browser	
Mobile」アプリケーションなどを用いて、以下の
操作が可能です。

ˎˎ プランニングメタデータ（54ページ）	
デバイスと本機でプランニングメタデータを送
受信できます。	
あらかじめ作成したプランニングメタデータを
本機に転送し、クリップ名を指定することがで
きます。

ˎˎ LAN経由でのリモート操作	
本機とLAN接続されたスマートフォンやタブ
レット、コンピューター、リモートコントロール
パネルから本機をリモート操作することができ
ます。

ˎˎ LAN経由でのファイル転送	
本機のSDカードに記録されたプロキシファイル

（低解像度）や本機で記録したオリジナルファイ
ル（高解像度）を、LAN経由でサーバーに転送
することができます。

ˎˎ LAN経由での映像をモニタリング	
本機のカメラ映像や再生映像からストリー
ム（H.264）を作成し、「Content	Browser	
Mobile」アプリケーションを使ってデバイスか
ら映像をモニタリングすることができます。

「Content	Browser	Mobile」アプリ
ケーション

デバイスの画面で本機の映像をモニタリングしな
がら、リモート操作や本機の設定をすることが
できるアプリケーションを用意しています。

	˜「Content	Browser	Mobile」アプリケーションについ
ては、お買い上げ店またはソニーのサービス窓口にご
確認ください。

ソニーのQoS	技術を用いた高品質な
ストリーミング（67ページ）

ソニー製ネットワークRXステーション（別売）また
はC3	Portal*のConnection	Control	Manager

（CCM）と本機をネットワーククライアントモード
で接続して使用すると、高品質なストリーミング
をすることができます。
*	 C3	Portalは、ソニーが提供するクラウドサービスです。	

このサービスをご利用になるには、別途契約が必要です。	
一部対応していない地域がありますので、サービス対象
地域についてC3	Portalのサイトをご確認ください。	
https://www.c3p.sony.net	
また、C3	Portalのプライバシーポリシーについては、
以下のサイトを参照してください。
	– 利用規約	
https://www.c3p.sony.net/site/tos_eu.html

	– C3	Portalのプライバシーポリシー	
https://www.c3p.sony.net/site/c3p_privacy_
policy.html

	– プロフェッショナルIDのプライバシーポリシー	
https://www.pro-id.sony.net/#/privacyPolicy

	 詳しくは、ソニー法人営業窓口にお問い合わせください。

ユーザー名とパスワードを設
定する

ネットワーク機能をご利用の際は、まず本機に
ユーザー名とパスワードを設定してください。

1 NetworkメニューのAccess	
AuthenticationのUser	Name（118ペー
ジ）を設定する。

2 NetworkメニューのAccess	
AuthenticationのPassword（118ペー
ジ）を設定する。

	 ［メモ］
手入力（Input	Password）または自動生成（Generate	
Password）を選べます。

ワイヤレスLANアクセスポ
イントモード（Access	Point
モード）で接続する

本機をアクセスポイントとしてデバイスとワイヤレ
スLAN	接続します。

スマートフォン/
タブレット

コンピューター

NFC機能搭載のデバイスでワンタッチ
接続する

デバイスがNFCをサポートしている場合には、
NFCを利用したワンタッチ接続が可能です。

1 デバイスの「設定」を起動して「その他の設
定」を選び、「NFC/おサイフケータイ設定」
の「NFC	R/W	P2P」または「Reader/Writer,	
P2P」にチェックを入れる。
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2 本機の電源を入れる。

3 NFC機能を有効にする。
NFCを割り当てたアサイナブルボタンを長
押し（3秒間）するか、Networkメニューの
Wireless	LANのNFCを実行して、NFC接続
モードにしてください。
画面に	 	が表示されているときのみNFC機
能を使用できます。

4 本機とデバイスをタッチする。
デバイスが本機に接続され、「Content	
Browser	Mobile」が起動します。

	 ［ご注意］

ˎˎ 一部の	 	が付いているデバイスはNFCに対応し
ています。詳しくはデバイスの取扱説明書でご確認
ください。
ˎˎ あらかじめデバイスのスリープおよび画面ロックを
解除してください。
ˎˎ デバイスで「Content	Browser	Mobile」が起動す
るまで（1～2秒）動かさずにタッチし続けてください。

WPS機能搭載のデバイスで接続する

デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1 NetworkメニューのWireless	LANの
Settingで、Access	Point	Modeを選択す
る。

2 NetworkメニューのWireless	LANのWPS
を実行する。

3 デバイスのNetwork設定/Wi-Fi設定を開
き、Wi-FiをOnにする。

4 Wi-Fi	NetworkのSSID一覧から、本機
のSSIDを選択し、詳細Optionを表示し、
WPS	Push	Buttonを選択して接続する。

	 ［ご注意］

ˎˎ 使用する機器によっては、操作が異なる場合があり
ます。
ˎˎ 本機のSSIDおよびPasswordは、Networkメ
ニューのAP	Mode	SettingsのCamera	SSID	&	
Password（118ページ）で表示してご確認くださ
い。

5 Webリモコンを表示する（71ページ）。ま
たは、Content	Browser	Mobileアプリケー
ションで接続する。

デバイスでSSID、Passwordを入力し
て接続する

デバイス側でSSIDとPasswordを入力して接続
します。

1 NetworkメニューのWireless	LANの
Settingで、Access	Point	Modeを選択す
る。

2 デバイスのNetwork設定/Wi-Fi設定を開
き、Wi-FiをOnにする。

3 Wi-Fi	NetworkのSSID一覧から、本機の
SSIDを選択し、Passwordを入力して接続
する。
本機のSSIDおよびPasswordは、Network
メニューのAP	Mode	SettingsのCamera	
SSID	&	Password（118ページ）でご確認
ください。

	 ［ご注意］
使用する機器によっては、操作が異なる場合がありま
す。

4 Webリモコンを表示する（71ページ）。ま
たは、Content	Browser	Mobileアプリケー
ションで接続する。

ワイヤレスLANステーション
モード（Stationモード）で接
続する

本機をクライアントとして既存のワイヤレスLAN
のアクセスポイントに接続します。デバイスとは
アクセスポイント経由で接続します。
接続したアクセスポイントの履歴は、過去10件
まで記憶されます。
接続履歴はALLファイルに保存されますが、アク
セスのパスワードは保存されないため、ALLファ
イル読み込み後の再接続の際にはパスワードの
入力が必要となります。

スマートフォン/
タブレット

アクセス
ポイント

コンピューター
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WPS機能を使ってアクセスポイントに
接続する

アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1 アクセスポイントの電源を入れる。

2 本機の電源を入れる。

3 NetworkメニューのWireless	LANの
Settingで、Station	Modeを選択する。

4 NetworkメニューのWireless	LANのWPS
を実行する。

5 アクセスポイントのWPS	ボタンを押す。
WPS	ボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。
接続が完了すると、ビューファインダー画面
のネットワーク状態表示のアイコンが強度1
以上で点灯します。

	 ［ご注意］
接続に失敗した場合は手順1からやり直してください。

6 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

7 Webリモコンを表示する（71ページ）。ま
たは、Content	Browser	Mobileアプリケー
ションで接続する。

ネットワーク自動検出または手動でア
クセスポイントに接続する

セットアップメニューから接続したいアクセスポイ
ントに接続設定することができます。
このときネットワーク自動検出機能を使用して、
接続したいアクセスポイントを検出し、接続設定
することができます。

ネットワーク自動検出機能を使用して接
続する

1 「WPS機能を使ってアクセスポイントに接続
する」（61ページ）の手順1～ 3を行う。

2 NetworkメニューのST	Mode	Settings
のScan	Networks（119ページ）で、
Executeを選択する。
本機が接続先の検出を開始します。
接続先の候補が見つかると一覧表示されま
す。

3 一覧から接続先を選択する。
ネットワーク（アクセスポイント）詳細設定画
面が表示されます。SSIDには選択した接続
先が表示されます。

4 Passwordを選択し、パスワード入力画面で
パスワードを設定する。
接続履歴にあるSSIDを選択すると、パスワー
ドを含んだ設定値が自動的に設定されます。
パスワードを設定したら、ネットワーク（アク
セスポイント）詳細設定画面に戻ります。

5 以下の接続設定を行う。

ˎˎ DHCP	
DHCPを設定します。	
Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP	Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet	Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
アクセスポイントのゲートウェイを入力します。	
DHCPがOffのときに有効です。

ˎˎ DNS	Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに
有効です。

ˎˎ Primary	DNS	Server	
アクセスポイントのプライマリー DNSサー
バーを入力します。	
DNS	AutoがOffのときに有効です。

ˎˎ Secondary	DNS	Server	
アクセスポイントのセカンダリー DNSサー
バーを入力します。	
DNS	AutoがOffのときに有効です。

6 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

手動で入力して接続する

1 「WPS機能を使ってアクセスポイントに接続
する」（61ページ）の手順1～ 3を行う。

2 NetworkメニューのST	Mode	Settings
のManual	Register（120ページ）で、
Executeを選択する。
決定すると、ネットワーク（アクセスポイント）
詳細設定画面が表示されます。

3 以下の接続設定を行う。

ˎˎ SSID	
接続先のアクセスポイントのSSIDを入力し
ます。

ˎˎ Security	
暗号化方式を選択します。

ˎˎ Password	
接続先のアクセスポイントのパスワードを
入力します。

ˎˎ DHCP	
DHCPを設定します。	
Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP	Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet	Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
ゲートウェイのアドレスを入力します。	
DHCPがOffのときに有効です。
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ˎˎ DNS	Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに
有効です。

ˎˎ Primary	DNS	Server	
プライマリー DNSサーバーのアドレスを入
力します。	
DNS	AutoがOffのときに有効です。

ˎˎ Secondary	DNS	Server	
セカンダリー DNSサーバーのアドレスを入
力します。	
DNS	AutoがOffのときに有効です。

4 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

LANケーブルを使用してデバ
イスと接続する

本機に取り付けたXDCA-FX9（25ページ）の
有線LAN端子とLANスイッチをLANケーブルで
接続することによって、デバイスと接続すること
ができます。

コンピューター

LANスイッチ

LANケーブルの接続と有線LAN設定

1 XDCA-FX9の有線LAN端子とLANスイッチ
をLANケーブルで接続する。

2 本機の電源を入れる。

3 NetworkメニューのWired	LANのSetting
（120ページ）をOnに設定する。

4 NetworkメニューのWired	LANのDetail	
Setting（120ページ）で、接続設定を行う。

ˎˎ DHCP	
DHCPを設定します。	
Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP	Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet	Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
ゲートウェイのアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ DNS	Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに
有効です。

ˎˎ Primary	DNS	Server	
プライマリー DNSサーバーのアドレスを入
力します。	
DNS	AutoがOffのときに有効です。

ˎˎ Secondary	DNS	Server	
セカンダリー DNSサーバーのアドレスを入
力します。	
DNS	AutoがOffのときに有効です。

5 設定が完了したらSetを選択し、設定内容を
確定する。

［ご注意］
接続設定を変更した場合、必ずSetを選択してください。
Setを選択しなかった場合は設定した内容が反映されませ
ん。
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本機は、モデム、ワイヤレスLAN、有線LANで
インターネットに接続することができます。

モデムを使用して接続する

本機にXDCA-FX9（25ページ）を取り付け、
モデム（別売）をXDCA-FX9に取り付けることに
よって、3G/4G回線経由でインターネットに接続
することができます。
また、複数のモデムを同時に取り付けて使用する
ことにより、ネットワーククライアントモードで
の高品質なストリーミングを、2回線を使用した、
より高品質かつ冗長性を持ったストリーミングと
することができます。
本機に対応しているモデムについては、お買い上
げ店またはソニーのサービス窓口にご確認くださ
い。

［ご注意］
モデムは、有線LANと同時には使用できません。

モデムをXDCA-FX9に取り付ける

XDCA-FX9のUSB端子（A型）に、USB規格に合
うモデムを取り付けます。両方の端子にモデムを
取り付けて、2台同時に使用することもできます。

［ご注意］
モデムの取り付け/取り外しは、本機の電源を切った状態
で行ってください。

ネットワークに接続する

1 本機の電源を入れる。

2 NetworkメニューのModemで、Settingを
Onに設定する。

設定を有効にするために他の設定を変更す
る必要がある場合は、機能選択画面が表示
されます。画面の指示に従って設定を選ん
でください。

	 ［ご注意］
3G/4G回線に接続するまでに時間がかかる（1分程度）
場合があります。ビューファインダー画面のネットワー
ク状態表示（11ページ）のモデムアイコンが強度1以
上で点灯するまでお待ちください。

USBテザリングを使用して接
続する

本機に装着したXDCA-FX9とスマートフォンを
USBケーブルで接続し、スマートフォンの回線を
使用してインターネットに接続できます。

スマートフォンを本機に取り付ける

USBケーブルを介してスマートフォンを本機に取
り付けたXDCA-FX9のUSB端子（A型）（4
ページ）に接続します。

［ご注意］

ˎˎ 	スマートフォンの取り付け/取り外しは、本機の電源を
切った状態で行ってください。
ˎˎ 	USBハブを介してスマートフォンを取り付けた場合、
USBテザリングは使用できません。

ネットワークに接続する

1 本機の電源を入れる。

2 NetworkメニューのModemで、Settingを
Onに設定する。
設定を有効にするために他の設定を変更す
る必要がある場合は、機能選択画面が表示

されます。画面の指示に従って設定を選ん
でください。

ワイヤレスLANステーション
モード（Wi-Fi	Stationモード）
で接続する

ワイヤレスLANルーター（別売）またはデバイス
のテザリングを使用することによって、Wi-Fiス
テーションモードでインターネットに接続するこ
とができます。

スマートフォン/
タブレット

ワイヤレスLAN
ルーター

コンピューター

インターネット

スマートフォン/
タブレット

インターネット

ワイヤレスLANルーターまたはデバイスへは、「ワ
イヤレスLANステーションモード（Stationモード）
で接続する」（60ページ）の手順で接続します。

インターネット接続する
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LANケーブルを使用して接続
する

本機に取り付けたXDCA-FX9（25ページ）の
有線LAN端子とインターネットルーターをLAN
ケーブルで接続することによって、インターネット
に接続することができます。

コンピューター

ルーター

インターネット

インターネットルーターへは「LANケーブルを使用
してデバイスと接続する」（62ページ）の手順
で接続します。
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ファイルを転送する
本機に記録したプロキシファイルやオリジナル
ファイルを、3G/4G回線やアクセスポイント経
由で接続したインターネット上のサーバーやロー
カルネット上のサーバーへ転送することができま
す。

［ご注意］

ˎˎ メディアスロットの蓋を開けると、ネットワーク経由での
ファイル転送は中断されます。蓋を開けている間はファ
イル転送はできません。蓋を閉じると転送処理は再開さ
れます。
ˎˎ ファイル転送中に再生を行うと、再生画が乱れることが
あります。

準備する

ネットワークに接続する

「インターネット接続する」（63ページ）または
「デバイスとLAN接続する」（59ページ）の手
順に従って、本機をインターネットまたはローカ
ルネットワークに接続します。

ファイルの転送先を登録する

あらかじめファイルを転送するサーバーを登録し
ておきます。

1 NetworkメニューのFile	Transfer
で、Server	Settings1（またはServer	
Settings2、Server	Settings3）を選択する。
転送先設定画面が表示されます。

2 転送先設定画面の各項目を設定する。
Display	Name
転送先のリストに表示されるサーバー名を入
力します。

Service
サーバーの種類を表示します。

「FTP」：FTP	サーバー
Host	Name
サーバーのアドレスを入力します。
Port
サーバーに接続する際のポート番号を入力し
ます。
User	Name
ユーザー名を入力します。
Password
パスワードを入力します。
Passive	Mode
パッシブモードのON/OFFを行います。
Destination	Directory
転送先ディレクトリー名を入力します。

	 ［ご注意］

ˎˎ 編集時、編集不可能な文字は“□”で表示されます。
この文字を含むディレクトリー名を編集した場合の
動作は保証されません。	
もし編集してしまった場合は、すべての文字を削除
して入力し直してください。
ˎˎ 転送先サーバーで使用できない文字をDestination	
Directoryに入力した場合、ファイルはユーザーの
ホームディレクトリーに転送されます。使用できな
い文字はサーバーによって異なります。
Using	Secure	Protocol
セキュアなFTP転送を行うかどうかを設定し
ます。
Root	Certificate
証明書の読み込みや消去を行います。

ˎˎ Load	
手順3でSetを選択すると、CA証明書を読
み込みます。

*	 読み込む証明書はPEM形式で、Utility	SDカードの
ルートディレクトリーに“certification.pem”のファ
イル名で書き込んでおいてください。

ˎˎ Clear	
手順3でSetを選択すると、CA証明書をク
リアします。

ˎˎ None	
読み込み/消去を行いません。

	 ［ご注意］

ˎˎ CA証明書を読み込む際は、本機の時刻を正しく設
定してください。
ˎˎ XAVC-I	3840×2160P	59.94/50Pで記録中は、
Loadは選択できません。
ˎˎ 低電圧時には、CA証明書をLoad/Clearすること
はできません。
Root	Certificate	Status
証明書の読み込み状態を表示します。
Reset
Server	Settingsの設定を初期値に戻しま
す。

3 設定が完了したらSetを選択し、設定内容を
確定する。
設定完了後は、必ずSetを選択してください。
Setを選択しなかった場合、設定した内容が
反映されません。

Webリモコンの「転送先のサーバーを登録する」
（72ページ）でもサーバーを登録できます。

ファイルを選んで転送する

本機のSDカードに記録したファイル、XQDメモ
リーカードのオリジナルファイルをサーバーに転
送します。
転送は、Webリモコンで行うこともできます。詳
しくは、「ファイルの転送「Slot	A、Slot	B、Slot	
SD/MS」」（73ページ）をご覧ください。

サムネイル画面からSDカードのプロキ
シファイルを転送する

1 本機とデバイスをLAN接続する（59ペー
ジ）。

2 ThumbnailメニューのTransfer	Clip	
(Proxy)で、Select	Clipを選択する。
画面がセットアップメニューからサムネイル
画面に変わります。
転送操作は、サムネイル画面またはフィル
タードクリップサムネイル画面で行えます。

3 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

4 Executeを選択する。
選択したファイルに対応するプロキシファイ
ルが転送ジョブとして登録され、転送が開
始されます。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。

5 OKを選択する。
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ファイルを一括転送するには
手順2でSelect	Clipではなく、All	Clipsを選択
するとファイルに対応するプロキシファイルが一
括転送されます。

［ご注意］
転送できるファイルの上限は200件です。

サムネイル画面からXQDメモリーカー
ドのオリジナルファイルを転送する

1 本機とデバイスをLAN接続する（59ペー
ジ）。

2 ThumbnailメニューのTransfer	Clipで、
Select	Clipを選択する。
画面がセットアップメニューからサムネイル
画面に変わります。
転送操作は、サムネイル画面またはフィル
タードクリップサムネイル画面で行えます。

3 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

4 Executeを選択する。
選択したファイルが転送ジョブとして登録さ
れ、転送が開始されます。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。

5 OKを選択する。

ファイルを一括転送するには
手順2でSelect	Clipではなく、All	Clipsを選択
するとファイルが一括転送されます。

［ご注意］
転送できるファイルの上限は200件です。

ファイル転送の確認をする

NetworkメニューのFile	TransferでView	Job	
List（122ページ）を選択すると、ファイル転送
の状態を確認することができます。
SD	Card、Slot	AまたはSlot	B画面のJob	Listを
選択して表示されるJob	List画面でもファイル転
送の状態を確認することができます（74ペー
ジ）。

［メモ］

ˎˎ Webリモコンの画面からファイル転送の状態を確認する
こともできます。
ˎˎ NetworkメニューのFile	TransferでAuto	Upload
（122ページ）またはAuto	Upload	(Proxy)
（122ページ）をOnに設定すると、ネットワーク接続
状態の場合、記録終了時にDefault	Upload	Server

（122ページ）で設定されたサーバーに対して自動的に
オリジナルファイルやプロキシファイルを送信します。オ
リジナルファイルとプロキシファイルの両方を自動転送
設定している場合には、プロキシファイルが優先して自
動転送されます。

［ご注意］

ˎˎ 転送ジョブは200件まで登録可能です。
ˎˎ ジョブリストは本機の電源を切っても保持されますが、
POWERスイッチをSTANDBYにせずにバッテリーパック
を取り外すなどして電源を切った場合には、最大で10分
間分程度の進捗情報が喪失する可能性があります。
ˎˎ バッテリー電圧低下状態に陥った後に追加されたジョブ
については、ジョブリスト上に保存されません。
ˎˎ ファイル転送中に転送がエラーになると、転送先サー
バーの設定や状態によっては、同じ名前のクリップが転
送できなくなることがあります。その場合は転送先サー
バーの設定や状態を確認してください。

ファイルを自動転送する

オリジナルファイルを自動転送する

記録終了時にオリジナルファイルを指定したサー
バーに転送します。この機能を有効にするに
は、NetworkメニューのFile	TransferでAuto	
Upload（122ページ）をOnに設定します。

プロキシファイルを自動転送する

記録終了時にプロキシファイルを指定したサー
バーに転送します。この機能を有効にするに
は、NetworkメニューのFile	TransferでAuto	
Upload	(Proxy)（122ページ）をOnに設定しま
す。
また、Auto	Upload	(Proxy)をChunkに設定す
ると、プロキシファイルを分割記録して、記録継
続中でも指定したサーバーに順次転送すること
ができます。分割記録したプロキシファイルの自
動転送は、他のファイル転送ジョブよりも優先さ
れて行われます。
設定方法については、「プロキシファイルを分割
記録し、転送する」（57ページ）をご覧くださ
い。

［メモ］
Auto	UploadとAuto	Upload	(Proxy)がいずれもOnに設
定されている場合はプロキシファイルを優先して転送しま
す。ただし、ネットワークの状況によっては順番が入れ替わ
ることがあります。

セキュアなFTP転送を行うに
は

ファイル転送先サーバーとの接続にFTPSの
Explicitモード（FTPES）を使用することで、ファ
イルを暗号化して転送することができます。

セキュアなFTP	転送の設定

セキュアなFTP転送を行うには、ファイル転送先
サーバーの設定で、Using	Secure	Protocolを
ONに設定し、証明書の読み込みを行います。
設定方法については、「ファイルの転送先を登録
する」（65ページ）をご覧ください。
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ネットワーククライアントモードを有効にし、本
機とソニー製ネットワークRXステーション（別売）
のConnection	Control	Manager（以降「CCM」）
またはC3	Portalを接続して使うことで、高品質
なストリーミングが可能になります。

ネットワーククライアントモー
ドの接続先を設定する

ネットワーククライアントモードの接続先は、
NCM	Settingsとして3つまで設定できます。

1 NetworkメニューのNetwork	Client	
Modeで、NCM	Settings1（またはNCM	
Settings2、NCM	Settings3）を選択する。
ネットワーククライアントモードの接続先設
定画面が表示されます。

2 接続先設定画面の各項目を設定する。
Display	Name
NCM	Settingsのメニュー上の表示名を設定
します。
CCM	Address
接続先のCCMのアドレスを入力します（ホス
ト名またはIPアドレス）。
CCM	Port
接続先のCCMのポート番号を入力します。
User	Name
ユーザー名を入力します。
Password
パスワードを入力します。
CCM	Certificate
CCMおよびC3	Portalに接続する場合は、
CCMルート証明書が必要です。CCMルート

証明書は本機に内蔵されていて、更新もで
きます。CCMルート証明書を更新するには、
メモリーカードに証明書を保存してから本機
で読み込みます。

ˎˎ Load	
手順3でSetを選択すると、証明書を読み
込みます。

*	 読み込む証明書はPEM形式で、SDカードのルート
ディレクトリーに“CCM_certification.pem”のファ
イル名で書き込んでおいてください。

ˎˎ Clear	
手順3でSetを選択すると、証明書を消去
します。

ˎˎ None	
読み込み／消去を行いません。

	 ［ご注意］

ˎˎ CCMおよびC3	Portal接続用の証明書を読み込む
際は、本機の時刻を正しく設定してください。
ˎˎ XAVC-I	3840×2160P	59.94/50PまたはXAVC-I	
4096×2160P	59.94/50Pで記録中は、Loadは
選択できません。
ˎˎ 低電圧時には、CCMおよびC3	Portal接続用の証
明書をLoad/Clearすることはできません。
CCM	Certificate	Status
証明書の読み込み状態を表示します。
Camera	Control
CCM接続時のカメラコントロール許可/不許
可を設定します。
Camera	Setting
CCM接続時のAll	File操作の許可/不許可を
設定します。
Reset
NCM	Settingsの設定を初期値に戻します。

3 設定が完了したらSetを選択し、設定内容を
確定する。
設定完了後は、必ずSetを選択してください。
Setを選択しなかった場合、設定した内容が
反映されません。

4 NetworkメニューのNetwork	Client	
ModeのNCM	Settings	Selectで、手順
1～ 3で設定したNCM	Settings1（または
NCM	Settings2、NCM	Settings3）を選
択する。

ストリーミングの品質を設定
する

高品質なストリーミングを行う場合は、
NetworkメニューのNetwork	Client	Modeの
Streaming	Quality（121ページ）をHighに設
定してください。Streaming	QualityをNormal
に設定すると通常品質になります。

［ご注意］

ˎˎ 以下の場合はStreaming	QualityをHigh（高品質）に設
定できません。
	– ProjectメニューのProxy	RecのSetting（95ペー
ジ）がOnのとき

	– Projectメニューの4K	&	HD	(Sub)	RecのSetting
（95ページ）がOnのとき
	– ShootingメニューのFocusのFace/Eye	Detection	
AF（90ページ）がOff以外のとき

ˎˎ NetworkメニューのNetwork	Client	ModeのSetting
（121ページ）がOnのとき、Streaming	Qualityの変
更はできません。

ネットワーククライアントモー
ドで接続する

1 「インターネット接続する」（63ページ）
の手順に従って、本機をインターネットに接
続する。

2 NetworkメニューのNetwork	Client	
Modeで、SettingをOnにする。
ネットワーククライアントモードが有効にな
り、ネットワークRXステーションまたはC3	
Portalと接続します。
ネットワークRXステーションの操作により、
ライブストリーミングが開始されます。操作
については、ネットワークRXステーションの
取扱説明書またはC3	Portalのヘルプをご覧
ください。
なお、Network	Client	Modeが割り当てら
れたアサイナブルボタン（47ページ）を押
すことでも、SettingをOn/Offできます。

［ご注意］

ˎˎ メニューの設定が以下の場合、ストリーミングを開始で
きません。
	– ShootingメニューのS&Q	MotionのSettingがOnの
とき

	– ProjectメニューのInterval	RecのSettingがOnのと
き

	– ProjectメニューのSimul	RecのSettingがOnのとき
ˎˎ ネットワーククライアントモードに移行すると、モニタリ
ング（72ページ）はできません。
ˎˎ モニタリング中にネットワーククライアントモードに移行
すると、モニタリングは停止します。
ˎˎ ネットワーククライアントモードでのストリーミング中
は、ファイルを転送できません。ストリーミングを停止
するとファイルを転送できます。
ˎˎ ファイル転送中にネットワーククライアントモードでのス
トリーミングを開始すると、ファイル転送は停止します。
ストリーミングを停止するとファイル転送を再開します。

ネットワーククライアントモードを使用する
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ˎˎ User	NameとPasswordと証明書はALLファイルに保
存されませんので、ALLファイルの読み込み後に再設定
する必要があります。
ˎˎ ネットワーククライアントモードでのストリーミング中に
SettingをOffにした場合は、ストリーミングが停止しま
す。
ˎˎ ネットワーククライアントモードでのストリーミング中
は、NCM	Settings	SelectとNCM	Settings	Selectで
選択されているNCM	Settingsの内容は変更できませ
ん。
ˎˎ ストリーミング中は画面情報の更新頻度が低下します
が、操作には影響しません。
ˎˎ ネットワーククライアントモードでのストリーミング中
は、記録設定は変更できません。
ˎˎ ネットワーククライアントモードでのストリーミング中
は、有線LAN設定は変更できません。
ˎˎ QoSストリーミング中にサムネイルや再生画面に遷移す
る際には、映像が一度停止します。
ˎˎ ストリーミング可能な配信フォーマットは、本線Rec	
Formatによって変わります。
ˎˎ USBテザリングを使用して接続している場合、QoSスト
リーミング中にスマートフォンを操作すると画像が乱れ
る場合があります。

ネットワーククライアントモー
ドでファイルを転送する

ネットワークRXステーションのCCMと本機をネッ
トワーククライアントモードで接続して、CCMで
設定されたサーバーへファイル転送することがで
きます。

1 CCMなどから転送したいファイルを選ぶ。

ˎˎ プロキシファイルを転送する場合	
「SD	カードのプロキシファイルを転送する」
（73ページ）の手順1～ 4参照

ˎˎ オリジナルファイルを転送する場合	
「XQDメモリーカードのオリジナルファイル
を転送する」（74ページ）の手順1～ 4
参照

［ご注意］
ネットワーククライアントモードでないときも、転送先を

「NCM：RX	Server」にできます。この場合は、転送は保留
となり、ネットワーククライアントモードでCCMに接続後、
CCMで設定されたサーバーへ転送を開始します。
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C3	Portal	Appを使用する
本機はスマートフォンアプリ「C3	Portal	App」と
連携して、クラウドサービス「C3	Portal」へのファ
イル転送を簡単に行うことができます。
あらかじめC3	Portalのアカウントを取得し、ス
マートフォンにC3	Portal	Appをインストールして
ください。
クラウドサービス「C3	Portal」のアカウント取得
については、所属組織の管理者にお問い合わせ
ください。

［ご注意］

ˎˎ 別売のXDCA-FX9が必要です。
ˎˎ お住まいの地域によってはサービスを提供していない場
合があります。
ˎˎ C3	Portal	Appの操作方法については、C3	Portal	
Appのヘルプをご覧ください。

本機とC3	Portalを接続する

1 NetworkメニューのSetup	for	Mobile	
Appで、Setup（118ページ）を選択する。
コーデック選択画面が表示されます。
ProjectメニューのRec	FormatのCodec

（93ページ）がRAW以外の場合は、手順
4の画面が表示されます。

2 コーデックを選択し、Nextを選択する。
ProjectメニューのRec	FormatのCodec
がRAWに設定されていると、USBテザリン
グでネットワークに接続することができませ
ん。手順2～3の設定でコーデックとビデオ
フォーマットを変更してください。

3 ビデオフォーマットを選択し、Nextを選択
する。

設定内容の確認画面が表示されます。

4 設定内容を確認してOKを選択する。
設定が開始されます。設定中は

「Changing...」のメッセージが表示されま
す。
設定が正常に終了すると、ビューファイン
ダーに次の画面が表示されます。

	 ［メモ］
本画面は映像出力へ出力されません。

	 ［ご注意］
パスワードを盗み見られたり、QRコードの画像を流出
させないように注意してください。

5 スマートフォンでC3	Portal	Appを実行し、
クラウドサービスにサインインする。

6 本機に取り付けたXDCA-FX9のUSB端子（A
型）とスマートフォンを、USBケーブルで接
続する。

7 スマートフォンの画面でUSBテザリングを有
効にする。
お使いのスマートフォンにより、操作が異な
ります。スマートフォンの取扱説明書をご確
認ください。

8 C3	Portal	Appの画面の指示に従って、
ビューファインダーに表示されたQRコード
を撮影する。
スマートフォンから本機へファイル転送の設
定情報が送られ、以下のメッセージが表示
されます。

	 ［メモ］
2回目以降の接続時には、ファイル転送のメッセージ
は表示されない場合があります。

9 OKを選択する。
設定の読み込みが開始されます。
設定の読み込みが正常に終了すると、

「Network	File	loaded.」のメッセージが表
示されます。

［メモ］

ˎˎ 本機が送信したファイルは、C3	Portal	Appでキャッシュ
されながらC3	Portalへ転送されます。本機のファイル
転送状態表示は、C3	Portal	Appへの転送状況を示し
ています。

ˎˎ 本機からスマートフォンのC3	Portal	Appへファイル転
送が終了した後は、本機の電源を切ることができますが、
スマートフォンからのファイル転送は継続している場合
があります。スマートフォンの電池残量にはご注意くだ
さい。

［ご注意］

ˎˎ C3	Portal	Appは、本機のNetworkメニューのFile	
Transfer（122ページ）の設定を書き換えます。
ˎˎ Root	Certificateは自動では設定できません。手動で
設定してください。

オリジナルファイルを転送する

NetworkメニューのFile	TransferのAuto	
Upload（122ページ）をOnにすると、オリジナ
ルファイルをC3	Portalへ転送できます。
記録を終了するたびに、C3	Portalのアカウント
に紐づけされた場所へファイルが転送されます。

プロキシファイルを転送する

NetworkメニューのFile	TransferのAuto	
Upload	(Proxy)（122ページ）をOnにすると、
プロキシファイルをC3	Portalへ転送できます。
記録を終了するたびに、C3	Portalのアカウント
に紐づけされた場所へファイルが転送されます。
Auto	Upload	(Proxy)がChunkに設定されてい
る場合は、記録開始後一定時間ごとに分割され
たプロキシファイルが転送されます。

任意のファイルを転送する

「ファイルを選んで転送する」（65ページ）を
ご覧ください。
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C3	Portalを使用したその他
の機能

3D	LUTファイルを管理する

C3	Portal側で保存された3D	LUTファイルを本
機に読み込むことができます。「クラウドサービ
スから読み込む」（53ページ）をご覧ください。

Allファイルを管理する

本機で作成したAllファイルをC3	Portalに保存し
たり、読み出したりして利用できます。

「Allファイルをクラウドサービスに保存する」
（124ページ）、「Allファイルをクラウドサービ
スから読み込む」（124ページ）をご覧ください。
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Webリモコンを使用する
ネットワーク接続時は、タブレットやコンピュー
ターから、本機に内蔵されたWebリモコンにア
クセスすることができます。
Webリモコンを使用すると遠隔から本機を操作
できます。記録の開始/停止や撮影設定を遠隔操
作で調整できるため、本機を離れた場所に固定
する場合や、本機をクレーンに装着して使用する
場合などに有効です。

Camera	Control	画面

Main画面

ˎˎ ステータス表示

ˎˎ 記録開始・停止ボタン

ˎˎ NDフィルタースライダー

ˎˎ アイリススライダー

ˎˎ フォーカススライダー

ˎˎ ズームスライダー

ˎˎ 撮影設定表示（撮影モード（27ページ）が
「SDRモード」または「HDRモード」のとき）		
S&Q	Frame	Rate、Shutter、	

Color	Temp/Tint、Gain、Gamma、
Shutter	Category、White	Mode、
Base	Sensitivity、Auto	ND	Filter、	
Auto	Iris、AGC、Color	Bars、
Focus	Mode、Auto	White

ˎˎ 撮影設定表示（撮影モードが「Cine	EIモード」の
とき）	
S&Q	Frame	Rate、Shutter、	
Color	Temp/Tint、Exposure	Index、	
Color	Gamut/Gamma、	
Shutter	Category、White	Mode、	
Base	ISO、Auto	ND	Filter、Auto	Iris、
AGC、Color	Bars、Focus	Mode、	
Monitor	LUT、Auto	White

Playback画面

ˎˎ ステータス表示

ˎˎ 再生操作ボタン	
F	Rev、Play/Pause、F	Fwd、Prev、Stop、
Next

Cursor画面

ˎˎ ステータス表示

ˎˎ カーソル操作ボタン、メニュー/ステータス表
示	
Up、Left、Set、Right、Down、Cancel/
Back、Menu、User	Menu、Thumbnail、
Status

Assign画面

ˎˎ ステータス表示

ˎˎ アサイナブルボタン表示	
アサイナブルボタン1～ 10、Focus	Holdボタ
ン

Webリモコンを表示する

1 本機とデバイスをネットワーク接続（59
ページ）する。

2 デバイスでブラウザーを起動し、「http://本
機のIPアドレス/rm.html」にアクセスする。
例：IPアドレスが「192.168.122.1」の場合
は、アドレスバーに「http://192.168.122.1/
rm.html」と入力します。
本機のIPアドレスは、ネットワークステータ
ス画面（16ページ）で確認してください。

3 ブラウザー画面に、ユーザー名とパス
ワード（Networkメニュー→Access	
Authentication→User	Nameおよび
Password）を入力する。
接続が完了すると、デバイスにWebリモコ
ン画面が表示されます。
以降は、画面表示のとおりに操作してくださ
い。
Lockつまみを右にスライドすると、ボタン
の操作を禁止することができます。

［ご注意］

ˎˎ 次の場合は、Webリモコン画面と本機の状態が一致し
なくなることがあります。その場合は、ブラウザーの表
示を更新してください。
	– 接続中に本機を再起動した場合
	– 接続中に本機を操作した場合
	– デバイスを再接続した場合
	– ブラウザーで進む/戻るを操作した場合

ˎˎ 電波状態が著しく悪い場合、Webリモコンが機能しな
くなることがあります。
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Webリモコンの対応デバイス
について

本機の設定や操作には、タブレットまたはコン
ピューターを使用することができます。
使用できるデバイス、OS、ブラウザーは以下を
ご覧ください。

デバイス OS ブラウザー
タブレット Android7/8 Chrome

iOS12/13.3/	
14/15

Safari

コンピューター Windows	
7/8.1/10

Chrome

macOS	
10.13/10.14

Safari

「Content	Browser	Mobile」アプリケーション
の対応デバイスについては、お買い上げ店または
ソニーのサービス窓口にご確認ください。

Webリモコンのメニューにつ
いて

画面左上の	 	をタップすると、画面選択メ
ニューが現れます。Monitoring	Settingsを選
択すると、モニタリング設定画面が表示されます。

モニタリング設定画面で画面左上の	 	をタップ
すると、ファイル転送などの設定メニューが表示
されます。

メニューの項目
ˎˎ Remote	Control	
Camera	Control

ˎˎ Monitoring	
Monitoring	Settings

ˎˎ File	Transfer	
Slot	A	
Slot	B	
Slot	SD/MS	
Job	List	
Upload	Settings

モニタリング映像の設定「Monitoring	
Settings」

デバイスでモニタリングするときのフォーマット
を設定します。

Size
モニタリング用の映像のサイズとビットレートを
設定します。

ˎˎ 480x270(1Mbps)

ˎˎ 480x270(0.5Mbps)

Frame	Rate
モニタリング用の映像のフレームレートが表示さ
れます。

ファイル転送先設定「Upload	
Settings」

本機に記録したプロキシファイルやオリジナル
ファイルを転送するサーバーの設定変更を行いま
す。

転送先のサーバーを登録する
Upload	Serverのリストでサーバーを選択し、
Editをタップすると、サーバー設定用の画面が表
示されますので、各項目を設定してサーバーを登
録します。
NetworkメニューのFile	Transfer（122ペー
ジ）でもサーバーを登録できます。
ここで設定したサーバーが、Slot	A、Slot	B、
Slot	SD/MSの画面でのファイル転送時の転送先
リストに表示されます。

Upload	Server	Edit画面

設定後にOKをタップすると設定を反映し、
Cancelをタップすると、設定を中止します。
Service
サーバーの種類を表示します。

「FTP」：FTP	サーバー
Display	Name
リストに表示されるサーバー名を入力します。
Host	Name
サーバーのアドレスを入力します。
Port
サーバーに接続する際のポート番号を入力しま
す。
User	Name
ユーザー名を入力します。
Password
パスワードを入力します。

［ご注意］

ˎˎ パスワードは、セキュリティの観点からEdit画面を開く
たびにクリアされます。サーバー設定を変更した場合は、
再入力してください。
ˎˎ セキュリティの観点から、パスワードには他人に推測さ
れにくく十分な長さのある文字列を設定し、厳重に保管
することを推奨します。
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Display	Password
パスワードの表示/非表示を切り替えます。
OFFにすると、設定されているパスワードは表示
されません。パスワード入力中は、文字はすべて
アスタリスクで表示されます。
ONにすると、設定されているパスワードが表示
されます。パスワード入力中は、文字はすべて表
示されます。
Passive	Mode
パッシブモードのON/OFFを行います。
Destination	Directory
転送先ディレクトリーを入力します。

［ご注意］
転送先サーバーで使用できない文字を転送先ディレクト
リーに入力した場合、ファイルはユーザーのホームディレク
トリーに転送されます。使用できない文字はサーバーによっ
て異なります。
Using	Secure	Protocol
セキュアなFTP転送を行うかどうかを設定しま
す。ONにすると証明書の状況が表示されます。
証明書の読み込みや消去は、Select	Function
をタップして、表示されるメニューで行います。

ˎˎ Load	
CA証明書を読み込みます。
*	 読み込む証明書はPEM形式で、SDカードのルート

ディレクトリーに“certification.pem”のファイル名
で書き込んでおいてください。

ˎˎ Clear	
CA証明書をクリアします。

ˎˎ None	
読み込み/消去を行いません。

［ご注意］
CA証明書を読み込む際は、本機の時刻を正しく設定して
ください。

登録済みのサーバーの設定を変更する
Upload	Settings画面で設定を変更したいサー
バー名を選んでEditをタップします。設定変更画
面が表示されますので、必要に応じて設定を変
更します。
NetworkメニューのFile	Transfer（122ペー
ジ）でもサーバーを設定できます。

プロキシファイルを自動転送する
Auto	Upload	On/Off
Auto	Upload	(Proxy)	On/Off/Chunk
インターネット接続状態で、Auto	Uploadまた
はAuto	Upload	(Proxy)設定がOnの場合、記
録を終了するとDefault	Upload	Serverで設定
した転送先に、自動的にオリジナルファイルまた
はプロキシファイルを送信します。Auto	Upload	
(Proxy)	設定がChunkの場合は、Proxy	Recの
Chunkで設定した時間ごとにDefault	Upload	
Serverで設定した転送先に、自動的にプロキシ
ファイルを送信します。
Default	Upload	Server
デフォルトのファイル転送先を選択します。

［メモ］
「ファイルを自動転送する」（66ページ）を参照してくだ
さい。

ファイル転送管理「File	Transfer」

XQDメモリーカードに記録されているオリジナル
ファイルやSDカードに記録されているプロキシ
ファイルの転送、転送ファイルの管理、転送先
の設定を行います。

ファイルの転送「Slot	A、Slot	B、Slot	
SD/MS」
Slot	A、Slot	Bに挿入されているメディアに記録
されているクリップ、またはUTILITY	SD/MSカー
ドスロットに挿入されているメディアに記録され
ているプロキシファイルの一覧を表示します。

［ご注意］
Webリモコンでは、分割記録されたプロキシファイルは個
別のクリップとして表示されます。これらのクリップは削除
できません。また、これらのクリップをWebリモコンから
転送した場合、サーバー側でクリップを自動連結できませ
ん。

表示されているファイルを選択して、インターネッ
ト上のサーバーへ転送することができます。

SD	カードのプロキシファイルを転送する

1 本機とデバイスをLAN接続する（59ペー
ジ）。

2 デバイスのブラウザーを起動して本機の
Webリモコンを表示する（71ページ）。

3 ファイルを選ぶためのファイルリスト画面を
表示させる。

	をタップし、File	TransferのSlot	SD/
MSをタップします。
UTILITY	SD/MSカードスロットに挿入され
ているメディアのファイルリスト画面が表示
されます。

4 転送したいファイルを選ぶ。
ファイルをタップして選びます。もう一度タッ
プすると、キャンセルします。
ダブルタップすると、ファイルを再生して内
容を確認することができます。（SDカードの
み）

5 Transferをタップする。
「転送先のサーバーを登録する」
（72ページ）のDefault	Upload	Server
でデフォルト設定された転送先が表示され
ます。
転送先を変更する場合は、転送先をタップ
してリストを表示させ、転送先を選びます。
必要に応じて、Directoryに転送先のディレ
クトリー名を入力します。
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6 Transferをタップする。
選んだファイルの転送を開始します。
転送を中止するときは、Cancelをタップし
ます。

	 ［メモ］

画面右上の	 	をタップして、Transferを選択しても、
ファイルの転送を	開始できます。

XQDメモリーカードのオリジナルファイルを転送
する

［メモ］
XQDメモリーカード内のファイル情報を見るためには、本
体のXQDカードスロットの蓋が閉じている必要があります。

1 本機とデバイスをLAN接続する（59ペー
ジ）。

2 デバイスのブラウザーを起動して本機の
Webリモコンを表示する（71ページ）。

3 ファイルを選ぶためのファイルリスト画面を
表示させる。

	をタップし、File	TransferのSlot	Aまた
はSlot	Bをタップします。
Slot	AまたはSlot	Bに挿入されているメディ
アのファイルリスト画面が表示されます。

例：Slot	A画面

4 転送したいファイルを選ぶ。
ファイルをタップして選びます。もう一度タッ
プすると、キャンセルします。

5 Transferをタップする。
「転送先のサーバーを登録する」
（72ページ）のDefault	Upload	Server
でデフォルト設定された転送先が表示され
ます。
転送先を変更する場合は、転送先をタップ
してリストを表示させ、転送先を選びます。
必要に応じて、Directoryに転送先のディレ
クトリー名を入力します。

6 Transferをタップする。
選んだファイルの転送を開始します。
転送を中止するときは、Cancelをタップし
ます。

	 ［メモ］

画面右上の	 	をタップして、Transferを選択しても、
ファイルの転送を開始できます。

ファイル転送の確認「Job	List」
転送中のファイルや転送ファイルのリストの確認
をしたり、転送するファイルの中止、再開、削除
などを行うことができます。
本機はFTPレジューム機能（転送途中からのファイ
ルの再転送機能）に対応しています。

ˎˎ Total：転送する全ファイルの進捗状況です。

ˎˎ Status：転送中のファイルの進捗状況です。

ˎˎ Remain	time	:	予想残り転送時間表示です。

ˎˎ Transfer	data	rate	:	転送レート表示です。

ファイルの転送中止、再開、転送リストからファ
イルを削除する

1 ファイルを選ぶ。

2 画面右上の	 	をタップして、項目を選ぶ。
ˎˎ Abort	selected：転送を中止します。

ˎˎ Delete	from	list：転送リストからファイル
を削除します。

ˎˎ Start	selected：ファイルの転送を開始し
ます。

ˎˎ Clear	completed：転送済みファイルリス
トを削除します。

	 ［ご注意］
分割記録中の分割クリップのジョブを削除すると、
以後その記録中の分割クリップは転送されません。

ˎˎ Select	All	:	リストを全選択します。
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サムネイル画面
THUMBNAILボタン（7ページ）を押すと、XQDメモリーカードに収録されているクリップが、サムネイル（縮小画）画面に表示されます。
サムネイル画面で選択したクリップから再生を開始することができます。再生画像は、ビューファインダー、外部ビデオモニターに表示できます。
THUMBNAILボタンを押すと、サムネイル画面を終了し、撮影画面に戻ります。

［ご注意］
サムネイル画面には、現在選択しているフォーマットで収録されたクリップのみが表示されます。収録したはずのクリップが表示されないときは、記録フォーマットをご確認ください。また、メディアのフォーマット（初期化）などを行う際にはご注意ください。

画面の構成

画面下部には、カーソル位置のクリップの情報が表示されます。

4 5

6

3

1

2

現在選択されているXQDメモリーカードをハイライト表示
（プロテクトされている場合は右にロックマーク表示）

カーソル（黄色）

クリップ番号／クリップ総数

1.	 サムネイル（縮小画）
各クリップの代表画像です。記録時にはクリップの
先頭フレームが自動的に代表画に設定されます。
サムネイルの下にはクリップ/フレーム情報が表
示されます。ThumbnailメニューのCustomize	
View（113ページ）の、Thumbnail	Captionで
表示内容を変更できます。

2.	クリップ名
選択されているクリップのクリップ名が表示され
ます。

3.	 記録時のビデオフォーマット
選択したクリップのファイルフォーマットが表示さ
れます。

4.	特殊記録撮影情報
特殊記録モードで記録されたクリップの場合の
み、そのモードが表示されます。
スロー＆クイックモーション記録されたクリップ
の場合は、右側にフレームレートが表示されます。

5.	 クリップの収録時間（Duration）

6.	作成日時



5章　サムネイル画面76

クリップの再生
記録したクリップを再生する

本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

1 再生するXQDメモリーカードを入れる。

2 THUMBNAILボタンを押す。

3 矢印ボタン（7ページ）またはマルチファ
ンクションダイヤル（4ページ）を操作し
て、再生を開始したいクリップのサムネイル
にカーソルを合わせる。

4 SETボタンまたはマルチファンクションダイヤ
ルを押す。
選択したクリップの先頭から再生が始まりま
す。

再生操作は次のボタンで行います。
SET ボタンまたはマルチファンクションダイヤ
ル押し：	
再生を一時停止します。	
もう一度押すと再生に戻ります。

矢印ボタンの左ボタン /右ボタン押し：	
クリップの先頭または前後のクリップに移
動します。

矢印ボタンの左ボタン /右ボタン長押し：	
高速再生します。	
長押しをやめると標準再生に戻ります。

CANCEL/BACKボタン：	
再生を停止し、記録停止状態にします。

［ご注意］

ˎˎ クリップとクリップの境界では、一時的に画像が乱れた
り、静止画になる場合があります。またこの間は操作が
できません。
ˎˎ サムネイル画面でクリップを選択して再生を開始すると、
クリップの先頭部分の再生映像が乱れる場合がありま
す。クリップの先頭から乱れのない映像で再生するには、
一度再生モードにした後で一時停止にし、矢印ボタンの
左ボタンを押してクリップの先頭に戻して再生を行ってく
ださい。
ˎˎ マルチセレクター（9ページ）でも操作できます。
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サムネイル画面では、Thumbnailメニューを使
用してクリップの操作や詳細情報の確認などが可
能です。
Menuボタンを押してThumbnailを選択すると、
Thumbnailメニュー（112ページ）が表示され
ます。

Thumbnailメニューの操作
方法

矢印ボタン（7ページ）またはマルチファンク
ションダイヤル（4ページ）を操作して機能を
選択し、SETボタンまたはマルチファンクション
ダイヤルを押してください。
CANCEL/BACKボタン（7ページ）を押すと、
操作前の画面に戻ります。

［メモ］
マルチセレクター（9ページ）でも操作できます。

［ご注意］
メニューを表示させたときの状態によって選択できない項
目があります。

クリップ操作メニュー

ˎˎ Display	Clip	Properties

ˎˎ Set	Shot	Mark

ˎˎ Set	Clip	Flag

ˎˎ Lock/Unlock	Clip

ˎˎ Delete	Clip

ˎˎ Copy	Clip

ˎˎ Copy	Sub	Clip

ˎˎ Transfer	Clip

ˎˎ Transfer	Clip	(Proxy)

ˎˎ Set	Index	Picture

ˎˎ Thumbnail	View

ˎˎ Filter	Clips

ˎˎ Customize	View

クリップ操作メニューについて詳しくは、
Thumbnailメニュー（112ページ）をご覧くだ
さい。

クリップの詳細情報画面を表示する

ThumbnailメニューのDisplay	Clip	Properties
（112ページ）を選択すると、クリップの詳細情
報画面を表示されます。

エッセンスマークサムネイル画面を表
示する

ThumbnailメニューのThumbnail	View（113
ページ）を選択し、Essence	Mark	Thumbnail
で表示したいエッセンスマークを選ぶと、指定し
た種別のエッセンスマークの付いているフレーム
をサムネイル表示することができます。
すべてのクリップを表示するには、Thumbnail
メニューのThumbnail	ViewのEssence	Mark	

ThumbnailでAllを選んでください。

フィルタードクリップサムネイル画面を
表示する

ThumbnailメニューのFilter	Clips（113ペー
ジ）で表示したいフラグを選ぶと、指定したフラ
グの付いているクリップのみを表示することがで
きます。
すべてのクリップを表示するには、Allを選んでく
ださい。

［メモ］
DISPLAYボタンでフィルターを順に切り替えることもでき
ます。

クリップを削除する

XQDメモリーカードからクリップを削除すること
ができます。
ThumbnailメニューのDelete	ClipからSelect	
ClipまたはAll	Clipsを選びます。
Select	Clip：	

任意のクリップを削除します。1 度に複数の
クリップを選択することもできます。

All	Clips：	
表示されているすべてのクリップを削除し
ます。

サムネイル画面の情報を変更する

サムネイルの下に表示されるクリップ／フレーム
情報を変更します。
ThumbnailメニューのCustomize	Viewの、
Thumbnail	Captionから、表示したい内容を選
びます。
Date	Time：	

作成日時または最終変更日時

Time	Code：	
タイムコード

Duration：	
収録時間

Sequential	Number：	
サムネイル番号

クリップ操作
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セットアップメニューの構成と階層
MENUボタンを押すと、撮影や再生に必要な各
種設定を行うセットアップメニューがビューファイ
ンダー画面に表示されます（外部ビデオモニター
に表示させることもできます）。下記のメニュー
から選択して設定します。

メニュー構成

Userメニュー
任意の設定を集めたメニュー	
Edit	User	Menuから編集できます。

Edit	Userメニュー
Userメニューの編集に関する設定

Shootingメニュー
撮影に関する設定

Projectメニュー
プロジェクトの基本的な設定

Paintメニュー
画質に関する設定

TC/Mediaメニュー
タイムコードと記録メディアに関する設定

Monitoringメニュー
ビデオ出力やビューファインダー出力に関す
る設定

Audioメニュー
音声に関する設定

Thumbnailメニュー
サムネイル表示に関する設定

Technicalメニュー
技術的な内容の設定

Networkメニュー
ネットワークに関する設定

Maintenanceメニュー
時計や言語設定などの機器設定 セットアップメニューの階層

User	
（工場出荷時の設
定）

Base	Setting
Rec	Format
ISO/Gain/EI
Focus
S&Q	Motion
Monitor	LUT
Monitor	LUT	Setting
Simul	Rec
4K	&	HD	(Sub)	Rec
Proxy	Rec
Picture	Cache	Rec
Assignable	Button
Assignable	Dial
Multi	Function	Dial
All	File
Clip	Name	Format
Format	Media
Output	Format
VF	Setting
Menu	Settings

Edit	User	Menu Add	Item
Customize	Reset

Shooting ISO/Gain/EI
ND	Filter
Shutter
Auto	Exposure
White
White	Setting
Offset	White
Focus
S&Q	Motion
Monitor	LUT
Monitor	LUT	Setting
Monitor	3D	LUT
Noise	Suppression
Flicker	Reduce
SteadyShot
Auto	Black	Balance

Project Base	Setting
Rec	Format
Cine	EI	Setting
HDR	Setting
Simul	Rec
4K	&	HD	(Sub)	Rec
Proxy	Rec
Interval	Rec
Picture	Cache	Rec
SDI/HDMI	Rec	Control
Assignable	Button
Assignable	Dial
Multi	Function	Dial
User	File
All	File
Planning	Metadata
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Paint HDR	Paint	Setting
Black
Gamma
Black	Gamma
Knee
White	Clip
Detail(4K/QFHD)
Detail(HD)
Skin	Detail
Aperture
Matrix
Multi	Matrix
Scene	File

TC/Media Timecode
TC	Display
Users	Bit
HDMI	TC	Out
Clip	Name	Format
Update	Media
Format	Media

Monitoring Output	On/Off
Output	Format
Output	Setting
Output	Display
Display	On/Off
Marker
VF	Setting
Gamma	Display	Assist
Peaking
Zebra

Audio Audio	Input
Audio	Output

Thumbnail Display	Clip	Properties
Set	Shot	Mark
Set	Clip	Flag
Lock/Unlock	Clip
Delete	Clip
Copy	Clip
Copy	Sub	Clip
Transfer	Clip
Transfer	Clip	(Proxy)
Set	Index	Picture
Thumbnail	View
Filter	Clips
Customize	View

Technical Color	Bars
Test	Saw
ND	Dial
Tally
HOLD	Switch	Setting
Touch	Operation
Rec	Review
Handle	Zoom
GPS
Menu	Settings
Status	Page	On/Off
RCP
Fan	Control
Lens
Video	Light	Set
APR
Camera	Battery	Alarm
Camera	DC	IN	Alarm
Ext.	Unit	Battery	Alarm
Ext.	Unit	DC	IN	Alarm

Network Setup	for	Mobile	App
Access	Authentication
Wireless	LAN
AP	Mode	Settings
ST	Mode	Settings
Wired	LAN
Modem
Network	Client	Mode
File	Transfer
Network	Reset

Maintenance Language
Clock	Set
Network	Public	Key
All	Reset
Hours	Meter
Version
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セットアップメニューの操作方法
MENUボタンを押すと、撮影や再生に必要な各
種設定を行うセットアップメニューがビューファイ
ンダー画面に表示されます（外部ビデオモニター
に表示させることもできます）。

メニュー操作部

MENUボタン（7ページ）
セットアップメニューを操作するメニュー
モードをOn/Offします。

////SETボタン（7ページ）
矢印ボタンを押すと、カーソルが上下左右に
移動して、メニュー項目や設定値を選択でき
ます。
SETボタンを押すと、選択している項目を決
定します。

	 ［メモ］
マルチセレクター（9ページ）でも同様に操作でき
ます。

マルチファンクションダイヤル（4ページ）
マルチファンクションダイヤルを回すとカーソ
ルが上下に移動して、メニュー項目や設定値
を選択できます。
マルチファンクションダイヤルを押すと、選
択している項目を決定します。

CANCEL/BACKボタン（7ページ）
1つ前の階層に戻ります。確定前の変更はキャ
ンセルされます。

［ご注意］

ˎˎ ピント拡大（35ページ）になっていると、セットアップ
メニューは操作できません。
ˎˎ メニューを表示させたときの状態によって選択できない
項目があります。
ˎˎ タッチ操作はできません。

メニューを設定する

矢印ボタンを押すか、またはマルチファンクショ
ンダイヤルを回して設定したい項目にカーソルを
合わせ、SETボタンまたはマルチファンクション
ダイヤルを押して決定します。

ˎˎ 選択項目が表示される選択肢エリアは最大8
行表示です。選択肢が一度に表示できない場
合は、カーソルを上下に移動すると表示がスク
ロールします。

ˎˎ 選択肢の範囲が大きい項目の場合	
（例：－99 ～ +99）は、選択肢エリアは表示
されません。文字がハイライト表示になり設定
変更が可能な状態であることを示します。

ˎˎ 実行項目でExecuteを選択した場合は、対応
する機能が実行されます。

ˎˎ 実行前に確認が必要な項目を選択すると、一
旦メニューが消え、確認メッセージが表示され
ます。メッセージに従って、実行するかキャン
セルするかを選択してください。

文字列を入力する

ファイル名など、文字列を設定する項目を選択し
た場合は、文字列の入力画面が表示されます。

1

2 3

1 矢印ボタンを押すか、またはマルチファンク
ションダイヤルを回して入力したい文字タイ
プを選択し、決定する。
ABC：英大文字
abc：英小文字
123：数字
!#$：特殊文字

2 選んだ文字タイプから文字を選択し、決定
する。
カーソルが次の欄に移動します。
Space：カーソルの位置にスペースを入力し

ます。
/：カーソル位置を移動します。
BS：カーソルの左の文字を削除します。

3 入力が終わったら、Doneを選択し、決定す
る。
文字列を確定して、入力画面が消えます。

メニューのロックと解除

セットアップメニューの表示をロックして、User
メニューだけを表示させることができます。
ステータス画面での設定変更もできなくなりま
す。

メニューをロックする

1 マルチファンクションダイヤルを押しながら
MENUボタンを押す。

2 TechnicalメニューのMenu	Settingsの
User	Menu	with	Lockを選択する。

	 ［ご注意］
MENUボタンのみを押して通常のセットアップメ
ニューを表示した場合、TechnicalメニューのMenu	
SettingsにはUser	Menu	Onlyが表示されますが、
マルチファンクションダイヤルを押しながらMENUボタ
ンを押すと、User	Menu	with	Lockが表示されます。

3 Onを選択してSETボタンまたはマルチファン
クションダイヤルを押す。
ビューファインダー画面の表示が、暗証番号
入力画面に切り替わります。

4 任意の番号を入力する。
0000 ～ 9999の4桁の数値が入力できま
す。初期値は0000となっています。
数値を入力し、SETボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSETに
移動します。
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5 SETボタンまたはマルチファンクションダイヤ
ルを押す。
入力が確定します。
設定が完了したメッセージが表示され、
Userメニュー表示に切り替わります。

メニューのロックを解除する

1 マルチファンクションダイヤルを押しながら
MENUボタンを押す。

2 UserメニューのMenu	SettingsのUser	
Menu	with	Lockを選択する。

	 ［ご注意］
MENUボタンのみを押して通常のセットアップメ
ニューを表示した場合、TechnicalメニューのMenu	
SettingsにはUser	Menu	Onlyが表示されますが、
マルチファンクションダイヤルを押しながらMENUボタ
ンを押すと、User	Menu	with	Lockが表示されます。

3 Offを選択してSETボタンまたはマルチファン
クションダイヤルを押す。
ビューファインダー画面の表示が、暗証番号
入力画面に切り替わります。

4 メニューをロックしたときの番号を入力す
る。
数値を入力し、SETボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSetに
移動します。

5 SETボタンまたはマルチファンクションダイヤ
ルを押す。
入力が確定します。

メニューをロックしたときの暗証番号と入力
した番号が一致した場合、ロックが解除で
きたことのメニュー表示に切り替わります。

［ご注意］

ˎˎ メニューをロックしたときの暗証番号と入力した番号が
不一致の場合は、ロックを解除できません。
ˎˎ 暗証番号は、忘れたときのため、手元に記録を残すこと
をお勧めします。忘れたときはサービス窓口にお問い合
わせください。
ˎˎ 下表のセットアップメニューのメニュー項目をUserメ
ニューに登録せずにメニューをロックした場合、同機能
をアサイナブルボタンに設定することはできません。
ˎˎ 下表の機能をアサイナブルボタンにアサインしていた場
合は、メニューをロックした時点でアサイナブルの設定
が強制的にOffになります。

セットアップメニューの
メニュー項目

アサイナブルボタン
の選択肢

Shooting>ISO/Gain/
EI>Base	Sensitivity、
Shooting>ISO/Gain/
EI>Base	ISO

Base	ISO/
Sensitivity

Shooting>Auto	
Exposure>AGC

AGC

Shooting>Auto	
Exposure>Auto	ND	
Filter

Auto	ND	Filter

Shooting>Auto	
Exposure>Auto	
Shutter

Auto	Shutter

Shooting>Auto	
Exposure>Level

Auto	Exposure	
Level

Shooting>Auto	
Exposure>Mode

Backlight

Shooting>Auto	
Exposure>Mode

Spotlight

Shooting>White>	
Preset	White

Preset	White	
Select

Shooting>Focus>	
AF	Transition	Speed、
Shooting>Focus>	
AF	Subj.	Shift	Sens.

AF	Speed/Sens.

セットアップメニューの
メニュー項目

アサイナブルボタン
の選択肢

Shooting>Focus>	
Focus	Area

Focus	Area

Shooting>Focus>	
Focus	Area(AF-S)

Focus	Area(AF-S)

Shooting>Focus>	
Face/Eye	Detection	
AF

Face/Eye	
Detection	AF

Shooting>Focus>	
Push	AF	Mode

Push	AF	Mode

Shooting>S&Q	
Motion>Setting

S&Q	Motion

Shooting>	
SteadyShot>Setting

SteadyShot

Project>Picture	
Cache	Rec>Setting

Picture	Cache	Rec

Technical>Rec	
Review>Setting

Rec	Review

Thumbnail>Set	Clip	
Flag>Add	OK

Clip	Flag	OK

Thumbnail>Set	Clip	
Flag>Add	NG

Clip	Flag	NG

Thumbnail>Set	Clip	
Flag>Add	KEEP

Clip	Flag	Keep

Technical>Color	
Bars>Setting

Color	Bars

Monitoring>Display	
On/Off>Lens	Info

Lens	Info

Monitoring>Display	
On/Off>Video	Signal	
Monitor

Video	Signal	
Monitor

Monitoring>	
Marker>Setting

Marker

Monitoring>VF	
Setting>Color	Mode

VF	Mode

Monitoring>Gamma	
Display	
Assist>Setting

Gamma	Display	
Assist

セットアップメニューの
メニュー項目

アサイナブルボタン
の選択肢

Monitoring>	
Peaking>Setting

Peaking

Monitoring>	
Zebra>Setting

Zebra

Audio>Audio	
Output>Monitor	CH

Audio	Monitor	CH

Audio>Audio	
Output>Monitor	CH

Audio	Mon.	CH	
Switch

Technical>Touch	
Operation>Setting

Touch	Operation

Technical>Handle	
Zoom>Setting

Handle	Zoom

Network>Wireless	
LAN>NFC

NFC

Network>Network	
Client	Mode>Setting

Network	Client	
Mode

Network>File	
Transfer>Auto	
Upload	(Proxy)

Auto	Upload	
(Proxy)

User User	Menu
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Userメニュー
各メニュー項目および対応する機能は以下のとおりです。

User
メニュー項目 内容
Base	Setting Project	>	Base	Settingの内容。
Rec	Format Project	>	Rec	Formatの内容。
ISO/Gain/EI Shooting	>	ISO/Gain/EIの内容。
Focus Shooting	>	Focusの内容。
S&Q	Motion Shooting	>	S&Q	Motionの内容。
Monitor	LUT Shooting	>	Monitor	LUTの内容。
Monitor	LUT	Setting Shooting	>	Monitor	LUT	Settingの内容。
Simul	Rec Project	>	Simul	Recの内容。
4K	&	HD	(Sub)	Rec Project	>	4K	&	HD	(Sub)	Recの内容。
Proxy	Rec Project	>	Proxy	Recの内容。
Picture	Cache	Rec Project	>	Picture	Cache	Recの内容。
Assignable	Button Project	>	Assignable	Buttonの内容。
Assignable	Dial Project	>	Assignable	Dialの内容。
Multi	Function	Dial Project	>	Multi	Function	Dialの内容。
All	File Project	>	All	Fileの内容。
Clip	Name	Format TC/Media	>	Clip	Name	Formatの内容。
Format	Media TC/Media	>	Format	Mediaの内容。
Output	Format Monitoring	>	Output	Formatの内容。
VF	Setting Monitoring	>	VF	Settingの内容。
Menu	Settings Technical	>	Menu	Settingsの内容。
Edit	User	Menu Edit	Userメニューを表示する。

［ご注意］
UserメニューはEdit	Userメニューによってメニュー項目の追加や削除ができます。設定できる項目数は20が上限です。
本機では初期設定で項目数20を使い切っているため、項目を追加するためにはEdit	UserメニューのDeleteで任意の項目
を削除した後、Add	Itemで追加します。
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Edit	Userメニュー
UserメニューでEdit	User	Menuを選択すると、Edit	Userメニューが第1階層に表示されます。

Edit	User
メニュー項目 細目と設定値 内容
Add	Item
Userメニュー項目の追加

Userメニューに第2階層の項目を追加
する。

Customize	Reset
Userメニュー項目のリ
セット

Userメニューの登録項目を工場出荷
時の状態に戻す。

編集中に選択した第2階
層の項目

Delete Userメニューに登録した第2階層の項
目を削除する。

Move Userメニューに登録した項目を並べ替
える。

Edit	Sub	Item Userメニューに登録した第3階層の項
目に属する細目を編集（登録・削除）す
る。



6章　メニュー表示と詳細設定84

Shootingメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Mode ISO/dB ゲイン設定モードを選択する。
ISO/
Gain<H>

ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがHighのとき

ISO	1600	/	ISO	2000	/	ISO	2500	/		
ISO	3200	/	ISO	4000	/	ISO	5000	/		
ISO	6400	/	ISO	8000	/	ISO	10000	/	
ISO	12800	/	ISO	16000	/	ISO	20000	/	
ISO	25600	/	ISO	32000	/	ISO	40000	/	
ISO	51200	/	ISO	64000	/	ISO	80000	/	
ISO	102400

ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがLowのとき

ISO	320	/	ISO	400	/	ISO	500	/	ISO	640	/	
ISO	800	/	ISO	1000	/	ISO	1250	/		
ISO	1600	/	ISO	2000	/	ISO	2500	/		
ISO	3200	/	ISO	4000	/	ISO	5000	/		
ISO	6400	/	ISO	8000	/	ISO	10000	/		
ISO	12800	/	ISO	16000	/	ISO	20000

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがHighのとき

ISO	2500	/	ISO	3200	/	ISO	4000	/		
ISO	5000	/	ISO	6400	/	ISO	8000	/	
ISO	10000	/	ISO	12800	/	ISO	16000	/	
ISO	20000	/	ISO	25600	/	ISO	32000	/	
ISO	40000	/	ISO	51200	/	ISO	64000	/	
ISO	80000	/	ISO	102400

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがLowのとき

ISO	500	/	ISO	640	/	ISO	800	/		
ISO	1000	/	ISO	1250	/	ISO	1600	/		
ISO	2000	/	ISO	2500	/	ISO	3200	/		
ISO	4000	/	ISO	5000	/	ISO	6400	/		
ISO	8000	/	ISO	10000	/	ISO	12800	/	
ISO	16000	/	ISO	20000

ゲインのプリセット値<H>を設定する。

［メモ］
ダイナミックレンジはガンマで決まります。HDR
モード時のガンマはHLGとなります。

ガンマ ダイナミック
レンジ

STD	/	HG1	/	HG2	/	
HG3	/	HG4	/		
S-Cinetone

460%

HG7	/	HG8 800%
S-Log3	/	HLG 1300%

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
ISO/
Gain<H>

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがHighのとき

ISO	4000	/	ISO	5000	/	ISO	6400	/		
ISO	8000	/	ISO	10000	/	ISO	12800	/	
ISO	16000	/	ISO	20000	/	ISO	25600	/	
ISO	32000	/	ISO	40000	/	ISO	51200	/	
ISO	64000	/	ISO	80000	/	ISO	102400

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがLowのとき

ISO	800	/	ISO	1000	/	ISO	1250	/		
ISO	1600	/	ISO	2000	/	ISO	2500	/		
ISO	3200	/	ISO	4000	/	ISO	5000	/		
ISO	6400	/	ISO	8000	/	ISO	10000	/	
ISO	12800	/	ISO	16000	/	ISO	20000

ModeがdBのとき
－3dB～27dB（12dB）（1	dB刻み）

ISO/
Gain<M>

設定値はISO/Gain<H>と同じです。
初期値は以下のとおりです。
ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがHighのとき
ISO	3200

ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがLowのとき
ISO	640

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがHighのとき
ISO	5000

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがLowのとき
ISO	1000

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがHighのとき
ISO	8000

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがLowのとき
ISO	1600

ModeがdBのとき
6dB

ゲインのプリセット値<M>を設定する。
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Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
ISO/Gain<L> 設定値はISO/Gain<H>と同じです。

初期値は以下のとおりです。
ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがHighのとき
ISO	1600

ModeがISOでダイナミックレンジが460%、
かつBase	SensitivityがLowのとき
ISO	320

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがHighのとき
ISO	2500

ModeがISOでダイナミックレンジが800%、
かつBase	SensitivityがLowのとき
ISO	500

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがHighのとき
ISO	4000

ModeがISOでダイナミックレンジが1300%、
かつBase	SensitivityがLowのとき
ISO	800

ModeがdBのとき
0dB

ゲインのプリセット値<L>を設定する。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Exposure	
Index<H>

Base	ISOがISO	800のとき
200EI	/	4.0E
250EI	/	4.3E
320EI	/	4.7E
400EI	/	5.0E
500EI	/	5.3E
640EI	/	5.7E
800EI	/	6.0E
1000EI	/	6.3E
1250EI	/	6.7E
1600EI	/	7.0E
2000EI	/	7.3E
2500EI	/	7.7E
3200EI	/	8.0E

Base	ISOがISO	4000のとき
1000EI	/	4.0E
1250EI	/	4.3E
1600EI	/	4.7E
2000EI	/	5.0E
2500EI	/	5.3E
3200EI	/	5.7E
4000EI	/	6.0E
5000EI	/	6.3E
6400EI	/	6.7E
8000EI	/	7.0E
10000EI	/	7.3E
12800EI	/	7.7E
16000EI	/	8.0E

Exposure	Index<H>を設定する。
Cine	EIモード時のみ有効です。

Exposure	
Index<M>

設定値はExposure	Index<H>と同じです。
Base	ISOがISO	800のとき
1000EI	/	6.3E

Base	ISOがISO	4000のとき
5000EI	/	6.3E

Exposure	Index<M>を設定する。

Exposure	
Index<L>

設定値はExposure	Index<H>と同じです。
Base	ISOがISO	800のとき
800EI	/	6.0E

Base	ISOがISO	4000のとき
4000EI	/	6.0E

Exposure	Index<L>を設定する。

Shockless	
Gain

On	/	Off ショックレスゲイン機能をOn/Offする。
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Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Base	
Sensitivity

High	/	Low SDR/HDRモード用の基準感度を設定す
る。

Base	ISO ISO	4000	/	ISO	800 Cine	EIモード用の基準ISO感度を設定す
る。

Shooting>ND	Filter
NDフィルターのプリセット値を設定します。

メニュー項目 細目と設定値 内容
Preset1 1/4	/	1/8	/	1/16	/	1/32	/	1/64	/	1/128 NDフィルターのプリセット1の値を設定す

る。
Preset2 1/4	/	1/8	/	1/16	/	1/32	/	1/64	/	1/128 NDフィルターのプリセット2の値を設定す

る。
Preset3 1/4	/	1/8	/	1/16	/	1/32	/	1/64	/	1/128 NDフィルターのプリセット3の値を設定す

る。

Shooting>Shutter
電子シャッターの動作条件を設定します。

メニュー項目 細目と設定値 内容
Mode Speed	/	Angle 電子シャッターのモードを選択する。

動きの速い被写体を鮮明に撮影したい場合
などに使用する。秒数でシャッター速度を
設定するSpeed（スピード）モードと開角度
でシャッター速度を設定するAngle（角度）
モードを選択する。

Shutter	
Speed	On/
Off

On	/	Off Speedモード選択時の露光時間を、
Shutter	Speedの設定値に従うかフル露光
にするかを設定する。

Shooting>Shutter
電子シャッターの動作条件を設定します。

メニュー項目 細目と設定値 内容
Shutter	
Speed

64F	～	1/8000
設定値は、選択されているビデオフォーマッ
トのフレーム周波数によって異なります。
59.94P	/	59.94i：	

64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/		
4F	/	3F	/	2F	/	1/50	/	1/60	/	1/100	/		
1/120	/	1/125	/	1/250	/	1/500	/	
1/1000	/	1/2000	/	1/4000	/	1/8000

50P	/	50i：	
64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/		
4F	/	3F	/	2F	/	1/50	/	1/60	/	1/100	/		
1/120	/	1/125	/	1/250	/	1/500	/	
1/1000	/	1/2000	/	1/4000	/	1/8000

29.97P：	
64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/	
4F	/	3F	/	2F	/	1/30	/	1/40	/	1/50	/	
1/60	/	1/100	/	1/120	/	1/125	/		
1/250	/	1/500	/	1/1000	/	1/2000	/	
1/4000	/	1/8000

25P：	
64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/	
4F	/	3F	/	2F	/	1/25	/	1/33	/	1/50	/	
1/60	/	1/100	/	1/120	/	1/125	/		
1/250	/	1/500	/	1/1000	/	1/2000	/	
1/4000	/	1/8000

24P/23.98P：	
64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/	
4F	/	3F	/	2F	/	1/24	/	1/32	/	1/48	/	
1/50	/	1/60	/	1/96	/	1/100	/	1/120	/		
1/125	/	1/250	/	1/500	/	1/1000	/	
1/2000	/	1/4000	/	1/8000

Speedモード選択時、シャッタースピード
を設定する。

Shutter	
Angle

64F	/	32F	/	16F	/	8F	/	7F	/	6F	/	5F	/	4F	/		
3F	/	2F	/	360.0°	/	300.0°	/	270.0°	/		
240.0°	/	216.0°	/	210.0°	/	180.0°	/		
172.8°	/	150.0°	/	144.0°	/	120.0°	/		
90.0°	/	86.4°	/	72.0°	/	45.0°	/	30.0°	/	
22.5°	/	11.25°	/	5.6°

Angleモード	選択時、開角度を設定する。

ECS	On/Off On	/	Off Extended	Clear	Scanの設定をOn/Offす
る。
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Shooting>Shutter
電子シャッターの動作条件を設定します。

メニュー項目 細目と設定値 内容
ECS	
Frequency

23.99 ～ 8000
設定値は、選択されているビデオフォーマッ
トのフレーム周波数によって異なります。
初期値は以下のとおりです。
59.94P：60.00
59.94i：60.00
50P：50.00
50i：50.00
29.97P：30.00
23.98P：23.99
25P：25.02
24P：24.02

ECSモード	選択時、ECS周波数を設定する。

Shooting>Auto	Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Level +3.0	/	+2.75	/	+2.5	/	+2.25	/	+2.0	/		

+1.75	/	+1.5	/	+1.25	/	+1.0	/	+0.75	/		
+0.5	/	+0.25	/	±0	/	–0.25	/	–0.5	/		
–0.75	/	–1.0	/	–1.25	/	–1.5	/	–1.75	/	
	–2.0	/	–2.25	/	–2.5	/	–2.75	/	–3.0

自動検出した露出に対する明暗レベルを設
定する。

Mode Backlight	/	Standard	/	Spotlight 自動露出調整の動作モードを設定する。
Backlight:	

バックライトモード（中心となる被写体
が逆光のとき、黒沈みを軽減するモー
ド）

Standard:	
標準モード

Spotlight:	
スポットライトモード（中心となる被写
体にスポットライトが当たっていると
き、白潰れを軽減するモード）

Speed －99 ～ +99（±0） 自動露出調整の調整スピードを設定する。
AGC On	/	Off AGC（オートゲインコントロール）機能を

On/Offする。

Shooting>Auto	Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
AGC	Limit ISO/Gain/EIのModeがdBのとき

3dB	/	6dB	/	9dB	/	12dB	/	15dB	/	
18dB	/	21dB	/	24dB	/	27dB

ISO/Gain/EIのModeがISOでダイナミック
レンジが460%、かつBase	Sensitivityが
Highのとき

ISO	2000	/	ISO	2500	/	ISO	3200	/		
ISO	4000	/	ISO	5000	/	ISO	6400	/		
ISO	8000	/	ISO	10000	/	ISO	12800	/	
ISO	16000	/	ISO	20000	/	ISO	25600	/	
ISO	32000	/	ISO	40000	/	ISO	51200	/	
ISO	64000	/	ISO	80000	/	ISO	102400

ISO/Gain/EIのModeがISOでダイナミック
レンジが460%、かつBase	Sensitivityが
Lowのとき

ISO	400	/	ISO	500	/	ISO	640	/		
ISO	800	/	ISO	1000	/	ISO	1250	/		
ISO	1600	/	ISO	2000	/	ISO	2500	/		
ISO	3200	/	ISO	4000	/	ISO	5000	/		
ISO	6400	/	ISO	8000	/	ISO	10000	/	
ISO	12800	/	ISO	16000	/	ISO	20000

ISO/Gain/EIのModeがISOでダイナミック
レンジが800%、かつBase	Sensitivityが
Highのとき

ISO	3200	/	ISO	4000	/	ISO	5000	/		
ISO	6400	/	ISO	8000	/	ISO	10000	/	
ISO	12800	/	ISO	16000	/	ISO	20000	/	
ISO	25600	/	ISO	32000	/	ISO	40000	/	
ISO	51200	/	ISO	64000	/	ISO	80000	/	
ISO	102400

ISO/Gain/EIのModeがISOでダイナミック
レンジが800%、かつBase	Sensitivityが
Lowのとき

ISO	640	/	ISO	800	/	ISO	1000	/		
ISO	1250	/	ISO	1600	/	ISO	2000	/		
ISO	2500	/	ISO	3200	/	ISO	4000	/		
ISO	5000	/	ISO	6400	/	ISO	8000	/		
ISO	10000	/	ISO	12800	/	ISO	16000	/	
ISO	20000

AGC機能の最大ゲインを設定する。
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Shooting>Auto	Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
AGC	Limit ISO/Gain/EIのModeがISOでダイナミック

レンジが1300%、かつBase	Sensitivityが
Highのとき

ISO	5000	/	ISO	6400	/	ISO	8000	/		
ISO	10000	/	ISO	12800	/	ISO	16000	/	
ISO	20000	/	ISO	25600	/	ISO	32000	/	
ISO	40000	/	ISO	51200	/	ISO	64000	/	
ISO	80000	/	ISO	102400

ISO/Gain/EIのModeがISOでダイナミック
レンジが1300%、かつBase	Sensitivityが
Lowのとき

ISO	1000	/	ISO	1250	/	ISO	1600	/		
ISO	2000	/	ISO	2500	/	ISO	3200	/		
ISO	4000	/	ISO	5000	/	ISO	6400	/	
ISO	8000	/	ISO	10000	/	ISO	12800	/	
ISO	16000	/	ISO	20000

AGC	Point TechnicalメニューのLensのIris	Displayが
F-Numberのとき。または、Iris	Displayが
Autoで、装着レンズからT値の情報取得でき
ないとき。
F2.8	/	F4	/	F5.6

TechnicalメニューのLensのIris	Displayが
Autoで、装着レンズからT値の情報取得でき
るとき。
T2.8	/	T4	/	T5.6

AGC機能がOnのとき、AGCを動作させ始
めるアイリスのF値を設定する。

Auto	
Shutter

On	/	Off オートシャッターコントロール機能をOn/
Offする。

A.SHT	Limit 1/100	/	1/150	/	1/200	/	1/250	/	1/2000 オートシャッター機能の最速シャッタース
ピードを設定する。

A.SHT	Point TechnicalメニューのLensのIris	Displayが
F-Numberのとき。または、Iris	Displayが
Autoで、装着レンズからT値の情報取得でき
ないとき。

F5.6	/	F8	/	F11	/	F16
TechnicalメニューのLensのIris	Displayが
Autoで、装着レンズからT値の情報取得でき
るとき。

T5.6	/	T8	/	T11	/	T16

オートシャッターを動作させ始めるアイリス
のF値を設定する。

Clip	High	
light

On	/	Off 高輝度部の検出を無視して、高輝度に対す
る反応を鈍くさせる機能をOn/Offする。

Shooting>Auto	Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Detect	
Window

1	/	2	/	3	/	4	/	5	/	6	/	Custom 被写体の明るさに追従して露出を自動調整
する測光範囲を選択する。（露出を手動調
整しているときは無効）

Detect	
Window	
Indication

On	/	Off 測光範囲の表示をOn/Offする。

Average	
Peak	Level	
Ratio

－99	～	+99（±0） Auto	Exposure用の検出に使う映像信号
の平均値とピーク値の比を設定する。

Custom	
Width

40	～	999（500） 測光範囲の幅を設定する。

Custom	
Height

70	～	999（500） 測光範囲の高さを設定する。

Custom	H	
Position

－479	～	+479（±0） 測光範囲の水平位置を設定する。

Custom	V	
Position

－464	～	+464（±0） 測光範囲の垂直位置を設定する。

Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

Preset	
White

2000K	～	15000K（3200K） ホワイトバランスのプリセット値を設定す
る。

Color	Temp	
<A>

2000K	～	15000K（3200K） メモリーAに保存されたホワイトバランスの
色温度を設定する。

［ご注意］
Color	Tempは、R/B	Gain操作時に2000Kや
15000Kでクリップされるため、R/B	Gain値の
正確なColor	Temp値を表示できない場合があり
ます。

Tint<A> －99	～	+99（±0） ホワイトメモリーAに保存されたホワイトバ
ランスのTint値を設定する。

［ご注意］
Tintは、R/B	Gain操作時に±99でクリップされ
るため、R/B	Gain値の正確なTint値を表示でき
ない場合があります。

R	Gain	<A> －99.0	～	+99.0（±0.0） メモリーAに保存されたホワイトバランスの
Rゲイン値を設定する。
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Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

B	Gain	<A> －99.0	～	+99.0（±0.0） メモリーAに保存されたホワイトバランスの
Bゲイン値を設定する。

Color	Temp	
<B>

2000K	～	15000K（3200K） メモリー Bに保存されたホワイトバランスの
色温度を設定する。

［ご注意］
Color	Tempは、R/B	Gain操作時に2000Kや
15000Kでクリップされるため、R/B	Gain値の
正確なColor	Temp値を表示できない場合があり
ます。

Tint<B> －99	～	+99（±0） ホワイトメモリー Bに保存されたホワイトバ
ランスのTint値を設定する。

［ご注意］
Tintは、R/B	Gain操作時に±99でクリップされ
るため、R/B	Gain値の正確なTint値を表示でき
ない場合があります。

R	Gain	<B> －99.0	～	+99.0（±0.0） メモリー Bに保存されたホワイトバランスの
Rゲイン値を設定する。

B	Gain	<B> －99.0	～	+99.0（±0.0） メモリー Bに保存されたホワイトバランスの
Bゲイン値を設定する。

Shooting>White	Setting
ホワイトバランスの調整を行います。

メニュー項目 細目と設定値 内容

Shockless	
White

Off	/	1	/	2	/	3 ホワイトバランスモード切り替え時のホワイ
トバランス変化速度を設定する。
Off：瞬時に切り替わる。
1～ 3：数字が大きいほどゆっくり切り替わ

る。
ATW	Speed 1	/	2	/	3	/	4	/	5 ATWモード時の反応速度を設定する。

1：最も反応速度が速い。
White	
Switch<B>

Memory	/	ATW WHT	BALスイッチをBに設定したときに選
択されるホワイトバランス調整モードを選
択する。

Shooting>White	Setting
ホワイトバランスの調整を行います。

メニュー項目 細目と設定値 内容

Filter	White	
Memory

On	/	Off NDフィルターごとにホワイトバランスメモ
リー領域を設定する機能をOn/Offする。
On：NDフィルターごとにホワイトバランス

メモリーを設定する。

	 [メモ]
プリセットモードのときはCLEAR/1/2/3の4
組、バリアブルモードのときはCLEARとOn
の2組となります。

Off：各NDフィルターでホワイトバランスメ
モリーは共通。

Shooting>Offset	White
ホワイトバランスのオフセットの設定を行います。

メニュー項目 細目と設定値 内容
Offset	White	
<A>

On	/	Off メモリーAのホワイトバランスにオフセット
値を付加する（On）か付加しないか（Off）を
選択する。

Offset	Color	
Temp<A>

－99 ～＋99（±0） Offset	White	<A>がOnの場合に、メモ
リーAのホワイトバランスに付加する色温
度方向のオフセットを設定する。

［ご注意］
Offset	Color	Tempは、R/B	Gain操作時に±
99でクリップされるため、R/B	Gain値の正確な
Offset	Color	Temp値を表示できない場合があ
ります。

Offset	
Tint<A>

－99 ～＋99（±0） Offset	White	<A>がOnの場合に、メモ
リーAのホワイトバランスに付加するTint方
向のオフセットを設定する。

［ご注意］
Offset	Tintは、R/B	Gain操作時に±99でク
リップされるため、R/B	Gain値の正確なOffset	
Tint値を表示できない場合があります。

Offset	White	
<B>

On	/	Off メモリー Bのホワイトバランスにオフセット
値を付加する（On）か付加しないか（Off）を
選択する。
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Shooting>Offset	White
ホワイトバランスのオフセットの設定を行います。

メニュー項目 細目と設定値 内容
Offset	Color	
Temp<B>

－99 ～＋99（±0） Offset	White	<B>がOnの場合に、メモ
リー Bのホワイトバランスに付加する色温
度方向のオフセットを設定する。

［ご注意］
Offset	Color	Tempは、R/B	Gain操作時に±
99でクリップされるため、R/B	Gain値の正確な
Offset	Color	Temp値を表示できない場合があ
ります。

Offset	
Tint<B>

－99 ～＋99（±0） Offset	White	<B>がOnの場合に、メモ
リー Bのホワイトバランスに付加するTint方
向のオフセットを設定する。

［ご注意］
Offset	Tintは、R/B	Gain操作時に±99でク
リップされるため、R/B	Gain値の正確なOffset	
Tint値を表示できない場合があります。

Offset	White	
<ATW>

On	/	Off ATWのホワイトバランスにオフセット値を
付加する（On）か付加しないか（Off）を選択
する。

Offset	Color	
Temp	
<ATW>

－99 ～＋99（±0） Offset	White	<ATW>がOnの場合に、
ATWのホワイトバランスに付加する色温度
方向のオフセットを設定する。

Offset	
Tint<ATW>

－99 ～＋99（±0） Offset	White	<ATW>がOnの場合に、
ATWのホワイトバランスに付加するTint方
向のオフセットを設定する。

Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
AF	
Transition	
Speed

1(Slow)	/	2	/	3	/	4	/	5	/	6	/	7(Fast) オートフォーカス中の被写体が移り変わる
際のフォーカス駆動の速さを設定する。

AF	Subj.	
Shift	Sens.

1(Locked	On)	/	2	/	3	/	4	/	5(Responsive) オートフォーカス中の被写体の乗り移り感
度を設定する。

Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
Focus	Area Wide	/	Zone	/	Flexible	Spot オートフォーカス、プッシュオートフォーカ

ス（AF）の対象とする領域を設定する（36
ページ）。
Wide：	

映像全域からフォーカスを合わせる位
置を探す。

Zone：	
指定したゾーン内から自動でフォーカス
を合わせる点を探す。

Flexible	Spot：	
映像の指定した位置にフォーカスを合
わせる。

Focus	Area	
(AF-S)

Flexible	Spot プッシュオートフォーカス（AF-S）の対象と
する領域を設定する。

Face/Eye	
Detection	
AF

Face/Eye	Only	AF	/	Face/Eye	Priority	
AF	/	Off

顔/瞳検出AFの有効/無効を設定する。

Push	AF	
Mode

AF	/	Single-shot	AF(AF-S) マニュアルフォーカス中のプッシュオート
フォーカスのモードを設定する。

Touch	
Function	in	
MF

Tracking	AF/Spot	Focus マニュアルフォーカス時にタッチスクリーン
をタップしたときの動作を設定する。

AF	Assist On	/	Off Onに設定すると、オートフォーカス時、一
時的に手動でフォーカスを合わせることが
できる。
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Shooting>S&Q	Motion
スロー＆クイックモーションモードの設定を行います（48ページ）。

メニュー項目 細目と設定値 内容

Setting On	/	Off スロー＆クイックモーションモードをOn/
Offする。
Onのとき、以下の機能が無効になります。
	ˎ オートアイリス
	ˎ オートフォーカス

Frame	Rate 1fps	～	60fps	/	100fps	/	120fps	/		
150fps	/	180fps

スロー＆クイックモーション撮影時のフレー
ムレートを設定する。

［ご注意］
設定値の範囲は、選択されているシステム周波数
やコーデック、ビデオフォーマットによって異なり
ます。

Shooting>Monitor	LUT
モニター LUTの設定を行います。Cine	EIモードの撮影時のみ有効です。

メニュー項目 細目と設定値 内容

Category LUT	/	User	3D	LUT モニター LUTのカテゴリーを選択する。

LUT	Select 709(800%)	/	 	HG8009G40	/	 	
HG8009G33	/	S-Log3	/	s709

［メモ］

	HG8009G40および	 	HG8009G33の「 」は、
HG8009G40およびHG8009G33がLUTデータを
メタデータに記録できない（Cubeデータがない）
ことを示しています。

モニター LUTの種類を選択する。
709（800%）：	

ITU-R709	をベースにダイナミックレン
ジを800%	まで拡張した信号。

	HG8009G40：	
ダイナミックレンジ800%、ホワイトリ
ミット109%、18%グレーカードのビデ
オ出力40%	のハイパーガンマを使用し
た信号。

	HG8009G33：	
ダイナミックレンジ800%、ホワイトリ
ミット109%、18%グレーカードのビデ
オ出力33%	のハイパーガンマを使用し
た信号。

S-Log3：	
Cineon	Logカーブに近い、よりフィ
ルム特性に似せたダイナミックレンジ
1300%のLog信号。

s709：	
709(800%)相当のシネマ色。

［ご注意］
CategoryがLUTに設定されている場合のみ設定
できます。

Shooting>Monitor	LUT
モニター LUTの設定を行います。Cine	EIモードの撮影時のみ有効です。

メニュー項目 細目と設定値 内容

User	3D	LUT	
Select

内部メモリーに保存されているユーザー3D	
LUTのファイル名（01～ 16）

ユーザー3D	LUTファイルを選択する。

［ご注意］

ˎˎ CategoryがUser	3D	LUTに設定されている
場合のみ設定できます。
ˎˎ 本機がファームウェアバージョン4.0より前のと
きにユーザー3D	LUTファイルを読み込んだ場
合は、ファイル名の先頭に「 」が表示されます。
本機をファームウェアバージョン4.0に更新後、
あらためてユーザー3D	LUTファイルを読み込
んでください。

Shooting>Monitor	LUT	Setting
モニター LUTの調整を行います。Cine	EIモードの撮影時のみ有効です。

メニュー項目 細目と設定値 内容

Internal	Rec MLUT	On	/	MLUT	Off XQDメモリーカードに記録する主映像にモ
ニター LUTを適用するか選択する。

Monitor	Out MLUT	On	/	MLUT	Off XQDメモリーカードに記録する主映像以外
の記録映像や映像出力にモニター LUTを適
用するか選択する。

HD(Sub)	
Rec/Proxy

表示のみ 4K	&	HD	(Sub)	記録のHD（Sub）映像およ
びProxy記録映像に対するモニター LUTの
適用状態を表示する。

SDI1 表示のみ SDI1出力映像に対するモニター LUTの適用
状態を表示する。

SDI2 表示のみ SDI2出力映像に対するモニターLUTの適用
状態を表示する。

HDMI 表示のみ HDMI出力映像に対するモニター LUTの適
用状態を表示する。

VF/
Streaming

表示のみ ビューファインダーおよびストリーミングの
出力映像に対するモニター LUTの適用状態
を表示する。

Shooting>Monitor	3D	LUT
ユーザー3D	LUTデータに関する設定を行います。

メニュー項目 細目と設定値 内容
Load	from	
Utility	SD/
MS

ユーザー3D	LUTデータをSDカードから読
み込む。
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Shooting>Monitor	3D	LUT
ユーザー3D	LUTデータに関する設定を行います。

メニュー項目 細目と設定値 内容
Load	from	
Cloud(Private)

Execute	/	Cancel クラウドサービス「C3	Portal」（個人）にアッ
プロードしたユーザー3D	LUTデータを読
み込む。
Execute：実行

Load	from	
Cloud(Share)

Execute	/	Cancel クラウドサービス「C3	Portal」（共通）にアッ
プロードしたユーザー3D	LUTデータを読
み込む。
Execute：実行

Reset 任意のユーザー3D	LUTデータ設定をリセッ
トする

Reset	All Execute	/	Cancel すべてのユーザー3D	LUTデータ設定をリ
セットする。
Execute：実行

Shooting>Noise	Suppression
ノイズサプレスの設定を行います。

メニュー項目 細目と設定値 内容
Setting	
(SDR/HDR)

On	/	Off SDRおよびHDRモード時のノイズサプレス
機能をOn/Offする。

Level	
(SDR/HDR)

Low	/	Mid	/	High SDRおよびHDRモード時のノイズサプレス
のレベルを設定する。

Setting	
(Cine	EI)

On	/	Off Cine	EIモード時のノイズサプレス機能を
On/Offする。

Level	
(Cine	EI)

Low	/	Mid	/	High Cine	EIモード時のノイズサプレスのレベル
を設定する。

Shooting>Flicker	Reduce
フリッカー補正の設定を行います。

メニュー項目 細目と設定値 内容
Mode Auto	/	On	/	Off フリッカー補正モードを設定する。
Frequency 50Hz	/	60Hz フリッカーの原因となる照明の電源周波数

を設定する。

Shooting>SteadyShot
手ブレ補正の設定を行います。

メニュー項目 細目と設定値 内容
Setting Active	/	Standard	/	Off 手ブレ補正機能をOn/Offする。

［ご注意］
対応レンズ装着時のみ設定できます。

Shooting>Auto	Black	Balance
オートブラックバランスの設定を行います。

メニュー項目 細目と設定値 内容
Auto	Black	
Balance

Execute	/	Cancel オートブラックバランス機能を実行する。

［ご注意］

ˎˎ オートブラックバランス機能は、レンズにキャッ
プをつけて実行してください。
ˎˎ 記録中、カラーバー表示中は実行できません。
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Projectメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Project>Base	Setting
基本設定を行います。

メニュー項目 細目と設定値 内容
Shooting	
Mode

SDR	/	HDR	/	Cine	EI 撮影モードを設定する。（27ページ）

Project>Rec	Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Frequency 59.94	/	50	/	29.97	/	25	/	24	/	23.98 システム周波数を選択する。
Imager	Scan	
Mode

FF	6K	/	FFcrop	5K	/	S35	4K	/	FF	2K	/	
S35	2K	/	S16	2K

画素読み出し方法（全画素/加算）と、イメー
ジャーサイズ設定を組み合わせから選択す
る。

Codec RAW	/	RAW	&	XAVC-I	/		
RAW	&	XAVC-L	/		
RAW	&	MPEG	HD	422	/	XAVC-I	/	
XAVC-L	/	MPEG	HD	422

記録・再生モードを設定する。

［ご注意］
RAW設定は、拡張ユニット装着時のみ表示され
ます。

RAW	Output	
Format

FrequencyとImager	Scan	ModeとCodec
の設定に応じて変わる（58ページ）。

外部RAWレコーダーで記録するフォーマッ
トを設定する。

Project>Rec	Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video	
Format

FrequencyとCodecの設定に応じて変わる。録画フォーマットを設定する。
Frequency Codec 選択肢
59.94 RAW ―

RAW	&	
XAVC-I

1920×1080P

RAW	&	
XAVC-L

1920×1080P	50

RAW	&	
MPEG	
HD422

1920×1080i	50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P	50
1920×1080P	35
1920×1080i	50
1920×1080i	35
1920×1080i	25

MPEG	
HD422

1920×1080i	50
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Project>Rec	Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video	
Format

50 RAW ―
RAW	&	
XAVC-I

1920×1080P

RAW	&	
XAVC-L

1920×1080P	50

RAW	&	
MPEG	
HD422

1920×1080i	50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P	50
1920×1080P	35
1920×1080i	50
1920×1080i	35
1920×1080i	25

MPEG	
HD422

1920×1080i	50

29.97 RAW ―
RAW	&	
XAVC-I

1920×1080P

RAW	&	
XAVC-L

1920×1080P	50

RAW	&	
MPEG	
HD422

1920×1080P	50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P	50
1920×1080P	35

MPEG	
HD422

1920×1080P	50

Project>Rec	Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video	
Format

25 RAW ―
RAW	&	
XAVC-I

1920×1080P

RAW	&	
XAVC-L

1920×1080P	50

RAW	&	
MPEG	
HD422

1920×1080P	50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P	50
1920×1080P	35

MPEG	
HD422

1920×1080P	50

24 RAW ―
XAVC-I 4096×2160P

23.98 RAW ―
RAW	&	
XAVC-I

1920×1080P

RAW	&	
XAVC-L

1920×1080P	50

RAW	&	
MPEG	
HD422

1920×1080P	50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P	50
1920×1080P	35

MPEG	
HD422

1920×1080P	50
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Project>Cine	EI	Setting
Cine	EIモードの設定を行います。

メニュー項目 細目と設定値 内容
Color	Gamut S-Gamut3/SLog3	/		

S-Gamut3.Cine/SLog3
Cine	EIモード時の色域を設定する。
S-Gamut3/SLog3：	

Cine	EIモード時の色域をS-Gamut3
に設定する。

S-Gamut3.Cine/SLog3：	
Cine	EIモード時の色域をS-Gamut3.
Cineに設定する。

Embed	LUT	
File

On	/	Off LUTデータ（Cubeデータ）をクリップにメタ
データとして記録する設定をOn/Offする。

Project>HDR	Setting
HDRモードの設定を行います。

メニュー項目 細目と設定値 内容
VF	SDR	
Preview

On	/	Off HDRモード時でガンマ表示アシストが有効
なときビューファインダー映像を簡易的に
HDRからSDRに変換した映像で表示する
機能をOn/Offする。

［メモ］
Onのときはビューファインダー映像にSDR	Gain
が適用されます。

SDR	Gain 0dB	～	－15dB（－6dB） HDRモード時でVF	SDR	PreviewがOnの
ときのビューファインダーに適用されるSDR	
Gainの値を設定する。

Project>Simul	Rec
同時記録の設定を行います（51ページ）。

メニュー項目 細目と設定値 内容
Setting On	/	Off 本線同時記録機能のOn/Offと記録先メ

ディアを一括設定する。
Rec	Button	
Set

Rec	Button:[SlotA	SlotB]	Handle	
Rec	Button:[SlotA	SlotB]	/	
Rec	Button:[SlotA]	Handle	Rec	
Button:[SlotB]	/	Rec	Button:[SlotB]	
Handle	Rec	Button:[SlotA]

記録メディアごとに録画ボタンの割り当て
を行う。

Project>4K	&	HD	(Sub)	Rec
4K	&	HD	(Sub)記録の設定を行います。

メニュー項目 細目と設定値 内容
Setting On	/	Off 4K	&	HD	(Sub)	記録をOn/Offする。

Project>Proxy	Rec
プロキシ記録モードの設定を行います。

メニュー項目 細目と設定値 内容
Setting On	/	Off プロキシ記録モードをOn/Offする。

［ご注意］
ShootingメニューのS&Q	MotionのSetting

（91ページ）がOnのときはOnにできません。

Proxy	
Format

1920x1080(9Mbps)	/	1280x720(9Mbps)	/	
1280x720(6Mbps)	/	640x360(3Mbps)

プロキシファイル用の映像のサイズを設定
する。
1920×1080(9Mbps)に設定した場合、シ
ステム周波数が23.98のときはプログレッ
シブで、システム周波数が23.98以外の場
合はインターレースで記録される。
1920×1080(9Mbps)以外に設定した場合
は、システム周波数に関わらずプログレッ
シブで記録される。

Audio	
Channel

CH1/CH2	/	CH3/CH4 プロキシデータに記録するオーディオチャ
ンネルを選択する。

Chunk 30s	/	1min	/	2min プロキシファイルの分割記録時間を選択す
る。

Project>Interval	Rec
インターバルレックの設定を行います（50ページ）。

メニュー項目 細目と設定値 内容
Setting On	/	Off インターバルレックモードをOn/Offする。

（この設定をOnにすると、他の特殊記録
モードの設定がOffになる。）

Interval	
Time

1	/	2	/	3	/	4	/	5	/	6	/	7	/	8	/	9	/	10	/	15	/		
20	/	30	/	40	/	50	(s)
1	/	2	/	3	/	4	/	5	/	6	/	7	/	8	/	9	/	10	/	15	/		
20	/	30	/	40	/	50	(min)
1	/	2	/	3	/	4	/	6	/	12	/	24	(h)

Interval	Recの設定がOnの場合に、イン
ターバル撮影時の録画間隔（インターバル）
を設定する。

Number	of	
Frames

1frame	/	2frames	/	3frames	/		
6frames	/	9frames	/	12frames
選択されているビデオフォーマットのフレー
ム周波数によって設定値が異なります。
50P/59.94P：	
2frames	/	6frames	/	12frames

23.98P/25P/29.97P/50i/59.94i：	
1frame	/	3frames	/	6frames	/	
9frames

Interval	Recの設定がOnの場合に、イン
ターバル撮影時の1回の記録フレーム数を
設定する。
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Project>Interval	Rec
インターバルレックの設定を行います（50ページ）。

メニュー項目 細目と設定値 内容
Pre-Lighting Off	/	2s/	5s	/	10s インターバルレック撮影開始時にビデオラ

イトを点灯させる場合は何秒前に点灯させ
るかを選択する。

［メモ］
HVL-LBPC（別売）使用時のみ有効な設定です。

Project>Picture	Cache	Rec
ピクチャーキャッシュレックモードの設定を行います（50ページ）。

メニュー項目 細目と設定値 内容
Setting On	/	Off ピクチャーキャッシュレックモードをOn/

Offする。
Cache	Rec	
Time

設定値は記録フォーマットの設定により変わ
る。

ピクチャーキャッシュメモリーに画像を蓄
積する時間（キャッシュレック開始時にさか
のぼる時間）を設定する。

Project>SDI/HDMI	Rec	Control
SDI/HDMI記録制御の設定を行います。

メニュー項目 細目と設定値 内容
Setting Off	/	SDI/HDMI	Remote	I/F	/	Parallel	

Rec
SDI/HDMI出力信号による外部接続機器の
記録/停止制御を設定する。
Off：	

リモート制御しない。
SDI/HDMI	Remote	I/F：	

本機にメディアを挿入していない状態
で、外部接続機器の記録/停止制御が
可能。本機のメディアとフレーム精度で
同期しない。

Parallel	Rec：	
本機にメディアを挿入している状態で、
外部接続機器の記録/停止制御が可
能。本機のメディアとフレーム精度で同
期する。

Project>Assignable	Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1>	～	<10>、
Focus	Hold	
Button

Off	/	Base	ISO/Sensitivity	/	AGC	/	
Push	AGC	/	ND	Filter	Position	/	Auto	
ND	Filter	/	Push	Auto	ND	/	Auto	Iris	/	
Push	Auto	Iris	/	Auto	Shutter	/	Auto	
Exposure	Level	/	Backlight	/	Spotlight	
/	Preset	White	Select	/	ATW	/	ATW	
Hold	/	AF	Speed/Sens.	/	Focus	Zero	
Marker	/	Focus	Setting	/	Focus	Area	/	
Focus	Area(AF-S)	/	Face/Eye	Detection	
AF	/	Push	AF	Mode	/	Push	AF/Push	MF	
/	Focus	Hold	/	Focus	Magnifier	x3/x6	
/	Focus	Magnifier	x3	/	Focus	Magnifier	
x6	/	S&Q	Motion	/	SteadyShot	/	Crop	
Select	/	Rec	/	Picture	Cache	Rec	/	Rec	
Review	/	Last	Clip	Del.	/	Shot	Mark1	/	
Shot	Mark2	/	Clip	Flag	OK	/	Clip	Flag	
NG	/	Clip	Flag	Keep	/	Color	Bars	/	
Tally	[Front]	/	CALL	/	DURATION/TC/
U-BIT	/	Display	/	Lens	Info	/	Video	
Signal	Monitor	/	Marker	/	VF	Adjust	
/	VF	Mode	/	Gamma	Display	Assist	/	
Peaking	/	Zebra	/	Audio	Monitor	CH	/	
Audio	Mon.	CH	Switch	/	Thumbnail	/	
Touch	Operation	/	Handle	Zoom	/	NFC	
/	Network	Client	Mode	/	Auto	Upload	
(Proxy)	/	Direct	Menu	/	User	Menu	/	
Menu

アサイナブルボタンに機能を割り当てる。
Base	ISO/Sensitivity：	

イメージセンサーの基準感度の切り替
え

AGC：	
AGC機能のOn/Off切り替え

Push	AGC：	
ボタンを押している間、AGC機能を有
効にする

ND	Filter	Position：	
NDフィルターの切り替え

Auto	ND	Filter：	
オートNDフィルターのOn/Off即時切
り替え

Push	Auto	ND：	
ボタンを押している間、オートNDフィ
ルター機能を有効にする

Auto	Iris：	
アイリス機能のOn/Off切り替え

Push	Auto	Iris：	
ボタンを押している間、オートアイリス
機能を有効にする

Auto	Shutter：	
オートシャッター機能のOn/Off切り替
え

Auto	Exposure	Level：	
Auto	Exposure	Levelのダイレクトメ
ニューを開始/終了する

Backlight：	
Backlight/Standard切り替え

Spotlight：	
Spotlight/Standard切り替え

Preset	White	Select：	
ホワイトバランス	プリセットモード値の
切り替え

ATW：	
ATW機能のOn/Off切り替え

ATW	Hold：	
ATW機能の動作を一時ホールド
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Project>Assignable	Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1>	～	<10>、
Focus	Hold	
Button

AF	Speed/Sens.:	
AFトランジション速度の設定とAF乗り
移り感度の設定の切り替え

Focus	Zero	Marker:	
現在のフォーカス位置を基準位置に設
定する

Focus	Setting：	
フォーカスエリアの設定を行う

Focus	Area：	
AF、プッシュ AF用のフォーカスエリア
の設定を行う

Focus	Area(AF-S)	：	
プッシュ AF(AF-S)用のフォーカスエリ
アの設定を行う

Face/Eye	Detection	AF：	
顔/瞳検出AFの設定を切り替える

Push	AF	Mode：	
Push	AFのモード設定を切り替える

Push	AF/Push	MF：	
フォーカスモードがMF時、ボタンを押
している間はAFになる	
フォーカスモードがAF時、ボタンを押
している間はMFになる

Focus	Hold：	
フォーカスモードがAF時、ボタンを押
している間フォーカスを固定する

Focus	Magnifier	x3/x6：
Focus	Magnifier	x3：
Focus	Magnifier	x6：	

ピント拡大機能のOn/Off切り替え
S&Q	Motion：	

スロー＆クイックモーション機能のOn/
Off切り替え	
長押しで記録フレームレートの設定

SteadyShot：	
Active	/	Standard	/	Off切り替え

Crop	Select:	
イメージャースキャンモードの設定切り
替え

Rec：	
記録の開始または停止

Project>Assignable	Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1>	～	<10>、
Focus	Hold	
Button

Picture	Cache	Rec：	
ピクチャーキャッシュレックモードの
On/Off切り替え

Rec	Review：	
レックレビューのOn/Off切り替え

Last	Clip	Del.：	
ラストクリップデリート（リテイク）機能
の実行

Shot	Mark1：	
Add	Shot	Mark1を実行する

Shot	Mark2：	
Add	Shot	Mark2を実行する

Clip	Flag	OK：	
Add	OKを実行する	
2回続けて押すとDelete	Clip	Flagを実
行する

Clip	Flag	NG：	
Add	NGを実行する	
2回続けて押すとDelete	Clip	Flagを実
行する

Clip	Flag	Keep：	
Add	Keepを実行する	
2回続けて押すとDelete	Clip	Flagを実
行する

Color	Bars：	
カラーバーのOn/Off切り替え

Tally	[Front]：	
記録/タリーランプ（フロント）の点灯、
点滅機能のOn/Off切り替え

CALL:	
ボタンを押している間、本機に接続し
たリモートコントロールパネルのタリー
ランプにコールを表示する

DURATION/TC/U-BIT：	
Time	Code/Users	Bit/Duration切り
替え

Display：	
画面表示のOn/Off切り替え

Lens	Info：	
被写界深度表示の切り替え
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Project>Assignable	Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1>	～	<10>、
Focus	Hold	
Button

Video	Signal	Monitor：	
映像信号モニター（波形モニターなど）
の表示切り替え

Marker：	
マーカー機能のOn/Off切り替え

VF	Adjust：	
ビューファインダー画面の明るさ調節用
レベルバーの表示

VF	Mode：	
ビューファインダー画面のカラー/モノ
クロ切り替え

Gamma	Display	Assist：	
ガンマ表示アシスト機能の切り替え

Peaking：	
ピーキング機能のOn/Off切り替え

Zebra：	
ゼブラ機能のOn/Off切り替え

Audio	Monitor	CH：	
音声チャンネルの組み合わせの切り替
え（54ページ）

Audio	Mon.	CH	Switch：	
音声チャンネルの組み合わせの切り替
え（54ページ）

Thumbnail：	
サムネイル画面の開始/終了

Touch	Operation:	
タッチ操作のOn/Off切り替え

Handle	Zoom：	
ハンドルズーム動作の切り替え

NFC：	
NFC機能の実行

Network	Client	Mode：	
ネットワーククライアントモードのOn/
Off切り替え

Auto	Upload	(Proxy)：	
プロキシファイルの自動転送のOn/
Off/Chunk切り替え

Direct	Menu：	
ダイレクトメニューの開始/終了

Project>Assignable	Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1>	～	<10>、
Focus	Hold	
Button

User	Menu：	
Userメニューの開始/終了

Menu：	
セットアップメニューの開始/終了

Project>Assignable	Dial
アサイナブルダイヤルへの機能割り当て、回転方向の設定を行います。

メニュー項目 細目と設定値 内容
Assignable	
Dial

Off	/	ISO/Gain/EI	/	ND	Filter	/	IRIS	/	
Audio	Input	Level

アサイナブルダイヤルに機能を割り当てる。
ISO/Gain/EI：	

ゲインまたはEIを調節する
ND	Filter：	

NDフィルターを調節する
IRIS：	

アイリスを調節する
Audio	Input	Level：	

録音レベルを調節する
Assignable	
Dial	
Direction

Normal	/	Opposite アサイナブルダイヤルの回転方向を設定す
る。
Normal：順方向に回転する
Opposite：逆方向に回転する

Project>Multi	Function	Dial
マルチファンクションダイヤルへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
Default	
Function

Off	/	IRIS	/	ISO/Gain/EI	/	Audio	Input	
Level

マルチファンクションダイヤルのデフォルト
機能を割り当てる。
IRIS：	

アイリスを調節する
ISO/Gain/EI：	

ゲインまたはEIを調節する
Audio	Input	Level：	

録音レベルを調節する
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Project>User	File
ユーザーファイルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容
Load	from	
Utility	SD/
MS

Execute	/	Cancel ユーザーファイルの設定をSDカードから読
み込む。
Execute：実行

Save	to	
Utility	SD/
MS

Execute	/	Cancel ユーザーファイルの設定をSDカードへ保存
する。
Execute：実行

File	ID ユーザーファイルのFile	ID表示と編集を行
う画面を表示する。

Load	
Customize	
Data

On	/	Off Load	from	Utility	SD/MSの実行時に
Userメニューの構成カスタマイズ情報を読
み込むかどうかを設定する。

Load	White	
Data

On	/	Off Load	from	Utility	SD/MSの実行時にホワ
イトバランス情報を読み込むかどうかを設
定する。

Project>All	File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Load	from	
Utility	SD/
MS

Execute	/	Cancel Allファイルを読み込む。
Execute：実行

Load	from	
Cloud(Private)

Execute	/	Cancel クラウドサービス「C3	Portal」（個人）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Load	from	
Cloud(Share)

Execute	/	Cancel クラウドサービス「C3	Portal」（共通）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Save	to	
Utility	SD/
MS

Execute	/	Cancel Allファイルを保存する。
Execute：実行

Save	to	
Cloud(Private)

Execute	/	Cancel Allファイルの設定をクラウドサービス「C3	
Portal」（個人）に保存する。
Execute：実行

Save	to	
Cloud(Share)

Execute	/	Cancel Allファイルの設定をクラウドサービス「C3	
Portal」（共通）に保存する。
Execute：実行

File	ID ファイルに名前を付ける。

Project>All	File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Load	
Network	
Data

On	/	Off Load	from	Utility	SD/MS、Load	
from	Cloud(Private)およびLoad	from	
Cloud(Share)の実行時に、Networkメ
ニューの設定情報を読み込むかどうかを設
定する。

Project>Planning	Metadata
プランニングメタデータの操作に関する設定を行います。

メニュー項目 細目と設定値 内容
Load	from	
Media(A)
または
Load	from	
Media(B)

Execute	/	Cancel スロットAまたはBのメモリーカードからプ
ランニングメタデータを読み込む。
Executeを選択するとスロットAまたはBの
メモリーカードに保存されているプランニ
ングメタデータのファイルリストが表示され
る。ファイルを選択し、Load	→	Execute
で読み込み実行。

［ご注意］

ˎˎ ファイルリストには、ファイルは64個まで表
示されます。プランニングメタデータファイル
の総数が64個以下であっても、メモリーカー
ド内のプランニングメタデータファイルと同じ
ディレクトリー（XDROOT/General/Sony/
Planning）に512個以上のファイルがあると、
すべてのプランニングメタデータファイルが表
示されないことがあります。
ˎˎ 読み込みを開始した後は、完了メッセージが
表示されるまで、メモリーカードを抜かないで
ください。
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Project>Planning	Metadata
プランニングメタデータの操作に関する設定を行います。

メニュー項目 細目と設定値 内容
Properties Execute	/	Cancel Executeを選択すると本機のメモリーに読

み込まれているプランニングメタデータの
内容を表示する。
File	Name：	

ファイル名
Assign	ID：	

アサインID
Created：	

ファイルの生成日時
Modified：	

ファイルの最終更新日時
Modified	by：	

ファイルの更新者
Title1：	

ファイルで指定されたTitle1の内容
（ASCII形式のクリップ名）

Title2：	
ファイルで指定されたTitle2の内容

（UTF-8形式のクリップ名）
Material	Group：	

マテリアルグループ（同じプランニング
メタデータを使用して収録したクリップ
群）の数

Shot	Mark0 ～ 9：	
ショットマーク0 ～ 9の名前

Clear	
Memory

Execute	/	Cancel Executeを選択すると本機のメモリーに読
み込まれているプランニングメタデータの
内容を消去する。

Clip	Name	
Display

Title1(ASCII)	/	Title2(UTF-8) プランニングメタデータでクリップ名を設定
する場合の表示形式を設定する。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Paint>HDR	Paint	Setting
ハイダイナミックレンジ（HDR）に関する設定を行います。

メニュー項目 細目と設定値 内容
HLG	Look Natural	/	Live Shooting	ModeがHDRのときのHLGの種

類を設定する。
Natural：	

ITU-R	BT.2100(HLG)に準拠した特性
があります。

Live：	
ITU-R	BT.2100(HLG)に準拠し、より
HDRの効果を引き出す特性がありま
す。

［ご注意］
Liveの設定を使用すると、ノイズレベルが上がる
ことがあります。

HDR	Black	
Offset

－95	～＋103（±0） Shooting	ModeがHDRのときのSDR設定
（Master	Black）に対するHDRのブラック
のオフセットを設定する。

HDR	Knee On	/	Off Shooting	ModeがHDRのときのHDR信号
に対するニー補正機能をOn/Offする。

HDR	Knee	
Point

－99	～＋99（±0） HDR	KneeがOnのときにHDR信号にかけ
るニーポイントを設定する。

HDR	Knee	
Slope

－99	～＋99（±0） HDR	KneeがOnのときにHDR信号にかけ
るニースロープを設定する。

Paint>Black
ブラックの設定を行います。

メニュー項目 細目と設定値 内容
Master	
Black

－99.0	～	+99.0（±0.0） マスターブラックレベルを設定する。

R	Black －99.0	～	+99.0（±0.0） Rブラックレベルを設定する。
B	Black －99.0	～	+99.0（±0.0） Bブラックレベルを設定する。

Paint>Gamma
ガンマ補正の設定を行います。

メニュー項目 細目と設定値 内容
Setting On	/	Off ガンマ補正機能をOn/Offする。
Step	
Gamma

0.35 ～ 0.45～ 0.90 ガンマ補正値を0.05ステップで設定する。

Master	
Gamma

－99 ～＋99（±0） マスターガンマレベルを設定する。

R	Gamma －99 ～＋99（±0） Rガンマレベルを設定する。
G	Gamma －99 ～＋99（±0） Gガンマレベルを設定する。
B	Gamma －99 ～＋99（±0） Bガンマレベルを設定する。
Gamma	
Category

Original	/	STD	/	HG	/	S-Log3 オリジナルガンマ（Original）、スタンダー
ドガンマ（STD）、ハイパーガンマ（HG）、
S-Log3を選択する。

Gamma	
Select

Gamma	CategoryがSTDのとき
STD1	DVW	/	STD2×4.5	/		
STD3×3.5	/	STD4	240M	/		
STD5	R709	/	STD6×5.0

Gamma	CategoryがHGのとき
HG1	3250G36	/	HG2	4600G30	/	
HG3	3259G40	/	HG4	4609G33	/	
HG7	8009G40	/	HG8	8009G33

Gamma	CategoryがS-Log3のとき
S-Log3

Gamma	CategoryがOriginalのとき
S-Cinetone

ガンマ補正に使用するガンマテーブルを選
択する。
ハイパーガンマとS-Log3の詳細は次のとお
りです。

名称 ダイナミック
レンジ

ホワイト
リミット

18%グレー
カードのビデ
オ出力（ビデオ
入力20%）

HG1	3250G36 325% 100% 36%
HG2	
4600G30

460% 100% 30%

HG3	3259G40 325% 109% 40%
HG4	4609G33 460% 109% 33%
HG7	
8009G40

800% 109% 40%

HG8	
8009G33

800% 109% 33%

S-Log3 1300% – 41%

Paintメニュー
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Paint>Black Gamma
ブラックガンマ補正の設定を行います。

メニュー項目 細目と設定値 内容
Setting On / Off ブラックガンマ補正機能をOn/Offする。

（Gamma設定のGamma Categoryが
STDのときのみ有効）

［ご注意］
Black GammaとKneeのKnee Saturationの機
能は同時に使用できません。

Range Low / L.Mid / H.Mid ブラックガンマ補正の有効範囲を選択す
る。

Master Black 
Gamma

－99 ～＋99（±0） マスターブラックガンマレベルを設定する。

Paint>Knee
ニー補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off ニー補正機能をOn/Offする。
（Gamma設定のGamma Categoryが
STDのときのみ有効）

Auto Knee On / Off オートニー機能をOn/Offする。
Point 75% ～ 109%（90%） ニーポイントを設定する。
Slope －99 ～＋99（±0） ニースロープを設定する。
Knee 
Saturation

On / Off Onにすると、ニーサチュレーション（ニーポ
イントより上の部分の色つき具合）の調整が
有効になる。

［ご注意］
Black GammaとKneeのKnee Saturationの機
能は同時に使用できません。

Knee 
Saturation 
Level

－99 ～＋99（±0） ニーポイントより上の部分の色つき具合
（ニーサチュレーション）を調整する。

Paint>White Clip
ホワイトクリップ調整の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off ホワイトクリップ調整機能をOn/Offする。
（Gamma設定のGamma Categoryが
STDのときのみ有効）

［ご注意］
本設定は電源を切るとOnに戻ります。永続的に
Offしたい場合はLevelを109%に設定してくださ
い。

Level 90.0% ～ 109.0% ホワイトクリップレベルを設定する。

Paint>Detail(4K/QFHD)
ディテール(4K/QFHD)調整の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off ディテール調整機能をOn/Offする。
Level －99 ～＋99（±0） ディテールレベルを設定する。
H/V Ratio －99 ～＋99（±0） HディテールレベルとVディテールレベルの

ミックス比を設定する。
Crispening －99 ～＋99（±0） クリスプニングレベルを設定する。
Frequency －99 ～＋99（±0） ディテールの中心周波数（ディテールの太

さ）を設定する。
中心周波数を高くするとディテールは細く
なり、中心周波数を低くするとディテール
は太くなる。

Knee 
Aperture

On / Off ニーアパーチャー補正機能をOn/Offする。

Knee 
Aperture 
Level

－99 ～＋99（±0） ニーアパーチャーレベルを設定する。

White Limit －99 ～＋99（±0） 白側のディテールリミッターを設定する。
Black Limit －99 ～＋99（±0） 黒側のディテールリミッターを設定する。
V Detail 
Creation

NAM / Y / G / G+R 垂直ディテールを生成するための元とする
信号を、NAM（GとRのどちらか大きい方）、
Y、G、G+Rのいずれかから選択する。

Paint>Detail(HD)
ディテール（HD）調整の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off ディテール調整機能をOn/Offする。
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Paint>Detail(HD)
ディテール（HD）調整の設定を行います。

メニュー項目 細目と設定値 内容

Level －99	～	+99（±0） ディテールレベルを設定する。
H/V	Ratio －99	～	+99（±0） HディテールレベルとVディテールレベルの

ミックス比を設定する。
Crispening －99	～	+99（±0） クリスプニングレベルを設定する。
Frequency －99	～	+99（±0） ディテールの中心周波数（ディテールの太

さ）を設定する。
中心周波数を高くするとディテールは細く
なり、中心周波数を低くするとディテール
は太くなる。

Knee	
Aperture

On	/	Off ニーアパーチャー補正機能をOn/Offする。

Knee	
Aperture	
Level

－99	～	+99（±0） ニーアパーチャーレベルを設定する。

White	Limit －99	～	+99（±0） 白側のディテールリミッターを設定する。
Black	Limit －99	～	+99（±0） 黒側のディテールリミッターを設定する。
V	Detail	
Creation

NAM	/	Y	/	G	/	G+R 垂直ディテールを生成するための元とする
信号を、NAM（GとRのどちらか大きい方）、
Y、G、G+Rのいずれかから選択する。

Paint>Skin	Detail
スキンディテール補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off スキンディテール補正機能をOn/Offする。
Area	
Detection

Execute	/	Cancel スキンディテール補正の対象となる色を検
出する。
Execute：実行

Area	
Indication

On	/	Off スキンディテール補正の対象となる色のエ
リアにゼブラを表示する機能をOn/Offす
る。

Level －99 ～＋99（±0） スキンディテールレベルを設定する。
Saturation －99 ～＋99（±0） スキンディテール補正の対象となる色の飽

和度（サチュレーション）を設定する。
Hue 0～359 スキンディテール補正の対象となる色の色

相（ヒュー）を設定する。
Width 0 ～ 90（40） スキンディテール補正の対象となる色の色

相の範囲を設定する。

Paint>Aperture
アパーチャー補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off Onにすると、アパーチャー補正（ビデオ信
号に、高周波数のアパーチャー信号を加え
て周波数特性による劣化を補正し、解像度
を高める処理）が有効になる。

Level －99 ～＋99（±0） アパーチャー補正のレベルを設定する。

Paint>Matrix
マトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容
Setting On	/	Off マトリクス補正機能をOn/Offする。
Adaptive	
Matrix

On	/	Off アダプティブマトリクス機能をOn/Offす
る。

Preset	
Matrix

On	/	Off プリセットマトリクス機能をOn/Offする。

Preset	
Select

S-Cinetone	/	Standard	/	FL	Light	/	
Cinema	/	BT.709	/	BT.2020

プリセットマトリクスを選択する。

User	Matrix On	/	Off ユーザーマトリクス補正機能をOn/Offす
る。

User	Matrix	
Level

－99 ～＋99（±0） 映像全域の色の濃さ（サチュレーション）を
調整する。

User	Matrix	
Phase

－99 ～＋99（±0） 映像全域の色合い（フェーズ）を調整する。

User	Matrix	
R-G

－99 ～＋99（±0） R-Gのユーザーマトリクスを任意に設定す
る。

User	Matrix	
R-B

－99 ～＋99（±0） R-Bのユーザーマトリクスを任意に設定す
る。

User	Matrix	
G-R

－99 ～＋99（±0） G-Rのユーザーマトリクスを任意に設定す
る。

User	Matrix	
G-B

－99 ～＋99（±0） G-Bのユーザーマトリクスを任意に設定す
る。

User	Matrix	
B-R

－99 ～＋99（±0） B-Rのユーザーマトリクスを任意に設定す
る。

User	Matrix	
B-G

－99 ～＋99（±0） B-Gのユーザーマトリクスを任意に設定す
る。
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Paint>Multi	Matrix
マルチマトリクス補正の設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off Multi	Matrix補正機能をOn/Offする。
Area	
Indication

On	/	Off Area	Indication機能をOn/Offする。

Color	
Detection

Execute	/	Cancel Multi	Matrix補正の対象となる色を検出す
る。

Reset Execute	/	Cancel 各軸の色の色相（ヒュー）と飽和度（サチュ
レーション）をすべて初期値にする。

Axis B	/	B+	/	MG－	/	MG	/	MG+	/	R	/	R+	/		
YL－	/	YL	/	YL+	/	G－	/	G	/	G+	/	CY	/		
CY+	/	B－

Axisを選択する。

Hue －99 ～＋99（±0） Multi	Matrix補正の対象となる色の色相
（ヒュー）を設定する。

Saturation －99 ～＋99（±0） Multi	Matrix補正の対象となる色の飽和度
（サチュレーション）を設定する。

Paint>Scene	File
Sceneファイルに関する設定を行います。

メニュー項目 細目と設定値 内容

Recall	
Internal	
Memory

内蔵メモリーからSceneファイルを読み込
む。

Store	
Internal	
Memory

Execute	/	Cancel 内蔵メモリーにSceneファイルを保存する。
Execute	:	実行

Load	from	
Utility	SD/
MS

Execute	/	Cancel Executeを選択するとSDカードから読み込
む。
Execute：実行

Save	to	
Utility	SD/
MS

Execute	/	Cancel Executeを選択するとSDカードへ保存す
る。
Execute：実行

File	ID ファイルに名前を付ける。
Scene	White	
Data

On	/	Off Scene	Fileを読み込む際にホワイトバラン
スのデータを反映させるかどうかを設定す
る。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

TC/Media>Timecode
タイムコードの設定を行います。

メニュー項目 細目と設定値 内容

Mode Preset	/	Regen	/	Clock タイムコードの歩進モードを設定する。
Preset（プリセット）：	

設定された値から歩進する。
Regen（リジェネ）：	

前のクリップのタイムコードに続けて歩
進する。

Clock（クロック）：	
内蔵時計をタイムコードとして使用す
る。

Run Rec	Run	/	Free	Run Rec	Run：記録時のみ歩進する。
Free	Run：記録に関係なく常に歩進する。

Setting タイムコードを任意の値に設定する。
SET：決定

Reset Execute	/	Cancel タイムコードを00:00:00:00にリセットす
る。
Execute：実行

TC	Format DF	/	NDF タイムコードのフォーマットを設定する。
DF：ドロップフレーム
NDF：ノンドロップフレーム

TC/Media>TC	Display
タイムデータ表示の設定を行います。

メニュー項目 細目と設定値 内容

Display	
Select

Timecode	/	Users	Bit	/	Duration タイムデータの表示を切り替える。

TC/Media>Users	Bit
ユーザービットに関する設定を行います。

メニュー項目 細目と設定値 内容

Mode Fix	/	Time ユーザービットのモードを設定する。
Fix：ユーザービットに任意の固定値を使用

する。
Time：ユーザービットに現在の時分秒を使

用する。
Setting ユーザービットを任意の値に設定する。

TC/Media>HDMI	TC	Out
HDMI利用時のタイムコード出力に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off HDMIを利用して、他の業務用機器にタイ
ムコードを出力するかどうかを設定する。

TC/Media>Clip	Name	Format
クリップの名称や削除に関する設定を行います。

メニュー項目 細目と設定値 内容

Auto	
Naming

Cam	ID	+	Reel#	/	Title	/	Plan クリップ名の設定方法を選択する。
Cam	ID	+	Reel#:	

Camera	ID	+	Reel	Number	+	Shot	
Number	+	年月日	+	ランダム文字列

Title:	
Title	Prefixで設定した任意文字列	+	
クリップ番号

Plan:	
プランニングメタデータで設定したク
リップ名がある場合はその名称、ない
場合はTitle	Prefixで設定した名称＋ク
リップ番号

Camera	ID A	～	Z クリップ名の生成時のカメラIDを設定する。

［ご注意］
Auto	NamingがCam	ID	+	Reel#に設定されて
いる場合のみ設定できます。

Reel	
Number

001	～	999 クリップ名の生成時のReel	Numberの数
字部分を設定する。

［ご注意］
Auto	NamingがCam	ID	+	Reel#に設定されて
いる場合のみ設定できます。

Camera	
Position

C	/	L	/	R クリップ名の生成時のShot	Numberの先
頭文字部分を選択する。

［ご注意］
Auto	NamingがCam	ID	+	Reel#に設定されて
いる場合のみ設定できます。

TC/Mediaメニュー
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TC/Media>Clip	Name	Format
クリップの名称や削除に関する設定を行います。

メニュー項目 細目と設定値 内容

Title	Prefix nnn_（nnnはシリアル番号の下3桁）
（最大7文字表示）

クリップ名のタイトル部分（4～ 46文字）を
設定する。
文字列の入力画面を呼び出す。

文字列の入力画面の構成
文字選択エリア（3行）:	

Title	Prefixエリアのカーソル位置に挿
入する文字を選択する。	
!#$%()+.-.;=@[	]^_~0123456789	
abcdefghijklmnopqrstuvwxyz	
ABCDEFGHIJKLMNOPQRSTUVW	
XYZ

カーソル操作エリア（1行）：	
Space:	カーソル位置にスペースを挿入
する。	
:	カーソルを左に移動する。	
:	カーソルを右に移動する。	
BS:	カーソル位置の左の文字を削除す
る。

Title	Prefixエリア（1行）：	
タイトルを入力するエリア。

タイトルを設定するには
1.	 矢印ボタンを使って、文字選択エリア

からTitle	Prefixエリアのカーソル位置
に入れる文字を選択（ハイライト表示）
し、SETボタンを押す。（選択した文字
が入り、カーソルが右に移動する。）

2.	 手順1を繰り返し、タイトルを設定する。
（必要に応じて、BSを使用する。）

3.	 タイトル名の設定が終わったら、Done
を選択して文字列の入力画面を閉じる。

Number	Set Auto	NamingがTitleのとき	
0001	～	9999

Auto	NamingがPlanのとき	
00001	～	99999

クリップ名の最後の番号部分（4桁）を設定
する。
プランニングメタデータを使用する場合は、
5桁になります。

TC/Media>Update	Media
メモリーカード内の管理ファイルを更新します。

メニュー項目 細目と設定値 内容

Media(A) Execute	/	Cancel スロットAのXQDメモリーカード内の管理
ファイルを更新する。
Execute：実行

Media(B) Execute	/	Cancel スロットBのXQDメモリーカード内の管理
ファイルを更新する。
Execute：実行

TC/Media>Format	Media
メモリーカードを初期化します。

メニュー項目 細目と設定値 内容

Media(A) Execute	/	Cancel スロットAのXQDメモリーカードを初期化す
る。
Execute：実行

Media(B) Execute	/	Cancel スロットBのXQDメモリーカードを初期化す
る。
Execute：実行

Utility	SD/
MS

Execute	/	Cancel UTILITY	SDカードを初期化する。
Execute：実行
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Monitoring>Output	On/Off
映像出力の設定を行います。

メニュー項目 細目と設定値 内容

SDI1 On	/	Off SDI1出力をOn/Offする。
SDI2 On	/	Off SDI2出力をOn/Offする。
HDMI On	/	Off HDMI出力をOn/Offする。

Monitoring>Output	Format
出力フォーマットの設定を行います。

メニュー項目 細目と設定値 内容

SDI1 設定項目について詳しくは、「出力のフォー
マットと制限」（132ページ）をご覧くださ
い。

SDIとHDMI出力の解像度設定をする。

［ご注意］
ピクチャーキャッシュレック中はOutput	Format
の設定を変更できない場合があります。この場合、
一度ピクチャーキャッシュレックをOffにしてから
変更操作を行ってください。

SDI2
HDMI
REF

Monitoring>Output	Setting
出力変換モードの設定を行います。

メニュー項目 細目と設定値 内容

RAW	to	HD	
Conv.

Edge	Crop	/	Letter	Box 17:9映像をHD映像出力するときの変換
モードを設定する。

Monitoring>Output	Display
出力信号の設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off SDI出力信号やHDMI出力信号にメニュー
やステータスを重畳するか選択する。

SDI1 Output	Formatの設定により制限があり
ます。詳しくは「出力のフォーマットと制限」

（132ページ）をご覧ください。

SDI1出力信号へのメニューやステータス重
畳の状態を表示する。

SDI2 SDI2出力信号へのメニューやステータス重
畳の状態を表示する。

HDMI HDMI出力信号へのメニューやステータス
重畳の状態を表示する。

Monitoring>Display	On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

Network	
Status

On	/	Off ビューファインダー画面に表示する項目を
選択する。

File	Transfer	
Status

On	/	Off

NCM/
Streaming	
Status

On	/	Off

Rec/Play	
Status

On	/	Off

RAW	Output	
Control	
Status

On	/	Off

Tally On	/	Off
Battery	
Remain

On	/	Off

Focus	Mode On	/	Off
Focus	
Position

On	/	Off

Focus	
Marker

On	/	Off

Focus	Area	
Indicator

On	/	Off

Focus	Area	
Ind.(AF-S)

On	/	Off

Face/Eye	
Detection	
Frame

On	/	Off

Lens	Info On	/	Off
Imager	Scan	
Mode

On	/	Off

Rec	Format On	/	Off
Frame	Rate On	/	Off
Zoom	
Position

On	/	Off

UWP	RF	
Level

On	/	Off

Monitoringメニュー
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Monitoring>Display	On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

GPS On	/	Off
SteadyShot On	/	Off
Gamma/
LUT

On	/	Off

SDI/HDMI	
Rec	Control

On	/	Off

Gamma	
Display	
Assist

On	/	Off

Proxy	Status On	/	Off
Base	ISO/
Sensitivity

On	/	Off

Media	
Status

On	/	Off

Video	Signal	
Monitor

Off	/	Waveform	/	Vector	/	Histogram

Clip	Name On	/	Off
White	
Balance

On	/	Off

Scene	File On	/	Off
Focus	
Indicator

On	/	Off

Auto	
Exposure	
Mode

On	/	Off

Auto	
Exposure	
Level

On	/	Off

Timecode On	/	Off
ND	Filter On	/	Off
Iris On	/	Off
ISO/Gain/EI On	/	Off
Shutter On	/	Off
Level	Gauge On	/	Off

Monitoring>Display	On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

Audio	Level	
Meter

On	/	Off

Video	Level	
Warning

On	/	Off

Clip	Number On	/	Off
Notice	
Message

On	/	Off

Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off すべてのマーカー表示をまとめてOn/Offす
る。

Color White	/	Yellow	/	Cyan	/	Green	/	
Magenta	/	Red	/	Blue

マーカーの信号色を選択する。

Center	
Marker

1	/	2	/	3	/	4	/	Off センターマーカーを選択する。

Safety	Zone On	/	Off セーフティーゾーンマーカーをOn/Offする。
Safety	Area 80%	/	90%	/	92.5%	/	95% セーフティーゾーンマーカーの大きさ（画面

全体に対する比率）を選択する。
Aspect	
Marker

Line	/	Mask	/	Off アスペクトマーカーの比を選択する。

Aspect	
Mask

0 ～ 15（12） マーカー外側のビデオ信号のレベルを設定
する。

Aspect	
Safety	Zone

On	/	Off アスペクトセーフティーゾーンマーカーを
On/Offする。

Aspect	
Safety	Area

80%	/	90%	/	92.5%	/	95% アスペクトセーフティーゾーンマーカーの大
きさ（画面全体に対する比率）を選択する。

Aspect	
Select

4:3	/	13:9	/	14:9	/	15:9	/	16:9	/	17:9	/	
1.66:1	/	1.85:1	/	2.35:1	/	2.39:1

アスペクトマーカーを表示するときのモード
を設定する。

［ご注意］
MonitoringメニューのVF	SettingのDe-
Squeeze（109ページ）がOff(1.0x)以外に設定
されている場合は、本設定は2.39:1に固定され
ます。

Guide	
Frame

On	/	Off ガイドフレーム表示をOn/Offする。
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Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

100%	
Marker

On	/	Off 100%マーカーをOn/Offする。

User	Box On	/	Off ユーザーボックスマーカーの表示をOn/Off
する。

User	Box	
Width

3 ～ 479（240） ユーザーボックスマーカーの幅（中心から左
右端までの距離）を設定する。

User	Box	
Height

3 ～269（135） ユーザーボックスマーカーの高さ（中心から
上下端までの距離）を設定する。

User	Box	H	
Position

－476 ～ +476（0） ユーザーボックスマーカーの中心の水平位
置を設定する。

User	Box	V	
Position

－266 ～ +266（0） ユーザーボックスマーカーの中心の垂直位
置を設定する。

Monitoring>VF	Setting
ビューファインダーの設定を行います。

メニュー項目 細目と設定値 内容

Contrast －99	～	+99（±0） ビューファインダー映像のコントラスト（明
暗の差）を調整する。

Brightness －99	～	+99（±0） ビューファインダー映像の明るさを調整す
る。

Color	Mode Color	/	B&W E-E表示/記録時のビューファインダーの表
示モードを選択する。

De-Squeeze Off(1.0x)	/	1.3x	/	2.0x アナモフィックレンズでの撮影時に、ビュー
ファインダーに表示する映像のデスクイーズ
倍率を選択する。

Monitoring>Gamma	Display	Assist
ガンマ表示アシストの設定を行います。

メニュー項目 細目と設定値 内容

Setting SDRおよびCine	EIモードのとき：
On	/	Off

HDRモードのとき：
On	/	Off

ガンマ表示アシスト機能をOn/Offする。

Monitoring>Peaking
ピーキングの設定を行います

メニュー項目 細目と設定値 内容

Setting On	/	Off ピーキング機能をOn/Offする。
Type Normal	/	Color ピーキングの種類を選択する。

Normal：通常のピーキング
Color：カラーピーキング

Normal	
Peaking	
Frequency

Normal	/	High ピーキング周波数を標準（Normal）にする
か高く（High）するかを選択する。

Normal	
Peaking	
Level

0 ～ 99（50） ノーマルピーキングのレベルを設定する。

Color B&W	/	Red	/	Yellow	/	Blue カラーピーキングの信号色を選択する。
Color	
Peaking	
Level

0 ～ 99（50） カラーピーキングのレベルを設定する。

Monitoring>Zebra
ゼブラパターンの設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off ゼブラ機能をOn/Offする。
Zebra	Select 1	/	2	/	Both ゼブラ表示の種類（ゼブラ1、ゼブラ2、ま

たは両方）を選択する。
Zebra1	Level 0%～ 107%（70%） ゼブラ1を表示するレベルを設定する。
Zebra1	
Aperture	
Level

1%～20%（10%） ゼブラ1のアパーチャーレベルを設定する。

Zebra2	
Level

0%～ 109%（100%） ゼブラ2を表示するレベルを設定する。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

「ブロックダイヤグラム」（149ページ）を併せてご覧ください。

Audio>Audio	Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH1	MI	SHOE	
Input	Select

Shoe	CH1	/	Wireless CH1	INPUT切り替えスイッチ（7ページ）
がMI	SHOEのときの外部入力の機能を設
定する。

［ご注意］
Wirelessは、拡張ユニット装着時のみ表示され
ます。

CH2	EXT	
Input	Select

INPUT1	/	INPUT2 記録CH2に対する外部入力の入力元を切り
替える。

CH2	MI	
SHOE	Input	
Select

Shoe	CH2	/	Wireless CH2	INPUT切り替えスイッチ（7ページ）
がMI	SHOEのときの外部入力の機能を設
定する。

［ご注意］
Wirelessは、拡張ユニット装着時のみ表示され
ます。

CH3	Input	
Select

Off	/	INPUT1	/	Internal	MIC	/		
Shoe	CH1	/	Wireless

記録CH3に対する入力元を切り替える。

［ご注意］
Wirelessは、拡張ユニット装着時のみ選択でき
ます。

CH4	Input	
Select

Off	/	INPUT1	/	INPUT2	/	Internal	MIC	/	
Shoe	CH2	/	Wireless

記録CH4に対する入力元を切り替える。

［ご注意］
Wirelessは、拡張ユニット装着時のみ選択でき
ます。

INPUT1	MIC	
Reference

－80dB	/	－70dB	/	－60dB	/	－50dB	/		
－40dB	/	－30dB

INPUT1からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

INPUT2	MIC	
Reference

－80dB	/	－70dB	/	－60dB	/	－50dB	/		
－40dB	/	－30dB

INPUT2からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

Line	Input	
Reference

+4dB	/	0dB	/	－3dB	/	EBUL INPUT1/INPUT2スイッチの設定がLINEの
場合の基準入力レベルを選択する。

Reference	
Level

－20dB	/－18dB	/	－16dB	/	－12dB	/	
EBUL

基準入力レベルの1	kHz信号の記録レベル
を選択する。

CH1	Wind	
Filter

On	/	Off 記録CH1に対する風音低減フィルターを設
定する。

Audio>Audio	Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH2	Wind	
Filter

On	/	Off 記録CH2に対する風音低減フィルターを設
定する。

CH3	Wind	
Filter

On	/	Off 記録CH3に対する風音低減フィルターを設
定する。

CH4	Wind	
Filter

On	/	Off 記録CH4に対する風音低減フィルターを設
定する。

CH3	Level	
Control

Auto	/	Manual 記録CH3の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3	Input	Select、CH4	Input	Selectがどちら
もInternal	MICに設定されている場合は、本設
定に連動してCH4の自動・手動も切り替わります。

CH4	Level	
Control

Auto	/	Manual 記録CH4の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3	Input	Select、CH4	Input	Selectがどちら
もInternal	MICに設定されている場合は、CH3	
Level	Controlの設定に連動してCH4の自動・手
動も切り替わります。

Audio	Input	
Level

0 ～ 99 マスター音声入力レベルを設定する。
CH1	Level ～ CH4	Levelの設定に従って、
マスターボリュームとして使用できます。

Limiter	
Mode

Off	/	－6dB	/	－9dB	/	－12dB	/	－15dB	/	
－17dB

オーディオ入力レベルの手動調節時の大き
な信号に対するリミッター特性を選択する。

CH1&2	AGC	
Mode

Mono	/	Stereo 記録CH1と記録CH2の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

CH3&4	AGC	
Mode

Mono	/	Stereo 記録CH3と記録CH4の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

AGC	Spec －6dB	/	－9dB	/	－12dB	/	－15dB	/		
－17dB

AGC特性を選択する。

Audioメニュー
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Audio>Audio	Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

1kHz	Tone	
on	Color	
Bars

On	/	Off カラーバー表示中の1	kHzの基準音声信号
をOn/Offする。

［ご注意］
Onに設定すると、CH3	Input	Select、CH4	
Input	SelectがOffの場合でも、1	kHzの基準音
声信号を記録CH3、記録CH4に乗せます。

CH1	Level XLRアダプター入力なし
Audio	Input	Level	/	Side	/	
Level+Side

XLRアダプター入力あり（46ページ）
Audio	Input	Level	/	Through

記録CH1の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO	LEVEL（CH1）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio	Input	Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（149ページ）。

CH2	Level XLRアダプター入力なし
Audio	Input	Level	/	Side	/	
Level+Side

XLRアダプター入力あり（46ページ）
Audio	Input	Level	/	Through

記録CH2の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO	LEVEL（CH2）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio	Input	Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（149ページ）。

CH3	Level XLRアダプター入力なし
Audio	Input	Level	/	Side	/	
Level+Side

XLRアダプター入力あり（46ページ）
Audio	Input	Level	/	Through

記録CH3の音声入力レベル調整の組み合
わせを設定する。

［ご注意］
Sideは本機側面のAUDIO	LEVEL（CH3）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio	Input	Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（150ページ）。

CH4	Level XLRアダプター入力なし
Audio	Input	Level	/	Side	/	
Level+Side

XLRアダプター入力あり（46ページ）
Audio	Input	Level	/	Through

記録CH4の音声入力レベル調整の組み合
わせを設定する。

［ご注意］
Sideは本機側面のAUDIO	LEVEL（CH4）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio	Input	Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります

（150ページ）。

Audio>Audio	Output
音声出力の設定を行います。

メニュー項目 細目と設定値 内容

Monitor	CH CH1/CH2	/	CH3/CH4	/	MIX	ALL	/	CH1	/	
CH2	/	CH3	/	CH4

ヘッドホン端子および内蔵スピーカーに出
力する音声チャンネルを選択する。

［ご注意］
複数チャンネルの音声を同時出力する設定値を
選択した場合は、音割れしないように各チャンネ
ルの出力レベルを下げて音声が出力されます。

Headphone	
Out

Mono	/	Stereo ヘッドホン端子をモノラル（Mono）出力に
するか、ステレオ（Stereo）出力にするかを
選択する。

Alarm	Level 0 ～7（4） 警告音の音量を調整する。
HDMI	
Output	CH

CH1/CH2	/	CH3/CH4 HDMIに出力される音声チャンネルの組み
合わせを設定する。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Thumbnail
メニュー項目 細目と設定値 内容

Display	Clip	
Properties

クリップ詳細情報画面を開く。

Thumbnail>Set	Shot	Mark
ショットマークの設定を行います。

メニュー項目 細目と設定値 内容

Delete	Shot	
Mark1

Shot	Mark1を削除する。

Delete	Shot	
Mark2

Shot	Mark2を削除する。

Thumbnail>Set	Clip	Flag
クリップフラグの編集を行います。

メニュー項目 細目と設定値 内容

Add	OK OKフラグを付ける。
Add	NG NGフラグを付ける。
Add	KEEP Keepフラグを付ける。
Delete	Clip	
Flag

すべてのフラグを外す。

Thumbnail>Lock/Unlock	Clip
クリップの保護設定を行います。

メニュー項目 細目と設定値 内容

Select	Clip 保護/保護解除するクリップを選択して実
行する。

Lock	All	
Clips

すべてのクリップを保護する。

Unlock	All	
Clips

すべてのクリップを保護解除する。

Thumbnail>Delete	Clip
クリップを削除します。

メニュー項目 細目と設定値 内容

Select	Clip 任意のクリップを削除する。
All	Clips クリップを一括削除する。

Thumbnail>Copy	Clip
クリップをコピーします。

メニュー項目 細目と設定値 内容

Select	Clip 任意のクリップをコピーする。
All	Clips クリップを一括コピーする。

Thumbnail>	Copy	Sub	Clip
サブクリップをコピーします。

メニュー項目 細目と設定値 内容

All	Clips 4K＆HD（Sub）記録で記録されたサブクリッ
プを、別のメディアにメインクリップとして
一括コピーする。

Thumbnail>Transfer	Clip
クリップを転送します。

［ご注意］
NetworkメニューのAccess	AuthenticationのPasswordが未設定の場合、Transfer	Clipは設定できません。

メニュー項目 細目と設定値 内容

Select	Clip 任意のクリップを転送する。
All	Clips クリップを一括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Thumbnail>Transfer	Clip	(Proxy)
プロキシクリップを転送します。

［ご注意］
NetworkメニューのAccess	AuthenticationのPasswordが未設定の場合、Transfer	Clip	(Proxy)は設定できま
せん。

メニュー項目 細目と設定値 内容

Select	Clip 任意のクリップに対応しているプロキシク
リップを転送する。

All	Clips クリップに対応するプロキシクリップを一
括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Thumbnail>Set	Index	Picture
クリップの代表画を設定します。

メニュー項目 細目と設定値 内容

Set	Index	
Picture

クリップの代表画を設定する。

Thumbnailメニュー
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Thumbnail>Thumbnail	View
サムネイル画面の表示形態の設定を行います。

メニュー項目 細目と設定値 内容

Essence	
Mark	
Thumbnail

All	/	Rec	Start	/	Shot	Mark1	/	Shot	
Mark2	/	Shot	Mark3	/	Shot	Mark4	/	Shot	
Mark5	/	Shot	Mark6	/	Shot	Mark7	/	Shot	
Mark8	/	Shot	Mark9	/	Shot	Mark0

エッセンスマークのついているフレームをサ
ムネイル表示する。

Clip	
Thumbnail

記録されているクリップのサムネイルを表
示する。

Thumbnail>Filter	Clips
表示するクリップの設定を行います。

メニュー項目 細目と設定値 内容

OK OKフラグのついたクリップのみを表示す
る。

NG NGフラグのついたクリップのみを表示す
る。

KEEP Keepフラグのついたクリップのみを表示す
る。

None フラグのついていないクリップのみを表示
する。

All フラグのありなしによらず、すべてのクリッ
プを表示する。

Thumbnail>Customize	View
サムネイル画面の表示を切り替えます。

メニュー項目 細目と設定値 内容

Thumbnail	
Caption

Date	Time	/	Time	Code	/	Duration	/	
Sequential	Number

サムネイル画像直下の表示内容を切り替え
る。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Technical>Color	Bars
カラーバーの設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off カラーバーをOn/Offする。

［ご注意］
ShootingメニューのS&Q	MotionのSetting

（91ページ）がOnのときはOnにできません。

Type ARIB	/	100%	/	75%	/	SMPTE カラーバーの種類を選択する。

Technical>Test	Saw
テスト信号の設定を行います。

メニュー項目 細目と設定値 内容

Test	Saw On	/	Off テスト信号をOn/Offする。

Technical>ND	Dial
ND	VARIABLEダイヤルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容

CLEAR	with	
Dial

On	/	Off ND	VARIABLEダイヤルの操作でNDの状
態遷移（CLEAR⇔On）を可能にするかどう
か設定する。

Technical>Tally
記録/タリーランプの設定を行います。

メニュー項目 細目と設定値 内容

Front	Tally	
Lamp

On	/	Off 記録/タリーランプ（フロント）をOn/Offする。

Rear	Tally	
Lamp

On	/	Off 記録/タリーランプ（リア）をOn/Offする。

Tally	Control REMOTE	/	RCP	/	Internal Tally/Call制御情報を受け付ける対象を指
定する。

Technical>HOLD	Switch	Setting
ホールドスイッチの設定を行います。

メニュー項目 細目と設定値 内容

with	Rec	
Button

On	/	Off 録画ボタンをホールドの対象にするか非対
象にするかを設定する。

with	Hand	
Grip	Remote

On	/	Off グリップリモコンによる操作をホールドの対
象にするか非対象にするかを設定する。

Technical>Touch	Operation
タッチ操作に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off タッチ操作をOn/Offする。

Technical>Rec	Review
レックレビューの設定を行います。

メニュー項目 細目と設定値 内容

Setting 3s	/	10s	/	Clip レックレビューで直前に記録したクリップを
再生する時間を選択する。

Technical>Handle	Zoom
ハンドルズームの設定を行います。

メニュー項目 細目と設定値 内容

Setting Off	/	Low	/	High	/	Variable ハンドルズームスピードを設定する。
High 1 ～ 8（8） ハンドルズームスピードHigh選択時、ハン

ドルズームレバーを押したときのズームス
ピードを設定する。

Low 1～ 8（3） ハンドルズームスピードLow選択時、ハンド
ルズームレバーを押したときのズームスピー
ドを設定する。

［ご注意］
ズームスピードが低速のときにズーミングにむら
が出ることがあります。

Technical>GPS
GPSの設定を行います。

メニュー項目 細目と設定値 内容

GPS On	/	Off GPSをOn/Offする。

［ご注意］
GPSはハンドルに内蔵されています。

Technical>Menu	Settings
メニューに関する設定を行います。

メニュー項目 細目と設定値 内容

User	Menu	
Only

On	/	Off メニューを表示したときに、Userメニュー
だけを表示するか（On）、メニューリストを
表示するか（Off）を設定する。

Technicalメニュー
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Technical>Menu	Settings
メニューに関する設定を行います。

メニュー項目 細目と設定値 内容

User	Menu	
with	Lock

On	/	Off メニュー表示にロックをかけて、Userメ
ニューだけの表示にするかどうかを設定す
る。

［ご注意］
通常のメニュー表示操作では表示されません。メ
ニュー表示の操作方法は、80ページをご覧く
ださい。

Technical>Status	Page	On/Off
ステータス画面の表示に関する設定を行います。

メニュー項目 細目と設定値 内容

Main On	/	Off メインステータス画面の表示をOn/Offす
る。

Camera On	/	Off カメラステータス画面の表示をOn/Offす
る。

Audio On	/	Off オーディオステータス画面の表示をOn/
Offする。

Project On	/	Off プロジェクトステータス画面の表示をOn/
Offする。

Monitoring On	/	Off モニタリングステータス画面の表示をOn/
Offする。

Assignable	
Button

On	/	Off アサイナブルボタンステータス画面の表示
をOn/Offする。

Battery On	/	Off バッテリーステータス画面の表示をOn/
Offする。

Media On	/	Off メディアステータス画面の表示をOn/Off
する。

GPS On	/	Off GPSステータス画面の表示をOn/Offする。
Network On	/	Off ネットワークステータス画面の表示をOn/

Offする。
NCM/
Streaming

On	/	Off NCM/ストリーミングステータス画面の表
示をOn/Offする。

File	Transfer On	/	Off ファイル転送ステータス画面の表示をOn/
Offする。

Technical>RCP
リモートコントロールパネルに関する設定を行います。

メニュー項目 細目と設定値 内容

CNS	Mode Off	/	Bridge リモートコントロールパネルとのBridge
モード接続を許可するかどうかを設定す
る。

Detail	
Control(RCP)

4K/QFHD	/	HD リモートコントロールパネルのディテール調
整を、ディテールメニューの4K/QFHDと
HDどちらに対応させるかを設定する。

Technical>Fan	Control
ファン制御モードの設定を行います。

メニュー項目 細目と設定値 内容

Setting Auto	/	Minimum	/	Off	in	Rec 本機のファン制御モードを設定する。

［ご注意］
Off	in	Recを選択していても、本機の内部温度
が一定温度を超えるとファンが回転します。

Technical>Lens
レンズに関する設定を行います。

メニュー項目 細目と設定値 内容

Zoom	Ring	
Direction

Left(W)/Right(T)	/	Right(W)/Left(T) ズームリングの操作方向を設定する。

［ご注意］
ズームリングの操作方向切り替えに対応したEマ
ウントレンズ使用時のみ設定できます。

Shading	
Compensation

Auto	/	Off 自動周辺光量補正をOn/Offする。

［ご注意］
Imager	Scan	ModeがS35	2Kのときは、周辺光
量補正はかかりません。

Chroma	
Aberration	
Comp.

Auto	/	Off 自動倍率色収差補正をOn/Offする。

［ご注意］
Imager	Scan	ModeがS35	2Kのときは、倍率色
収差補正はかかりません。

Distortion	
Comp.

Auto	/	Off 自動歪曲収差補正をOn/Offする。

［ご注意］
Imager	Scan	ModeがS35またはS16のときは、
歪曲収差補正はかかりません。

Distance	
Display

Meter	/	Feet レンズ情報とフォーカスポジションの表示
単位を設定する。



6章　メニュー表示と詳細設定：Technicalメニュー116

Technical>Lens
レンズに関する設定を行います。

メニュー項目 細目と設定値 内容

Zoom	
Position	
Display

Focal	Length	/	Number	/	Bar ズーム位置の表示形式を設定する。

Iris	Display Auto	/	F-Number 絞りの表示単位を設定する。
Auto：	

装着レンズからT値の情報取得できると
きはT値表示、それ以外はF値表示され
る。

F-Number：	
常にF値で表示される。

Technical>Video	Light	Set
ビデオライトの点灯方式を設定します。HVL-LBPC（別売）使用時のみ有効な設定です。

メニュー項目 細目と設定値 内容

Video	Light	
Set

Power	Link	/	Rec	Link	/	Rec	Link	+	Stby マルチインターフェースシューに取り付ける
ビデオライトの点灯方式を設定する。
Power	Link：	

本機の電源の入/切に連動してビデオラ
イトが点灯/消灯する。

Rec	Link：	
本機の録画開始/終了に連動してビデ
オライトが点灯/消灯する。

Rec	Link	+	Stby：	
本機の録画開始/終了に連動してビデ
オライトが点灯/スタンバイ点灯する。

Technical>APR
APRを実行します。

メニュー項目 細目と設定値 内容

APR Execute	/	Cancel APR（Auto	Pixel	Restoration：イメージ
センサーの自動調整）を実行する。
Execute：実行

［ご注意］
実行前に必ずレンズキャップを装着してください。

Technical>Camera	Battery	Alarm
バッテリーの電圧低下警告の設定を行います。

メニュー項目 細目と設定値 内容

Low	Battery 5%	/	10%	/	15%	/	...	/	45%	/	50% バッテリー電圧低下警告を表示する残量を
設定する（5%刻み）。

Battery	
Empty

3%～7% バッテリー切れ警告を表示する残量を設定
する。

Technical>Camera	DC	IN	Alarm
入力電圧警告の設定を行います。

メニュー項目 細目と設定値 内容

DC	Low	
Voltage1

16.0V	～	19.0V（16.5V） DC	INへの入力電圧の低下警告を表示する
電圧を設定する。

DC	Low	
Voltage2

15.5V	～	18.5V DC	INへの入力電圧の不足警告を表示する
電圧を設定する。

Technical>Ext.	Unit	Battery	Alarm
XDCA-FX9のバッテリーに関する設定を行います。

メニュー項目 細目と設定値 内容

Near	
End:Info	
Battery

5%～100% Info対応バッテリーの電圧低下警告を表示
する残量を設定する（5%刻み）。

End:Info	
Battery

0%～ 5% Info対応バッテリーのバッテリー切れ警告
を表示する残量およびメディアアクセスを
禁止する残量を設定する。

Near	
End:Sony	
Battery

11.5V～17.0V Info非対応バッテリーの電圧低下警告を表
示する残量を設定する。

End:Sony	
Battery

11.0V～14.0V Info非対応バッテリーのバッテリー切れ警
告を表示する残量およびメディアアクセス
を禁止する残量を設定する。

Near	
End:Other	
Battery

11.5V～ 17.0V（11.8V） アントンバウアー製バッテリーの電圧低下
警告を表示する残量を設定する。

End:Other	
Battery

11.0V～14.0V アントンバウアー製バッテリーのバッテリー
切れ警告を表示する残量およびメディアア
クセスを禁止する残量を設定する。
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Technical>Ext.	Unit	Battery	Alarm
XDCA-FX9のバッテリーに関する設定を行います。

メニュー項目 細目と設定値 内容

Detected	
Battery

XDCA-FX9に接続されている電源の種別
を表示する。
XDCA-FX9に接続したバッテリーまたは
DC	INで駆動している場合は、「Sony	Info	
Battery」、「Sony	Battery」、「Other	
Battery」、「DC	IN」のいずれかを表示する。
本機に接続したバッテリーまたはDC	INで
駆動している場合は、「---」と表示する。

Technical>Ext.	Unit	DC	IN	Alarm
XDCA-FX9の入力電圧警告の設定を行います。

メニュー項目 細目と設定値 内容

DC	Low	
Voltage1

11.5V～17.0V DC	INへの入力電圧の低下警告を表示する
電圧を設定する。

DC	Low	
Voltage2

11.0V～14.0V DC	INへの入力電圧の不足警告を表示する
電圧を設定する。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Network>Setup	for	Mobile	App
ネットワーク設定支援ツールを実行します。

メニュー項目 細目と設定値 内容

Setup ネットワーク設定支援ツールを起動する。

Network>Access	Authentication
認証に関する設定を行います。

メニュー項目 細目と設定値 内容

User	Name アクセス認証のためのユーザー名を設定す
る。

Input	
Password

アクセス認証のためのパスワードを設定す
る。

［ご注意］
セキュリティの観点から、パスワードには他人に
推測されにくく十分な長さのある文字列を設定
し、厳重に保管することを推奨します。

Generate	
Password

Execute	/	Cancel アクセス認証のためのパスワードを自動生
成する。
Execute：実行

Show	
Settings

アクセス認証のユーザー名、パスワードお
よびシリアル番号をテキストとQRコードで
表示する。

［ご注意］
パスワードを盗み見られたり、QRコードの画像
を流出させないように注意してください。

Network>Wireless	LAN
ワイヤレスLAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting Access	Point	Mode	/	Station	Mode	/	
Off

ワイヤレスLAN接続の動作モードを選択す
る。

WPS Execute	/	Cancel WPS（Wi-Fi	Protected	Setup）による接
続設定を開始する。
Execute：実行

NFC Execute	/	Cancel NFC（Near	Field	Communication）によ
る接続設定を開始する。
Execute：実行

MAC	
Address

本機のワイヤレスLANインターフェースの
MACアドレスを表示する。

Network>AP	Mode	Settings
アクセスポイントモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Channel Auto(5GHz)	/	Auto	/	CH1	/	CH2	/	CH3	/		
CH4	/	CH5	/	CH6	/	CH7	/	CH8	/	CH9	/	
CH10	/	CH11

ワイヤレスLANのチャンネルを設定する。

Camera	SSID	
&	Password

本機のSSIDとパスワードを表示する。

Regenerate	
Password

Execute	/	Cancel パスワードを再生成する。
Execute：実行

IP	Address 本機のアクセスポイントモードでのIPアドレ
スを表示する。

Subnet	
Mask

本機のアクセスポイントモードでのサブ
ネットマスクを表示する。

Network>ST	Mode	Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Camera	
Remote	
Control

Enable	/	Disable ステーションモードで本機とワイヤレス
LAN接続されているデバイスからのリモー
トコントロールを許可するかどうかを設定
する。

Networkメニュー
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Network>ST	Mode	Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Connected	
Network

接続中のワイヤレスLANネットワーク（アク
セスポイント）を表示する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを表
示する。
セキュリティがWEP/WPA時：*******
セキュリティがNone時：空欄

DHCP DHCPの有効（On）、無効（Off）を表示する。
IP	Address DHCPがOffのときに本機のIPアドレスを表

示する。
Subnet	Mask DHCPがOffのときに本機のサブネットマス

クを表示する。
Gateway DHCPがOffのときに本機のデフォルトゲー

トウェイを表示する。
DNS	Auto DNS自動取得のON/OFFを表示する。
Primary	DNS	Server DNS	AutoがOffのときに本機のプライマ

リー	DNSサーバーを表示する。
Secondary	DNS	Server DNS	AutoがOffのときに本機のセカンダ

リー	DNSサーバーを表示する。

Network>ST	Mode	Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Scan	
Networks

ワイヤレスLANネットワーク（アクセスポイ
ント）を検出し、リスト表示する。
リストから接続先を選択し、接続する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを入
力する。

DHCP	
On	/	Off

DHCPの有効（On）、無効（Off）を設定する。

IP	Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet	Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときに本機のデフォルトゲー
トウェイを入力する。

DNS	Auto	
On	/	Off

DNS自動取得をOn/Offする。

Primary	DNS	Server DNS	AutoがOffのときに本機のプライマ
リー DNSサーバーを入力する。

Secondary	DNS	Server DNS	AutoがOffのときに本機のセカンダ
リー DNSサーバーを入力する。
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Network>ST	Mode	Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Manual	
Register

アクセスポイントと手動接続する。
SSID 接続先アクセスポイントのSSIDを入力す

る。
Security	

None	/	WEP	/	WPA
接続先アクセスポイントのセキュリティ種
別を設定する。接続先アクセスポイントの
セキュリティ種別がWPAまたはWPA2の場
合は、WPAを選択。

Password 接続先アクセスポイントのパスワードを入
力する。

DHCP	
On	/	Off

DHCPの有効（On）、無効（Off）を設定する。

IP	Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet	Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS	Auto	
On	/	Off

DNS自動取得をOn/Offする。

Primary	DNS	Server DNS	AutoがOffのときにプライマリー	
DNSサーバーを入力する。

Secondary	DNS	Server DNS	AutoがOffのときにセカンダリー	
DNSサーバーを入力する。

Network>Wired	LAN
有線LAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off 有線LANをOn/Offする。
Camera	
Remote	
Control

Enable	/	Disable 本機と有線LAN接続されているデバイスか
らのリモートコントロールを許可するかどう
かを設定する。

Detail	
Settings

有線LAN接続の詳細設定を行う。
DHCP	
On	/	Off

DHCPの有効（On）、無効（Off）を設定する。

IP	Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet	Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS	Auto	
On	/	Off

DNS自動取得をOn/Offする。

Primary	DNS	Server DNS	AutoがOffのときにプライマリー	
DNSサーバーを入力する。

Secondary	DNS	Server DNS	AutoがOffのときにセカンダリー	
DNSサーバーを入力する。
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Network>Modem
モデムの使用に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off モデム接続の有効（On）、無効（Off）を設定
する。

Camera	
Remote	
Control

Enable	/	Disable モデム/スマートフォンで本機とワイヤレス
LAN接続されているデバイスからのリモー
トコントロールを許可するかどうかを設定
する。

［ご注意］
本機とC3	Portalを接続すると、本設定が
Enableに切り替わります（69ページ）。

Modem1	IP	
Address

モデム1のIPアドレスを表示する。

Modem1	
Subnet	
Mask

モデム1のサブネットマスクを表示する。

Modem2	IP	
Address

モデム2のIPアドレスを表示する。

Modem2	
Subnet	
Mask

モデム2のサブネットマスクを表示する。

Network>Network	Client	Mode
ネットワーククライアントモードに関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On	/	Off ネットワーククライアントモードを開始
（On）または停止（Off）する。

NCM	
Settings	
Select

ネットワーククライアントモードの接続先
設定を、あらかじめ設定したプリセット設定

（NCM	Settings1/NCM	Settings2/NCM	
Settings3）から選択する。

Network>Network	Client	Mode
ネットワーククライアントモードに関する設定を行います。

メニュー項目 細目と設定値 内容

NCM	
Settings1

Display	Name NCM	Settingsのメニュー上の表示名を入
力する。

CCM	Address 接続先CCMのアドレスを設定する。
ホスト名またはIPアドレス

CCM	Port（1～ 65535	（8443）） 接続先CCMのポート番号を設定する。
User	Name CCM接続の認証用ユーザー名を設定する。
Password CCM接続の認証パスワードを設定する。
CCM	Certificate	

Load	/	Clear	/	None
CCMまたはC3	Portalに接続する際の証明
書の読み込み、削除を設定する。

CCM	Certificate	Status	
Loaded	/	Default

CCMまたはC3	Portalに接続する際の証明
書の読み込み状態を表示する。

Camera	Control	
Enable	/	Disable

CCM接続時のCCMまたはC3	Portalから
のカメラコントロール許可/不許可を設定す
る。

Camera	Setting	
Always	/	Onetime	/	Off

CCM接続時のCCMまたはC3	Portalからの
All	File操作の許可/不許可を設定する。
Always：	

常にCCMまたはC3	PortalからのAll	
File	操作を許可する。

Onetime：	
1回だけCCMまたはC3	PortalからのAll	
File操作を許可する。

Off：	
CCMまたはC3	PortalからのAll	File操
作を許可しない。

Reset	
Execute	/	Cancel

NCM	Settingsの設定を初期値に戻す。
Execute：実行

NCM	
Settings2

NCM	Settings1と同じ

NCM	
Settings3

NCM	Settings1と同じ

Streaming	
Quality

Normal	/	High ストリーミングの品質を設定する。

［ご注意］
本設定はMaintenanceメニューのAll	Resetで
Reset	without	Network（123ページ）を実行
した場合もリセットされます。
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Network>File	Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Auto	Upload On	/	Off オリジナルファイルの自動転送をOn/Offす
る。

［ご注意］
Projectメニュー >Simul	RecのSetting

（95ページ）がOnに設定されている場合は、
スロットBのメディア上に記録されるクリップは、
自動転送の対象にはなりません。

Auto	Upload	
(Proxy)

On	/	Off	/	Chunk On：	
プロキシファイルの自動転送を有効に
する。

Off：	
プロキシファイルの自動転送を無効に
する。

Chunk：	
分割記録したプロキシファイルを自動
で転送する。

Default	
Upload	
Server

ファイルの転送先サーバーを選択する。こ
こで選択したサーバーは、プロキシファイ
ルの自動転送先、およびサムネイル画面か
らのファイル転送先のサーバーになる。
Server	Settings	(NCM)、Server	
Settings	1 ～ 3で設定したDisplay	Name
を表示する。

Clear	
Completed	
Jobs

Execute	/	Cancel 転送完了済みのジョブをリストからクリア
する。
Execute：実行

Clear	All	
Jobs

Execute	/	Cancel すべての転送ジョブをリストからクリアす
る。
Execute：実行

View	Job	
List

転送ジョブ一覧を表示する。

Server	
Settings	
(NCM)

NCMサーバーのDisplay	Nameおよびサー
ビス（CCM）を表示する。

Display	Name NCMサーバーのDisplay名を表示する。
Service サービスを表示する。

Network>File	Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Server	
Settings1

Display	Name 転送先設定のメニュー上の表示名を入力す
る。

Service	
FTP

サーバーの種類を表示する。

Host	Name 転送先サーバーのホスト名を設定する。
Port（1～ 65535（21）） 転送先サーバーのポート番号を設定する。
User	Name 転送先サーバー接続の認証用ユーザー名を

設定する。
Password 転送先サーバー接続の認証パスワードを設

定する。
Passive	Mode	

On	/	Off
PASVモードをOn/Offする。

Destination	Directory 転送先のディレクトリー名を入力する。
Using	Secure	Protocol	

On	/	Off
セキュアなFTP転送（FTPSのExplicit	
Mode：FTPES）を行うか（On）、行わない
か（Off）を設定する。

Root	Certificate	
Load	/	Clear	/	None

セキュアなFTP転送ためのルート証明書の
読み込み、削除を設定する。

Root	Certificate	Status	
Loaded	/	No	Certificate

セキュアなFTP転送ためのルート証明書の
読み込み状態を表示する。

Reset	
Execute	/	Cancel

Server	Settingsの設定を初期値に戻す。
Execute：実行

Server	
Settings2

Server	Settings	1と同じ

Server	
Settings3

Server	Settings	1と同じ

Network>Network	Reset
ネットワークの設定をリセットします。

メニュー項目 細目と設定値 内容

Reset Execute	/	Cancel ネットワークの設定をリセットする。
Execute：実行
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Maintenance>Language
表示する言語を設定します。

メニュー項目 細目と設定値 内容

Select 表示する言語を設定する。
SET：実行

Maintenance>Clock	Set
内蔵時計に関する設定を行います。

メニュー項目 細目と設定値 内容

Time	Zone UTC	-12:00	～	UTC	+14:00 UTCからの時差を30分単位で設定する。
Date	Mode YYMMDD	/	MMDDYY	/	DDMMYY 年月日の表示方式を選択する。

YYMMDD：年月日の順
MMDDYY：月日年の順
DDMMYY：日月年の順

12h/24h 12h	/	24h 時刻の表示形式を選択する。
12h：12時間表示
24h：24時間表示

Date 現在の日付を設定する。
SET：決定

Time 現在の時刻を設定する。
SET：決定

Maintenance>Network	Public	Key
公開鍵に関する設定を行います。

メニュー項目 細目と設定値 内容

Key	Creation Execute	/	Cancel 公開鍵を作成する。
Execute：実行

Key	Clear Execute	/	Cancel 本機に保存されている公開鍵を消去する。
Execute：実行

Create	Key	
Date

公開鍵の生成日時を以下の形式で表示す
る。

年4桁（西暦）＋月2桁＋日2桁＋時2桁
（24時間）＋分2桁＋秒2桁
表示例：2020年12月1日12時34分56
秒
→20201201123456

Maintenance>All	Reset
工場出荷時の状態にリセットします。

メニュー項目 細目と設定値 内容

Reset Execute	/	Cancel 工場出荷時の状態へのリセットを実行す
る。
Execute：実行

Reset	
without	
Network

Execute	/	Cancel Networkメニュー以下の設定を除いたメ
ニュー設定値を工場出荷状態にリセットす
る。

［ご注意］
NetworkメニューのNetwork	Client	Modeの
Streaming	Quality（121ページ）は工場出荷
状態にリセットされます。

Maintenance>Hours	Meter
積算時間を表示します。

メニュー項目 細目と設定値 内容

Hours
（System）

積算使用時間（リセット不可）を表示する。

Hours
（Reset）

積算使用時間（リセット可）を表示する。

Reset Execute	/	Cancel Hours（Reset）表示を0にリセットする。
Execute：実行

Maintenance>Version
バージョンを表示します。

メニュー項目 細目と設定値 内容

Version	
Number

Vx.xx 本機のソフトウェアバージョンを表示する。

Ext.	Unit	
Version	
Number

Vx.xx XDCA-FX9のソフトウェアバージョンを表
示する。

Version	Up Execute	/	Cancel 本機をバージョンアップ*する。
Execute：実行
*	 バージョンアップは本機のソフトウェアをアッ

プデートする機能です。

Lens	Version	
Number

Vxx Eマウントレンズのソフトウェアバージョン番
号を表示する。

Maintenanceメニュー
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設定データ

セットアップメニューの設定内容を、本機の内蔵
メモリーまたはSDカード、“メモリースティック”
に保存することができます。また、Allファイルを
クラウドサービスに保存することができます。こ
のデータを使って適切なセットアップ状態をすば
やく再現できます。
設定データは、次のように分類されて保存され
ます。

User	File（ユーザーファイル）
カスタマイズしたUserメニューの設定項目と設定
データを保存します。
SDカードまたは“メモリースティック”に64個まで
保存することができます。
このファイルを本機のメモリーに読み込むことに
より、Userメニューをカスタマイズした状態に
セットアップすることができます。

All	File（ALL	ファイル）
全メニューの設定データを保存します。SDカー
ドまたは“メモリースティック”に64個まで保存す
ることができます。C3	Portal（クラウドサービス）
には、個人(Private)60個までと共通(Share)60
個までの計120個まで保存することができます。

［ご注意］
機器固有のデータ（機器ごとに調整が必要なシェーディング
や出力レベルなど）は保存されません。

Scene	File（シーンファイル）
撮影シーンに合わせて設定したペイント項目の設
定値を保存します。本機の内蔵メモリーに5個、
SDカードまたは“メモリースティック”に64個まで
保存することができます。

ユーザーファイル、ALLファイ
ルを保存する

メモリーカードに保存する

1 SDカードまたは“メモリースティック”を、ラ
ベルを右にしてUTILITY	SD/MSカードス
ロット（8ページ）に差し込む。

2 ユーザーファイルの場合は、Projectメ
ニューのUser	FileのSave	to	Utility	SD/MS

（99ページ）を選択する。
ALLファイルの場合は、Projectメニューの
All	FileのSave	to	Utility	SD/MS（99
ページ）を選択する。
ファイルの保存先画面が表示されます。

3 保存先画面のNo	Fileの行を選択する。
File	IDが記載されている行を選択すると、
そのファイルに上書きされます。
File	IDは自動的に付けられますが、変更す
ることもできます。

4 確認画面のExecuteを選択する。

Allファイルをクラウドサービスに保存
する

1 本機をスマートフォンアプリ「C3	Portal	
App」に接続する（69ページ）。

2 ProjectメニューのAll	FileのSave	
to	Cloud(Private)またはSave	to	
Cloud(Share)（99ページ）を選択する。
ファイルの保存先画面が表示されます。

3 保存先画面のNo	Fileの行を選択する。
File	IDが記載されている行を選択すると、
そのファイルに上書きされます。
File	IDは自動的に付けられますが、変更す
ることもできます。

4 確認画面のExecuteを選択する。

ユーザーファイル、ALLファイ
ルを読み込む

メモリーカードから読み込む

1 ファイルを保存したSDカードまたは“メ
モリースティック”を、ラベルを右にして
UTILITY	SD/MSカードスロット（8ペー
ジ）に差し込む。

2 ユーザーファイルの場合は、Projectメニュー
のUser	FileのLoad	from	Utility	SD/MS

（99ページ）を選択する。
ALLファイルの場合は、Projectメニュー
のAll	FileのLoad	from	Utility	SD/MS

（99ページ）を選択する。
ファイルの一覧画面が表示されます。

3 読み込むファイルを選択する。
確認画面が表示されます。

4 Executeを選択する。

［ご注意］

ˎˎ 設定データを読み込むと、本機は自動的に再起動され
ます。
ˎˎ ProjectメニューのAll	FileのLoad	Network	Dataが
Offの場合は、Networkメニューの設定項目を除いた
ALLファイルを読み込みます。

Allファイルをクラウドサービスから読
み込む

1 本機をスマートフォンアプリ「C3	Portal	
App」に接続する（69ページ）。

2 ProjectメニューのAll	FileのLoad	from	
Cloud(Private)またはLoad	from	
Cloud(Share)（99ページ）を選択する。
ファイルの一覧画面が表示されます。

3 読み込むファイルを選択する。
確認画面が表示されます。

4 Executeを選択する。

設定データの保存と読み込み
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シーンファイルを保存する

内蔵メモリーに保存するには

1 PaintメニューのScene	FileのStore	
Internal	Memory（104ページ）を選択す
る。
シーンファイル一覧画面が表示されます。
File	IDがStandardの保存先にはあらかじめ
標準設定が保存されています。

2 保存先を選択する。
選択した保存先にシーンファイルが上書き保
存されます。

3 確認画面のExecuteを選択する。

SDカードまたは“メモリースティック”
に保存するには

1 SDカードまたは“メモリースティック”を、ラ
ベルを右にしてUTILITY	SD/MSカードス
ロット（8ページ）に差し込む。

2 PaintメニューのScene	FileのSave	to	
Utility	SD/MS（104ページ）を選択する。
シーンファイルの保存先画面が表示されま
す。

3 保存先画面のNo	Fileの行を選択する。
File	IDが記載されている行を選択すると、
そのファイルに上書きされます。
File	IDは自動的に付けられますが、変更す
ることもできます。

4 確認画面のExecuteを選択する。

シーンファイルを読み込む

内蔵メモリーから読み込むには

1 PaintメニューのScene	FileのRecall	
Internal	Memory（104ページ）を選択す
る。
シーンファイル一覧画面が表示されます。

2 読み込むファイルを選択する。
確認画面が表示されます。

3 Executeを選択する。

	 ［メモ］
シーンファイルは、ダイレクトメニュー（47ページ）
で読み込むこともできます。

SDカードまたは“メモリースティック”
から読み込むには

1 シーンファイルを保存したSDカードまたは
“メモリースティック”を、ラベルを右にして
UTILITY	SD/MSカードスロット（8ペー
ジ）に差し込む。

2 PaintメニューのScene	FileのLoad	from	
Utility	SD/MS（104ページ）を選択する。
シーンファイルの一覧画面が表示されます。

3 読み込むファイルを選択する。
確認画面が表示されます。

4 Executeを選択する。

File	IDを変更するには

1 ユーザーファイルの場合は、Projectメニュー
のUser	Fileで、File	ID（99ページ）を選
択する。
ALLファイルの場合は、Projectメニューの
All	Fileで、File	ID（99ページ）を選択する。
シーンファイルの場合は、Paintメニューの
Scene	File（104ページ）で、File	IDを選
択する。
File	IDの編集画面が表示されます。

2 矢印ボタン（7ページ）またはマルチファ
ンクションダイヤル（4ページ）で文字を
選択し、SETボタン（7ページ）またはマ
ルチファンクションダイヤルを押す。

3 手順2を繰り返す。

4 文字の入力が終了したら、Doneを選択する。
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リモートコントロールパネルを接続する
RCP1500/1501/1530/3100/3500/3501など
のリモートコントロールパネルと本機をLANケー
ブルで接続すると、それらの機器から本機の機
能の一部をコントロールできます。

リモートコントロールパネル
を接続する

1 「LANケーブルを使用してデバイスと接続す
る」（62ページ）の手順に従って、有線
LANネットワークの設定をする。

2 NetworkメニューのWired	LANのCamera	
Remote	Control（120ページ）をEnable
にする。

3 TechnicalメニューのRCPのCNS	Mode
（115ページ）をBridgeに設定する。

4 リモートコントロールパネルをBRIDGEモー
ドに設定する。

5 本機のIPアドレスをリモートコントロールパ
ネルに設定する。
設定方法については、各リモートコントロー
ルパネルの取扱説明書をご覧ください。

6 本機に取り付けたXDCA-FX9（25ペー
ジ）の有線LAN端子とLANスイッチをLAN
ケーブルで接続し、リモートコントロールパ
ネルと接続する。

リモートコントロール
パネル

PoE	対応スイッチング
ハブ

7 本機の電源を入れる。
本機はリモートコントロールモードになり、
リモートコントロールパネルで本機の撮影操
作が可能となります。

［ご注意］

ˎˎ 無線LANで接続することはできません。
ˎˎ インターネット経由で接続することはできません。
ˎˎ 他のネットワーク機能と同時に使用することはできませ
ん。

リモートコントロールモード
を解除する

本機の電源を切り、リモートコントロールパネル
を取り外します。
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外部モニターや記録装置を接続する
記録・再生画像を外部モニターに表示させるとき
は、本機の出力信号を選択し、接続するモニター
に応じた接続ケーブルを使用してください。
VTRなどの記録装置を接続して、本機の出力信
号を記録することもできます。
外部モニターにビューファインダーと同様の各
種ステータス情報やメニューなどを表示させる
ことができます。モニターに出力する信号に応
じて、MonitoringメニューのOutput	Display

（107ページ）をOnに設定してください。

SDI	OUT端子（BNC型）

Monitoringメニュー（107ページ）で、出力の
On/Offや出力フォーマットを設定します。
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。

［ご注意］
本機と外部機器の間のアースが確実に接地されていること
を確認してから、電源を入れてください。

（75Ω同軸ケーブルを接続した後に、本機と外部
機器の電源を入れることをお勧めします。）
やむを得ず、電源投入状態で外部機器を接続す
る場合は、75Ω同軸ケーブルを外部機器に接続
した後に、本機と接続してください。

本機と同時に外部機器で記録を開始
するには

SDI信号出力時は、ProjectメニューのSDI/
HDMI	Rec	Control（96ページ）のSettingを
SDI/HDMI	Remote	I/FまたはParallel	Recに
設定すると、SDI	OUT端子に接続した外部機器

にRECトリガー信号を出力することによって、本
機と同期した記録が可能になります。

［ご注意］

ˎˎ 接続した外部機器がRECトリガー信号に対応していない
場合は動作しません。
ˎˎ 録画START/STOPボタンとハンドル録画START/STOP
ボタンが異なるメディアに記録操作する設定になってい
るときは、スロットAの動作に合わせてRECトリガー信
号が出力されます。

HDMI	OUT端子（Type	Aコネ
クター）

Monitoringメニュー（107ページ）で、出力の
On/Offや出力フォーマットを設定します。
接続には、市販のハイスピードHDMIケーブルを
使用します。
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外部同期
本機のGenlock端子を介して、本機を複数台使
用して撮影するときなど、特定の基準信号に同期
させたり、タイムコードを合わせることができま
す。

映像信号の位相を合わせる
（ゲンロック）

本機のIN/OUT切り替えスイッチ（8ページ）
をIN側に設定し、GENLOCK	IN/REF	OUT端子

（8ページ）に基準信号を入力することによっ
て、ゲンロックが可能です。
入力できる基準信号は、選択している記録フォー
マットのシステム周波数によって異なります。

記録フォーマットの
システム周波数

入力可能な基準信号

59.94P 1920×1080	59.94i	
720×486	59.94i	
1280×720	59.94P

50P 1920×1080	50i	
720×576	50i	
1280×720	50P

29.97P 1920×1080	59.94i	
720×486	59.94i

25P 1920×1080	50i	
720×576	50i

24P 1920×1080	48i(24PsF)
23.98P 1920×1080	47.95i	

(23.98PsF)
59.94i 1920×1080	59.94i	

720×486	59.94i
50i 1920×1080	50i	

720×576	50i

［ご注意］

ˎˎ 基準信号が不安定な場合は、ゲンロックできません。

ˎˎ サブキャリアは同期しません。

他機のタイムコードにロック
させる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free	RunやClock）に
設定してください。

1 TC/MediaメニューのTimecode（105
ページ）を次のように設定する。
Mode：Preset
Run：Free	Run

2 DURATION/TC/U-BIT機能が割り当てられ
たアサイナブルボタン（47ページ）を押し
て、画面にタイムコードを表示させる。

3 IN/OUT切り替えスイッチ（8ページ）が
IN側になっていることを確認し、GENLOCK	
IN/REF	OUT端子とTC	IN/OUT端子に、そ
れぞれHDまたはSDのリファレンスビデオ信
号およびそれに同期した基準タイムコードを
供給する。

これで本機のタイムコードジェネレーターが基準
タイムコードにロックし、画面に「EXT-LK」と表
示されます。
ロックしてから約10秒経過した後は、外部から
の基準タイムコードの接続を外しても、外部ロッ
ク状態は保たれます。

［ご注意］

ˎˎ 供給する基準タイムコードとリファレンスビデオ信号が、
SMPTEタイムコードの規格を満たした位相関係にある
ことを確認してください。
ˎˎ 外部ロックの操作をすると、タイムコードは瞬時に外部
のタイムコードにロックし、外部タイムコードの値と同じ
値がタイムデータ表示部に出ますが、タイムコードジェ
ネレーターが安定するまでの数秒間は、記録を開始しな
いでください。
ˎˎ リファレンスビデオ信号の周波数と本機のフレーム周波
数が同じでないと、正しくロックできず、本機が正常に
動作できません。この場合、タイムコードも外部のタイ
ムコードに正しくロックできません。
ˎˎ 接続を外した場合、基準タイムコードに対し1時間で1フ
レームずれる場合があります。

外部ロックを解除するには

TC/MediaメニューのTimecodeの設定を変更
してください。
システム周波数を変更した場合や、特殊記録モー
ド（スロー＆クイックモーションまたはインターバ
ルレック）での記録を開始した場合も、外部ロッ
クは解除されます。

本機のタイムコードに他機の
タイムコードを合わせる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free	RunやClock）に
設定してください。

1 TC/MediaメニューのTimecodeで本機の
タイムコードを設定する（105ページ）。

2 IN/OUT切り替えスイッチ（8ページ）が
OUT側になっていることを確認し、TC	IN/
OUT端子とGENLOCK	IN/REF	OUT端子
を、同期させたい機器のタイムコード入力端
子、リファレンス信号入力端子に接続する。
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コンピューターでクリップ管理・編集する
USBケーブルを使って接続す
る

XQDカードリーダー（別売）を使う

XQDカードリーダーをUSBケーブルで接続する
と、スロットに装着されたメモリーカードがコン
ピューターの拡張ドライブとして認識されます。
なお、対応したコンピューターの場合、本機のマ
スストレージモードを使用するよりも高速に、ク
リップを取り込むことができます。

本機のマスストレージモードを使う

本機をUSBケーブルで接続すると、XQDカード
スロットA/Bに装着されたメモリーカードがコン
ピューターの拡張ドライブとして認識されます。

1 本機のグリップリモコンを取り外し、USB/
マルチ端子（4ページ）とコンピューター
をUSBケーブルで接続する。

2 本機のPOWERスイッチをOnにする。
ビューファインダー画面にUSBの接続を有効
にするかどうかを確認するメッセージが表示
されます。

	 ［ご注意］
XQDメモリーカードのフォーマットや修復など、実行
を確認するメッセージや実行中のメッセージが表示さ
れている間は、USB接続確認メッセージは表示されま
せん。
フォーマットや修復などの実行が終了後に表示されま
す。またクリップの詳細情報表示中もUSB接続確認
メッセージは表示されません。処理が終了するか、サ
ムネイル画面に戻ると表示されます。

3 マルチファンクションダイヤルを回して
Executeを選ぶ。

4 Windowsの場合、「マイコンピュータ」にリ
ムーバブルディスクとして追加されているこ
とを確認する。
Macintoshの場合、デスクトップにNO	
NAMEまたはUntitledフォルダー（フォル
ダー名は任意に変更可）が作成されているこ
とを確認する。

［ご注意］

ˎˎ アクセスランプが赤く点灯しているときは、次の操作を
しないでください。
	– 電源を切る。電源コードを抜く
	– XQDメモリーカードを抜く
	– USBケーブルを抜く

ˎˎ すべてのコンピューターについて、動作を保証するもの
ではありません。

ノンリニア編集システムを使
う

ノンリニア編集システムには、本機で記録した
フォーマットに対応した編集ソフトウェア（別売）
が必要です。
専用アプリケーションソフトウェアを使って、あ
らかじめコンピューターのHDDに編集したいク
リップを保存しておきます。
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使用上のご注意
結露について

本機を寒いところから急に暖かいところに持ち込
んだときなど、機器表面や内部に水滴がつくこと
があります。これを結露といいます。結露が起き
たときは電源を切り、結露がなくなるまで放置し、
結露がなくなってからご使用ください。結露時の
ご使用は機器の故障の原因となる場合がありま
す。

LCDパネルについて

本機のLCD（液晶）パネルは有効画素99.99％以
上の非常に精密度の高い技術で作られています
が、画面上に黒い点が現れたり（画素欠け）、常
時点灯している輝点（赤、青、緑など）や滅点が
ある場合があります。また、LCD（液晶）パネル
の特性上、長期間ご使用の間に画素欠けが生じ
ることもあります。これらの現象は故障ではあり
ませんので、ご了承の上本機をお使いください。
なお、これらの点が記録されることはありません。

本機搭載のCMOSイメージセンサーの
現象

［ご注意］
撮影画面に出る下記の現象は、イメージセンサー特有の現
象で、故障ではありません。

白点
イメージセンサーは非常に精密な技術で作られ
ていますが、宇宙線などの影響により、まれに
画面上に微小な白点が発生する場合があります。
これはイメージセンサーの原理に起因するもので
故障ではありません。
また、下記の場合、白点が見えやすくなります。

ˎˎ 高温の環境で使用するとき

ˎˎ ゲイン（感度）を上げたとき

フリッカー
蛍光灯、ナトリウム灯、水銀灯、LEDによる照明
下で撮影すると、画面が明滅したり、色が変化
したように見えることがあります。

有寿命部品について

ˎˎ ファン、バッテリーは有寿命部品として定期的
な交換が必要です。	
常温でのご使用の場合、5年を目安に交換し
てください。ただし、交換時期は目安であり、
部品の寿命を保証するものではありません。
交換の際はお買い上げ店	にご相談ください。

ˎˎ ＡＣアダプターと電解コンデンサの寿命は約5
年です。（常温で1日に8時間、1カ月で25日間、
通常に使用すると想定した場合）したがって、
使用時間が上記より長い場合は、その分寿命
は短くなります。

ˎˎ 機器に搭載されているバッテリー端子（バッテ
リーパックやACアダプターとの接点部分）は消
耗品です。	
振動や衝撃によって端子が変形したり、曲がっ
たり、あるいは長期の屋外での使用などによっ
て表面が腐食したりすると、本体に電源が供
給されなくなります。	
長期間機器を使用していただくために、定期
点検を実施することをお願いします。点検につ
きましては、ソニーのサービス担当者または営
業担当者にご相談ください。

内蔵の充電式電池について

本機は日時や各種の設定を電源の入/切と関係
なく保持するために、充電式電池を内蔵していま
す。内蔵の充電式電池は、本機の電源の入/切に

関わらず、ACアダプターでコンセントにつながっ
ているか、充電されたバッテリーを本機に装着し
た状態で24時間経過すれば充電されます。ACア
ダプターで電源につながない、またはバッテリー
を入れないままで3か月近くまったく使わないと
完全に放電してしまいます。充電してから使って
ください。ただし、充電式電池が充電されてい
ない場合でも、使用時の日時を記録する必要が
なければ本機を使えます。

イメージセンサーの自動調整について

日時の設定後一定時間以上APRを実行しない場
合、APRを促すメッセージが表示されます。

使用場所・保管場所について

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。

ˎˎ 極端に寒い所、暑い所（使用温度は0	℃～
40	℃）。	
真夏、窓を閉め切った自動車内は50	℃を越え
ることがあります。

ˎˎ 湿気・ほこりの多い所。雨があたる所。

ˎˎ 激しく振動する所。

ˎˎ 強い磁気を発生するものの近く。

ˎˎ 強力な電波を発生するテレビやラジオの送信
所の近く。

ˎˎ 直射日光が長時間当たる場所や暖房器具の近
く。

携帯電話などによる電波障害を防止す
るために

携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を与
えることがあります。本機の近くでは携帯電話な
どの電源はできるだけ切ってください。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに損傷
を与えることがあります。レーザービームを使用
した撮影環境では、CMOSイメージセンサー表
面にレーザービームが照射されないように充分
注意してください。特に医療用などの強力なレー
ザー光の場合は、反射光や散乱光でも損傷を与
えることがあります。

セキュリティに関するご注意

ˎˎ 安全に設計されたファイアウォールの下で使用
してください。信用できない機器に接続される
可能性があるネットワークには、本機を接続し
ないでください。

ˎˎ FTPはコンテンツ、ユーザー名、パスワードが
暗号化されないため、FTPSを使用できる場合
はFTPSを使用してください。

ˎˎ 通信を行う機器でセキュリティ対策を行わな
かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリティ
上の問題が発生した場合、弊社ではそれによっ
て生じたあらゆる損害に対する責任を負いかね
ます。

ˎˎ 使用環境によってはネットワーク上の意図せぬ
第三者から製品にアクセスされる可能性があり
ます。本機をネットワークに接続する際には、
セキュアなネットワークであることをご確認の
上ご使用ください。

ˎˎ 利用者が気付かないうちに、電波が届くところ
から意図せぬ第三者に通信内容を盗み見られ
てしまうおそれがあります。無線LAN通信を利
用する際は、通信内容を保護するために、適
切なセキュリティ対策をしてください。
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ˎˎ セキュリティの面から、製品をネットワークに
接続してご使用になる際は、アクセス制限設
定を工場出荷時の設定値から変更して設定す
ることを強く推奨します（118ページ）。特に
Openのネットワークに接続する場合はご注意
ください。	
また、セキュリティの観点から、パスワードに
は他人に推測されにくく十分な長さのある文字
列を設定し、厳重に保管することを推奨します。

ˎˎ 設定作業中または設定作業後のブラウザーで
他のサイトを閲覧しないでください。	
ブラウザーにログインした状態が残りますの
で、意図しない第三者の使用や悪意のあるプ
ログラムの実行を防ぐために、設定作業が完
了したら必ずブラウザーを終了してください。
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初期設定値は、太文字（例：1920×1080P	(Level	A)）で示します。

［ご注意］

ˎˎ 出力フォーマットの解像度はProjectメニューのRec	FormatのFrequencyおよびVideo	Formatなどの設定によって制
限されます（93ページ）。
ˎˎ 再生画像より映像出力の解像度が大きい場合、映像は出力されません。

SDI	OUT/HDMI	OUT端子の出力フォーマット

システム周波数
（Projectメニュー
>Rec	Formatの
Frequency）

録画フォーマット設
定（Projectメニュー
>Rec	Formatの
Video	Format）

出力フォーマット（Monitoring>Output	Format）
SDI1 SDI2 HDMI

59.94	/	50 4096×2160P 4096×2160P ― 4096×2160P
1920×1080P	
(Level	A)

1920×1080P	
(Level	A)

1920×1080P

1920×1080P	
(Level	B)

1920×1080P	
(Level	B)

―

1920×1080P	
(Level	A)

1920×1080i 1920×1080i

1920×1080P	
(Level	B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i
3840×2160P 3840×2160P ― 3840×2160P

1920×1080P	
(Level	A)

1920×1080P	
(Level	A)

1920×1080P

1920×1080P	
(Level	B)

1920×1080P	
(Level	B)

―

1920×1080P	
(Level	A)

1920×1080i 1920×1080i

1920×1080P	
(Level	B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

システム周波数
（Projectメニュー
>Rec	Formatの
Frequency）

録画フォーマット設
定（Projectメニュー
>Rec	Formatの
Video	Format）

出力フォーマット（Monitoring>Output	Format）
SDI1 SDI2 HDMI

59.94	/	50 1920×1080P	/		
RAWのみ1)

1920×1080P	
(Level	A)

1920×1080P	
(Level	A)

1920×1080P

1920×1080P	
(Level	B)

1920×1080P	
(Level	B)

―

1920×1080P	
(Level	A)

1920×1080i 1920×1080i

1920×1080P	
(Level	B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i
― ― 720×480P/	

720×576P
29.97	/	25 4096×2160P 4096×2160P ― 4096×2160P

1920×1080i(PsF)	 1920×1080i(PsF)	 1920×1080i(PsF)	
3840×2160P 3840×2160P ― 3840×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)
1920×1080P	/		
RAWのみ1)

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

24 4096×2160 4096×2160P ― 4096×2160P
1920×1080P 1920×1080P 1920×1080P

RAWのみ1) 1920×1080P 1920×1080P 1920×1080P
23.98 4096×2160P 4096×2160P ― 4096×2160P

1920×1080P 1920×1080P 1920×1080P
3840×2160P 3840×2160P ― 3840×2160P

1920×1080P 1920×1080P 1920×1080P
1920×1080P	/		
RAWのみ1)

1920×1080P 1920×1080P 1920×1080P

1)	 内蔵記録なしの場合

出力のフォーマットと制限
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モニター LUTの制限

モニター LUT機能は、Cine	EIモードで記録解像度4096×2160または3840×2160のとき、使用で
きます。
ShootingメニューのMonitor	LUT	SettingのMonitor	OutをMLUT	Onに設定した場合、映像出力
解像度1920×1080は、モニター LUTが当たった映像となります。
映像出力解像度4096×2160または3840×2160は、記録映像と同じ映像となります。

画面表示出力の制限

各出力信号（SDI1、SDI2、HDMI）へのメニューやステータス重畳のOn/Offの状態は、Output	
Formatの出力解像度とMonitoringメニューのOutput	DisplayのSettingの設定によって以下のよう
に決まります。

出力解像度 Output	Display>	
Setting

Output	Display>	
SDI1

Output	Display>	
SDI2

Output	Display>	
HDMI

4K On On ―（出力Off） On
Off Off ―（出力Off） Off

HD On Off On On
Off Off Off Off
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電源

症状 原因 対策
電源が入らない。 バッテリーパックからの電源、

DC	IN電源のどちらも供給さ
れていない。

バッテリーパックを取り付ける（18ペー
ジ）か、ACアダプターを使用してAC電源
に接続する（19ページ）。

バッテリーパックが完全に消耗
している。

充電済みのバッテリーパックと交換する
（18ページ）。

電源が途中で切れる。 バッテリーパックが消耗してい
る。

充電済みのバッテリーパックと交換する
（18ページ）。

バッテリーパックがすぐ消耗す
る。

温度が極端に低いところで使
用している。

バッテリーパックの特性によるもので、故
障ではありません。

充電が不充分。 バッテリーパックをもう一度充電し直す
（18ページ）。
フル充電してもすぐに消耗する場合は、
バッテリーパックの寿命です。新しいバッ
テリーパックに交換してください。

記録・再生

症状 原因 対策
録画ボタンを押しても記録が
始まらない。

XQDメモリーカードの容量が
いっぱいになっている。

充分な空き容量のあるXQDメモリーカー
ドに交換する。

修復が必要なXQDメモリー
カードが入っている。

XQDメモリーカードを修復する（31
ページ）。

音声が記録できない。 AUDIO	LEVEL（CH1/CH2/
CH3/CH4）ダイヤルが最小の
位置になっている。

AUDIO	LEVEL（CH1/CH2/CH3/CH4）ダ
イヤルを調節する（45ページ）。

記録した音声がひずんでいる。 音声レベルが高すぎる。 AUDIO	LEVEL（CH1/CH2/CH3/CH4）ダ
イヤルを調節する（45ページ）。

雑音が多い。 音声レベルが低すぎる。 AUDIO	LEVEL（CH1/CH2/CH3/CH4）ダ
イヤルを調節する（45ページ）。
外部マイク選択時は、Audioメニューの
Audio	InputのINPUT	MIC	Reference
の設定値も調節する（110ページ）。

症状 原因 対策
クリップを再生できない。 クリップが編集されている。 コンピューターでフォルダーやファイル名

を変更したり、クリップを加工したりする
と、再生できない場合があります。故障
ではありません。

クリップが他機で記録されて
いる。

他機で記録したクリップは、再生できな
かったり、正しいサイズで表示されなかっ
たりすることがあります。故障ではありま
せん。

外部機器

症状 対策
本機がコンピューターに認識され
ない。

コンピューターからUSBケーブルを抜き、もう一度しっかりと差し込む。
コンピューターからUSBケーブルを抜き、コンピューターを再起動して
から正しい手順でもう一度コンピューターと本機をつなぐ。

クリップがコンピューターに取り込
めない。

コンピューターからUSBケーブルを抜き、本機の電源を入れてから、
もう一度つなぐ。
クリップをコンピューターに取り込むにはアプリケーションソフトウェ
アのダウンロードが必要です（129ページ）。

トラブル時の対処
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ワイヤレスLAN使用時

［ご注意］
本機とワイヤレスLANアクセスポイントまたは端末機器間の障害物や電波状況、壁の材質など、周囲の環境によって通信
可能距離が短くなったり、接続できなくなったりすることがあります。本機の場所を移動するなど、本機とアクセスポイン
トまたは端末機器の距離を近づけて、接続/通信状態を確認してください。

症状 対策
端末機器から本機にアクセスでき
ない

	ˎ ワイヤレスLANの接続（IPアドレスなど）を確認してください
	ˎ アクセスポイントのクライアント間の通信設定が無効になっている
可能性があります。詳しくは、アクセスポイントの取扱説明書をご
覧ください。

ログインできない 登録したユーザー名、パスワードが正しいか確認してください。
Webリモコンが表示できない IPアドレスを確認してください。

インターネット接続

症状 対策
ファイル転送が失敗する サーバーのユーザー名/パスワードが間違っている可能性があります。

正しい値を入力してください。
ファイル転送ができない 3G/4Gの電波状態が悪い可能性があります。

移動して再度試してください。

NDフィルター使用時

症状 対策
NDフィルターが動かない。 次の作業により、手動でClearの位置に移動させることができます。

1 本機のPOWERスイッチをOffにする。

2 底面の丸いフタを外す。

3 ドライバーを穴に差し込んで左に回す。

ˎˎ 左に回すことで、NDフィルターがClear側に動きます。Clearの位置になるまで回し続けてくだ
さい。

ˎˎ φ2.4以下のマイナスドライバーを使用してください。ドライバー挿入部の深さは約3.0	cmです。

ドライバー挿入部
（フタを外した状態）

4 ND	PRESET/VARIABLEスイッチ（6ページ）をPRESETの位置にして、ND	FILTER	
POSITION上下ボタン（6ページ）をCLEARの位置にする。

［ご注意］

ˎˎ 上記の作業は、通常の動作時には行わないでください。NDフィルターが動かなくなった場合のみに行ってください。通
常の動作時に行うと、NDユニットが故障するおそれがあります。
ˎˎ 上記の作業を行ったあと、サービスセンターで本機を修理してください。
ˎˎ 上記の作業を行ってもエラーメッセージが出たままの場合がありますが、撮影は可能です。
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本機では警告、注意、動作確認などが必要な状況では、ビューファインダー画面のメッセージ表示、
記録/タリーランプの点滅、および警告音で対応します。
警告音は、内蔵スピーカーまたはヘッドホン端子に接続したヘッドホンに出力します。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

E+エラーコード 連続音 高速点滅 本体の異常の可能性があります。ビューファインダー
画面上にRECと表示されていても記録は止まってい
ます。
電源を切り、接続している機器やケーブル類、メディ
アに異常がないか確認してください。これらに異常が
ないときは、再度電源を入れ、エラーが継続する場
合はソニーのサービス窓口にご連絡ください。

（POWERスイッチをOffにしても電源が切れない場合
は、バッテリーパックやDC	IN電源も外してください。）
本機の状況によっては、エラー表示や警告音が出な
い可能性があります。

警告表示

次のような表示が出た場合は、メッセージに従って対策してください。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

Battery	Near	End 断続音 点滅 バッテリーパックの残量が少なくなっています。
早い機会に充電してください。

Battery	End 連続音 高速点滅 バッテリーパックが消耗しました。記録はできません。
一旦操作を中止し、バッテリーパックを交換してくだ
さい。

Temperature	High 断続音 点滅 内部温度が上昇しました。
一旦電源を切り、温度が下がるまで使用を中止してく
ださい。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

Voltage	Low 断続音 点滅 DC	IN電圧が低くなっています（段階1）。供給電源を
確認してください。

Insufficient	Voltage 連続音 高速点滅 DC	IN電圧が低すぎます（段階2）。記録はできません。
他の電源に接続し直してください。

Media	Near	Full 断続音 点滅 XQDメモリーカードの残量が少なくなっています。
早い機会に交換してください。

Media	Full 連続音 高速点滅 XQDメモリーカードの残量がないため、記録、コピー
はできません。
交換してください。

Clips	Near	Full 断続音 点滅 XQDメモリーカードに記録できる残りのクリップ数が
少なくなっています。
早い機会に交換してください。

Clips	Full 連続音 高速点滅 XQDメモリーカードに記録できるクリップ数の上限に
達しました。
これ以上記録やコピーはできません。交換してくださ
い。

Last	Clip	Recording 断続音 点滅 記録中のクリップの記録を完了すると、記録可能なク
リップ数の上限に達します。
新しいXQDメモリーカードをご用意ください。

Media(A)1)	Near	Full 断続音 点滅 同時記録機能使用時
Media(A)1)	Full 連続音 高速点滅 同時記録機能使用時
Media(A)1)	Clips	
Near	Full

断続音 点滅 同時記録機能使用時

Media(A)1)	Clips	Full 連続音 高速点滅 同時記録機能使用時
Media(A)1)	Last	Clip	
Rec

断続音 点滅 同時記録機能使用時

Transfer	Jobs	Near	
Full

― ― FTPファイル転送ジョブ登録可能数が少なくなってい
ます。

Transfer	Jobs	Full ― ― FTPファイル転送ジョブ登録可能数が上限に達しまし
た。ジョブを追加したい場合は、不要なジョブを削
除してください。2)

1)	 スロットBに入れたカードの場合は(B)
2)	NetworkメニューのFile	Transfer	>	View	Job	List（122ページ）からジョブを選んで削除することができます。または、

CBMのジョブリストからジョブを削除することができます。

エラー/警告表示
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注意・動作確認表示

画面中央部分に次のような注意・動作確認表示が現れることがあります。この場合は次表に従って対
処してください。

表示内容 原因と対策
Battery	Error
Please	Change	Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

Backup	Battery	End
Please	Change

バックアップ電池の残量が不足しています。
バックアップ電池を充電してください。

Unknown	Media（A）1）

Please	Change
パーティションが切られているメモリーカードや、本機では未対
応のメモリーカードが挿入されました。
本機では使用できませんので、交換してください。

Cannot	Use	Media（A）1）

Unsupported	File	System
ファイルシステムの異なるカードまたはフォーマットされていない
カードが挿入されました。
本機では使用できませんので、交換または本機でフォーマットし
てください。

Media	Needs	to	be	Restored メモリーカードに異常が発生し、修復が必要な状態になりました。
メモリーカードの修復を行ってください。

Media	Error
Cannot	Record	to	Media（A）1）

メモリーカードが故障して、記録ができなくなりました。
再生は可能ですので、コピーをとるなどして、新しいメモリーカー
ドに交換することをお勧めします。

Media	Error
Cannot	Use	Media（A）1）

メモリーカードが故障して記録も再生もできなくなりました。
本機では扱えませんので、他のカードに交換してください。

Media（A）1）Error
Recording	Halted
Playback	Halted

メモリーカードに異常が発生したため、記録または再生が停止し
ました。
頻繁に起きる場合には、メモリーカードを交換してください。

Media	Reached	Rewriting	Limit
Change	Media（A）1）

メモリーカードの寿命がきました。
バックアップをとり、速やかに交換してください。継続して使用す
ると、正常に記録・再生できない可能性があります。
詳しくは、メモリーカードの取扱説明書を参照してください。

Copy	All	Sub	Clips
NG:	Reached	Clip	Number	Limit
NG:	Same	File	Already	Exists
NG:	Not	Enough	Capacity

Copy	All	Sub	Clipsの全コピーが、表示されている理由で完了し
ませんでした。
	ˎ 最大クリップ数になった
	ˎ 同名のファイルが存在する
	ˎ メディアの残量が足りない

メディアを交換してください。
The	specified	address	is	invalid. 指定したアドレスが間違っています。

正しく設定しているか確認してください。

表示内容 原因と対策
Cannot	Use	Specified	Port	
Number

指定したポート番号が間違っています。
正しく設定しているか確認してください。

Fan	Stopped 本体内のファンが停止しています。
高温下での使用を避け、電源を切ってソニーのサービス担当者に
連絡してください。

Invalid	setting	value	was	reset:
Media/Clip	Naming/Camera	
Position
Please	save	All	File	again

不正なAllファイルが読み込まれたため、Clip	Namingの設定値
をリセットしました。
希望の設定値に合わせて、再度Allファイルの保存を実行してくだ
さい。

Lens	I/F	Error(xx:xx) Eマウントレンズ装着時にレンズI/F通信でレンズの不具合が検出
されました。
Eマウントレンズとの接続状態を確認してください。
改善しない場合は、ソニーのサービス担当者にエラーコード（括
弧内の5文字）をお伝えください。

This	Multi	Term.	acc	is	not	
supported	by	the	device	and	
cannot	be	used.
Please	verify	the	compatibility.

非対応のアクセサリーが検出されました。
本機が対応するマルチ端子アクセサリーは、付属のグリップリモ
コンのみです。

Failed. DHCP	Onでアドレスが割り当てられない場合、本エラーが出る
可能性があります。
DHCPサーバーの設定を確認してください。

Addition	of	auto	upload	job	failed. 転送ジョブの数が上限に達しています。
不要なジョブをクリアしてください。また、オリジナルファイルま
たはプロキシファイルの自動転送先設定が間違っている可能性が
あります。正しく設定しているか確認してください。

<SSID>Not	found. 指定した<SSID>のネットワーク（アクセスポイント）が見つかりま
せん。
正しく設定しているか確認してください。

<SSID>Authentication	Failed 指定した<SSID>のネットワーク（アクセスポイント）の接続認証に
失敗しました。
パスワードなどを正しく設定しているか確認してください。

An	IP	address	conflict	has	
occurred.	Please	check	the	
network	settings.

ワイヤレスLANと有線LANかモデム、またはモデム同士のネット
ワークアドレスが衝突しています。
アドレスを手動で変更するか、お使いのネットワークルーターの
設定を変更してください。

The	IP	address	of	the	Wireless	
LAN	Access	Point	Mode	has	been	
changed	due	to	an	IP	address	
conflict.

ワイヤレスLANアクセスポイントモードと有線LAN、またはモデ
ムのネットワークアドレスが衝突したため、ワイヤレスLANアクセ
スポイントモードのIPアドレスを変更しました。
IPアドレスを確認してください。

1）	スロットBに入れたカードの場合は（B）
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ファイルに保存される項目
セットアップメニューによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Shooting ISO/Gain/EI Mode Yes Yes
ISO/Gain<H> Yes Yes
ISO/Gain<M> Yes Yes
ISO/Gain<L> Yes Yes
Exposure	Index<H> Yes Yes
Exposure	Index<M> Yes Yes
Exposure	Index<L> Yes Yes
Shockless	Gain Yes Yes
Base	Sensitivity Yes Yes
Base	ISO Yes Yes

ND	Filter Preset1 Yes Yes
Preset2 Yes Yes
Preset3 Yes Yes

Shutter Mode Yes Yes
Shutter	Speed	On/Off Yes Yes
Shutter	Speed Yes Yes
Shutter	Angle Yes Yes
ECS	On/Off Yes Yes
ECS	Frequency Yes Yes

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Shooting Auto	Exposure Level Yes Yes
Mode Yes Yes
Speed Yes Yes
AGC Yes Yes
AGC	Limit Yes Yes
AGC	Point Yes Yes
Auto	Shutter Yes Yes
A.SHT	Limit Yes Yes
A.SHT	Point Yes Yes
Clip	High	light Yes No
Detect	Window Yes No
Detect	Window	Indication Yes Yes
Average	Peak	Level	Ratio Yes No
Custom	Width Yes No
Custom	Height Yes No
Custom	H	Position Yes No
Custom	V	Position Yes No

White Preset	White Yes No
Color	Temp	<A> Yes Yes*1

Tint<A> Yes Yes*1

R	Gain	<A> Yes Yes*1

B	Gain	<A> Yes Yes*1

Color	Temp	<B> Yes Yes*1

Tint<B> Yes Yes*1

R	Gain	<B> Yes Yes*1

B	Gain	<B> Yes Yes*1

White	Setting Shockless	White Yes No
ATW	Speed Yes No
White	Switch<B> Yes Yes
Filter	White	Memory Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Shooting Offset	White Offset	White	<A> Yes No
Offset	Color	Temp<A> Yes No
Offset	Tint<A> Yes No
Offset	White	<B> Yes No
Offset	Color	Temp<B> Yes No
Offset	Tint<B> Yes No
Offset	White<ATW> Yes No
Offset	Color	Temp<ATW> Yes No
Offset	Tint<ATW> Yes No

Focus AF	Transition	Speed Yes No
AF	Subj.	Shift	Sens. Yes No
Focus	Area Yes No
Focus	Area	(AF-S) Yes No
Face/Eye	Detection	AF Yes No
Push	AF	Mode Yes No
Touch	Function	in	MF Yes No
AF	Assist Yes No

S&Q	Motion Setting Yes No
Frame	Rate Yes No

Monitor	LUT Category Yes No
LUT	Select Yes No
User	3D	LUT	Select Yes No

Monitor	LUT	Setting Internal	Rec Yes No
Monitor	Out Yes No
HD(Sub)	Rec/Proxy ― ―
SDI1 ― ―
SDI2 ― ―
HDMI ― ―
VF/Streaming ― ―

Monitor	3D	LUT Load	from	Utility	SD/MS ― ―
Load	from	Cloud(Private) ― ―
Load	from	Cloud(Share) ― ―
Reset ― ―
Reset	All ― ―

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Shooting Noise	Suppression Setting(SDR/HDR) Yes Yes
Level(SDR/HDR) Yes Yes
Setting(Cine	EI) Yes No
Level(Cine	EI) Yes No

Flicker	Reduce Mode Yes No
Frequency Yes No

SteadyShot Setting Yes No
Auto	Black	Balance Auto	Black	Balance ― ―

Project Base	Setting Shooting	Mode Yes No
Rec	Format Frequency Yes No

Imager	Scan	Mode Yes No
Codec Yes No
RAW	Output	Format Yes No
Video	Format Yes No

Cine	EI	Setting Color	Gamut Yes No
Embed	LUT	File Yes No

HDR	Setting VF	SDR	Preview Yes No
SDR	Gain Yes No

Simul	Rec Setting Yes No
Rec	Button	Set Yes No

4K	&	HD	(Sub)	Rec Setting Yes No
Proxy	Rec Setting Yes No

Proxy	Format Yes No
Audio	Channel Yes No
Chunk Yes No

Interval	Rec Setting No No
Interval	Time Yes No
Number	of	Frames Yes No
Pre-Lighting Yes No

Picture	Cache	Rec Setting Yes No
Cache	Rec	Time Yes No

SDI/HDMI	Rec	Control Setting Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Project Assignable	Button <1> Yes No
<2> Yes No
<3> Yes No
<4> Yes No
<5> Yes No
<6> Yes No
<7> Yes No
<8> Yes No
<9> Yes No
<10> Yes No
Focus	Hold	Button Yes No

Assignable	Dial Assignable	Dial Yes No
Assignable	Dial	Direction Yes No

Multi	Function	Dial Default	Function Yes No
User	File Load	from	Utility	SD/MS ― ―

Save	to	Utility	SD/MS ― ―
File	ID No No
Load	Customize	Data Yes No
Load	White	Data Yes No

All	File Load	from	Utility	SD/MS ― ―
Load	from	Cloud(Private) ― ―
Load	from	Cloud(Share) ― ―
Save	to	Utility	SD/MS ― ―
Save	to	Cloud(Private) ― ―
Save	to	Cloud(Share) ― ―
File	ID Yes No
Load	Network	Data No No

Planning	Metadata Load	from	Media(A) ― ―
Load	from	Media(B) ― ―
Properties ― ―
Clear	Memory ― ―
Clip	Name	Display Yes No

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Paint HDR	Paint	Setting HLG	Look Yes Yes
HDR	Black	Offset Yes Yes
HDR	Knee Yes Yes
HDR	Knee	Point Yes Yes
HDR	Knee	Slope Yes Yes

Black Master	Black Yes Yes
R	Black Yes Yes
B	Black Yes Yes

Gamma Setting Yes Yes
Step	Gamma Yes Yes
Master	Gamma Yes Yes
R	Gamma Yes Yes
G	Gamma Yes Yes
B	Gamma Yes Yes
Gamma	Category Yes Yes
Gamma	Select Yes Yes

Black	Gamma Setting Yes Yes
Range Yes Yes
Master	Black	Gamma Yes Yes

Knee Setting Yes Yes
Auto	Knee Yes Yes
Point Yes Yes
Slope Yes Yes
Knee	Saturation Yes Yes
Knee	Saturation	Level Yes Yes

White	Clip Setting No Yes
Level Yes Yes
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Paint Detail(4K/QFHD) Setting Yes Yes
Level Yes Yes
H/V	Ratio Yes Yes
Crispening Yes Yes
Frequency Yes Yes
Knee	Aperture Yes Yes
Knee	Aperture	Level Yes Yes
White	Limit Yes Yes
Black	Limit Yes Yes
V	Detail	Creation Yes Yes

Detail(HD) Setting Yes Yes
Level Yes Yes
H/V	Ratio Yes Yes
Crispening Yes Yes
Frequency Yes Yes
Knee	Aperture Yes Yes
Knee	Aperture	Level Yes Yes
White	Limit Yes Yes
Black	Limit Yes Yes
V	Detail	Creation Yes Yes

Skin	Detail Setting Yes Yes
Area	Detection ― ―
Area	Indication No No
Level Yes Yes
Saturation Yes Yes
Hue Yes Yes
Width Yes Yes

Aperture Setting Yes Yes
Level Yes Yes

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Paint Matrix Setting Yes Yes
Adaptive	Matrix Yes Yes
Preset	Matrix Yes Yes
Preset	Select Yes Yes
User	Matrix Yes Yes
User	Matrix	Level Yes Yes
User	Matrix	Phase Yes Yes
User	Matrix	R-G Yes Yes
User	Matrix	R-B Yes Yes
User	Matrix	G-R Yes Yes
User	Matrix	G-B Yes Yes
User	Matrix	B-R Yes Yes
User	Matrix	B-G Yes Yes

Multi	Matrix Setting Yes Yes
Area	Indication No No
Color	Detection ― ―
Reset ― ―
Axis No No
Hue Yes Yes
Saturation Yes Yes

Scene	File Recall	Internal	Memory ― ―
Store	Internal	Memory ― ―
Load	from	Utility	SD/MS ― ―
Save	to	Utility	SD/MS ― ―
File	ID No Yes
Scene	White	Data Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

TC/Media Timecode Mode Yes No
Run Yes No
Setting No No
Reset ― ―
TC	Format Yes No

TC	Display Display	Select Yes No
Users	Bit Mode Yes No

Setting No No
HDMI	TC	Out Setting Yes No
Clip	Name	Format Auto	Naming Yes No

Camera	ID No No
Reel	Number No No
Camera	Position No No
Title	Prefix Yes No
Number	Set No No

Update	Media Media(A) ― ―
Media(B) ― ―

Format	Media Media(A) ― ―
Media(B) ― ―
Utility	SD/MS ― ―

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Monitoring Output	On/Off SDI1 Yes No
SDI2 Yes No
HDMI Yes No

Output	Format SDI1 Yes No
SDI2 Yes No
HDMI Yes No
REF No No

Output	Setting RAW	to	HD	Conv. Yes No
Output	Display Setting Yes No

SDI1 Yes No
SDI2 Yes No
HDMI Yes No

Display	On/Off Network	Status Yes No
File	Transfer	Status Yes No
NCM/Streaming	Status Yes No
Rec/Play	Status Yes No
RAW	Output	Control	Status Yes No
Tally Yes No
Battery	Remain Yes No
Focus	Mode Yes No
Focus	Position Yes No
Focus	Marker Yes No
Focus	Area	Indicator Yes No
Focus	Area	Ind.(AF-S) Yes No
Face/Eye	Detection	Frame Yes No
Lens	Info Yes No
Imager	Scan	Mode Yes No
Rec	Format Yes No
Frame	Rate Yes No
Zoom	Position Yes No
UWP	RF	Level Yes No
GPS Yes No
SteadyShot Yes No
Gamma/LUT Yes No
SDI/HDMI	Rec	Control Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Monitoring Display	On/Off Gamma	Display	Assist Yes No
Proxy	Status Yes No
Base	ISO/Sensitivity Yes No
Media	Status Yes No
Video	Signal	Monitor Yes No
Clip	Name Yes No
White	Balance Yes No
Scene	File Yes No
Focus	Indicator Yes No
Auto	Exposure	Mode Yes No
Auto	Exposure	Level Yes No
Timecode Yes No
ND	Filter Yes No
Iris Yes No
ISO/Gain/EI Yes No
Shutter Yes No
Level	Gauge Yes No
Audio	Level	Meter Yes No
Video	Level	Warning Yes No
Clip	Number Yes No
Notice	Message Yes No

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Monitoring Marker Setting Yes No
Color Yes No
Center	Marker Yes No
Safety	Zone Yes No
Safety	Area Yes No
Aspect	Marker Yes No
Aspect	Mask Yes No
Aspect	Safety	Zone Yes No
Aspect	Safety	Area Yes No
Aspect	Select Yes No
Guide	Frame Yes No
100%	Marker Yes No
User	Box Yes No
User	Box	Width Yes No
User	Box	Height Yes No
User	Box	H	Position Yes No
User	Box	V	Position Yes No

VF	Setting Contrast Yes No
Brightness Yes No
Color	Mode Yes No
De-Squeeze Yes No

Gamma	Display	Assist Setting Yes No
Peaking Setting Yes No

Type Yes No
Normal	Peaking	Frequency Yes No
Normal	Peaking	Level Yes No
Color Yes No
Color	Peaking	Level Yes No

Zebra Setting Yes No
Zebra	Select Yes No
Zebra1	Level Yes No
Zebra1	Aperture	Level Yes No
Zebra2	Level Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Audio Audio	Input CH1	MI	SHOE	Input	Select Yes No
CH2	EXT	Input	Select Yes No
CH2	MI	SHOE	Input	Select Yes No
CH3	Input	Select Yes No
CH4	Input	Select Yes No
INPUT1	MIC	Reference Yes No
INPUT2	MIC	Reference Yes No
Line	Input	Reference Yes No
Reference	Level Yes No
CH1	Wind	Filter Yes No
CH2	Wind	Filter Yes No
CH3	Wind	Filter Yes No
CH4	Wind	Filter Yes No
CH3	Level	Control Yes No
CH4	Level	Control Yes No
Audio	Input	Level Yes No
Limiter	Mode Yes No
CH1&2	AGC	Mode Yes No
CH3&4	AGC	Mode Yes No
AGC	Spec Yes No
1kHz	Tone	on	Color	Bars Yes No
CH1	Level Yes No
CH2	Level Yes No
CH3	Level Yes No
CH4	Level Yes No

Audio	Output Monitor	CH Yes No
Headphone	Out Yes No
Alarm	Level Yes No
HDMI	Output	CH Yes No

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Thumbnail Display	Clip	
Properties

― ―

Set	Shot	Mark Delete	Shot	Mark1 ― ―
Delete	Shot	Mark2 ― ―

Set	Clip	Flag Add	OK ― ―
Add	NG ― ―
Add	KEEP ― ―
Delete	Clip	Flag ― ―

Lock/Unlock	Clip Select	Clip ― ―
Lock	All	Clips ― ―
Unlock	All	Clips ― ―

Delete	Clip Select	Clip ― ―
All	Clips ― ―

Copy	Clip Select	Clip ― ―
All	Clips ― ―

Copy	Sub	Clip All	Clips ― ―
Transfer	Clip Select	Clip ― ―

All	Clips ― ―
Transfer	Clip	(Proxy) Select	Clip ― ―

All	Clips ― ―
Set	Index	Picture ― ―
Thumbnail	View Essence	Mark	Thumbnail ― ―

Clip	Thumbnail ― ―
Filter	Clips OK ― ―

NG ― ―
KEEP ― ―
None ― ―
All ― ―

Customize	View Thumbnail	Caption Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Technical Color	Bars Setting No No
Type Yes No

Test	Saw Test	Saw Yes No
ND	Dial CLEAR	with	Dial Yes No
Tally Front	Tally	Lamp Yes No

Rear	Tally	Lamp Yes No
Tally	Control Yes No

HOLD	Switch	Setting with	Rec	Button Yes No
with	Hand	Grip	Remote Yes No

Touch	Operation Setting Yes No
Rec	Review Setting Yes No
Handle	Zoom Setting Yes No

High Yes No
Low Yes No

GPS GPS Yes No
Menu	Settings User	Menu	Only Yes No

User	Menu	with	Lock No No
Status	Page	On/Off Main Yes No

Camera Yes No
Audio Yes No
Project Yes No
Monitoring Yes No
Assignable	Button Yes No
Battery Yes No
Media Yes No
GPS Yes No
Network Yes No
NCM/Streaming Yes No
File	Transfer Yes No

RCP CNS	Mode Yes No
Detail	Control(RCP) Yes No

Fan	Control Setting Yes No

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Technical Lens Zoom	Ring	Direction Yes No
Shading	Compensation Yes No
Chroma	Aberration	Comp. Yes No
Distortion	Comp. Yes No
Distance	Display Yes No
Zoom	Position	Display Yes No
Iris	Display Yes No

Video	Light	Set Video	Light	Set Yes No
APR APR ― ―
Camera	Battery	Alarm Low	Battery Yes No

Battery	Empty Yes No
Camera	DC	IN	Alarm DC	Low	Voltage1 Yes No

DC	Low	Voltage2 Yes No
Ext.	Unit	Battery	
Alarm

Near	End:Info	Battery Yes No
End:Info	Battery Yes No
Near	End:Sony	Battery Yes No
End:Sony	Battery Yes No
Near	End:Other	Battery Yes No
End:Other	Battery Yes No
Detected	Battery No No

Ext.	Unit	DC	IN	Alarm DC	Low	Voltage1 Yes No
DC	Low	Voltage2 Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Network Setup	for	Mobile	App Setup ― ―
Access	
Authentication

User	Name No No
Input	Password No No
Generate	Password No No
Show	Settings No No

Wireless	LAN Setting Yes No
WPS ― ―
NFC ― ―
MAC	Address ― ―

AP	Mode	Settings Channel Yes No
Camera	SSID	&	Password ― ―
Regenerate	Password ― ―
IP	Address ― ―
Subnet	Mask ― ―

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Network ST	Mode	Settings Camera	Remote	Control Yes No
Connected	Network

SSID ― ―
Security ― ―
Password ― ―
DHCP ― ―
IP	Address ― ―
Subnet	Mask ― ―
Gateway ― ―
DNS	Auto ― ―
Primary	DNS	Server ― ―
Secondary	DNS	Server ― ―

Scan	Networks
SSID ― ―
Security ― ―
Password No No
DHCP Yes No
IP	Address Yes No
Subnet	Mask Yes No
Gateway Yes No
DNS	Auto Yes No
Primary	DNS	Server Yes No
Secondary	DNS	Server Yes No

Manual	Register
SSID Yes No
Security Yes No
Password No No
DHCP Yes No
IP	Address Yes No
Subnet	Mask Yes No
Gateway Yes No
DNS	Auto Yes No
Primary	DNS	Server Yes No
Secondary	DNS	Server Yes No
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Network Wired	LAN Setting Yes No
Camera	Remote	Control Yes No
Detail	Settings

DHCP Yes No
IP	Address Yes No
Subnet	Mask Yes No
Gateway Yes No
DNS	Auto Yes No
Primary	DNS	Server Yes No
Secondary	DNS	Server Yes No

Modem Setting Yes No
Camera	Remote	Control Yes No
Modem1	IP	Address ― ―
Modem1	Subnet	Mask ― ―
Modem2	IP	Address ― ―
Modem2	Subnet	Mask ― ―

Network	Client	Mode Setting Yes No
NCM	Settings	Select Yes No
NCM	Settings1/NCM	Settings2/NCM	Settings3

Display	Name Yes No
CCM	Address Yes No
CCM	Port Yes No
User	Name No No
Password No No
CCM	Certificate ― ―
CCM	Certificate	Status ― ―
Camera	Control Yes No
Camera	Setting No No
Reset ― ―

Streaming	Quality Yes No

LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Network File	Transfer Auto	Upload Yes No
Auto	Upload	(Proxy) Yes No
Default	Upload	Server Yes No
Clear	Completed	Jobs ― ―
Clear	All	Jobs ― ―
View	Job	List ― ―
Server	Settings(NCM) ― ―
Server	Settings1/Server	Settings2/Server	Settings3

Display	Name Yes No
Service Yes No
Host	Name Yes No
Port Yes No
User	Name No No
Password No No
Passive	Mode Yes No
Destination	Directory Yes No
Using	Secure	Protocol Yes No
Root	Certificate ― ―
Root	Certificate	Status ― ―
Reset ― ―

Network	Reset Reset ― ―
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LEVEL	1 LEVEL	2 LEVEL	3 All	File Scene	
File

Maintenance Language Select Yes No
Clock	Set Time	Zone Yes No

Date	Mode Yes No
12h/24h Yes No
Date No No
Time No No

Network	Public	Key Key	Creation ― ―
Key	Clear ― ―
Create	Key	Date ― ―

All	Reset Reset ― ―
Reset	without	Network ― ―

Hours	Meter Hours(System) ― ―
Hours(Reset) ― ―
Reset ― ―

Version Version	Number ― ―
Ext.	Unit	Version	Number ― ―
Version	Up ― ―
Lens	Version	Number ― ―

*1	 PaintメニューのScene	FileのScene	White	DataがOffのときは読み込みされません。

アサイナブルボタンによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

アサイナブルボタンの選択肢 All	File Scene	File
ND	Filter	Position Yes Yes
Auto	Iris Yes Yes
ATW Yes Yes*1

Focus	Setting Yes No
Display Yes No
VF	Adjust Yes No

*1	 PaintメニューのScene	FileのScene	White	DataがOffのときは読み込みされません。

アサイナブルダイヤルによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

アサイナブルダイヤルの選択肢 All	File Scene	File
IRIS Yes Yes
ND	Filter Yes Yes
Audio	Input	Level Yes No
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ブロックダイヤグラム
「収録する音声を設定する」（45ページ）と「Audioメニュー」（110ページ）の関連項目をあわせてご覧ください。

Audio	Input	(CH1&CH2)

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
（モノラル）

CH1

[CH2 EXT Input Select]
INPUT1
INPUT2

<CH1 INPUT SELECT>
EXT
INT
MI SHOE

<CH2 INPUT SELECT>
EXT
INT
MI SHOE

[CH2 MI SHOE Input
Select]
Shoe CH2
Wireless

[CH1 MI SHOE Input Select]
Shoe CH1
Wireless

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ～ 10

[CH1 Wind Filter]
On
Off

[CH2 Wind Filter]
On
Off

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ～ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
Off

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 XLRアダプターからの音声入力があるときはManualになります。
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Audio	Input	(CH3&CH4)

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

<CH3 INPUT LEVEL>
0 ～ 10

CH4

<CH4 INPUT LEVEL>
0 ～ 10

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
Off
INPUT1
Internal MIC
Shoe CH1
Wireless

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

[CH3 Wind Filter]
On
Off

[CH4 Wind Filter]
On
Off

[CH4 Input Select]
Off
INPUT1
INPUT2
Internal MIC
Shoe CH2
Wireless

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
（モノラル）

[CH3 Level]
Audio Input Level
Side
Level + Side
Through

[CH4 Level]
Audio Input Level
Side
Level + Side
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
Off

	

*	 XLRアダプターからの音声入力があるときはManualになります。
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Audio	Output

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

<VOLUME>
0 ～ 50

L

R

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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本機でEマウントレンズ本体のソフトウェアをアッ
プデートできます。
アップデートできるレンズ本体とそのソフトウェア
は、レンズのWebサイトをご覧ください。

バージョンを確認する

1 Eマウントレンズを本機に取り付ける（22
ページ）。

2 MaintenanceメニューのVersionを選択
してLens	Version	Numberを表示する

（123ページ）。
Eマウントレンズのソフトウェアバージョン番
号が横に表示されます。

ソフトウェアをアップデートす
る

本機をマスストレージモードにします（129ペー
ジ）。
レンズのソフトウェアに添付された手順書に従っ
てソフトウェアをアップデートしてください。

Eマウントレンズのソフトウェアをアップデートする
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MPEG-4	AVC	Patent	
Portfolio	Licenseについて

本製品は、MPEG	LA,	LLCがライセンス活動を
行っているAVC	PATENT	PORTFOLIOLICENSE
の下、次の用途に限りライセンスされています：
(i)	消費者が個人的または他の報酬を受けていな

い使用目的で、MPEG-4	AVC規格に合致し
たビデオ信号（以下、AVC	VIDEOといいます）
にエンコードすること。

(ii)	AVC	VIDEO（消費者が個人的または他の報
酬を受けていない目的でエンコードしたもの、
若しくはMPEG	LAよりライセンスを取得した
プロバイダーがエンコードしたものに限られま
す）をデコードすること。

なお、その他の用途に関してはライセンスされて
いません。プロモーション、商業的に利用するこ
とに関する詳細な情報につきましては、MPEG	
LA,	LLC.のホームページをご参照ください。

GPL/LGPL適用ソフトウェア
の入手について

本製品はGPL/LGPL適用のソフトウェアを使用
しており、お客様には、これらのソフトウェアの
ソースコードの入手、改変、再配布の権利がある
ことをお知らせします。
これらのソースコードはインターネットのサーバー
からダウンロードすることが可能です。以下の
URLにアクセスすれば、具体的なダウンロードの
方法がわかるようになっています。
https://oss.sony.net/Products/Linux/

なお、ソースコードの中身についてのお問い合わ
せはご遠慮ください。

ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、

「PMHOME」	-	「LICENSE」内にあるファイルをご
一読ください。

END	USER	LICENSE	
AGREEMENT

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt to 
derive source code, modify, reverse engineer, decompile, 
or disassemble any of the SOFTWARE, whether in whole 
or in part, or create any derivative works from or of the 
SOFTWARE unless such derivative works are intentionally 
facilitated by the SOFTWARE. You may not modify or 
tamper with any digital rights management functionality 
of the SOFTWARE. You may not bypass, modify, defeat 
or circumvent any of the functions or protections of the 
SOFTWARE or any mechanisms operatively linked to 
the SOFTWARE. You may not separate any individual 
component of the SOFTWARE for use on more than one 
wireless adapter unless expressly authorized to do so 
by SONY. You may not remove, alter, cover or deface 
any trademarks or notices on the SOFTWARE. You may 
not share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, network 
services or other products other than SOFTWARE upon 
which the SOFTWARE’S performance depends might 
be interrupted or discontinued at the discretion of 
the suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 

ライセンスについて
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termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES (“CONTENT 
SERVICE”). USE OF THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF THAT CONTENT 
SERVICE. IF YOU DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE LIMITED. You 
acknowledge and agree that certain content and 
services available through the SOFTWARE may be 
provided by third parties over which SONY has no 
control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line 
control equipment in hazardous environments requiring 
fail-safe performance, such as in the operation of nuclear 
facilities, aircraft navigation or communication systems, 
air traffic control, direct life support machines, or 
weapons systems, in which the failure of the SOFTWARE 
could lead to death, personal injury, or severe physical or 
environmental damage (“HIGH RISK ACTIVITIES”). SONY, 
each of the THIRD-PARTY SUPPLIERS, and each of their 
respective affiliates specifically disclaim any express or 
implied warranty, duty or condition of fitness for HIGH 
RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR 
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF ANY 
EXPRESS OR IMPLIED WARRANTY, BREACH OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR UNDER ANY OTHER 
LEGAL THEORY RELATED TO THE SOFTWARE, INCLUDING, 
BUT NOT LIMITED TO, ANY DAMAGES ARISING OUT OF 
LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, 
LOSS OF USE OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER'S TIME, EVEN IF ANY 
OF THEM HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. IN ANY CASE, EACH AND ALL OF THEIR 
AGGREGATE LIABILITY UNDER ANY PROVISION OF THIS 
EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its affiliates, 
partners and agents may read, collect, transfer, process 
and store certain information collected from the 
SOFTWARE, including but not limited to information 
about (i) the SOFTWARE and (ii) the software 
applications, contents and peripheral devices that 
interact with your wireless adapter and the SOFTWARE 
(“Information”). Information includes, but is not limited 
to: (1) unique identifiers relating to your wireless adapter 
and its components; (2) performance of the wireless 
adapter, the SOFTWARE and their components; (3) 
configurations of your wireless adapter, the SOFTWARE 

and the software applications, contents and peripheral 
devices that interact with the wireless adapter and the 
SOFTWARE; (4) use and frequency of use of the functions 
of (x) the SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with the 
SOFTWARE; and (5) location data, as indicated below. 
SONY and its affiliates, partners and agents may use 
and disclose Information subject to applicable laws in 
order to improve its products and services or to provide 
products or services to you. Such uses include, but are 
not limited to: (a) administering the functionalities 
of the SOFTWARE; (b) to improve, service, update or 
upgrade the SOFTWARE; (c) improving, developing and 
enhancing the current and future products and services 
of SONY and other parties; (d) to provide you with 
information about the products and services offered by 
SONY and other parties; (e) complying with applicable 
laws or regulations; and (f) to the extent offered, 
providing you with location-based services of SONY 
and other parties, as indicated below. In addition, SONY 
retains the right to use Information to protect itself and 
third parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by the 
privacy policies of SONY or such third party. By reviewed 
the privacy policies applicable to such services and 
consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify the 
owner or user of the SOFTWARE without your knowledge 
or consent. Any use of Information will be in accordance 
with the privacy policies of SONY or such third party. 

Please contact applicable contact address of each area or 
country for SONY's current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 
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Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY's or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY's sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 

This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

オープンソースソフトウェアの
ライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭載
されています。
当該ソフトウェアの著作権者の要求に基づき、弊
社はこれらの内容をお客様に通知する義務があ
ります。
ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、

「PMHOME」	-	「LICENSE」内にあるファイルをご
一読ください。
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保証書

ˎˎ この製品には保証書が添付されていますので、
お買い上げの際お受け取りください。

ˎˎ 所定の事項の記入および記載内容をお確かめ
のうえ、大切に保存してください。

アフターサービス

調子が悪いときはまずチェックを

この説明書をもう一度ご覧になってお調べくださ
い。

それでも具合が悪いときは

お買い上げ店、または添付の「ソニー業務用商品
相談窓口のご案内」にあるお近くのソニーのサー
ビス窓口にご相談ください。

保証期間中の修理は

保証書の記載内容に基づいて修理させていただ
きます。詳しくは保証書をご覧ください。

保証期間経過後の修理は

修理によって機能が維持できる場合、ご要望に
より有料修理させていただきます。

保証期間中の修理など、アフターサービスにつ
いてご不明な点は、お買い上げ店、またはソニー
のサービス窓口にお問い合わせください。

保証書とアフターサービス
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一般

質量		 約2.3	kg（本体、ハンドル含む）
外形寸法	 （単位：mm、本体、ハンドル含む）1)

159.5

246

142.5

146

257

216

229

	

1)	寸法は概算値です。

電源電圧	 DC	19.5	V（18.0	V	～	20.5	V）
消費電力	 約35.2	W（本体、レンズ付、XAVC-I	

QFHD	59.94P記録時、ビューファ
インダー点灯時、外部機器接続な
し）

	 	 約36.8	W（本体、レンズ付、XAVC-I	
QFHD	59.94P記録時、ビュー
ファインダー点灯時、3G-SDI×2、
HDMI、外部機器接続端子を使用）

動作温度	 0	℃～ 40	℃
保存温度	 －20	℃～＋60	℃
連続操作時間
	 	 約54分（BP-U35使用時）	

（本体、レンズ付、XAVC-I	QFHD	
59.94P記録時、ビューファインダー

点灯時、外部機器接続なし）
記録フォーマット（ビデオ）
	 XAVC	Intra
	 	 XAVC-I	4K/QFHDモード：VBR、最大

ビットレート600	Mbps、MPEG-
4	AVC/H.264

	 	 XAVC-I	HDモード：CBG、最大ビット
レート223	Mbps、MPEG-4	AVC/
H.264

	 XAVC	Long
	 	 XAVC-L	QFHDモード：VBR、最大

ビットレート150	Mbps、MPEG-4	
H.264/AVC

	 	 XAVC-L	HD	50モード：VBR、最大
ビットレート50	Mbps、MPEG-4	
H.264/AVC

	 	 XAVC-L	HD	35モード：VBR、最大
ビットレート35	Mbps、MPEG-4	
H.264/AVC

	 	 XAVC-L	HD	25モード：VBR、最大
ビットレート25	Mbps、MPEG-4	
H.264/AVC

	 MPEG-2	Long	GOP
	 	 MPEG	HD422モード：CBR、最大

ビットレート50	Mbps、MPEG-2	
422P@HL

記録フォーマット（オーディオ）
	 LPCM	24ビット、48	kHz、4チャンネル
記録フレームレート
	 XAVC	Intra
	 	 XAVC-I	4Kモード：4096×

2160/59.94P、50P、29.97P、
25P、24P、23.98P

	 	 XAVC-I	QFHDモード：3840×
2160/59.94P、50P、29.97P、
23.98P、25P

	 	 XAVC-I	HDモード：1920×
1080/59.94P、50P、59.94i、
50i、29.97P、23.98P、25P

	 XAVC	Long
	 	 XAVC-L	QFHDモード：3840×

2160/59.94P、50P、29.97P、
23.98P、25P

	 	 XAVC-L	HD	50モード：1920×
1080/59.94P、50P、59.94i、
50i、29.97P、23.98P、25P

	 	 XAVC-L	HD	35モード：1920×
1080/59.94P、50P、59.94i、
50i、29.97P、23.98P、25P

	 	 XAVC-L	HD	25モード：1920×
1080/59.94i、50i

	 MPEG-2	Long	GOP
	 	 MPEG	HD422モード：1920×

1080/59.94i、50i、29.97P、
23.98P、25P

記録・再生時間
XAVC	Intra
	 XAVC-I	4K/QFHDモード：
	 	 59.94P
	 	 	 約22分（QD-G128E/QD-G120F使

用時）
	 XAVC-I	HDモード：
	 	 59.94P
	 	 	 約57分（QD-G128E/QD-G120F使

用時）
XAVC	Long
	 XAVC-L	QFHDモード：
	 	 59.94P
	 	 	 約86分（QD-G128E/G120F使用

時）
	 XAVC-L	HD	50モード：
	 	 59.94P
	 	 	 約110分（QD-G64E使用時）
	 XAVC-L	HD	35モード：
	 	 59.94P
	 	 	 約150分（QD-G64E使用時）
	 XAVC-L	HD	25モード：
	 	 59.94i
	 	 	 約200分（QD-G64E使用時）

MPEG-2	Long	GOP
	 MPEG	HD422モード：
	 	 59.94i
	 	 	 約105分（QD-G64E使用時）

［ご注意］
記録再生時間は、使用条件やメモリーの特性などにより、
多少の誤差が生じる場合があります。また、記録・再生時
間は、1クリップとして連続記録したときの時間です。記録
するクリップ数によっては記載の時間より短くなる場合が
あります。

カメラ部

撮像素子
	 35mmフルサイズ相当単板CMOSイメージセン

サー
画素数
	 20.5M（total）
オートフォーカス
	 検出方式：位相差検出方式/コントラスト検出

方式
内蔵NDフィルター
	 CLEAR：OFF
	 1：1/4ND
	 2：1/16ND
	 3：1/64ND
	 リニア可変ND：1/4ND ～ 1/128ND
ISO感度
	 ISO	800/4000（Cine	EIモード、D55	Light	

source）
レンズマウント
	 Eマウント（レバーロックタイプ）
ラティチュード
	 15+	stops
映像S/N
	 57	dB（Y）（Typical）
シャッタースピード
	 64F	～	1/8000秒（23.98P時）

仕様
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シャッターアングル
	 5.6°～	360°、2	～	64frame
スロー＆クイックモーション
	 XAVC	QFHD：1～ 60P、XAVC	HD：1～ 180P
ホワイトバランス
	 2000	K	～	15000	K
ゲイン
	 －3	dB	～	＋27	dB（1	dB単位）
ガンマカーブ
	 S-Cinetone、STD1、STD2、STD3、STD4、

STD5、STD6、HG1、HG2、
HG3、HG4、HG7、HG8、
S-Log3、HLG

オーディオ部

サンプリング周波数
	 48	kHz
量子化特性
	 24ビット
周波数特性
	 本体XLR入力MICモード時：20	Hz～20	kHz

（±3	dB以内）
	 本体XLR入力LINEモード時：20	Hz～20	kHz

（±3	dB以内）
ダイナミックレンジ
	 本体XLR入力MICモード時：80	dB（Typical）
	 本体XLR入力LINEモード時：90	dB（Typical）
ひずみ率
	 本体XLR入力MICモード時：0.08%以下（入力

レベル－40	dBu時）
	 本体XLR入力LINEモード時：0.08%以下（入力

レベル＋14	dBu時）
内蔵スピーカー
	 モノラル
内蔵マイク
	 モノラル

ワイヤレスLAN

対応規格
	 IEEE	802.11a/b/g/n/ac
使用周波数帯
	 2.4	GHz帯
	 5.2/5.3/5.6	GHz帯
セキュリティ
	 WEP/WPA-PSK/WPA2-PSK
	 NFCフォーラム	Type	3	Tag準拠

入出力部

入力
INPUT	1/2：
	 XLR型、3ピン、凹
	 LINE	/	MIC	/	MIC+48V切り替え可能
	 MIC：Reference	－30	dBu	～	－80	dBu
GENLOCK	IN：
	 BNC	型
TC	IN：
	 BNC	型

出力
SDI	OUT1：
	 BNC型、12G-SDI、6G-SDI、	

3G-SDI（Level	A/B）、HD-SDI
SDI	OUT2：
	 BNC型、3G-SDI（Level	A/B）、HD-SDI
ヘッドホン（ステレオミニジャック）：
	 －16	dBu（基準レベル出力、モニターボリューム

最大、16	Ω負荷時）
HDMI：
	 TypeA、19ピン
REF	OUT：
	 BNC	型

TC	OUT：
	 BNC	型

その他
DC	IN：
	 EIAJ標準、DC	18	V	～	20.5	V
拡張ユニット接続端子：
	 専用144ピン
マルチインターフェースシュー：
	 専用21ピン
REMOTE：
	 2.5φ3極ミニミニタイプ
USB/マルチ：
	 2.0規格準拠	マスストレージ用	microBタイプ

（1）
VF：
	 専用40ピン

表示部

ビューファインダー（LCD）
画面サイズ
	 対角8.8	cm（3.5型）
アスペクト比
	 16:9
画素数
	 1280（H）×720（V）

メディアスロット部

映像記録用XQDカードスロット（2）
UTILITY	SD/MSカードスロット（1）

付属品

ACアダプター（1）
電源コード（1）
LCDモニター（ロッド、クランプ含む）
アイピース（1）
USBケーブル（1）
グリップリモコン（1）
レンズマウントキャップ（1）
ハンドル端子保護キャップ（1）
アクセサリーシューキット（アクセサリーシュー（1）、
シューバネ（1）、ネジ（4））
メジャーフック（1）
丸形クランプスペーサー（2）
ネジ（5）
ご使用になる前に（1）
保証書（1）

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。
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ˎˎ 必ず事前に記録テストを行い、正常に記録
されていることを確認してください。本機や
記録メディア、外部ストレージなどを使用中、
万一これらの不具合により記録されなかった
場合の記録内容の補償については、ご容赦
ください。

ˎˎ お使いになる前に、必ず動作確認を行ってく
ださい。故障その他に伴う営業上の機会損
失等は保証期間中および保証期間経過後に
かかわらず、補償はいたしかねますのでご了
承ください。

ˎˎ 本製品を使用したことによるお客様、または
第三者からのいかなる請求についても、当社
は一切の責任を負いかねます。

ˎˎ 本機内、記録メディア、外部のストレージ等
に記録されたデータの損失、修復、複製の
責任は負いかねます。

ˎˎ 諸事情による本製品に関連するサービスの停
止、中断について、一切の責任を負いかねま
す。

ソフトウェアのダウンロード
について

本機をPCと接続して使用する際は、必要に応
じてデバイスドライバーや各種プラグインソフト
ウェア、アプリケーションソフトウェアを下記サイ
トからダウンロードしてお使いください。

ソニープロフェッショナル/業務用製品	
サイトホームページ：

日本	 https://www.sony.jp/professional/
日本以外の国	

https://pro.sony/（ページ下部の
［Change	Country	&	Language］で地
域と言語を選択できます）

Sony	Creative	Software社のソフトウェアダウ
ンロードページ
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

商標について

ˎˎ “XDCAM”はソニー株式会社の商標です。

ˎˎ “XAVC”および	 	はソニー株式会社の登録
商標です。

ˎˎ XQD、および	 	はソニー株式会社の
商標です。

ˎˎ HDMI、High-Definition	Multimedia	
Interface、およびHDMIロゴ	は、米国お
よびその他の国におけるHDMI	Licensing	
Administrator,	Inc.の商標または、登録商標
です。

ˎˎ Microsoft、Windowsは、Microsoft	
Corporationの米国およびその他の国におけ
る登録商標または商標です。

ˎˎ Mac、Mac	OSはApple	Inc.の米国およびそ
の他の国における登録商標です。

ˎˎ “Memory	Stick”、“メモリースティック”、“メ
モリースティック	デュオ”、“メモリースティック	
PRO	デュオ”、“Catalyst	Browse”、“Content	
Browser	Mobile”、“Content	Browser	
Mobile”ロゴはソニー株式会社の商標または
登録商標です。

ˎˎ iOSは、米国シスコの商標もしくは登録商標で
す。

ˎˎ Android、Google	PlayはGoogle	Inc.の登
録商標または商標です。

ˎˎ Wi-Fi、Wi-Fiロゴ、Wi-Fi	PROTECTED	
SETUPはWi-Fi	Allianceの商標または登録商
標です。

ˎˎ「おサイフケータイ」は、株式会社NTTドコモ
の登録商標です。

ˎˎ NマークはNFC	Forum,Inc.の米国およびその
他の国における商標あるいは登録商標です。

ˎˎ QRコードは株式会社デンソーウェーブの登録
商標です。

その他の各社名および各商品名は各社の登録商
標または商標です。なお、本文中では™、®マー
クは明記していません。


